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1. Installing Teamcenter with Active
Workspace
Teamcenter is a product lifecycle management (PLM) platform that supports product development
from design through manufacturing. Active Workspace is a web-based Teamcenter client with powerful
collaboration, search, and visualization capabilities.

Installing Teamcenter with Active Workspace is a flexible process that accommodates the set of
applications you choose from its wide selection, the geographic distribution of your users, and other
variables. A Teamcenter administrator performs the installation in phases:

If you do not use Active Workspace, you can alternatively install the Teamcenter rich client, a Java-based
desktop client. Active Workspace requires no initial desktop installation or plug-ins like Java or ActiveX,
runs in a web browser, and provides enhanced functionality compared to the rich client.

Where do I go from here?

If your starting point is: And you want to: Begin here:
No existing Teamcenter
environment

Install Teamcenter and Active
Workspace

Plan the Teamcenter Environment

Teamcenter with Active
Workspace

Update Active Workspace Upgrade Teamcenter with Active
Workspace

Teamcenter without Active
Workspace

Add Active Workspace Adding Active Workspace to a
Teamcenter environment

Teamcenter with rich client Update Teamcenter and rich
client

Teamcenter Rich Client Installation
on Windows
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1. Installing Teamcenter with Active Workspace
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Part I: Plan the Teamcenter Environment

Begin the Plan phase of Teamcenter installation by gathering Teamcenter documentation and software.

Learn the architecture of a Teamcenter environment, and guidelines for distributing Teamcenter
components.

The Teamcenter Deployment Reference Architecture, available from the Teamcenter Downloads area
on Support Center, is an essential resource for planning a Teamcenter environment with Active
Workspace. It provides information such as:

• Detailed examples of Teamcenter and Active Workspace deployments.

• Guidelines for test environments and development environments and how to copy a Teamcenter
environment for upgrade testing.

When planning your distribution of Teamcenter components, see the Connection and Communication
Table (Teamcenter_Deployment_Connection_and_Communication_Table.xlsx) in the Teamcenter
Deployment Reference Architecture package. This document contains helpful guidelines for planning
communication between Teamcenter components.

Prepare the machines that will host your Teamcenter test and production environments. This includes
installing database infrastructure, the license server, locale support, and software like Security Services
that will support the Teamcenter and Active Workspace components.

Teamcenter Installation on Windows Using TEM, Teamcenter 2412
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2. Where to start
Get documentation

Teamcenter documentation is available from two sources:

• Internet: Support Center

This is Siemens Digital Industries Software's comprehensive support portal, which provides
documentation for all Siemens software products and versions.

You require a Webkey account to access Support Center. However, you can avoid this requirement
by installing the Siemens Documentation Proxy, which provides secure documentation access using
a personalized API key, with no need to log on. Teamcenter clients can be configured to access help
through the Documentation Proxy.

• Intranet: Siemens Documentation Server

This is a locally installed server that can host documentation for all your Siemens Digital Industries
Software products. No Internet access is required. You can configure the server for single-machine use
or network-wide access with no Webkey or API key required.

Teamcenter clients can be configured to access the help on the Siemens Documentation Server.

For an orientation to Support Center, see Siemens Software Support Center videos on YouTube.

Install the Documentation Proxy or the Documentation Server

Log on to Support Center and open the Siemens Documentation Server Downloads page:

Products→Siemens Documentation Server→Downloads

Choose how you want to access documentation, and then install the Documentation Proxy or the
Documentation Server.

Installing Siemens Documentation Proxy
Installing Siemens Documentation
Server

1. Under Select a Version, choose Documentation
Proxy 3, and then click the tile for the latest
Documentation Proxy 3.x release.

2. Download the Documentation Proxy installer:

DocumentationProxy.version.exe

1. Under Select a Version, choose
Siemens Documentation Server 3,
and then click the tile for the latest
Siemens Documentation Server 3.x
release.

2. Download the Documentation Server
installer:

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  2-1
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Installing Siemens Documentation Proxy
Installing Siemens Documentation
Server

3. Install the Documentation Proxy according to the
Documentation Proxy Installation Guide for Windows,
available under Release Documentation on the
software download page.

Installing the Documentation Proxy requires
generating an API key at the Siemens Support Center
account site. This may require you to obtain your
Siemens site ID from your Teamcenter administrator.

HelpServer.version.exe

3. Install the Documentation Proxy
according to the Siemens
Documentation Server Installation
Guide for Windows, available under
Release Documentation on the
software download page.

Note the machine and port on which you configured the Documentation Proxy or Documentation Server.
These are required to configure help access from Teamcenter clients.

Install the Teamcenter 2412 documentation kit

If you installed the Siemens Documentation Proxy, skip this section.

Teamcenter documentation is delivered in documentation kits. Each kit contains documentation content
and an installation wizard that automatically installs documentation onto your Documentation Server.

1. Log on to Support Center and open the Teamcenter Downloads page:

Products→Teamcenter→Downloads

2. Under Select a Version, choose Teamcenter 2412, and then click the Teamcenter 2412 tile.

3. Download the Teamcenter 2412 documentation kit:

docs-teamcenter-2412-locale.exe

4. Install the Teamcenter 2412 documentation onto the Documentation Server:

Double-click the docs-teamcenter-2412-locale.exe file.

For more information about installing documentation kits and managing the Documentation Server, see
the Siemens Documentation Server Installation Guide for Windows.

Verify documentation access

Open the Teamcenter 2412 documentation from your preferred source:

• Support Center (Webkey logon):

2. Where to start
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• Support Center (via Documentation Proxy):

http://doc-proxy-host:doc-proxy-port/en-US/doc/282219420/
PL20240523460057788.tc_doc_home

• Siemens Documentation Server:

http://doc-server-host:doc-server-port/en-US/doc/282219420/
PL20240523460057788.tc_doc_home

Enable help access in Teamcenter clients

Configure help in the rich client

If you use the rich client, configure the Help button in the client to open Teamcenter help from
your preferred source.

During installation:

When prompted in TEM, enter your preferred documentation URL in the Documentation
server URL box.

After installation:

Configure help access in the rich client.

Configure help in Active Workspace

Configure the Help button in the client to open Teamcenter help from your preferred source.

During installation:

The Active Workspace Help button links to Support Center by default and cannot be changed
during installation. Accessing help directly on Support Center requires a Webkey account.

After installation:

If you use the Documentation Proxy or the Documentation Server, set the
TC_Help_Documentation_Link preference to the path to your preferred documentation
source. This configures the Active Workspace Help button to link to that source.

If you use Support Center via the Documentation Proxy, set this preference to http://doc-
proxy-host:doc-proxy-port/en-US/doc/282219420/PL20240523460057788.

Get documentation
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If you use Siemens Documentation Server, set the preference to http://doc-server-host:doc-
server-port/en-US/doc/282219420/PL20240523460057788.

Get software

Installing Teamcenter requires the Teamcenter software kit, which includes microservice framework and
Active Workspace software.

1. Log on to Support Center and open the Teamcenter Downloads page:

Products→Teamcenter→Downloads

2. Under Select a Version, choose Teamcenter 2412, and then click the Teamcenter 2412 tile.

3. Download the Teamcenter 2412 software kit for Windows (Tc2412_wntx64.zip).

4. Expand the software kit to a directory that is accessible to the machines on which you install
Teamcenter software.

If an update (patch) to Teamcenter 2412 is available, for example, Teamcenter 2412.0001, you can
additionally download the update, and apply it during the Teamcenter installation.

Can I place the software in a remote location?

TEM cannot install software from UNC paths, for example, \\mediaserver\tcmedia. If the software kits
are located on a remote host, map a drive to each software location using the net use command.

Open an administrator command prompt and type the net use command:

net use drive-letter: UNC-path

For example:

net use z: \\mediaserver\tcmedia

Get started

If you are new to Teamcenter installation, the following resources may help you get started.

If you want to
know more
about: See these resources:
Support Center Support Center is Siemens Digital Industries Software's comprehensive support

portal, providing software, documentation, and a variety of support content:

https://support.sw.siemens.com

2. Where to start
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If you want to
know more
about: See these resources:

For a step-by-step orientation to Support Center, see Siemens Software Support
Center videos on YouTube.

Teamcenter If you are new to Teamcenter, learn about Teamcenter architecture and
components.

Also, see the Teamcenter Deployment Reference Architecture, which provides
detailed examples of Teamcenter deployments, with sample deploy scripts and
other resources. This package is available in the Teamcenter Downloads area on
Support Center.

Active Workspace If you are new to Active Workspace, learn about Active Workspace components
in Teamcenter, and how Active Workspace installation is part of installing a
Teamcenter environment.

Microservice
Framework

Active Workspace requires the microservice framework. Learn about microservices
and the microservice framework.

Deployment
Center

If you are familiar with Teamcenter Environment Manager (TEM) but have not
yet explored Deployment Center, learn how installing and managing a Teamcenter
environment is different with Deployment Center.

Note:

TEM is deprecated and will be obsolete in a future version of Teamcenter.

At a glance: Deployment Center vs. TEM

These two Teamcenter deployment tools use distinct approaches to building and maintaining
Teamcenter environments.

• Deployment Center

Deployment Center manages environments from a central machine, and generates scripts and
software packages for multiple machines. Deployment Center tracks the software applications and
components installed on each machine.

In Deployment Center, selecting Teamcenter software to install primarily involves selecting
applications, packages of administration data, software modules, and parameters that add specialized
functionality to the Teamcenter environment. When you select applications, Deployment Center
automatically selects the components required to support the selected applications. Components are
the architectural pieces of Teamcenter, such as servers, services, and databases.

You select applications in the Applications tab. You select and configure components in the
Components tab.

Get started
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You can designate which machines host each component from a single instance of the Deployment
Center web application. Deployment scripts supply machine information to components that
communicate with each other.

• Teamcenter Environment Manager

Teamcenter Environment Manager (TEM) is run on individual machines, and the Teamcenter
administrator tracks what software components are installed on each machine.

In TEM, applications and components are called features. Some feature groups like Base Install and
Server Enhancements contain components.

You select features (applications and components) in the Features panel.

TEM refers to a collection of features that share a common Teamcenter data directory as a
configuration. You can install multiple configurations on a single machine that share the same
Teamcenter application root directory.

Run TEM on every machine where you install components. Record information about each machine to
enter in configurations on other machines to enable components to communicate.

An environment created using TEM can be imported into Deployment Center by registering the
environment in Deployment Center.

Table 2-2. Comparison: Installing applications

Step Deployment Center TEM
1. Select applications. Select in the Applications tab. Select in the Features panel.
2. Select dependent
components.

Selected automatically. Select dependent components to
enable features for selection.

3. Enter parameter
values.

Enter values in the Components tab. Enter values in the sequence of panels.

4. Deploy software. Generate deploy scripts in the
Deploy tab, and then run scripts on
affected machines.

Click Start in the Confirmation
panel. Repeat steps on other affected
machines.

Table 2-3. Comparison: Installing components

Step Deployment Center TEM
1. Select components. Select in the Components tab. Select in the Features panel.
2. Enter parameter
values.

Enter values in the Components tab. Enter values in the sequence of
panels.

3. Deploy software. Generate deploy scripts in the Deploy
tab, and then run scripts on affected
machines.

Click Start in the Confirmation
panel. Repeat steps on other affected
machines.

2. Where to start
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System requirements

Verify system software requirements

1. Log on to Support Center and open the Support White Papers Certifications page:

a. Open Products→Teamcenter→Downloads.

b. Under Select a Version, choose Support White Papers→Support White Papers
Certifications, and then click the Support White Papers Certifications tile.

2. Download the following support documents:

Software Certifications Matrix (Tc2412PlatformMatrix-date.xlsx)

Contains information about system software certified for Teamcenter, such as operating
systems and Java runtime environments (JREs).

Teamcenter Interoperability Matrix (Teamcenter Interoperability Matrix date.xlsx).

Lists versions of Siemens Digital Industries Software products that are compatible with
Teamcenter 2412. It also lists supported Teamcenter paths.

Make sure you install versions of the required software that are listed in the Software Certifications
Matrix and the Teamcenter Interoperability Matrix.

Platforms

Determine from the following table which Teamcenter 2412 components are supported on your
operating system. Check marks (√) indicate components supported on the given operating system.

Operating system
Corporate
server Web tier

Active
Workspace Rich Client

Business Modeler IDE
client TCCS

Microsoft Windows
(desktop platforms)

✔ ✔ ✔ ✔

Microsoft Windows Server ✔ ✔ ✔

SUSE Linux ✔ ✔ ✔ ✔ ✔ ✔

Red Hat Linux ✔ ✔ ✔ ✔ ✔ ✔

• On Windows platforms, disable Windows User Account Control (UAC) before you install
Teamcenter. This option is available in the Control Panel→User Accounts dialog box.

Windows UAC can interfere with Teamcenter installation programs. Siemens Digital Industries
Software recommends turning off UAC for administrative users only.

System requirements
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For more information, see Microsoft Windows documentation.

• If you use a non-English language operating system version of Windows, you must install and
enable the Multilingual User Interface (MUI) pack to ensure the language font is displayed
properly.

1. Download and install the MUI pack for Windows from Microsoft.

2. Open the Regional and Language Options dialog box in the Windows Control Panel.

3. In the Languages tab, set the required language for the menus and dialogs.

4. In the Advanced tab and the Regional Options tab, set the required language.

Database

Teamcenter requires a relational database management system (RDBMS) for storing Teamcenter data.
Before you install Teamcenter, you must install an Oracle database server or a Microsoft SQL Server
database server.

If your database server is not a supported version, upgrade your database server to a supported version
before you install Teamcenter.

Choose a database management system that suits the platforms of your Teamcenter servers and clients,
and make sure your Teamcenter corporate server host has access to the database server.

If you use Oracle, set system parameters to recommended values to ensure adequate database
performance.

Java Runtime Environment

Teamcenter Environment Manager (TEM) requires a supported 64-bit Java Runtime Environment (JRE) or
Java Development Kit (JDK). If a certified JRE is not available on the host, TEM cancels installation.

Note:

If you use open-source Java, you must use a JDK, as some open-source JREs do not contain all
required libraries.

Before you launch TEM to install Teamcenter:

1. Download and install a certified 64-bit JRE or JDK.

For certified Java versions, see the Software Certifications Matrix on Support Center.

2. Where to start
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2. Set the JRE_HOME environment variable to the location of the supported JRE or JDK. After
installation is complete, TEM no longer requires this variable.

Alternatively, you can launch TEM in a command prompt and specify the JRE location using the -jre
argument:

tem -jre JRE-path

For example:

tem -jre c:\apps\jre1.8

Web tier support

Install the required software for the Teamcenter web tier you use:

• Java EE web tier

Java Runtime Environment (JRE)

Install a supported JRE on the host where you build Teamcenter web applications.

Java EE application server

Install a supported application server on the host where you deploy Teamcenter web
applications.

• .NET web tier

Microsoft Internet Information Server (IIS)

Install IIS on your Teamcenter corporate server host and add the required role services.

Microsoft .NET framework

Install the .NET framework on all Teamcenter hosts.

Some web application servers require special configuration for use with Teamcenter.

Web browser

A web browser is required if you use the following:

• Teamcenter online help
• Active Workspace
• Deployment Center

System requirements
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For these products, Teamcenter supports the following web browsers:

• Windows systems: Microsoft Edge, Mozilla Firefox, and Google Chrome
• Linux systems: Mozilla Firefox and Google Chrome

For supported browser versions, see the Software Certifications Matrix on the Support White Papers
Certifications page on Support Center.

2. Where to start
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3. The Teamcenter environment
Four-tier architecture

The Teamcenter platform is a software architecture that consists of four logical tiers that provide the
major functions:

Client interfaces through which users access Teamcenter.
Secure communication between client machines and
Teamcenter servers over local, wide-area, and global
networks.
Core Teamcenter operations, and retrieval and routing of
Teamcenter data.

Storage and organization of user data files, metadata, and
other forms of Teamcenter data.

Teamcenter environment

Each tier of the architecture hosts Teamcenter components, software modules that provide supporting
resources and services. Components may be installed on physical machines, virtual machines, or
containers.

A Teamcenter environment consists of all client and server machines that share resources of a
Teamcenter resource tier.

This simplified illustration shows groups of components representing the kinds of functionality
performed in each tier.
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Some components are contributed by the Teamcenter platform, some by Microservice Framework, and
some by Active Workspace, as indicated.

This illustration shows names of common components in each group. These components can be
selected for installation in TEM:

3. The Teamcenter environment
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Components can be installed on a single machine, as in a single box environment, or distributed on
multiple machines, as in a distributed environment.

The Teamcenter Deployment Reference Architecture, available on Support Center, provides detailed
examples of distributions of Teamcenter and Active Workspace components.

Web architecture types

Teamcenter supports two third-party platforms for communication through the web tier between
Teamcenter servers and clients.

Java EE The Java Platform, Enterprise Edition (Java EE) is supported on Windows and Linux
systems. The Teamcenter Java EE web tier is built on the Java EE platform and requires
a supported Java EE web server.

Microsoft
.NET

The Microsoft .NET framework is supported on Windows systems. The Teamcenter .NET
web tier is built on this platform and requires Microsoft Internet Information Server
(IIS).
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Environment types

The four-tier architecture does not represent physical locations of software components, it is a logical
organization for grouping components and functionality. Teamcenter components can be deployed on a
single machine or multiple machines, in the following two types of environments:

Single Box All components are installed on one machine, and all tiers operate on that machine.
This type of environment is useful for developing and testing Teamcenter deployment.

Distributed Components are installed on multiple machines, and the functions of the four logical
tiers may be distributed across multiple machines. This type is common for production
environments where software functions can be distributed over a network to optimize
performance with load balancing, failover support, and high availability.

3. The Teamcenter environment

3-4  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



4. Design the Teamcenter environment
How many servers do I need?

A Teamcenter network requires one corporate server configuration. Additional servers are optional, but
can help balance network loads and facilitate heterogeneous networks (networks with hosts running
different operating systems).

If you install the optional servers, Siemens Digital Industries Software recommends installing in the
following order:

1. Install a Teamcenter corporate server.

The corporate server is a network node used as an application file server (from the Teamcenter
application root directory) and database-specific configuration file server (from the Teamcenter
data directory). Run Teamcenter Environment Manager and install the Teamcenter executables and
the directory containing the database-specific configuration files. Teamcenter can also run locally
on this network node.

A Teamcenter corporate server contains the Teamcenter Foundation and FMS Server Cache
features as a minimum.

2. Optionally install additional Teamcenter servers to provide the following capabilities:

• Run Teamcenter executables and point to the existing data directory on the corporate server
host or another Teamcenter server. This server can contain a Teamcenter application root
directory structure on a network node that may be configured to run Teamcenter in the future.

• Run Teamcenter Environment Manager and point to an existing database. This server can
contain a Teamcenter network node to be used as a database-specific configuration file
(Teamcenter data directory) server when the Teamcenter application root directory is mapped
from a Teamcenter application server. Teamcenter can also be run locally on this system. You are
creating an additional Teamcenter database for use with an existing Teamcenter application root
directory.

Mixed platform considerations

Homogeneous network environment

In a homogeneous environment, all hosts run the same platform, for example, a corporate server,
web tier, and Teamcenter clients all running on Microsoft Windows or all running on SUSE Linux.

When deploying the two-tier architecture, you can install Teamcenter application executable files
on a single application server host, export the Teamcenter application root directory structure
from the Teamcenter application server, and mount it using CIFS on client workstations to run
Teamcenter locally. Typically, the Teamcenter application server is also the Teamcenter data server.
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Similarly, you can export the data directory structure and mount it using CIFS to other Teamcenter
clients to provide access to the database-specific information.

Heterogeneous network environment

In a heterogeneous environment, hosts do not all run the same platform, for example, a corporate
server and a web application server may run on Linux hosts, and workstations on Microsoft
Windows.

Installation considerations for a heterogeneous environment are the same as for a homogeneous
environment, except that you must install Teamcenter for each type of workstation on the network,
resulting in a Teamcenter application directory structure for each different type of workstation. You
can configure one Teamcenter application server to serve many Teamcenter directory structures for
different platforms.

Teamcenter volume data must be accessible by all Teamcenter clients in a heterogeneous network.
Configure File Management System for volume access for all clients.

Make sure your Windows and Linux server configurations contain identical sets of Teamcenter
features. For example, if you install features or custom templates on a Linux server, you must install
the same features and templates on your Windows server.

Additional considerations:

• The Teamcenter root directory is platform-specific. The files within it can be shared only between
systems of the same platform type. For heterogeneous Teamcenter environments that include
Windows clients or Windows volume servers, configure File Management System to allow all
clients to communicate with all volume servers.

• The Teamcenter root directory is specific to Windows or Linux systems (endian-specific). Maintain
separate Teamcenter data directories on Windows and Linux systems.

Planning File Management System installation

Overview of FMS installation

File Management System (FMS) downloads and uploads file data for the rich client, embedded viewer,
and Lifecycle Visualization. Multi-Site Collaboration also uses FMS servers to transfer data.

If you install File Management System, the FMS server cache (FSC) and the server manager must run on
the same host server, with the same user ID.

If the FSC does not manage any volumes, that is, if it is purely a cache server, it can run as any user that
is convenient.

FMS provides the following functions:

4. Design the Teamcenter environment
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• Volume server for file management

• Shared server-level performance cache for shared data access between multiple users

• Client-based private user cache for rich clients

• Transient data store mechanism for transporting reports, PLM XML, and other nonvolume data
between the web and client tiers in the four-tier architecture

FMS caching enables placing the data close to the user, while maintaining a central file volume and
database store.

FMS requires the installation of FMS server cache (FSC) and FMS client cache (FCC) components:

• The FSC component provides a server process and file caches for Teamcenter server hosts.

• The FCC component provides a client process and file caches for rich clients on user workstations.

Basic File Management System deployment

Installing the FMS server cache

You can configure the FMS server cache (FSC) server to perform any combination of the following
functions:

• Volume server or performance cache server

Installing the FMS server cache
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When running on a host where a volume is located or directly mounted on the computer hosting the
FSC, the FSC acts as a volume server.

When running on a host where a volume is not located or directly mounted, the FSC acts as a
performance cache server.

As a volume or cache server, the FSC checks all file access requests for a ticket that Teamcenter
generates to authorize file access. As a cache server, it manages two segment caches, one for
downloading files and one for uploading files.

• Configuration server

As a configuration server, the FSC provides FMS configuration information to the FMS client caches
and other FSCs.

• Transient server (in a deployment of the four-tier architecture only)

As a transient server, the FSC delivers PLM XML and other transient files to clients.

Any deployment of Teamcenter requires a minimum of one FSC server. You can deploy multiple FSC
servers, each performing multiple roles or each performing a designated purpose as either a volume,
a cache, or a configuration server. When you install multiple volumes on different hosts for the same
database, the multiple FSC servers are linked through a common primary (master) FSC. (You can
manually configure more than one primary FSC.)

You must install an FSC server on:

• Each host running a Teamcenter server manager.

• Each host that will contain a Teamcenter volume.

FSC servers and caches are configured using XML-based files, in a hierarchical structure:

• FMS primary configuration file (fmsmaster_fsc_id.xml)

The primary configuration file describes the File Management System network and defines FSC
groups. It is the highest file in the hierarchy and can define default values for FSCs and FCCs, such as
the maximum sizes of the caches.

Each installation of Teamcenter requires one FMS primary configuration file. At least one FSC server
reads this file and is called the primary FSC. Other FSC servers in the network download FMS
configuration information from the primary FSC server.

If you install only one FSC server in a Teamcenter network, it is the primary server.

• FSC configuration file (fscfsc_id.xml)

4. Design the Teamcenter environment

4-4  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



The FSC configuration file configures an individual FSC in a network. It specifies the address of the
primary FSC (for downloading FMS network information) and defines such values as the maximum
sizes of the server segment file caches and the upload timeout value.

This file can either inherit values from the primary file or override them. It can also define default
values for FCCs.

• The FCC configuration file defines values for the FCC on client hosts, such as the maximum sizes of the
caches.

It can either inherit values from the FSC configuration file or override them.

When planning your FMS installation, you must be prepared to supply the following information to the
Teamcenter installation tools:

Data Description

Read cache directory and size? For FMS to operate correctly, the location you specify must be on
the local host.

If you are installing a volume on the host, FMS does not use the
read cache; Siemens Digital Industries Software recommends
accepting the default cache size (10 megabytes). Do not specify
0; specifying 0 creates a file cache with a default size larger than
10 megabytes.

If you are not installing a volume on this host, FMS acts as a
cache server. In this case, Siemens Digital Industries Software
recommends increasing the value to 1000 megabytes. However,
choose a size that represents the maximum size of the data that
must be processed. If you choose 1000 megabytes, and a user
requests a 3 gigabyte assembly, the request fails.

Write cache and size? This cache is required when the FSC acts as a cache server.

For FMS to operate correctly, the location you specify must be on
the local host.

If you are installing a volume on this host, FMS does not use the
write cache; Siemens Digital Industries Software recommends
accepting the default cache size (10 megabytes). Do not specify
0; specifying 0 creates a file cache with a default size larger than
10 megabytes.

If you are not installing a volume on this host, FMS acts as a
cache server. In this case, Siemens Digital Industries Software
recommends increasing the value to 512 megabytes or more.
However, choose a size that represents the maximum size of the
data that must be processed.

Installing the FMS server cache
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Data Description

Communication mode between
FMS components?

Either HTTP or HTTPS.

Configure proxy servers? Either HTTP proxy server or HTTPS proxy server.

If you choose to configure proxy servers, you must provide:

• The name of the host running the proxy server.

• The number of the port the proxy server listens on.

Is this host an FMS primary
(master)?

If you are installing only one FSC server in the network, it must
be the primary host. Each Teamcenter network must have at
least one primary configuration file and one FSC designated to
read this file.

Symmetric or asymmetric keys for
ticket validation?

By default, FMS uses symmetric keys for ticket validation. You
can use Deployment Center to configure your site to use more
secure public-private (asymmetric) key pairs.

Default settings for the FCC? • Location of the cache directory for all Windows systems and
for all Linux systems.

• Default maximum size in megabytes of whole files
downloaded from the volume to rich client hosts. Users
cannot download a file whose size exceeds the value you set
for this value. This default setting can be overridden by the
FMS client cache configuration file.

Choose a size large enough to accommodate the largest
whole file that users download from the volume. If the user
requests a 3-gigabyte assembly when the cache size is set to
1000 megabytes, the request fails.

• Default maximum size in megabytes of whole files uploaded
to a volume from rich client hosts. Users cannot upload a
file whose size exceeds the value you set for this value. This
default setting can be overridden by the FMS client cache
configuration file.

Choose a size large enough to accommodate the largest
whole file that users upload to the volume.

• Default maximum size in megabytes of the segment file cache
used by the embedded viewer and the standalone application
viewer on rich client hosts.

4. Design the Teamcenter environment
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Data Description

This default setting can be overridden by the FMS client cache
configuration file.

• If no or few rich client users in the network deploy
Lifecycle Visualization, Siemens Digital Industries Software
recommends setting this cache size to 10 megabytes. Do
not specify 0; specifying 0 creates a file cache with a default
size larger than 10 megabytes.

• If rich client users in the network deploy Lifecycle
Visualization, Siemens Digital Industries Software
recommends setting this cache size in the range of 2000
megabytes to 4000 megabytes.

The cache size is initially small, expanding to the maximum
size only if a user launches Lifecycle Visualization to view a
file of that size. The initial size of the cache is proportional
to the value specify.

Teamcenter installation tools install and initially configure the FSC servers, segment file caches, primary
configuration file, and FSC configuration file or files. For small deployments of Teamcenter, this may be
the only installation and configuration required. For large deployments, you can take advantage of FMS
flexibility by manually configuring the FMS network.

Installing the FMS client cache

The FMS client cache (FCC) process runs on a client host and performs the following functions:

• Uploads files to an FSC server

• Requests files from an FSC server

• Caches files on the client host

The FCC process manages three file caches:

• A write cache containing whole files uploaded to a Teamcenter volume

• A read cache containing whole files downloaded from a Teamcenter volume

• A segment cache for Teamcenter lifecycle visualization

Installing the FCC supports the rich client and some other Siemens Digital Industries Software products.

Installing the FMS client cache

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  4-7
© 2025 Siemens



• The rich client requires an FCC, and TEM automatically installs an FCC with each rich client.

The rich client uploads files to the Teamcenter volume and downloads files from the Teamcenter
volume using the FCC. If Teamcenter lifecycle visualization 6.0 or later is installed on the workstation
and used with the rich client, it optionally uses the FCC.

When you install the rich client on user workstations, configure the location of the cache on the
workstation and the maximum size of files downloaded from the volume or uploaded to the volume.
Installing the rich client on a workstation simultaneously installs the FCC process and caches. No
additional configuration steps are required.

Configuring the FCC this way may be the only configuration you require, but you can take advantage
of additional configuration options by manually configuring the FCC.

• If you use NX or Teamcenter lifecycle visualization, you can install the FCC and use it to upload files to
and download files from the Teamcenter volume.

Installing the FCC enables users to take advantage of FMS features:

• Improved file transfer performance

FMS is a high-performance file transfer solution that gives client applications direct access to files
over a high-performance network connection.

• File streaming

Teamcenter lifecycle visualization uses proprietary file streaming technology to download
appropriate portions of the JT files over the network as they are needed. FMS supports segment file
transfer to keep network loads down and support this high-performance file streaming technology.

• Built-in caching infrastructure

The FCC is dedicated to a specific user on the client. The FSC server can be shared by groups of
users.

• Deployment flexibility

FMS components support a multitude of deployment configurations. This enables administrators to
geographically locate volumes and shared FSC servers close to client workstations, providing the
ability to tune the system for optimal file transfer performance.

Installing an FCC for use with NX and Teamcenter lifecycle visualization is described in the Teamcenter
client installation guides for Windows and Linux.

4. Design the Teamcenter environment
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Web tier dependencies and application integrations

Install the web tier for four-tier rich client and Active Workspace

If you use the four-tier rich client or Active Workspace, you must install a Teamcenter web tier to provide
communication between clients and the corporate server. Teamcenter provides two web tier types:

Type Framework Installed using Deployed on

.NET web tier Microsoft .NET Teamcenter Environment
Manager (TEM)

Microsoft Internet Information
Server (IIS)

Java EE web tier Java EE Web Application Manager Any supported Java EE web server

Choose applications and install dependent software

Teamcenter provides many applications you can include in your environment, including integrations to
third-party applications and other Siemens Digital Industries Software products. These are listed in the
Features panel in TEM.

If you use Teamcenter integrations to other Siemens Digital Industries Software products or third-party
software, install those products before you install Teamcenter.

Some software products require separate licenses from Siemens Digital Industries Software. Purchase
the required licenses and install them into the Siemens License Server.

If you use integrations with the rich client, make sure you install those applications in locations specified
by the Teamcenter administrator. Some of these integrations include:

• NX integrations

Installing NX is not a prerequisite for installing or using Teamcenter, but if you intend to integrate NX
with Teamcenter, install the following software before you install Teamcenter:

• NX

Install NX locally on every workstation according to the installation guide distributed with NX. This
is required for NX integrations to function in a rich client environment.

• Teamcenter Integration for NX or NX Integration

Teamcenter Integration for NX and NX Integration provide the same NX user interface and are both
installed with NX, but neither can be used until Teamcenter is configured.

Web tier dependencies and application integrations
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If you include the NX Foundation feature on your Corporate Server, you must install this feature on
every machine where Teamcenter Foundation is installed in the environment. Also, you must install
the NX Rich Client Integration feature on all two-tier rich clients in your environment.

When you upgrade to a new version of NX, uninstall the NX Rich Client Integration feature, then
reinstall it, specifying the path to the new NX installation in the NX Install Location box in TEM.

For more information about using Teamcenter with NX, see the installation guides distributed with
NX.

• Teamcenter lifecycle visualization (embedded viewer)

Download the Lifecycle Visualization software kit and install a supported version of Lifecycle
Visualization on your workstation.

When you choose this integration, Teamcenter lifecycle visualization executable files are installed on
the local client host.

Installing this feature requires system administrator privileges on the client workstation, even though
the rich client does not require these privileges.

• Remote workflow

When you choose this option, the rich client is enabled to support the linking of objects between
Teamcenter and other applications such as Teamcenter portfolio, program and project management.
Separate installation of remote workflow components are required.

4. Design the Teamcenter environment
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5. Configure language support
Supported Teamcenter localizations

Siemens Digital Industries Software provides localized versions of Teamcenter in the following locales:

Language Locale code
Chinese (Simplified) zh_CN
Chinese (Traditional) zh_TW
Czech cs_CZ
English en_US
French fr_FR
German de_DE
Italian it_IT
Japanese ja_JP
Korean ko_KR
Polish pl_PL
Portuguese (Brazilian) pt_BR
Russian ru_RU
Spanish es_ES

Use the appropriate locale codes to deploy Teamcenter localizations or launch Teamcenter clients in a
desired locale.

If you provide your own localizations for locales not provided by Siemens Digital Industries Software, use
the appropriate Java standard locale codes similar to the locale codes in the preceding table.1

Localizing Teamcenter in Hebrew

Siemens Digital Industries Software does not provide a Hebrew translation but provides recommended
configuration settings for Hebrew locales. In Hebrew locales, set the locale code to en_US. This allows
data entry in Hebrew, but user interface text is in English.

1 Standard locale codes are composed of a two lowercase character language code from the ISO 639-1 standard, followed
by an underscore, followed by a two uppercase character country code from the ISO 3166-1-alpha-2 standard.
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Choose the character set for Teamcenter

Choosing the correct character set for Teamcenter and the Teamcenter database is critical. If a
Teamcenter client user enters a character that is not recognized by the Teamcenter database, the
character is misinterpreted or corrupted when the user's data is checked into the Teamcenter database.

Determine the character set your Teamcenter network requires based on the following considerations.

Language support

Determine the languages you need to support, considering both initial needs and future needs. If you
support one language currently but anticipate supporting additional languages in the future, choose a
character set that accommodates those future requirements.

Some character sets support groups of languages. The standard localizations provided with
Teamcenter support the following language groups:

Language group Languages

Western European English
French
German
Italian
Portuguese (Brazilian)
Spanish

Eastern European Czech
Polish
English

Japanese Japanese
English

Chinese (Simplified) Chinese (Simplified)
English

Chinese (Traditional) Chinese (Traditional)
English

Korean Korean
English

Russian Russian
English

If the languages you plan to support are all in the same language group, you may choose a non-UTF-8
character set for your Teamcenter network. But, if you plan to support languages that are not all within a
single language group, you must choose the UTF-8 character set.

5. Configure language support
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For example, if your Teamcenter hosts run in English, French, and German locales, which are all in
the Western European language group, you may choose a non-UTF-8 character set or you may choose
UTF-8. However, if you also need to support hosts in Japanese locales, you must choose UTF-8 because
Japanese is not in the Western European language group.

The UTF-8 character set supports all languages supported by standard Teamcenter.

Choosing UTF-8 or non-UTF-8

Unicode encodings like UTF-8 enable seamless manipulation of all existing characters in all languages.
Teamcenter supports non-Unicode and UTF-8 Unicode encodings.

In a system fully configured for UTF-8 (for example, a server host configured for UTF-8 and a database
encoding of Oracle utf8 or Oracle al32utf8), all characters can be entered in the application.

In a system configured for a non-Unicode encoding, only characters belonging to it can be entered.
ASCII characters are always part of that character list. For example, if you choose Western European
setup (Microsoft cp1252 or ISO iso-88559-1 encodings), you cannot enter Russian, Japanese, Chinese,
Czech, Polish, Taiwanese, or Korean characters. Furthermore, database migration from one encoding to
Unicode can be tedious. It is important, then, to fully consider present and future needs when choosing
encoding.

Character support

Determine what special or extended characters you must support in Teamcenter data, and choose a
character set that supports them. For example:

En dash (–) or em dash (—)

These characters are part of Windows 1252 code page, but not part of the ISO8859_1 character set.
However, the UTF-8 character set supports these characters.

Currency symbols such as the euro (€)

This symbol is in the we8iso8859p15 character set, but not in the we8iso8859p1 character set.

To ensure correct character mapping, make sure the database and the Teamcenter server use the same
encoding.

Platform and database

• Platform

Choose a character set that accommodates the platforms in your Teamcenter network. For example,
if your Teamcenter server is a Linux host but your client hosts are Windows, and you use default
character sets on each, data corruption can result because the default character sets for these
platforms are not compatible. Choose a character set supported on both platforms.

Choose the character set for Teamcenter

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  5-3
© 2025 Siemens



The UTF-8 character set accommodates all platforms Teamcenter supports.

• Database

Oracle supports UTF-8 and non-UTF-8 character sets on all platforms.

Microsoft SQL Server does not provide native support for UTF-8. However, you can configure
Teamcenter to use UTF-8 with a Microsoft SQL Server database. The Enable UTF-8 option in the
Foundation Database panel in TEM enables the Teamcenter server to convert character encoding to
and from UTF-8 when interacting with the database.

Verify that your locale is supported

If you do not use UTF-8, ensure the locale you want to use is supported on your host. Perform the
following steps to set the Windows system locale and install the required language packs:

1. Open the Regional and Language Options dialog box in the Windows Control Panel.

2. In the Languages tab, set the required language for the menus and dialog boxes.

3. In the Region and Language dialog box, click the Administrative tab.

4. Under Language for non-Unicode programs, click Change system locale.

5. In the Region and Language Settings dialog box, verify the correct locale (language and country)
is selected. If not, choose the correct locale.

6. Close all dialog boxes and restart your system to install and configure the required language pack.

Configuring a UTF-8 environment for Teamcenter

Overview of UTF-8 configuration

Teamcenter supports the Unicode UTF-8 character set on Windows and Linux hosts that are configured
to process UTF-8.

Set the required values for your platform, locale, and database type before you begin installing
Teamcenter.

Enable UTF-8 support for Teamcenter servers and clients during Teamcenter installation

• Teamcenter servers

With UTF-8 support configured on your host, Teamcenter Environment Manager (TEM) can create a
UTF-8-enabled Teamcenter database during Teamcenter installation.

5. Configure language support
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If you use Microsoft SQL Server, select the Enable UTF-8 option in the Foundation Database panel in
TEM.

• Two-tier rich client

If the Teamcenter database is configured for the UTF-8 character set, UTF8 is selected by default in the
TcServer Character Encoding Settings panel in TEM.

• Four-tier rich client

When installing the Teamcenter web tier, in the TcServer Character Encoding Settings panel in TEM,
select UTF8.

The four-tier rich client can run on any Windows or Linux platform running any language character
set.

• Web tier

Make sure UTF-8 support is configured on the web tier host.

The web tier can run on any Windows or Linux platform running any language character set. The
Teamcenter web tier converts client character encoding to and from UTF-8 as it passes through the
web tier.

The following example shows a Teamcenter configuration for restricted Unicode UTF-8 character set
support with clients displaying multiple locales. Servers in this configuration run a Unicode UTF-8
character set operating system.

On Windows platforms, if the database is configured for the UTF-8 character set, the Teamcenter server
operates in UTF-8 mode independent of the system locale.

Overview of UTF-8 configuration
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Unicode homogeneous server platform configuration

• Teamcenter does not support Unicode Supplementary Characters.2

• If you import translated content in languages that require multibyte characters, such as Russian and
Chinese Simplified, you must configure your Teamcenter installation to support the UTF-8 character
set to ensure that titles and other properties display correctly in your environment.

2 Unicode Supplementary Characters are characters in the Unicode Character Standard outside of the Basic Multilingual
Plane (BMP), that is, characters with code point values larger than 0xFFFF.

5. Configure language support
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Configure UTF-8 environment settings

If you use UTF-8, select the al32utf8 or utf8 character set when you install your database server.3

For Microsoft SQL Server, no special setting is needed during database server installation. If you select
the Enable UTF-8 option in TEM (in the Foundation Database panel), the Teamcenter server converts
character encoding to and from UTF-8. This allows Teamcenter to use UTF-8 with Microsoft SQL Server's
(non-UTF-8) internal encoding.4

In Hebrew locales, set the following additional variables:

1. In the TC_DATA/tc_profilevars file, set TC_XML_ENCODING to UTF-8.

2. In two-tier environments, set TC_CHARACTER_ENCODING_SET to UTF8 in the following files:

• TC_ROOT/tccs/Start_TcServer1
• TC_ROOT/pool_manager/confs/MYDB/mgrstart

Do not set the TC_XML_ENCODING or TC_CHARACTER_ENCODING_SET environment variables in the
system environment. TEM sets these values in the Teamcenter configuration.

Configuring a non-UTF-8 environment for Teamcenter

To ensure correct display and processing of Teamcenter data, set the required values in your operating
system environment. Use the appropriate values for your locale and platform.

Environment settings on non-UTF-8 systems

Value

Locale Setting Linux Microsoft Windows

Chinese (Simplified),
GB2312-80 encoding

Database character set
(Oracle)

zhs16cgb231280 or zhs16gbk zhs16cgb231280 or zhs16gbk

Database collation
(MS SQL Server)1

N/A chinese_prc_bin

LANG and LC_ALL2 zh_CN N/A

Notes:
1. The database collation you select during Microsoft SQL Server installation determines the database character set.
2. Set LANG and LC_ALL in the system environment variables. These variables must have identical values to function

properly.
3. we8iso8859p15 contains additional characters, including the euro symbol (€).
4. we8mswin1252 contains more characters than ISO-8859-15.
5. No ISO-8859-15 equivalent is available for this locale.
6. Siemens Digital Industries Software does not provide a Hebrew translation. The configuration settings shown allow data

entry in Hebrew, but user interface text is in English.
7. If you migrate to ko16ksc5601 from UTF-8, some data may be truncated. You must modify truncated valued because

Teamcenter does not support modifying the default field size.

3 Oracle recommends al32utf8. UTF8 supports only supports Unicode Version 3.0 and earlier.
4 Microsoft SQL Server does not provide native support for UTF-8 character set encoding.

Configure UTF-8 environment settings
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Value

Locale Setting Linux Microsoft Windows

Chinese (Simplified),
GBK encoding

Database character set
(Oracle)

zhs16cgb231280 or zhs16gbk zhs16cgb231280 or zhs16gbk

Database collation
(MS SQL Server)1

N/A chinese_prc_bin

LANG and LC_ALL2 zh_CN.gb18030 N/A

Chinese (Traditional) Database character set
(Oracle)

zht16big5 or zht16mswin950 zht16big5 or zht16mswin950

Database collation
(MS SQL Server)1

N/A chinese_taiwan_stroke_bin

LANG and LC_ALL2 zh_TW N/A

Czech Database character set
(Oracle)

ee8mswin1250 ee8mswin1250

Database collation
(MS SQL Server)1

N/A czech_bin

LANG and LC_ALL2 cs_CZ N/A

English Database character set
(Oracle)

we8iso8859p1 or
we8iso8859p153 or
we8mswin12524

we8iso8859p1 or we8iso8859p153 or
we8mswin12524

Database collation
(MS SQL Server)1

N/A latin1_general_bin

LANG and LC_ALL2 en_US or en_US.iso885915 N/A

French Database character set
(Oracle)

we8iso8859p1 or
we8iso8859p153 or
we8mswin12524

we8iso8859p1 or we8iso8859p153 or
we8mswin12524

Database collation
(MS SQL Server)1

N/A latin1_general_bin

LANG and LC_ALL2 fr_FR5 N/A

German Database character set
(Oracle)

we8iso8859p1 or
we8iso8859p153 or
we8mswin12524

we8iso8859p1 or we8iso8859p153 or
we8mswin12524

Database collation
(MS SQL Server)1

N/A latin1_general_bin

LANG and LC_ALL2 de_DE5 N/A

Notes:
1. The database collation you select during Microsoft SQL Server installation determines the database character set.
2. Set LANG and LC_ALL in the system environment variables. These variables must have identical values to function

properly.
3. we8iso8859p15 contains additional characters, including the euro symbol (€).
4. we8mswin1252 contains more characters than ISO-8859-15.
5. No ISO-8859-15 equivalent is available for this locale.
6. Siemens Digital Industries Software does not provide a Hebrew translation. The configuration settings shown allow data

entry in Hebrew, but user interface text is in English.
7. If you migrate to ko16ksc5601 from UTF-8, some data may be truncated. You must modify truncated valued because

Teamcenter does not support modifying the default field size.

5. Configure language support
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Value

Locale Setting Linux Microsoft Windows

Hebrew6 Database character set
(Oracle)

iw8iso8859p8 or
iw8mswin1255

iw8iso8859p8 or iw8mswin1255

Database collation
(MS SQL Server)1

N/A hebrew_bin

LANG and LC_ALL2 iw_IL.utf8 N/A

Italian Database character set
(Oracle)

we8iso8859p1 or
we8iso8859p153 or
we8mswin12524

we8iso8859p1 or we8iso8859p153 or
we8mswin12524

Database collation
(MS SQL Server)1

N/A latin1_general_bin

LANG and LC_ALL2 it_IT5 N/A

Japanese (EUC) Database character set
(Oracle)

ja16euc ja16euc

Database collation
(MS SQL Server)1

N/A N/A

LANG and LC_ALL2 ja_JP.eucjp N/A

Japanese (Shift-JIS) Database character set
(Oracle)

ja16sjis ja16sjis

Database collation
(MS SQL Server)1

N/A japanese_bin

LANG and LC_ALL2 ja_JP.sjis N/A

Korean Database character set
(Oracle)

ko16ksc56017 ko16ksc56017

Database collation
(MS SQL Server)1

N/A korean_wansung_bin

LANG and LC_ALL2 ko_KR.EUC N/A

Polish Database character set
(Oracle)

ee8mswin1250 ee8mswin1250

Database collation
(MS SQL Server)1

N/A polish_bin

LANG and LC_ALL2 pl_PL.ISO8859-2 N/A

Portuguese
(Brazilian)

Database character set
(Oracle)

we8iso8859p1 or
we8iso8859p153 or
we8mswin12524

we8iso8859p1 or we8iso8859p153 or
we8mswin12524

Database collation N/A latin1_general_bin
Notes:
1. The database collation you select during Microsoft SQL Server installation determines the database character set.
2. Set LANG and LC_ALL in the system environment variables. These variables must have identical values to function

properly.
3. we8iso8859p15 contains additional characters, including the euro symbol (€).
4. we8mswin1252 contains more characters than ISO-8859-15.
5. No ISO-8859-15 equivalent is available for this locale.
6. Siemens Digital Industries Software does not provide a Hebrew translation. The configuration settings shown allow data

entry in Hebrew, but user interface text is in English.
7. If you migrate to ko16ksc5601 from UTF-8, some data may be truncated. You must modify truncated valued because

Teamcenter does not support modifying the default field size.

Configuring a non-UTF-8 environment for Teamcenter
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Value

Locale Setting Linux Microsoft Windows

(MS SQL Server)1

LANG and LC_ALL2 pt_BR5 N/A

Russian Database character set
(Oracle)

cl8mswin1251 or
cl8iso8859p5

cl8mswin1251 or cl8iso8859p5

Database collation
(MS SQL Server)1

N/A cyrillic_general_bin

LANG and LC_ALL2 ru_RU N/A

Spanish Database character set
(Oracle)

we8iso8859p1 or
we8iso8859p153 or
we8mswin12524

we8iso8859p1 or we8iso8859p153 or
we8mswin12524

Database collation
(MS SQL Server)1

N/A latin1_general_bin

LANG and LC_ALL2 es_ES5 N/A

Notes:
1. The database collation you select during Microsoft SQL Server installation determines the database character set.
2. Set LANG and LC_ALL in the system environment variables. These variables must have identical values to function

properly.
3. we8iso8859p15 contains additional characters, including the euro symbol (€).
4. we8mswin1252 contains more characters than ISO-8859-15.
5. No ISO-8859-15 equivalent is available for this locale.
6. Siemens Digital Industries Software does not provide a Hebrew translation. The configuration settings shown allow data

entry in Hebrew, but user interface text is in English.
7. If you migrate to ko16ksc5601 from UTF-8, some data may be truncated. You must modify truncated valued because

Teamcenter does not support modifying the default field size.

In Hebrew locales, set the following additional variables:

1. In the TC_DATA/tc_profilevars file, set TC_XML_ENCODING to ISO-8859-8.

2. In two-tier environments, set TC_CHARACTER_ENCODING_SET to ISO8859_8 in the following files:

• TC_ROOT/tccs/Start_TcServer1
• TC_ROOT/pool_manager/mgrstartMYDB

Do not set the TC_XML_ENCODING or TC_CHARACTER_ENCODING_SET environment variables in the
system environment. TEM sets these values in the Teamcenter configuration.

Choose the default language for the Teamcenter server process

Teamcenter server (TcServer) processes and other Teamcenter processes, and Teamcenter command-line
utilities, start in the language specified in the TC_language_default environment variable. To make
these display in a different preferred locale, set the TC_language_default environment variable to a
supported locale code.

Teamcenter allows users to select a locale on their client hosts, regardless of the locale used by the
Teamcenter server pool manager. Requested locales must be installed on the Teamcenter server (which

5. Configure language support
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may not be true for customized locales) and the server system be configured to accept the locale
encoding.

Choose the default language for the Teamcenter server process
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6. Installing a database server
Install a database server

Teamcenter requires a supported relational database management system (RDBMS) for
storing Teamcenter data. Before you begin installing Teamcenter, you must install and
configure one of the following supported database systems:

• Oracle

• Microsoft SQL Server

Before proceeding with database server installation, make sure you are correctly
licensed through your database vendor for the database edition you install.

For information about database versions supported for use with Teamcenter, see
Support Center.

Because of Teamcenter's high resource demands, Siemens Digital Industries Software
recommends a dedicated database server. At a minimum, there should be a dedicated
database instance for Teamcenter. This allows the instance to be tuned specifically for
Teamcenter.

Install and configure Oracle

Preparing the Oracle server

Your Oracle database server must be a version certified for use with Teamcenter 2412. For information
about certified Oracle versions, Oracle disk space requirements, and operating system and service patch
requirements, see the Hardware and Software Certifications knowledge base article on Support Center.

You may choose to create a new Oracle database or upgrade existing Oracle databases. Install a certified
version of Oracle Server if a certified version is not installed on the system. For certified Oracle versions
and disk space requirements, see the Hardware and Software Certifications knowledge base article on
Support Center.

Teamcenter supports pluggable databases (PDB) with container databases (CDB) if you use Oracle 12c or
later.

You can install Oracle from either of the following sources:

• Oracle software kit supplied by Siemens Digital Industries Software
• Oracle software kit supplied by Oracle Corporation

Prepare an Oracle database server and configure an Oracle database for Teamcenter:
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1. Choose a name for the Oracle user for the Teamcenter database. Teamcenter uses this account as
the owner of all Teamcenter-created tables. This account is used by the database administrator to
perform tasks required by Teamcenter.

2. If you do not have a certified version of Oracle, install or upgrade Oracle:

• If you do not have an Oracle server installed, install a certified version of Oracle.

• If you have an Oracle server installed, but it is not a version certified for Teamcenter 2412,
upgrade your Oracle server.

3. Configure Oracle software for Teamcenter.

4. Create a database for Teamcenter.

To ensure correct character mapping, make sure the database and the Teamcenter server use the same
encoding.

Additional database instances

Create a database instance if one does not exist or if an additional database instance is required, for
example, to support testing, training, or Repeatable Digital Validation (RDV).

If you are installing Repeatable Digital Validation (RDV) services, Siemens Digital Industries Software
recommends strongly that you create a new database instance on an Oracle server with database
partitions on a separate drive. RDV requires extensive data warehousing with large uploads and simple
queries. Such a configuration also makes the fine-tuning of the database easier.

A separate RDV database is not required if you use cacheless search.

Upgrade an Oracle server and database

Export an Oracle database

1. Log on to the Oracle server as an administrator user.

2. Export the contents of your Teamcenter Oracle database to the dump file:

ORACLE_HOME\bin\expdp db-user/password full=y dumpfile=file-name.dmp 
logfile=export.log

Replace db-user with the Teamcenter database user account name; replace password with the
database user account password; replace file-name with the full path and name of the dump file to
contain the exported data; replace export with the name of the log file to contain export output.

3. Store the dump file in a safe place.

6. Installing a database server
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If you have multiple databases, repeat this procedure for each database.

Caution:

Siemens Digital Industries Software strongly recommends backing up the dump file on tape or
another disk. If the dump file becomes corrupted or lost, all data from the existing database is lost.

Terminate Oracle sessions

Stop the listener process

1. Log on to the operating system as a user with administrator privileges.

2. Open the Services dialog box in the Windows Control Panel.

3. Select the Oracle TNS listener services (Oraclerelease-IDTNSListener) and click Stop.

Shut down an Oracle database

Shut down Oracle using Windows Control Panel

1. Log on to the operating system as a user with administrator privileges.

2. Open the Services dialog box in the Windows Control Panel.

Windows displays the Services window.

3. Select the OracleServiceSID service.

Replace SID with the system identifier of the database instance.

4. Click Stop.

Shut down Oracle using SQL*Plus

1. Log on to the operating system as a user with administrator privileges.

2. Start the Oracle SQL*Plus utility:

sqlplus sys/password@Oracle-SID as sysdba

Replace password with the password for the sys user account.

Oracle starts the Oracle SQL*Plus utility.

Stop the listener process
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The sys user must be in the Oracle sysdba group for the Oracle system identifier (SID) used
by Teamcenter. To connect as internal (without a password), the account must be part of the
ORA_DBA local group in Windows.

3. Shut down the database instance by typing the following command:

shutdown

4. Exit SQL*Plus:

exit

Back up an Oracle installation

If you are upgrading to the certified Oracle version, back up the existing Oracle installation.

Back up the following files and directories:

• The Oracle home directory on each installed workstation.

• The directories containing database files for each configured database.

• The Oracle Net listener.ora and tnsnames.ora configuration files.

These are the only Teamcenter directories affected by Oracle installation. If you created other directories
containing data used by Oracle, such as an administration script directory, you should also back up these
directories.

Upgrading an Oracle server

Upgrade the Oracle server

Upgrade your Oracle server by one of the following methods:

• Upgrade using the Oracle installer

• Upgrade by uninstalling/reinstalling Oracle

Upgrade using the Oracle installer

1. Launch the Oracle installer to install a certified version of Oracle server.

2. When the Oracle installer prompts you to upgrade existing databases, enter the required
information about the databases you want to upgrade.

6. Installing a database server
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Upgrade by uninstalling/reinstalling Oracle

1. Remove existing Oracle databases.

2. Uninstall all existing Oracle server software.

3. Install a certified version of Oracle server. Then, configure Oracle and create an Oracle
database.

4. After Oracle installation is complete, import your Teamcenter database from the Oracle dump file
into the new Oracle database. Enter the following command on a single line:

ORACLE_HOME\bin\imp db-user/password fromuser=db-user touser=db-user 
file=file-name.dmp log=import.log

Replace db-user with the Teamcenter database user account name, password with the database
user account password, file-name with the full path and name of the dump file that contains the
exported data, and import with the name of the log file.

Migrate a non-CDB database to a CDB database

Teamcenter supports Oracle's multitenant database architecture if you use Oracle 12c or later. A
multitenant architecture is deployed as a Container Database (CDB) with one or more Pluggable
Databases (PDB).

A Container Database (CDB) is similar to a conventional (non-CDB) Oracle database, with familiar
concepts like control files, data files, undo, temp files, redo logs, and so on. It also houses the data
dictionary for objects owned by the root container and those that are visible to databases in the
container.

A Pluggable Database (PDB) contains information specific to the database itself, relying on the container
database for its control files, redo logs and so on. The PDB contains data files and temp files for its own
objects, plus its own data dictionary that contains information about objects specific to the PDB. From
Oracle 12.2 onward a PDB can and should have a local undo tablespace.

You can migrate a non-CDB database to a CDB database using Oracle tools. The following example
illustrates the database architectures before and after migration.

Migrate a non-CDB database to a CDB database
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Teamcenter supports CDB and non-CDB databases. Be aware that Oracle has deprecated support for
non-CDB databases and may discontinue support after Oracle 19c.

If you migrate a non-CDB Teamcenter database to a CDB database, you must perform the migration after
you upgrade to Teamcenter 2412.

Install Oracle server

You can download and install Oracle from Siemens Support Center if you have purchased it from
Siemens Digital Industries Software, or by purchasing it directly from Oracle Corporation.

If you install Oracle from a hard disk, copy the entire contents of the Oracle software kit to the hard disk.

You can install Oracle application files on shared directories. However, Oracle Corporation does not
support Oracle database files on shared directories. To ensure data integrity, create database files on
local disk drives.

6. Installing a database server
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1. Log on to the server host as a member of the Administrators group. If you are installing on a
primary domain controller (PDC) or a backup domain controller (BDC), log on as a member of the
Domain Administrator group.

The operating system user account under which you install the Oracle database server must have
system administrator privileges.

The recommended approach is to create a system user account named oracle to use during Oracle
installation. When you use the oracle account to install Oracle, this account is automatically added
to the Windows ORA_DBA local group, giving it SYSDBA privileges.

2. Record the name of the Oracle database server host. Teamcenter Environment Manager requires
this name during corporate server installation.

3. In the Oracle RDBMS installation media, launch the setup program.

If you install from a DVD, the system displays the Autorun dialog box when you insert the DVD.

4. In the Configure Security Updates dialog box, specify whether and how you want to be informed
about security updates from Oracle, and then click Next.

5. In the Select Installation Option dialog box, select Install database software only, and then click
Next.

6. In the Select Database Installation Option dialog box, select Single instance database
installation, and then click Next.

7. In the Select Database Edition dialog box, select the database edition to install, and then click
Next.

Teamcenter supports Enterprise Edition and Standard Edition.

8. In the Specify Oracle Home User dialog box, specify the system account you created to install
Oracle.

9. In the Specify Installation Location dialog box, specify:

• Oracle Base

Specifies the path in which to install all Oracle software and configuration files.

• Software Location

Specifies the path in which to install Oracle software files. This is the Oracle home directory.

Install Oracle server
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Do not install a later version of Oracle into an existing Oracle home directory that contains an
earlier version.

10. In the Perform Prerequisite Checks dialog box, verify that all the prerequisite checks succeeded
and click Next.

If a check fails, review the displayed cause of the failure for that check, correct the problem, and
rerun the check.

A check occasionally fails erroneously, for example, when you install a later patch that obsoletes
a listed patch. When you are satisfied that the system meets a requirement, manually verify the
requirement by selecting the check box for the failed check.

11. In the Summary dialog box, review the information to ensure you have sufficient disk space, and
then click Install.

12. In the Install Product dialog box, monitor the success of the installation stages.

13. When the Finish dialog box displays the The installation of Oracle Database was successful
message, click Close to complete the installation.

Configure Oracle software

Configure Oracle Net

Teamcenter uses Oracle Net protocols to communicate with an Oracle database. These protocols require
that you run a listener process (OracleTNSListener) on the Oracle server to listen for remote connect
requests and that all clients can translate the service alias identifying the server and database.

Configure Oracle listener

1. Start Oracle Net Manager. For example, choose Start→All Programs→Oracle - instance-
name→Net Manager, or search for Net Manager.

2. Create the listener.ora file:

a. Expand the Local icon.

b. Select the Listeners folder and choose Edit→Create.

c. Accept the default listener name (LISTENER) and click OK.

d. Click the Add Address button.

e. Specify the port number.

6. Installing a database server
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For the first listener, it is recommended you accept the default port number (1521).

Tip:

Record the number of the port used by the Oracle database server listener for entry
during corporate server installation. Teamcenter Environment Manager requires this
port number.

f. In the Local tree, click Profile.

g. In the Naming list (to the right of the Oracle Net Configuration tree), choose General.

h. Click the Advanced tab.

i. In the TNS Time Out Value box, type 10.

This step sets the Oracle server-side SQLNET.EXPIRE_TIME parameter. This value determines
how often the Oracle server checks for aborted client connections. Teamcenter requires that
this parameter be set to a nonzero value, and the recommended value is 10 (10 minutes).

j. Select the Service Naming folder and choose Edit→Create.

k. Type the Net Service Name for your pluggable database and then click Next.

l. Select TCP/IP (Internal Protocol) and then click Next.

m. Enter the host name for your Oracle server and then click Next.

If you chose to not use the default port during database creation, change the Port Number.

3. Type the Service Name and then click Next.

4. Click Test…

5. Change the Login value to the system user name and the Password value to the system password
used during database installation and then click Test.

6. After the connection test is successful, click Close.

7. Click Finish.

8. Save the listener information, choose File→Save Network Configuration.

Oracle Net Manager saves the listener information and creates the network\admin\listener.ora
and network\admin\sqlnet.ora files in the Oracle home directory.

Configure Oracle listener
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9. Exit Oracle Net Manager, choose File→Exit.

10. In a command prompt, create and start the listener service:

cd ORACLE_HOME\bin
lsnrctl start LISTENER

Replace ORACLE_HOME with the path to the directory where you installed the Oracle server, for
example, d:\app\tcdba\product\12.2.0\dbhome_1. This command creates and starts the service if
it does not exist. If the service exists, the command starts it.

Configure Oracle for TCPS

Teamcenter Environment Manager (TEM) allows you to install the corporate server and the server
manager using a TCPS-enabled Oracle database. However, you need to configure the Oracle database for
TCPS prior to deployment.

Teamcenter supports the TCPS configuration that uses the Diffie-Hellman anonymous authentication.
With Diffie-Hellman anonymous authentication, neither the server nor the client is authenticated
through SSL. Authentication must be completed using another method, for example, a user name and
password.

In the Oracle database configuration, do not enter a specific cipher suite as this is not supported by TEM.

1. In the listener.ora section of the Oracle listener machine, set the SSL_CLIENT_AUTHENTICATION
parameter to FALSE as the supported TCPS configuration only covers encryption and data integrity.

2. Verify that the Oracle wallet is stored on the same Teamcenter machine on which the corporate
server and server manager are to be installed or upgraded.

During Teamcenter installation, in the Foundation Database panel in TEM, select Enable TCPS and
enter the Wallet Location (location of the Oracle wallet on the Teamcenter machine) and TLS Version
(SSL_VERSION specified in the Oracle database).

Create an Oracle database

Create an Oracle database instance with Oracle Database Configuration Assistant (DBCA). Siemens
Digital Industries Software provides two templates for creating the Teamcenter database:

• Teamcenter_Oracle template is used to create a traditional non-CDB database instance with Oracle
user accounts and tablespaces.

• Teamcenter_Oracle_multitenant template is used to create a Container and Pluggable database
instance where the two databases are identified by their Oracle service names. Teamcenter supports
the Oracle 12c multitenant architecture.

6. Installing a database server
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The following are key considerations when creating an Oracle Container (CDB) database instance in the
Oracle multitenant architecture with Oracle 12c:

• Teamcenter Oracle database tablespaces and the Teamcenter Oracle user account are always created
in the pluggable database.

• Teamcenter cannot be installed into the container database.  TEM detects if a Container database is
specified and does not allow the Teamcenter installation to proceed.

• The Teamcenter tablespaces are not created using the DBCA template, as this is not supported by
Oracle. After you configure the pluggable database, you can manually create a tablespace for the
pluggable database, or allow Teamcenter to create the tablespace automatically.

Using the existing non-CDB template does create tablespaces.

For best performance and reliability, database parameters set by Teamcenter templates should be
customized to suit your installation. This can be performed by your Oracle administrator after
Teamcenter installation is complete.

Teamcenter Environment Manager (TEM) verifies your Oracle version during installation. If your Oracle
server does not meet the minimum required version, TEM does not allow installation to proceed. For
information about supported database servers, see the Hardware and Software Certifications knowledge
base article on Support Center.

Copy database creation scripts

1. Make sure you have access to the Teamcenter software kit.

2. Log on to the Oracle server host as a user who is a member of the ORA_instance-name_DBA
group. This may be the user who installed Oracle on the server host or one assigned to
ORA_instance-name_DBA by a member of the ORA_instance-name_DBA group.

3. Log on to the Oracle server host as a user who is a member of the ORA_instance-name_DBA
group. This may be the user who installed Oracle on the server host or one assigned to
ORA_instance-name_DBA by a member of the ORA_instance-name_DBA group.

4. Copy the Siemens Digital Industries Software-supplied Oracle database template files:

a. Access the Teamcenter 2412 software kit.

b. Copy files from tc\dbscripts\oracle to the templates directory of the Oracle server:

copy e:\tc\db_scripts\oracle\*   ORACLE_HOME\assistants\dbca\templates

c. Repeat step b, copying files from the same directory on the Teamcenter 2412 software kit.

Create an Oracle database
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Create the Oracle database

1. Make sure you are logged on as the Oracle user.

2. Start Oracle Database Configuration Assistant (DBCA). For example:

Start→All Programs→Oracle - instance-name→Database Configuration Assistant

Alternatively, search for Database Configuration Assistant.

3. In the Select Database Operation dialog box, select Create a database and click Next.

4. In the Select Database Creation Mode dialog box, select Advanced configuration and click Next.

5. In the Select Database Deployment Type dialog box, in the list of templates, select the
appropriate template:

• If you use a non-container (non-CDB) database, select the Teamcenter_Oracle template.

• If you use a container (CDB) database, select the Teamcenter_Oracle_multitenant template.

If you use a CDB database, the DBCA templates do not create tablespaces. The template no longer
configures tablespaces for pluggable databases.

6. In the Specify Database Identification Details dialog box, enter the appropriate values according
to the type of database you use:

• Container database:

a. Accept the default database name in the Global Database Name box or type a different
name and click Next.

The SID box is automatically filled in with the name you enter in the Global Database
Name box.

Tip:

Record the SID of the Oracle instance for entry during corporate server installation.
Teamcenter Environment Manager requires this name.

b. Select the Create as Container Database check box.

The Create a Container Database with one or more PDBs radio button is selected by
default. Do not change this setting.

c. In the PDB Name text box, type the name of the pluggable database, and then click Next.
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• Traditional (non-container) database:

a. Accept the default database name in the Global Database Name box or type a different
name and click Next.

The SID box is automatically filled in with the name you enter in the Global Database
Name box.

Tip:

Record the SID of the Oracle instance for entry during corporate server installation.
Teamcenter Environment Manager requires this name.

b. In the Database Identification dialog box, either accept the default database name in the
Global Database Name box or type a different name and click Next.

The SID box is automatically filled in with the name you enter in the Global Database
Name box.

Tip:

Record the SID of the Oracle instance for entry during corporate server installation.
Teamcenter Environment Manager requires this name.

7. In the Select Database Storage Option dialog box, select Use template file for database storage
attributes.

8. In the Select Fast Recovery Option dialog box, select the Specify Fast Recovery Area  check
box and accept the default values.

9. In the Specify Network Configuration Details dialog box, verify the listener you created and
started is running and selected in the Listener Selection tab.

If the listener is not running, start the listener and make sure it is selected before you continue.

10. In the Select Database Options dialog box, click Next.

11. In the Specify Configuration Options dialog box, select Use Automatic Shared Memory
Management, and then click Next.

12. In the Specify Management Options dialog box, accept the default selections, and then click
Next.

13. In the Specify Database User Credentials dialog box, select Use the Same Password for All
Accounts, and then enter and confirm the password.

Create an Oracle database
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The password you enter is applied to the SYS, SYSTEM, and PDBADMIN accounts.

14. In the Select Database Creation Option dialog box:

a. Select Create Database  check box.

b. Click Next.

15. In the Summary dialog box, verify your selections, and then click Finish to begin creating the
database.

When the database is created, DBCA displays a window containing information about the created
database.

16. In the Progress Page dialog box, click Close to exit DBCA.

After the database is created, check for possible errors in the installation log files. The Oracle DBCA
displays the directory location of the installation log files in the window that contains information about
the created database after the database is created.

If this script did not execute successfully, execute it again using the Oracle SQL*Plus utility. Log on to
SQL*Plus as sysdba.

The first time Oracle Universal Installer runs, it creates the ORACLE_BASE/oraInventory/logs directory,
containing an inventory of installed components and performed actions. The most recent log file is
named installActions.log. Names of previous installation sessions are in the form installActionsdate-
time.log. For example:

installActions2008-07-14_09-00-56-am.log

You can also view a list of installed components by choosing Installed Products on any Oracle Universal
Installer window. Do not delete or manually alter the Inventory directory or its contents. Doing so can
prevent Oracle Universal Installer from locating products you installed on the system.

Configure the pluggable database

If you use a container (CDB) database, create the Teamcenter Oracle user and set permissions for the
pluggable database:

1. Open SQL*Plus and type the following command to connect to the container database:

connect user/password;

Replace user and password with the Oracle administrator user name and password. For example:

connect system/manager;
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2. Type the following command to set the pluggable database so the Teamcenter Oracle user is
created inside the pluggable database.

alter session set container=Tc-Oracle-user;

For example:

connect alter session set container=tcpdb;

If successful, SQL*Plus responds:

Session altered.

3. Set privileges for the Teamcenter Oracle user:

grant connect, create table, create tablespace, create procedure, 
create view, create sequence, select_catalog_role, alter user, 
alter session to Tc-Oracle-user identified by Tc-Oracle-user;

If successful, SQL*Plus responds:

Grant succeeded.

Create a tablespace for the pluggable database

You can manually create a tablespace for the pluggable database using the following steps. If you do not
perform these steps, Teamcenter automatically creates a tablespace with the default size.

1. Open a command prompt and log on to sqlplus as the Oracle administrator, for example, system.

2. Create a new tablespace for the pluggable database:

create tablespacetablespace-namedatafile 'dbf-path/dbf-filename' sizedbf-sizeM;

Replace tablespace-name with the tablespace name. Replace dbf-path, dbf-file, and dbf-size with
the path, file name, and size of the database file in megabytes. For example:

create tablespace tcpdb datafile 'D:\apps\oracle\oradata\tc\tcpdb.dbf' size 100M;

3. Grant all permissions on the new tablespace to the Teamcenter Oracle user:

a. Enter:

alter userTc-Oracle-userquotadbf-sizeM ontablespace-name;

For example:

Create an Oracle database
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alter user tcdba quota 100M on tcpdb;

b. Enter:

grant unlimited tablespace to Tc-Oracle-user;

4. Log off sqlplus by typing exit.

Install and configure Microsoft SQL Server

Install Microsoft SQL Server

The steps to install Microsoft SQL Server and to configure a database for Teamcenter depend on your
operating system, your edition of SQL Server, and your selections during installation.

To optimize MS SQL Server database performance, consider the following steps:

• To implement a Teamcenter network incrementally at multiple sites, configure each site in a Multi-Site
Collaboration environment with separate hosts for the MS SQL database server (including Multi-Site
Collaboration), the rich client, and volume servers, starting with the first phase. This allows you
to configure and manage the network consistently, as you scale it in each phase. You can add
CPUs, memory, and disks to the appropriate servers or deploy additional servers as required, without
moving or reconfiguring server processes on different hosts or changing operational procedures.

• For large or critical system implementations, implement high-availability systems with mirrored, dual-
ported disk arrays. For the Teamcenter volume, consider a file server with storage attached network
(SAN) or network attached storage (NAS) disk arrays.

• To minimize system maintenance interruptions, create separate file backup server hosts to process
metadata and volume data backups in real time. While the primary disk sets remain online, you can
take secondary MS SQL Server and volume disk sets offline simultaneously and back them up together
(assuring MS SQL Server and Teamcenter volume synchronization). When the backup is complete, you
can return the secondary disk sets online and resynchronize them with the primary disk sets. The file
backup servers also serve as fail-over machines.

• To ensure correct character mapping, make sure the database and the Teamcenter server use the
same encoding.

For certified versions of MS SQL Server, see the Hardware and Software Certifications knowledge base
article on Support Center. Install the MS SQL Server database server before you begin installing
Teamcenter.

Teamcenter requires the TCP/IP protocol to be enabled, but this protocol is disabled by default when you
install Microsoft SQL Server. Before you install Teamcenter, make sure you enable the TCP/IP protocol.

For information about enabling the TCP/IP protocol in Microsoft SQL Server, see
http://technet.microsoft.com.
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Typical Microsoft SQL Server installation on Windows

1. Log on to an account with system administrator privileges.

2. Launch the Microsoft SQL Server Installation Center application (setup.exe).

3. In the SQL Server Installation Center dialog box, click Installation in the navigation pane on the
left side.

4. Click New SQL Server stand-alone installation or add features to an existing installation.

The SQL Server Installation Center launches the SQL Server Setup wizard.

5. Proceed through the pre-installation tests and other initial setup panes to the Install Setup Files
pane. Click Install to install SQL Server setup support files.

After setup support files are installed, the wizard displays the Install Rules pane. Click Next.

6. In the Feature Selection pane, select Instance Features→Database Engine Services and any
other features you want to include.

Click Next.

7. In the Instance Configuration pane, select an instance type. Teamcenter supports both Default
Instance and Named Instance.1

A default instance in a Microsoft SQL Server installation uses the name MSSQLSERVER.
Teamcenter's persistent object manager (POM) utilities cannot connect to an instance with this
name. If you use a default instance, make sure you connect to the instance using a port connection
rather than the name.

If you use a named instance, make sure the instance has a unique name other than
MSSQLSERVER.

8. Enter remaining instance configuration values, and then click Next,

9. Proceed to the Server Configuration pane.

a. Click the Service Accounts tab.

b. Enter account information for starting SQL Server services.

1 If you choose Named Instance, make sure you start the SQL Browser service before connecting to the database. If this
service is not enabled, you can change these settings using the SQL Server Configuration Manager after installation is
complete.
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The SQL Server Setup wizard validates user accounts for SQL Server services. Make sure the
accounts you enter exist on the host.

c. Click the Collation tab.

d. On the Collation tab, click Customize.

The wizard displays a customization dialog box for database engine collation.

e. Select Windows Collation designator and sort order.

f. In the Collation designator box, select Latin1_General and then select Binary.

g. Click OK.

h. In the Server Configuration pane, click Next.

10. Proceed to the Database Engine Configuration pane.

a. Click the Server Configuration tab.

b. Under Authentication Mode, select Mixed Mode and define a password for the SQL Server
sa logon account.

c. Specify at least one SQL Server administrator account.

d. Click Next.

11. Proceed to the Ready to Install pane and click Install to install.

Create an SQL Server database

Teamcenter Environment Manager (TEM) can create and populate a SQL Server database when
you install a Teamcenter corporate server.2 If you want TEM to create your Teamcenter database
automatically, skip this topic. Otherwise, create your Teamcenter database using the SQL Server
Management Studio.

1. Make sure you have access to the Teamcenter software kit.

2. Launch Microsoft SQL Server Management Studio.For example:

Start→Programs→Microsoft SQL Server→SQL Server Management Studio

2 In the Database Engine Selection panel, TEM prompts you for database information for the SQL Server database. To
create a new database, enter new values. To connect to an existing database, enter values for the existing database. For
information about installing a corporate server, see Create a Teamcenter environment using TEM.
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Alternatively, search the start menu for SQL Server Management Studio.

3. In the SQL Server Connect to Server dialog box, log on using the system administrator (sa) logon
name and password.

4. Choose File→Open→File or press Control+O.

5. Browse to the tc\db_scripts\mssql directory in the Teamcenter software kit.

6. Select the create_database.sql.template file and click Open.

If SQL Server Management Studio prompts you to log on, enter the system administrator (sa) logon
name and password.

7. Edit the database template (create_database.sql.template) to replace the necessary values.

The following table describes the database parameters to replace in the template. Within the
template file, there are also comments on values that must be replaced.

Parameter Example value Description

@DB_NAME@ TC Name of the database to create.

@DATA_PATH@ D:\MSSQL_DATA Path to the directory in which to place the data file.

@USER_NAME@ tcdba Database logon name for the Teamcenter database.

@PASSWORD@ tcdbapw Password for the database logon name.

@COLLATION@ Latin1_General_BIN Collation sequence you want the Teamcenter database to use.
Choose the appropriate collation for your locale. The collation
value must end with _BIN.3.

Collation defines the alphabet or language whose rules are
applied when data is sorted or compared. The collation value
determines the character set used by the database server.

@LANGUAGE@ us_english Database language.

8. Save the newly modified file as filename.sql, removing the _template extension.

9. Open the new file in Microsoft SQL Server Management Studio.

10. In the SQL Editor toolbar, click Execute (or choose Query→Execute to begin creating the database.

11. When creation of the MS SQL database instance is complete, verify the newly created database. In
the Object Explorer pane, under the MS SQL Server host name, expand the Databases tree. Verify
the new database name is included in the list of databases.

3 Do not use the default collation value that ends with _CI_AS.
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7. Install the Siemens License Server
Before you install Teamcenter, you must download and install the supported version of the Siemens
License Server to distribute licenses to Teamcenter hosts.

For the version of the Siemens License Server certified with Teamcenter 2412, see the Hardware and
Software Certifications knowledge base article on Support Center.

Download and install the Siemens License Server:

1. Open Support Center:

https://support.sw.siemens.com

2. Under Product Centers, find Siemens License Server.

Caution:

Make sure you download Siemens License Server, not Siemens PLM Licensing.1

3. In the Siemens License Server product center, click Downloads, and then download the certified
version of the Siemens License Server.

4. Install the License Server according to the Siemens Digital Industries Software License Server
Installation Instructions available from the Siemens License Server downloads page.

5. On your designated Teamcenter corporate server host, set the following system environment
variables:

SPLM_LICENSE_SERVER

Set to the location of the Siemens License Server:

port@host

Replace port with the port number and host with the machine name of the License Server, for
example, 29000@tchost.

TCP_NODELAY

Set to a value of 1 on the License Server host. This helps optimize logon time when launching
Teamcenter.

1 Siemens PLM Licensing is no longer supported by Teamcenter. The Siemens License Server is the currently supported
license server.

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  7-1
© 2025 Siemens

https://support.sw.siemens.com/en-US/product/1586485382/downloads
https://support.sw.siemens.com/en-US/product/1586485382/downloads
https://support.sw.siemens.com


6. Install Teamcenter licenses on the License Server according to the information provided to you by
Siemens Digital Industries Software support.

The Siemens License Server downloads page contains additional links to documentation, Knowledge
Base articles, and videos about installing and maintaining the License Server.

Caution:

The License Server must be running and two or more seats must be available on that license
server during Teamcenter server installation. Otherwise, database creation fails because the
make_user utility cannot create the required users in the database.

7. Install the Siemens License Server
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8. Installing Security Services
Install the Web Application Manager for Security Services

Install the Web Application Manager

1. In the Teamcenter software kit, locate the Security Services installation package:

kit-location\additional_applications\sso\TcSecurityServices2412_date.zip

Expand this package to a local directory on your Security Services machine. This local directory is
referenced as TCSS_ROOT.

2. Create a home directory for the Security Services web applications on your Security Services
machine, for example, c:\webroot.

This directory is referenced as WEB_ROOT.

3. Expand the Web Application Manager files:

a. Browse to the TCSS_ROOT\TcSecurity\default directory.

b. Double-click the INSTALL_TCWEB.EXE program icon.

This opens a self-extractor dialog box.

c. In the Extract to box, type the path to WEB_ROOT, and then click Extract.

After the wizard finishes, close the self-extractor dialog box.

Expand Security Services ICD files

1. Create a home directory for the Security Services installable component descriptor (ICD) files.1 For
example, c:\tcss_icd.

This directory is referenced as TCSS_ICD.

2. Expand the Security Services ICD files:

a. Browse to the TCSS_ROOT\TcSecurity\default directory.

b. Double-click the INSTALL_SSO.EXE program icon.

1 ICD files provide solution information to the Web Application Manager.
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This opens a self-extractor dialog box.

c. In the Extract to box, type the path to TCSS_ICD, and then click Extract.

After the wizard finishes, close the self-extractor dialog box.

3. If you want to install an additional locale for Security Services, repeat step 2, with the following
changes:

• Replace the default directory under TcSecurity with the directory corresponding to the locale
you want to install:

Chinese (Simplified): zh_cn German: de_de Polish: pl_pl
Chinese (Traditional): zh_tw Italian: it_it Portuguese (Brazilian): pt_br
Czech: cs_cz Japanese: jp_jp Russian: ru_ru
French: fr_fr Korean: ko_ko Spanish: es_es

• Replace INSTALL_SSO.EXE|TZ with INSTALL_SSO_locale.EXE|TZ.

Install Security Services web applications

The Security Services login service and identity service are Java EE web applications that provide the
essential functions of Security Services. Build these applications using the Web Application Manager and
deploy them on a supported Java EE web application server.

The Web Application Manager requires a supported Java Runtime Environment (JRE). For supported
web application servers and Java Runtime Environments, see the Hardware and Software Certifications
knowledge base article on Support Center.

Note:

If you deploy Security Services on JBoss/Wildfly, you must enable Apache JServ Protocol (AJP)
before you configure the SSO gateway. Enable AJP as described in one of the following topics in
the Web Application Deployment guide:

• Deploy the Teamcenter web application on JBoss (H-S)

• Deploy on a JBoss application server (H-S)

Build the Login Service web application

1. Launch the Web Application Manager. Browse to the WEB_ROOT directory and double-click the
insweb.bat program icon.

2. Load Security Services ICD files. This populates the list of solutions available to install.

8. Installing Security Services
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a. Click Copy ICDs.

b. In the Copy ICD Files dialog box, click Browse.

c. Browse to the TCSS_ICD directory, select the icd directory, and then click Open.

d. In the Copy ICD Files dialog box, click OK to load ICD files.

3. Click Add to begin creating a web application.

The Web Application Manager displays the Add Web Application dialog box.

4. In the Name box, type a name for the application, for example, TcLoginService.

5. In the Staging Location box, enter a path where you want to place the web application files.
Typically, this is a directory under the WEB_ROOT directory. Web Application Manager creates the
directory if it does not exist.

Optionally, in the Description box, type a description of the application.

6. Enter advanced web application options. Click Advanced Web Application Options and enter
values in the Advanced Web Application Options dialog box:

a. In the Deployable File Name box, type a name for the web application WAR file, for example,
TcLoginService.

Leave the Automatically Build Deployable File  check box selected.

b. Set the Session Timeout value 600, as 600 minutes is the default session timeout set for the
Identity Service sessionLifetime parameter.

c. Leave the default values for remaining advanced options and click OK to return to the Add
Web Application dialog box.

7. Enter software locations:

a. Clear the Disk Locations for Install Images list by selecting any default paths shown and
clicking Remove.

b. Click Add.

c. In the Add Disk Location dialog box, browse to the path to the Security Services web
application files (TCSS_ROOT\TcSecurity\default), and then click OK:

Install Security Services web applications
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d. If you want to install an additional locale for Security Services, repeat step Install
Security Services web applications to add the path to the locale-specific software:
TCSS_ROOT\TcSecurity\

8. Click Solutions.

9. In the Select Solutions dialog box, select solutions to include in the web application:

a. Select Teamcenter Security Services Login Service Web Application.

b. If you are installing an additional locale for Security Services, select Teamcenter Security
Services Login Service Web Application Localization (language).

c. Optionally, select Teamcenter Security Services Java API Documentation. This solution
provides a reference of APIs exposed by the Login Service and Identity Service.

d. Click OK to continue. The Selected Solutions box shows the solutions selected for
installation.

Note:

The Solution Type box cannot be changed from its default value, Web Tier.

10. Click OK to begin building the web application.

When the web application creation is complete, click OK to close the Progress dialog box.

Build the Identity Service web application

To build the Security Services Identity Service web application, repeat the steps in Build the Login
Service web application, with the following differences:

• Skip step Install Security Services web applications because ICD files are already loaded.

• For the Name and Deployable File Name values of the web application, enter a name for the Identity
Service, for example, TcIdentityService.

• In the Select Solutions dialog box, select the Teamcenter Security Services Identity Service Web
Application.

Deploy Security Services web applications

Locate the deployable files generated by the Web Application Manager for the Security Services Login
Service and the Security Services Identity Service. These files are in the deployment directory under the
staging location you specified for each application.

8. Installing Security Services
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For example:

c:\webroot\staging1\deployment\TcLoginService.war

c:\webroot\staging2\deployment\TcIdentityService.war

Deploy the web applications on a supported application server. Deployment procedures for Teamcenter
web applications on supported application servers are described in Web Application Deployment.

Note:

Make sure the Security Services web applications are installed and running before you launch
TEM to install Teamcenter. TEM verifies the connection to Security Services and does not allow
installation to proceed if the connection fails.

Deploying on an IPv6 network

If your network includes client hosts running on an IPv6 network, you must deploy Security Services web
applications in an application server that supports an IPv6 URL as an external endpoint and uses IPv4
addresses to support all communication with the Teamcenter enterprise tier.

A typical environment for the Security Services web applications is a dual-stack machine that supports
both IPv4 and IPv6 addresses in which the application server accepts HTTP requests from either IPv4 or
IPv6.

Teamcenter server components that communicate within the same network are assumed to be on
an IPv4 network and are not supported on IPv6. IPv6 is supported only with Teamcenter clients or
integrations that use Teamcenter client communication system (TCCS) and Teamcenter components that
communicate with clients on IPv6-enabled networks.

Moving to a new version of Security Services

To move to a new version of Security Services, perform the following steps.

1. Record your existing Security Services context parameter settings.2

2. Remove old Security Services WAR files from your web servers, undeploy Security Services
components, and delete the old installation.

3. Install the latest version of Security Services, entering the context parameter settings you recorded
in step 1.

2 You can record settings for the Security Services login service and identity service in the context parameter worksheets in
Security Services Configuration.
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Part II: Build the Teamcenter Environment

Prepare the machines that will host your Teamcenter test and production environments. This includes
installing database infrastructure, license server, locale support, and software like Security Services that
will support the Teamcenter and Active Workspace components.

Install Teamcenter and Active Workspace in a test environment, including the applications and
components you want to use.

Installing a test environment allows to configure components and identify and resolve and potential
issues before you commit your settings to a production environment.

The Teamcenter Deployment Reference Architecture, available from the Teamcenter Downloads
area on Support Center, provides guidelines and examples for setting up test and development
environments. It also provides sample configurations ready to deploy in Deployment Center as starter
environments for testing.
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9. Configure available units of measure
Administrators can configure the units of measure that are available across Teamcenter. This unit
management system (UMS) based on classified units is first available in Teamcenter version 2406.

This procedure is not required, but if you want to include optional or custom units of measure in your
Teamcenter environment, you can add them before you begin installation.

A list of nearly 1400 units of measure is provided in the Teamcenter installation kit. Out of the box, only
a subset of the units are installed, depending on the applications installed. Installers and administrators
can configure the units to add, and can add new units.

1. In the Teamcenter kit or in the TC_ROOT\TD folder, find and open unit_definitions.csv.

Application columns begin with column Q (BASE). Unit rows for which an application column has
the value 1 will be considered by the ums_import_unit_definitions utility.

Note:

During initial installation, if an application is installed in the environment, unit rows for which
the application column has the value 1 are imported to the database.

2. Edit the file to ensure that the unit definitions you want to administer have the value 1 for an
application.

In the event that no class definition exists for a unit you want in your environment, create a new
row.

3. Using the edited unit_definitions.csv, run the ums_import_unit_definitions utility.
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10. Create user accounts and directories
Create the required user accounts and directories that Teamcenter requires for installation and
maintenance.

Create required user accounts

On the local host where you install Teamcenter software, create the Teamcenter operating system user
account.

All Teamcenter services run as this user account. Make sure this account belongs to the Administrators
group and is granted the Log on as a service right.

Ensure that all Teamcenter directories and files are owned and writable by this operating system user.

• Operating system logon account

Create an operating system logon account for Teamcenter. This account must belong to the
Administrators group and must be granted the Log on as a service right. Teamcenter services run on
the server as this user account.

Log on using this account when you install the Teamcenter environment and when you perform
maintenance. Ensure that all Teamcenter directories and files are owned and writable by this
operating system user.

The following are some services that may run under this user account:

Database Daemons
FSC
Linked Data Framework Web Services
Multi-Site IDSM and ODS daemons

Schedule Manager
Dispatcher Module and Client
AM Read Expression Service
Server Manager

• Teamcenter administrative user account

Teamcenter provides an administrative user account named infodba. Teamcenter Environment
Manager automatically creates this account when you install Teamcenter on a server host. This
account is used by the Teamcenter administrator to access the Teamcenter system administration
functions to perform setup and maintenance tasks. You create a password for this account during
Teamcenter installation.
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Caution:

• The password must not be empty nor contain any whitespace characters such as space, tab,
newline, carriage return, form feed, or vertical tab.

In addition, the password must not contain any of the following characters:

! # @ $ % = & ' " ^ : ; . _ < > ( ) { }

• Never use the infodba user to create working data or initiate workflow processes. The
infodba user is to be used only for specific installation tasks described in Teamcenter
installation documentation. Using this account to create data or initiate workflow processes
can cause unexpected and undesirable behaviors.

If you require a user with high-level privileges to create data, create a new user and grant
database administrator privileges to that user.

• Database user

Create a database user to be the owner of Teamcenter-created tables and to perform tasks required
by Teamcenter. You create this database user either by using the templates provided for Oracle
databases, or by using Teamcenter installation tools to populate a database. Teamcenter installation
tools refer to this user as DB user.

Each user and group is identified by an alphanumeric name and an ID number. The ID number is
retained with the file information when a file is exported across a network. If the ID numbers do not
match for a user or group, file access privileges may be unintentionally granted to the wrong user, or
not granted at all, on an NFS/CIFS client.

Create required directories

Teamcenter
installation
root
directory

Choose a parent directory to contain Teamcenter software. This parent directory must
exist before installation. The Teamcenter root directory is created within this directory
during installation. Requirements for this directory:

• The directory must be excluded from real-time virus scanning.

Real-time virus scanning prevents Teamcenter from updating the persistent object
manager (POM) schema during installation, causing installation errors.

• If the directory is on a mapped drive or a UNC path (not on the local host) you must
be logged on as an authenticated domain user to ensure the remote host recognizes
you. Alternatively, you can set the permissions on the remote host to allow an
anonymous user to access it. This is necessary to ensure Teamcenter services such as
the FMS server cache (FSC) and Multi-Site Collaboration services can start.

• The directory must be on an NTFS partition, not a FAT partition. This is necessary to
take advantage of the file security features of NTFS.
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• If the directory is in an automounted NFS directory, but you must supply the
automount link name for the Teamcenter application root directory. Do not supply
the automounted directory (for example, /tmp/mnt/node-name).

• If you install File Management System file caches and/or Multi-Site Collaboration
services, the directory must be on a local disk.

Teamcenter
volume
location

Choose a parent directory to contain a Teamcenter volume or volumes.

This parent directory must exist before installation. The volume directory is created
within this parent directory during installation.

Do not place the volume directory under the Teamcenter application root directory.
Doing so can cause problems when upgrading to a new version of Teamcenter.
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11. Create a Teamcenter environment using
TEM
A Teamcenter environment contains components of Teamcenter Foundation, Active Workspace, and
Microservice Framework.

The central component of a Teamcenter environment is the corporate server. With this and Active
Workspace server extensions, you build the framework on which to install more core components of
Teamcenter:

Server manager

Microservices

Active Workspace Gateway

Active Workspace Client

Indexing

Dispatcher

Visualization Server

Web tier (Java EE or .NET)

You can further add applications and components from the extensive lists of features available in TEM:

• Server Enhancements features
• Active Workspace Server Extensions features
• Active Workspace Client features
• Microservices features

Before you begin creating a Teamcenter environment, make sure you download the required software
kit for Teamcenter.

Launch TEM and choose software

1. Log on to the operating system with the Teamcenter user account you created for installing and
maintaining the Teamcenter installation.

2. Specify the path to the required Java Runtime Environment (JRE) by setting the JRE64_HOME
environment variable on your host.1

3. Start Teamcenter Environment Manager (TEM):

a. Browse to the root directory of the Teamcenter 2412 software kit.

b. Right-click the tem.bat program icon and choose Run as administrator.

TEM starts and displays the Installer Language dialog box.

1 Alternatively, you can specify the JRE path when you launch TEM from a command prompt using the -jre JRE-path
argument.
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c. In the Installer Language dialog box, select a language and click OK.

Your language selection applies only to the TEM session, not the Teamcenter installation.

For information about any TEM panel, click the help button .

4. In the Welcome to Teamcenter, select Teamcenter.

5. Proceed to the Install/Upgrade Options panel. This panel contains the following options:

• Install

Installs a new Teamcenter configuration using a fully configurable installation process.

• Quick Preconfigured Install

Installs preconfigured corporate server and client configurations using a simplified installation
process.

• Upgrade

Upgrades an existing Teamcenter configuration.

Click Install to begin creating the Teamcenter environment.

Note:

The Install/Upgrade Options panel also provides these installation options:

• Create environment for upgrade testing

TEM can create a copy of an existing Teamcenter environment for upgrade testing only.
The copied environment cannot be used as a production database.

• Create custom distribution

To simplify installations of Teamcenter on multiple hosts, TEM can create a silent
distribution or a compact distribution. Compact distribution is recommended only for
Teamcenter client configurations, not for servers.

6. In the Media Locations panel, optionally specify locations of any Teamcenter patches you want to
apply during your installation.

TEM applies updates in the order you specify. If updates contain different versions of the same
software component, the update closest to the bottom of the list takes precedence. To change the
order in which updates are applied, select an update in the list and click Up or Down.
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Create a configuration and choose features

1. In the Configuration panel, type a unique ID and description for the new Teamcenter
configuration.

The configuration ID identifies your Teamcenter configuration when you maintain, upgrade,
uninstall, or add features to the configuration. Installation log files are also named based on the ID
you enter.

2. In the Solutions panel, select the Corporate Server and Active Workspace Server Extensions
solutions.

3. Proceed to the Features panel. This panel shows the features preselected by the Corporate Server
solution:

Teamcenter Foundation
FMS Server Cache
NX Part Family Classification Integration

Also shown are features preselected by the Active Workspace Server Extensions solution:

Active Workspace
Active Collaboration
Active Content Structure
Audit
Multisite Integration
Relationship Viewer

Reporting
Shape Search
Subscription
Workflow
TC XML Import and Export

4. Select any additional features you want to include in your configuration.

If you select additional features, TEM displays additional panels during installation that are not
described in this procedure.

For help with any panel in TEM, click the help button .

You can add features to the corporate server later using TEM in maintenance mode. You can also
install custom features by installing a custom solution or third-party template.

5. In the Installation Directory box, enter the path to a new directory where you want to install
Teamcenter.

The Installation Directory value is the Teamcenter application root directory (TC_ROOT).

Do not set the TC_ROOT environment variable in the system environment. TEM sets this variable as
required in Teamcenter configuration files. Setting this variable in the operating system can cause
conflicts if you install multiple Teamcenter configurations.
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The installation directory must meet the following requirements:

• The directory must not already exist on your system. (TEM creates the directory during
installation.)

• The directory must be in a location excluded from real-time virus scanning.2

• The path to the installation directory must not exceed 64 characters.

If your Teamcenter installation directory is on a mapped drive or a UNC path (not on the local host)
you must be logged on as an authenticated domain user to ensure the remote host recognizes
you. Alternatively, you can set the permissions on the remote host to allow an anonymous user to
access it. This is necessary to ensure Teamcenter services such as the FMS server cache (FSC) and
Multi-Site Collaboration services can start.

Configure Teamcenter Foundation and the Teamcenter database

1. In the Key Manager Configuration panel, choose whether to install the Teamcenter Key Manager,
an optional feature that enables you to manage, edit, and share encryption keys and policies for a
distributed Teamcenter site.

To enable Key Manager, select the Enable Key Manager  check box, and then enter the path to a
key storage location on the local host in the Satellite Location box.

2. In the File System Cache (FSC) panel, type a unique identifier and port for the FMS server cache in
the FSC ID and Port boxes.

A Teamcenter network must have at least one primary (master) FSC. If you want to designate the
current FSC as an FSC primary, select the Enable configuration master check box. Otherwise, type
the URL to the parent FSC in the FSC Parent URL box.

For advanced FSC configuration options, click Advanced.

3. In the Foundation panel, select how you want to create or designate the Teamcenter database and
Teamcenter data directory (TC_DATA).

Database
exists?

Database
populated?

TC_DATA
exists?

Select this option

No N/A No Create and populate database, create new data directory

No Teamcenter database or data directory exists and you want
TEM to create both. This option is selected by default.

Yes No No Populate database, create new data directory

2 Real-time virus scanning prevents Teamcenter from updating the persistent object manager (POM) schema during
installation, causing installation errors.

11. Create a Teamcenter environment using TEM

11-4  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



Database
exists?

Database
populated?

TC_DATA
exists?

Select this option

A database exists but is not populated with Teamcenter data.
You want TEM to populate the database and create a new data
directory.

Yes Yes No Create new data directory using existing populated
database

A database exists and is populated. You want TEM to use this
database and create a new data directory.

Yes Yes Yes Use populated database and existing data directory

A database exists and is populated, and a data directory exists.
You want TEM to use both of these.

4. Enter the required values for your Teamcenter database according to your selection in the
Foundation panel.

• Create and populate database, create new data directory:

a. Proceed to the Foundation Database panel.

b. Select the appropriate database server vendor (Oracle or MS SQL Server).

c. Enter the required values for the database server, the database user, and the database
administrator account.

• Populate database, create new data directory:

a. Proceed to the Foundation Database panel.

b. Select the appropriate database server vendor (Oracle or MS SQL Server).

c. Enter the required values for the database server and the database user.

• Create new data directory using existing populated database:

a. Proceed to the Foundation Database panel.

b. Select the appropriate database server vendor (Oracle or MS SQL Server).

c. Enter the required values for the database server and the database user.

• Use populated database and existing data directory:

No database information is required. Proceed to the Data Directory panel.
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The directory you specify in the Database Path box must exist and you must have write permission
to the directory.

Caution:

When you enter the password for the database system user, observe the following
restrictions:

• The password must not be empty nor contain any whitespace characters such as space,
tab, newline, carriage return, form feed, or vertical tab.

• In addition, the password must not contain any of the following characters:

! # @ $ % = & ' " ^ : ; . _ < > ( ) { }

5. If your database is Oracle, specify whether you want to enable TCPS support for your Oracle
database:

Value Description
Enable TCPS Specifies whether to your Oracle server is configured for secured communication

using TCPS protocol. If TCPS is enabled, select the Enable TCPS check box and
then type values for Wallet Location and TLS Version.

Wallet Location Specifies the location of the wallet on the Teamcenter machine where Oracle
wallets are kept.

TLS Version Specifies the version of Transport Layer Security (TLS) configured on the Oracle
server. This is equal to SSL_VERSION value specified on Oracle database
machine.

6. In the Data Directory box, enter a location for the Teamcenter data directory.

The Teamcenter data directory is called the TC_DATA directory. TEM stores this location as the
TC_DATA variable in Teamcenter configuration files. TEM creates shared data subdirectories and
files in this location. Each data directory is associated with a single database user within a database
instance.

TEM creates a security directory to store password files. In a distributed environment, you may
place this directory on a network share, provided the location is secured. When you share a
Teamcenter data directory (TC_DATA), all secondary servers have access to the same files. Make
sure the configuration IDs are consistent across those machines.

As an alternative to shared Teamcenter data directories, you can create local data directories. Local
data directories do not need to have matching configuration IDs, and password files do not need to
be on a share, but you must ensure the separate data directories are kept synchronized.

11. Create a Teamcenter environment using TEM
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Note:

Do not set TC_DATA as a system environment variable. Setting this variable in the operating
system can cause conflicts if you install more than one configuration.

7. Proceed to the Volume Information panel.

In the Name box, type a name for the Teamcenter volume you want TEM to create.

In the Directory box, type the absolute path to the directory in which to create the volume, or
accept the default location.

Do not define the volume location under the Teamcenter application root directory (TC_ROOT).
Doing so leads to complications when upgrading to a later version of Teamcenter.

8. Proceed to the Foundation Settings panel.

Value Description
Transient
Volume
Directories

Specifies transient volume locations for Windows hosts, Linux hosts, or both.

A transient volume is an operating system directory controlled by Teamcenter
and used to store temporary data for transport of reports, PLM XML data, and
other nonvolume data between the enterprise tier and client tier in a deployed
four-tier architecture. All four-tier clients that access the corporate server you
are installing use this transient volume.

Caution:

Do not define the path as a UNC path, for example, \\server\shared-
transient-folder. You must use a direct path location.

Some ZIP archive utilities do not accept UNC paths, resulting in failure of
exports to Excel or Word.

Windows
clients

Specifies the location for a transient volume for Windows client hosts.

Linux
clients

Specifies the location for a transient volume for Linux client hosts.

Generate server
cache

Specifies you want to generate a shared server cache. If you select this
option, TEM runs the generate_client_meta_cache utility at the end of
the install, upgrade, or update action. This option reduces Teamcenter
memory consumption by moving metadata to shared memory. Types, property
descriptors, and constants are placed in a shared cache that is shared by all
Teamcenter server instances.

This option is selected by default in a Teamcenter server installation.
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Value Description
Generate client
cache

Specifies that you want to generate a cache of data that rich clients can
download once at initial logon and then reuse on the client host. This
option reduces server demand, reduces startup time, and improves overall
performance. When this option is selected, TEM generates the client cache at
the end of the install, upgrade, or update action. If you clear this option, but a
client cache already exists, the old client cache is deleted.

This option is selected by default in a Teamcenter server installation.
Production
Environment

Specifies your new environment is to be used as a live environment where you
will store your product data.

Test
Environment

Specifies your new environment is to be used for development, testing, or
training. Selecting Test Environment enables the bulk loader tool to copy data
from another environment (such as a production environment) into this test
environment.

If you designate this environment as a test environment, the designation
cannot be changed.

A test environment cannot participate in Multi-Site sharing with a production
environment.

For advanced Teamcenter Foundation options, click Advanced.

9. If you want to configure Teamcenter online help, click Advanced in the Foundation Settings panel
and perform the following steps:

a. Click the Online Help tab.

b. Select the Enable Online Help  check box.

c. In the Documentation Server URL box, type the Teamcenter online help URL.

Configure other features and begin installation

1. Proceed to the Flex License Client panel. Enter settings for the Siemens License Server.

The Siemens License Server must be installed before you begin Teamcenter installation.

2. Proceed to the Teamcenter Administrative User panel. Enter a password for the Teamcenter
administrative user account.

The password must not be empty nor contain any whitespace characters such as space, tab,
newline, carriage return, form feed, or vertical tab. In addition, the password must not contain any
of the following characters:

! # @ $ % = & ' " ^ : ; . _ < > ( ) { }

11. Create a Teamcenter environment using TEM
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3. Proceed to the Password Security panel. In the Administrative Password Directory box, enter the
directory in which to place Teamcenter password files. TEM locks access to this directory to all users
except the user performing Teamcenter installation.

4. In the Operating System User panel, type the password for the operating system account under
which you install Teamcenter.

5. In the AM Read Expression Settings panel, in the Sleep Time box, specify the time in seconds for
the Read Expression Manager service to wait until a new update task is performed. The default is
10 seconds.

6. In the Indexing Engine User panel, type the user name and password for the Solr administrator.

The Solr administrator’s user name and password are defined when you install the Indexing
Engine.

If the Indexing Engine is not installed yet, record the Solr administrator user name and password
and make sure to use these credentials when you install the Indexing Engine. These credentials
must match for Indexing Engine, the Indexer, Server Extensions, and the Active Content Structure
Translator (if used).

7. In the Active Workspace Server Extensions Settings panel, type the Solr search engine URL. The
format is:

http://host:port/solr

host is the machine designated to run Solr. This is the machine on which Indexing Engine is to
be installed.

port is the port value used by Solr. The default is 8983.

If your environment uses multiple Solr search engines for failover, select Use additional search
engine URLs, and then type the URLs in the Search Engine URL List.

8. Proceed through any remaining panels, entering the required information for the features you
selected.

For information about these panels, click the help button .

Note:

If your configuration includes the Teamcenter Security Services component, make sure
Security Services is installed and running. TEM verifies the connection to Security Services
and does not allow installation to proceed if the connection fails.

9. Proceed to the Confirmation panel. Verify the information you entered.

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  11-9
© 2025 Siemens



If you want to change any values, click Back to return to the panels you want to change.
Otherwise, click Start to begin installing the Teamcenter corporate server.

If an error occurs during installation, follow the instructions in the error message displayed by TEM
or see the available troubleshooting solutions.

10. When installation is complete, close TEM.

After installation, you can find Teamcenter in the list of installed programs in the Windows control panel.
The program name is displayed as Teamcenter 2412 (x64) (TC_ROOT).

11. Create a Teamcenter environment using TEM
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12. Complete the Teamcenter server
installation
Start database daemons

If you select Teamcenter database daemon features during Teamcenter installation, Teamcenter
Environment Manager (TEM) configures the database daemons to start automatically as Windows
services. After installation, you can find these services in the Services dialog box in the Windows Control
Panel:

Teamcenter Action Manager Service
Teamcenter Subscription Manager Service
Teamcenter Task Monitor Service
Teamcenter Tesselation Manager Service
Teamcenter Shared Metadata Cache Service
Teamcenter Revision Configuration Accelerator Service
Teamcenter Read Expression Manager Service1

Teamcenter Workflow Remote Inbox Sync Service

If the services do not start automatically, see the available troubleshooting solutions.

Each service behaves as follows:

1. After the services are started, a program runs in TC_ROOT\bin named tc_service.exe.

Windows displays tc_service.exe in the task manager. If you do not see this process, either your
registry entry for that service is corrupted (specifically the path to the image) or the file is not on
the system.

2. The tc_service.exe program identifies the service that launched it by examining the
service name. It expects the service name to contain either actionmgrd, subscripmgrd,
task_monitor, or tess_server. The default service names for Teamcenter are tc_actionmgrd,
tc_subscripmgrd, tc_taskmonitor, and tc_tess_server. These services are defined in
\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services.

3. The tc_service.exe program assembles a .bat file name by prefixing the service name with run_
and appending the extension of .bat. For example, the tc_actionmgrd service has the file name
run_tc_actionmgrd.bat.

4. The tc_service.exe program calls the .bat file (created by the setup program during configuration
and placed in the \bin directory of the Teamcenter application root directory).

5. The task manager displays the process, for example, actionmgrd.exe.

1 This service is installed by default and is not selectable in TEM
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If the process is not displayed in the task manager, either the service name is not one of the three
supported names, the .bat file for the process does not exist, or the process executable is missing.

6. The Services dialog box is updated to Started.

Install database triggers manually

The TcFTSIndexer process requires database triggers that enable database access for the Indexer to
detect additions, modifications, and deletions to the database when performing run-time (synchronous)
indexing.

In most cases, TEM installs these indexing triggers automatically. However, if you do not provide the
necessary values (logon values for the database user and the system user) to install them during your
TEM session, TEM displays a TODO message about enabling database access to Teamcenter. If this
happens, install the database triggers manually using the appropriate procedure for your database:

Install database triggers in Oracle

1. To grant the create trigger privilege to the Oracle user that owns the Teamcenter database,
perform the following steps:

a. Open a command prompt.

b. Type:

sqlplus system/password

c. Type:

grant Create trigger to Tc-Oracle-user identified by password;

d. Type:

exit

2. Create the trigger:

a. In the command prompt, type:

sqlplus Tc-Oracle-user/password

b. Type:

@Teamcenter-installation-media\tc\install\sitecons\sitecons_install_triggers_oracle.sql
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Install database triggers in Microsoft SQL Server

1. Open Microsoft SQL Server Management Studio.

2. Complete the Connect to Server dialog box:

a. In the Server name box, select the host on which Microsoft SQL Server is installed.

b. In the Authentication box, select SQL Server Authentication.

c. In the Login box, type the database administrative user name.

d. In the Password box, type the database administrative user password.

e. Click Connect.

3. In the Object Explorer panel of the Microsoft SQL Server Management Studio dialog box,
expand the Databases tree and select the Teamcenter database name, for example, tc.

4. From the menu bar, choose File→Open→File.

5. In the Open File dialog box, navigate to the software kit for the Teamcenter release.

In the Tc-software-path\tc\install\sitecons directory, select sitecons_install_triggers_mssql.sql.

Microsoft SQL Server Management Studio opens the selected file.

6. Click Query→Execute.

The query installs the database triggers.

7. Verify that the query completed with no errors.

8. Close the Microsoft SQL Server Management Studio.

Installing database triggers from the command line

If Microsoft SQL Server Management Studio is not installed on your host, you can install the database
triggers from a command line. Type the following command in a Windows command prompt:

sqlcmd -H host -d database -U user -P password -i 
path\sitecons_install_tables_and_triggers_mssql.sql  

Replace:

• host with the database server host name.

Install database triggers manually
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• database with the Teamcenter database name.
• user with the database user name.
• password with the database user password.
• path with the path to the sitecons_install_triggers_mssql.sql file.

For example:

sqlcmd -H myhost -d TcDB -U dbUser -P dbPassword -i
      C:\software\tc\install\sitecons\sitecons_install_triggers_mssql.sql  

To verify the triggers installed successfully, log into Microsoft SQL Server and type the following
commands in an SQL prompt:

1> Select name,is_disabled from sys.triggers2> Go  

If the installation succeeds, Microsoft SQL Server displays a table similar to the following showing that
the database triggers are not disabled:

name                              is_disabled
-----------------------------------------------------------------
fast_sync_add_trigger                  0
fast_sync_delete_trigger               0     
(2 rows affected)  
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13. Installing distributable components
Install the server manager

1. Launch Teamcenter Environment Manager (TEM).

If you are adding the server manager to an existing configuration, launch TEM in maintenance
mode.

If you are creating a new Teamcenter configuration, launch TEM from the Teamcenter software
kit.

2. In the Features panel, select Server Enhancements→Server Manager.

The Server Manager requires the following features. Select these if they are not yet included in
your environment:

Base Install→Teamcenter Foundation
Server Enhancements→File Management→FMS Server Cache

3. Proceed to the Multiplexing Proxy (MUX) panel and specify values for the Teamcenter
multiplexing proxy (MUX).

Value Description
Port Specifies the TCP/IP port on which the MUX listens for web tier requests. This is

the Jetty server connector port.
TECS Admin
Port

Specifies the port used by the Teamcenter Enterprise Communication System
(TECS).

The MUX listens on a single port for incoming requests from the web tier, forwards those
requests to an appropriate Teamcenter server using operating system named-pipe communication
protocol, and then streams the response back to web tier. The MUX runs as an application within
the Teamcenter Enterprise Communication System (TECS).  The TECS container is based on the
Teamcenter client communication system (TCCS) container used in the client tier.

4. Proceed to the Communication Configuration panel and enter the required values.

Value Description
Pool ID Type a name for the server pool.
JMX RMI Port Type a port for the server pool.
Assignment
Service Port

Type a port number for the Server Manager Assignment Service.

The Server Manager Assignment Service is a service used by the Java EE web
tier for business logic server assignment requests to the server manager. The
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Value Description
assignment request is a POST HTTP request in which the input and output
parameters are transmitted as XML payload.

Server Host Type the logical host name of the server manager host. This value allows you
to control which IP address is used when connecting to Teamcenter servers.

Startup Mode Select one of the following:

• Service/Daemon

Specifies that you want to run the server manager as a Windows service.
This is the default mode.

• Command Line

Specifies you want to run the server manager manually from a command
line.

5. Proceed to the Server Manager Cluster Configuration panel and enter remaining values as
needed. For more information about fields in this panel, click the help button .

6. Proceed through remaining panels to the Confirmation panel. Click Start to begin installing the
Teamcenter server with the server manager.

7. If you install the server manager in Service/Daemon startup mode, a user with root privileges must
run the root post installation tasks script to register the server manager daemon.

In the TC_ROOT/install directory, locate and run the following script:

root_post_tasks_id.ksh

Alternatively, to use systemd to register the server manager daemon, follow the instructions in
TC_ROOT/pool_manager/confs/config-name/server.mgr.service_config-name_pool-id.readme.

8. After you install the server manager, install the Teamcenter Management Console using the
appropriate steps for the Windows platform.

When installation completes, exit TEM.

If you experience connection delays during server manager startup, see the available troubleshooting
solutions.

Java EE configuration files

You can install multiple server manager services on the same machine. Each server manager service has
its own configuration directory:
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TC_ROOT\pool_manager\confs\config-name 

where config-name is the name of the server manager.

The server manager configuration directory contains configuration files, log files, and server manager
scripts. These include the following.

File/Directory Description
mgrstart Script that launches the server manager in console mode.
mgrstop Script that stops the server manager when started from a command line.

If you run the server manager as a Windows service, stop the service using the Windows
services manager.

You can also stop the server manager using the Teamcenter Management Console.
mgr.output If you run the server manager as a service, this file contains all output from the server

manager.

This file is not used if you run the server manager from the command line.
logs Directory that contains all server manager log files.

If you run the server manager as a Windows service, the starts automatically.

Installing Teamcenter microservices

Microservices and the microservice framework

Various Teamcenter solutions and applications include microservices as part of their deployment. For
example:

• Active Workspace requires TcGQL and File Repository microservices.

The File Repository provides centralized temporary storage for web client content accessed through
the web client gateway. This storage gives other microservices an alternative to the File Management
System (FMS).

• The Classification and Requirements Manager applications each have their own required
microservices.

• The Product Configurator application can optionally employ its application-specific microservice to
achieve better performance.

The microservice framework enables microservices to run seamlessly across diverse platforms.

Microservices and the microservice framework
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To install the microservice framework and the microservices that run on it, you must configure and
deploy a microservice node. If the server hardware has sufficient capacity, you can deploy a microservice
node on the same hardware as a Teamcenter pool manager.

To increase capacity and provide failover, the microservice framework can include multiple nodes. For
Linux deployments, a single node configuration is reused by the Docker swarm or the Kubernetes cluster.
For Windows deployments, you can add and configure worker microservice nodes in addition to a master
microservice node.

All microservice nodes in a Teamcenter environment must be hosted on servers of a single operating
system type. The following table compares the characteristics of microservice nodes hosted on Linux
and Windows.

Linux 64-bit Windows 64-bit
Prerequisite third-
party software

On the microservice node:

• Mirantis Container Runtime (formerly Docker
Engine - Enterprise)

• Kubernetes (only if deploying into a Kubernetes
environment)

In a location accessible from the microservice node:

• A container registry

None

Management
of microservice
framework and
application
microservices

Docker Swarm or Kubernetes starts, stops, restarts,
and scales all Teamcenter microservices running as
containers in a way that best utilizes resources.

On Windows, each
microservice framework
node includes a
Teamcenter process
manager to handle the
microservices on that
node.

Microservice framework constituents

The microservice framework has the following constituents:

Service Registry Maintains a list of running microservice instances across all nodes.
Service Dispatcher Receives microservice requests from a Teamcenter client, queries the

service registry to find an instance of the requested microservice, and
then routes the request to an instance of the microservice.

Microproxy Forwards web tier application requests to the service dispatcher.
Teamcenter Process
Manager (Windows hosts)

Starts the microservices and Active Workspace Gateway on the node
(Windows hosts).

13. Installing distributable components

13-4  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



Microservice Parameter
Store (MPS)

Manages logging levels for microservices.

File Repository Manages files for web client and microservices.

Install microservices using TEM

Install microservices using TEM

Before you install microservices:

• Review Microservices and the microservice framework for a comparison of the microservice
framework requirements in different environments and a list of framework constituents.

Add the microservice feature

Add the microservice feature to the Teamcenter environment.

For this task Perform these steps
Install a new
Teamcenter
environment

1. Launch Teamcenter Environment Manager (TEM) with administrative
privileges. In the Teamcenter software kit, right-click the tem.bat program icon
and choose Run as administrator.

2. Proceed to the Install/Upgrade Options panel and click Install.

3. Proceed to the Configuration panel, enter an ID and description for the
Teamcenter configuration.

4. Proceed to the Features panel, and then install Teamcenter microservices.
Update an
existing
Teamcenter
environment

1. Stop all Teamcenter services except FSC services.

2. Launch TEM from its installed location, with administrative privileges.

Choose Start > Teamcenter version, right-click Environment Manager and
choose Run as administrator.

3. In the Maintenance panel, select Updates Manager.

4. In the Apply Updates panel, enter the required paths:
Update kit
location

Enter the path to the expanded Teamcenter software kit.

Backup
directory

Enter a path in which to create backups of files replaced
during the update.
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For this task Perform these steps
5. Proceed to the Confirmation panel and click Start to add microservice features

to TEM.

When the update is complete, close TEM.

6. Launch TEM as specified in step 2.

7. In the Configuration Maintenance panel, select Perform maintenance on an
existing configuration.

8. In the Old Configuration panel, select the configuration to update.

9. In the Feature Maintenance panel, select Add/Remove Features.

10. Proceed to the Features panel, and then install Teamcenter microservices.

Install Teamcenter microservices

1. In the Features panel in TEM, under Microservices, select Microservice Framework and the
microservices you want to install.

2. Proceed to the Microservice Framework panel and specify values.

a. Choose the node type to install, either Master Node or Worker Node.

A master microservice node is required in an environment.

b. If you are installing a master microservice node, then enter a Keystore Password to be
used for generating the .p12 files that contain keys for signing and validating authentication
tokens. These tokens identify the logged on Teamcenter user.

Record and securely store the password for potential use in case you want to open and edit
the keys.

c. If you are installing a worker microservice node, then in Keystore ZIP file enter the location of
the keys.zip file that was generated when the master node was installed.

The keystore ZIP file (keys.zip) was copied to the TC_ROOT/jwt_config_tool directory of the
master microservice node host. For your convenience when installing a worker microservice
node, copy that file to a location on the local machine and in Keystore ZIP file point to that
local copy. For security, a best practice is to delete the copy of keys.zip from the local machine
after the worker node installation is complete.

d. Enter parameter values for the service dispatcher and service registry:
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Service Dispatcher parameters:

Install
Microservice

On a master microservice node, the service dispatcher is required and
preselected. On a worker microservice node, you may optionally install the
service dispatcher for failover or scalability.

Dispatcher
Port

Type the port for the service dispatcher that will run on this host.

Additional
URLs

Type the URLs for additional endpoints for accessing the service dispatcher.
This field can be empty or can include URLs for one or more microservice
nodes. Use a comma to separate multiple URLs. For example:

http://masternode_1:9090,http://workernode1:9090,http://
workernode2:9090

If service dispatchers are configured on multiple nodes (Windows hosts) in
an environment, the file service_dispatcher.json on each node must list all
instances.

If service dispatcher instances are added or changed, then edit
the file on each node where a service dispatcher is installed
as needed to update the file. The default location of the file
is TC_ROOT\Clients\aw\microservices\services_config. Similarly, some
microservice .json files include an ARGS or DSP variable. In such cases,
update the variable value in each .json file on each node.

Service Registry (Eureka) parameters:

Install
Microservice

On a master microservice node, the service registry is required and
preselected. On a worker microservice node, you may optionally install the
service registry for failover or scalability.

Registry Port Type the port for the service registry that will run on this host.
Additional
URLs

Type the URLs to all other instances of the service registry in the
environment, separated by commas.

The URL pattern for a service registry is:

http://<host>:port/eureka/v2/

where <host> is the hostname, fully qualified domain name, or IP address.

When multiple microservice nodes with service registry instances are
configured in an environment, every .json file for every microservice on
every node must list all instances. If service registry instances are added
or changed, then edit the files as needed to update the list of service
registries (eureka). (For installation via Deployment Center, all instances are
automatically included in the list.)
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Example:

eureka definitions when a service registry exists on port 8787 on
servers JPS008601, JPS008602, and JPS008603:

{  
  "eureka":{  
    "image":"eureka_server-1.9.12_1.2.1",
    "environment":[  
      "ARGS=-Deureka.serviceUrl.default=
         http://JPS008601:8787/eureka/v2,
         http://JPS008602:8787/eureka/v2,
         http://JPS008603:8787/eureka/v2"
      "JETTY_PORT=8787"
    ]
  }
}

3. If you are installing a master node, proceed to the Microservices panel. Review the instance
quantity for each service that you want to run on this node. Typically, Teamcenter microservices are
multi-threaded, so only one instance of the microservice is needed on a node.

When the environment includes multiple microservice nodes on Windows hosts, you may want to
run only a subset of microservices on a given node. In that case, for microservices that you do not
want to install on the node, set the instance value to 0.

4. Proceed to the File Repository Microservice panel and enter parameter values.

In File Repository Storage Location, enter the path to the shared location for persistent file
storage.

The path must be accessible by all microservice nodes.

5. Proceed through the remaining panels and enter configuration values for your selected
microservices.

6. Review the Confirmation panel and click Start to begin the installation.

The framework and microservices are installed. If you are installing a master node, then signer and
validator keys are generated.

7. When installation is complete, carefully examine any messages to determine what post-installation
steps are necessary.
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8. Add microservices support to the Teamcenter web tier, as applicable for Java EE or .NET web tier
architecture.

Add microservice framework support to a Java EE web tier

If you used Teamcenter Environment Manager to install the microservice framework, use the following
procedure to add microservice framework support to a Teamcenter Java EE architecture web tier WAR
file.

This procedure assumes you installed the Web Application Manager and the WEB_ROOT directory as
described in the appropriate Teamcenter installation guide for Windows or Linux.

If you use scripts generated by Deployment Center to install the microservice framework, you do not
need to manually perform this procedure.

1. Install a microservice framework master node.

Locate the keystore ZIP file (keys.zip) in the TC_ROOT/jwt_config_tool directory of the master
microservice node host.

2. Copy the keystore ZIP file (keys.zip) to a location on your local machine and extract the ZIP file
contents.

The keystore ZIP file contains a directory named signer_config.

Caution:

Safeguard the keystore files. A best practice is to remove them from any temporary locations
once you complete this procedure.

3. Locate the following software kits:

• Teamcenter software kit for your installed version of Teamcenter

• Microservices Framework

4. Change to the WEB_ROOT directory and launch the Web Application Manager using the appropriate
command:

• Windows systems: insweb.bat

• Linux systems: insweb.sh
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5. Copy ICD files from the software kits. This populates the list of solutions available to install.

a. Click Copy ICDs.

b. In the Copy ICD Files dialog box, click Browse and browse to the following location:

Teamcenter-kit\Web_tier\icd

c. Click OK to copy ICD files from the kit.

d. Repeat steps a through c, specifying the path to the Microservices Framework ICD files:

Microservices-Framework-kit\Web_tier\icd

6. Click Add to begin creating a new web application.

7. In the Add Web Application dialog box, create the web application:

a. Type a Name and Staging Location for the web application.

b. Enter software locations:

A. Click Add.

B. In the Add Disk Location dialog box, enter software locations:

i. Click Browse, browse to the signer_config directory from the keystore ZIP file you
extracted in step 2, and then click Apply.
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ii. Click Browse, browse to the location of the Microservice Framework kit, and then
click Apply.

iii. Click Browse, browse to the location of the Teamcenter software kit, and then click
OK.

c. Select solutions:

A. Click Solutions.

B. In the Select Solutions dialog box, select the following web tier solutions:

• Teamcenter - Web Tier Infrastructure

• Teamcenter - Web Tier Core Applications

• Teamcenter Microservices

8. Verify your selections, and then click OK to continue creating the web application.

9. In the Modify Required Context Parameters dialog box, ensure the following context parameters
have correct values:

MICROSERVICE_ENABLED

Set to true.

MICROSERVICE_ADDRESS

Add microservice framework support to a Java EE web tier
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Specifies a comma-separated list of service dispatcher URLs of the form:

http://host:port

10. Click OK to begin building the WAR file.

When the web application generation is complete, close the Web Application Manager.

11. Locate the WAR file (tc.war) in the deployment directory under the staging location you specified.

12. Deploy the web application on a supported application server, as described in Web Application
Deployment in the Teamcenter help.

Add microservice framework support to a .NET web tier

In the typical case that the Teamcenter .NET architecture web tier machine does not also have a
microservice node installed on it, and installation is through TEM, the following procedure adds
microservice framework support (the microservice proxy).

The procedure is performed automatically if TEM is used to install both a master microservice node and
the .NET web tier on the same host, or if installation is through Deployment Center.

If you use a distributed environment in which your server managers are on hosts separate from your
microservice nodes, make sure that on the local machine that runs IIS, the IIS_IUSRS ID has full control
permissions on the net_webtier_configuration directory. IIS_IUSRS is a local user account created by IIS.

1. Install a master microservice node on some machine in the Teamcenter environment.

The keystore file signer_keystore.p12 is installed to the TC_ROOT\signer_config directory of the
microservice node host.
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2. On the web tier machine, before starting IIS, copy the private key signer_keystore.p12 from the
microservice node host to C:\windows\System32\inetsrv.

3. From the microservice framework kit, extract the file dotnet_microproxy-1.0.1.zip and then
extract its contents into the IIS bin folder on the web tier machine.

4. On the web tier machine, modify ApplicationConfiguration.xml, which you can find in the
TC_ROOT\net_webtier_Configuration ID\tc\ directory.

• Set microserviceEnabled to true.

<!-- Enable/disable microservice requests. (Value: true/false) -->
<param name="microserviceEnabled" value="true"></param>

• Set microserviceAddress to the location of the microservice dispatcher(s).

<!-- Specify the URL(s) to access backend microservices.  This is a
comma-separated list of addresses for service dispatchers.
Each address should include the scheme, host and (optional)
port portions of a URL (e.g., "http://localhost:9090"). An IP
address can be used for the host.  If the port is omitted the 
service dispatcher must be listening on the default port for the scheme. -->
<param name="microserviceAddress" value="http://localhost:9090"></param>

• Set the microservice keystore.

<!-- Name of the keystore file that stores private key to sign JWT. -->
<param name="microserviceKeyStore" value="signer_keystore.p12"></param>

• Set the microservice keystore password. This is the password that was entered when installing
the microservice framework master node.

<!-- Password to read private key to sign JWT. -->
<param name="microserviceKeyStorePassword" value="password"></param>

• Set the login-manager for microservices.

<!-- Micro Services -->

<injector id="micro" 
handler="Framework,Teamcenter.Presentation.Framework.RequestProcessing.RequestInje
ctorImpl">
  <!--<pre-trigger 
handler="Micro,Teamcenter.WebIntegrations.Micro.MicroPreTrigger"></pre-trigger>-->
  <login-manager 
handler="Micro,Teamcenter.WebIntegrations.Micro.MicroLoginManager" 
login-failure-response-chain="microLoginFailure_response_chain">
  </login-manager>
  <!-- for urls tc/micro -->
  <group-association-path id="micro"></group-association-path>
  <config-param name="DEFAULT_LINK" value="microInvoke_link"></config-param>
  <error-handler 
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response-handler="Micro,Teamcenter.WebIntegrations.Micro.MicroResponseHandler"></
error-handler>
</injector>

5. Start IIS and in the Application Pools > DefaultAppPool or Teamcenter App Pool > Advanced
Settings page, set Load User Profile to True.

Finding microservice logs

If a microservice framework node is running on a Windows host, by default logs of microservice
instances on the node are written to the location %USERPROFILE%\Siemens\logs\TcMSF. If the
environment variable SIEMENS_LOGGING_ROOT is defined, then the logs are written to the location
%SIEMENS_LOGGING_ROOT%\TcMSF.

Service Log file name Example
Service Dispatcher service_dispatcherinstance#@PI

D-msf.log
service_dispatcher1@2184-
msf.log

Service Registry eurekainstance#@PID-msf.log eureka1@2184-msf.log
Microservices microservice-name

instance#@PID-msf.log
file-repo1@2184-msf.log

Teamcenter Process Manager TC_ROOT\process_manager\mgr.
output

web client gateway gatewayinstance#@PID-msf.log gateway1@2184-msf.log

Securing microservices

Encrypting microservices traffic for Windows

An administrator can configure the microservice framework to encrypt data traffic based on an SSL
certificate.
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Configuring the microservice framework and microservices for encrypted communication requires the
following:

• Obtain an SSL certificate and keys for the server that will host the service dispatcher.

A server certificate signed by a certificate authority (CA) can be purchased from a CA, and is
recommended. Alternatively, cryptographic tools such as OpenSSL can be used to create a self-signed
certificate and its keys. In the case of a self-signed certificate, the certificate issuer must be added to
the client machine's trust store.

• When configuring a microservice node, for the Service Dispatcher Setting, choose the HTTPS
protocol and complete the configuration parameters in the HTTPS Config component.

• When configuring the web client gateway, if you choose to override the default service dispatcher
URL, ensure that you enter the HTTPS protocol for the Service Dispatcher URL.

Encrypting microservices traffic for Windows
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Configure microservices for self-signed certificates

If the service dispatcher is configured for HTTPS and the TLS certificate used is self-signed, each
microservice on a node must be configured to trust the self-signed certificate. The following instructions
apply to microservices that communicate with a server using a self-signed certificate. These steps
describe how to configure the microservices with the Certificate Authority.

The following instructions are for microservices running on a Windows host. For a Linux host, see
Configure microservices for self-signed certificates - Docker swarm in Teamcenter Installation on Linux.
This configuration is also necessary for other services that use self-signed certificates.

Add the certificate to the list of certificates the microservice trusts. The procedure for this varies based
on the language in which the microservice is written.

For these
microservices Do this
iModel Viewer
Service

(Source code
language:
Javascript/
Typescript using
NodeJS)

Prerequisite: The certificate must be in the PEM format and must not have been
generated using DSA encryption.

1. Edit the file %TC_ROOT%
\microservices\services_config\<microservice>.json.

2. In the environment section, add the environment variable
NODE_EXTRA_CA_CERTS and set it to point to the location of the certificate.

Example:

For additional information about this variable, see NodeJS documentation.

3. Restart the process manager.
ep-app 1. Ensure that the following two arguments are passed to the JVM:

-Djavax.net.ssl.trustStorePassword=password

13. Installing distributable components

13-16  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



For these
microservices Do this

FileRepo

mfe-vis

odata_service

req-compare-
service

(Source code
language: Java)

-Djavax.net.ssl.trustStore=path_to_trust_store_file_in
_.jks_format

The method for doing this for Java-based microservices depends on their
implementation.

• The preferred method is to edit the
TC_ROOT\microservices\services_config\microservice.json file to alter the
JVM arguments.

For most microservices, the .json file has an ARGS variable, to which you
can append arguments.

• Some microservices, notably odata_service, require that you modify
the corresponding TC_ROOT\microservices\microservice\start_service.bat
script to add the JVM arguments.

2. Restart the process manager.
Command
Prediction

Google Online

Office Online

Product
Configurator
Service

reqexportservice

reqimportservice

Teamcenter Share

(Source code
language: C#)

1. If the trust store file is in .jks format, convert the .jks file to .pk12.

To convert a keystore file named keystore2.jks to a .pk12 file using the key
mykey and the password testKeyStorepw, run the command:

keytool -importkeystore -srckeystore [./keystore2.jks] 
-destkeystore ./keystore2.p12 -srcstoretype JKS -deststoretype 
PKCS12 
-srcstorepass testKeyStorepw -deststorepass testKeyStorepw 
-srcalias mykey 
-destalias mykey -srckeypass testKeyStorepw -destkeypass 
testKeyStorepw -noprompt

2. Double-click the .pk12 file to install it as a trusted certificate.

High availability for microservices

In a distributed Teamcenter production environment, ensure high availability by configuring redundant
microservice node servers and service instances. For detailed deployment examples and sample
configurations, see Teamcenter Deployment Reference Architecture, available from the Teamcenter
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documentation and also from the Support White Papers Teamcenter Deployment Reference
Architecture page on Support Center.

Capacity

With the many variables affecting a Teamcenter environment, no simple formula exists that can
prescribe the precise combination of microservice nodes and microservice instances. As with all server-
side deployments, monitor the consumption of CPU and memory on each microservice node. If you
observe resource contention, you can increase resources for microservice execution by deploying
additional microservice nodes and services running on additional hardware.

Failover

Windows

Achieving failover capability on Windows requires that a service registry, a service dispatcher, and
instances of all microservices must each be running on at least two nodes. By default, an instance
of the service registry and service dispatcher run on the master node; additional instances can be
running on any worker nodes. When installing microservice nodes through TEM, be sure to list all
instances of the service registry and the service dispatcher.

Docker Swarm

Achieving failover capability with Docker Swarm on Linux requires that an odd number of servers
be joined to the swarm as managers, typically three or five. This helps the Docker swarm effectively
manage the swarm by majority vote. Any number of servers can be joined to the swarm as workers.

Kubernetes

Control Plane Follow the vendor documentation. If using a cloud provider, the provider typically
provides a Control Plane with failover.

Microservice
nodes

To avoid a single point of failure, in on-site deployments implement at least two
microservice nodes. Ensure that these nodes are allocated on different physical
hardware. Allocate at least two replicas of every component to avoid a single point
of failure. For nodes in cloud deployments, to avoid location-specific outages,
ensure that the nodes are spread across different failure zones (such as AWS
Availability Zones).

The exception to replicating components is the Service Registry. A single Service
Registry is sufficient. This is because in the event that the Service Registry (Eureka)
container goes down, the Eureka Client Cache provides needed information during
the brief period of time that passes while the container manager brings back up
the container.

If possible, test for node failure conditions and validate that client requests are handled using
service load balancing. Ensure desired scale once the nodes are recovered.

For backup options, consult the vendor documentation.
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Example microservice deployment topologies for high availability

In a high availability configuration, where there is more than one File Repository microservice deployed,
with the File Repository storage shared between the multiple instances of File Repository, the Active
Workspace publish operation needs to be performed only once, from one of the nodes (preferably the
primary node). This updates the shared storage of the File Repository microservice, so the publish does
not need to be repeated from another node. Any new publish will overwrite the previous publish in the
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shared storage. Additionally, the publish should always be done from the same node (for example, the
primary node) as used for the previous publish. It is not recommended to publish from a different node
in a subsequent publish, as this may cause errors.

Install microservices

The microservice framework must be installed before you begin these steps. You can add microservices
to an existing microservice node or install the microservices and Microservice Framework at the same
time.

1. Launch TEM in maintenance mode and select the configuration that contains the microservice
node.

2. In the Features panel, find the Microservices feature group and select the following microservices:

• File Repository Service

• Teamcenter GraphQL Service

• Declarative Artifact Service (optional)

3. Configure the microservices with the required values.

Table 3-5. File Repository Service

Value Description
File Repository
Storage Location

Type a location for the file repository to be used by the web client gateway.
The path must exist on the machine that hosts the microservice node. For
example: c:\tc\file_repository

The file repository stores web client content.
User ID (Linux only) Type the user ID of the user installing the File Repository

Microservice.
Group ID (Linux only) Type the Group ID of the user installing the File Repository

Microservice.

Table 3-6. Teamcenter GraphQL Service

Value Description
Teamcenter Web Tier URL In TEM, type the path to the deployed Teamcenter web tier, for

example:

http://host:port/tc
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Note:

On Linux systems, microservices Worker Nodes must contain the same installed
microservices as the Master Node.

4. After you complete the microservices installation, start the microservices using the appropriate
method for your operating system.

Install Active Workspace Gateway

Active Workspace Gateway requires the keystore ZIP file (keys.zip) from the microservice master node.
Before you install Active Workspace Gateway, copy the keys.zip file from the jwt_config_tool directory
under TC_ROOT on the microservice master node host to a directory on the Active Workspace Gateway
host.

You can install Active Workspace Gateway in a new or an existing Teamcenter environment.

Note:

Install Active Workspace Gateway using the same tool with which you install Active Workspace
microservices. For example, if you install microservices using Deployment Center, install Gateway
using Deployment Center. Or, use TEM for both installations.

When entering URLs, ensure you use URLs with fully qualified domain names or IP addresses.

1. If you are installing Active Workspace Gateway in a new configuration (on a machine with no
existing Teamcenter environment), skip to step 2.

If you are adding Active Workspace Gateway to an existing configuration:

a. Add Active Workspace and microservices to the Teamcenter host.

b. Launch the installed TEM in maintenance mode.

c. Skip to step 6.

2. Make sure you have access to the Teamcenter 2412 software kit.

3. Launch TEM from the Teamcenter software kit.

On Windows hosts, right click the tem.bat program icon and choose Run as administrator.

4. Proceed to the Install/Upgrade Options panel and then click Install.

5. Proceed to the Configuration panel. Enter an ID and a Description for the configuration.
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6. In the Features panel, under Base Install>Active Workspace>Client, select Active Workspace
Gateway.

If you are installing a new configuration, enter an installation location in the Installation Directory
box.

7. In the Gateway Settings I panel, enter the required values:

Value Description
Teamcenter Web Tier
URL

Enter the URL for the Teamcenter web application, in the following form:

http://host:port/tc
Visualization
Assigner URL

Enter the URL to the Visualization Server Assigner, in the following form:

http://host:port
Easy Plan URL Enter the URL to the Easy Plan application, if installed. The URL should be

of the following form:

http://host:port/application-name
NGP URL Enter the URL to the Next Generation Planning (NGP) application, if

installed. The URL should be of the following form:

http://host:port/application-name
Service Dispatcher
URLs

Enter the URL to the service dispatcher, based on the service dispatcher
host and port you used when you installed the microservice node:

http://host:port

The default port is 9090.

If you installed multiple nodes, you may enter multiple URLs as a comma-
separated list. Use fully-qualified domain names or IP addresses in URLs.

Container Registry
URL

Specifies the registry URL to store Docker images.

The value should be in the form of a host name, FQDN, or IP:port. Do not
include protocol, such as http:// or https://. For example:

registry.example.com

This value should reference a live container registry. TEM attempts to
connect to the registry. If the connection attempt fails, TEM does not
allow you to continue.

Container Repository
Name

Specifies the name of the container repository. The default value is
teamcenter.
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Value Description
This value must not contain spaces. The repository name must already
exist in the container registry.

Gateway Service
Port

Enter the port used by the Active Workspace Gateway. The default value is
3000.

The URL to the Active Workspace client interface is based on this port.
Under FMS Settings, enter the following settings for accessing FMS volumes:

Use as Bootstrap
URLs

The Active Workspace client uses FMS to download and upload files. You
define the FSC servers that are used by selecting either Use as Bootstrap
URLS or Use Assigned FSC URLs.

To use bootstrap URLs, select this option and fill in the Bootstrap URLs
and Bootstrap Client IP boxes.

On Linux hosts, if you select Use as Bootstrap URLs, you need to ensure
the client map is configured correctly.

Bootstrap
URLs

Enter a comma-separated list of URLs to one or more existing FMS server
caches (FSCs).

URLs must be of the form:

http://host:port

By default, the IP address from the HTTP connection of the requestor is
used unless a Bootstrap Client IP value is provided. (The client/requestor
is the host on which Active Workspace Gateway is deployed.)

Bootstrap
Client IP

Enter the FMS bootstrap client IP address to be used for the assignment.

On Linux hosts, enter the internal IP address of the Active Workspace
Gateway machine.

Use Assigned FSC
URLs

Specifies whether you want to assign FSC servers. Select this only if you
want explicit control of the FSCs used.

To use assigned FSCs, select this option and fill in the Assigned FSC URLs
box.

Assigned FSC
URLs

Enter a comma-separated list of one or more assigned FSC URL values.

The URL values entered are directly used for file operations. This allows
you to declare the FSC servers that should be used.

For information about other values in the Gateway Settings panel, click the help button .

8. In the Gateway Settings II panel, enter the required values:
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Value Description
Enable Teamcenter Share
Collaboration

Select this check box to enable Teamcenter Share Collaboration.

Teamcenter Share Values for configuring the Teamcenter Share Collaboration
integration to Teamcenter.

Teamcenter Share URL Specifies the URL to the Teamcenter Share site.

The default value is https://share.sws.siemens.com.
Client ID Specifies the SAMAuth client ID you obtained through SAM URL.
Client Secret ID Specifies the client secret ID you obtained through SAM URL.

9. In the Gateway Security Settings panel, enter the required values:

Value Description
Keystore Zip File Enter the location of the keystore zip file (keys.zip) generated when you

installed the microservice master node.

The keystore file is generated in the jwt_config_tool directory under
TC_ROOT on the microservice node host. For security, copy the keys.zip
file to a directory on the Active Workspace Gateway host and specify that
location here.

Under Enable TcSS Support, enter values for configuring Security Services.
Enable TcSS Support Select this check box if you want to enable Security Services support in

Active Workspace.
TcSS Application ID Type the Security Services application ID.
TcSS Login URL Type the logon URL for the Security Services application.

For details about configuring Security Services, see Security Services
Configuration.

When you configure Active Workspace for Security Services, be sure to
only install the language packs for the Security Services that Active
Workspace supports.

If Active Workspace is deployed on a different URL, you must configure
Security Services with multiple application IDs.

Under Security Key Settings, enter security key values for Teamcenter.
Security Certificate Enter the path to the security certificate.

The file must be in .pem format.
Security Key Enter the path to the security key file.

The file must be in .pem format and must be without a password.

10. In the Confirmation panel, click Start to begin the installation.
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11. When the installation is complete, close TEM.

12. Verify the FMS server cache (FSC) service is running.

13. On Linux hosts, start the Docker swarm, microservices node, and the Gateway service.

Install the Active Workspace client

Before you install the Active Workspace client using TEM, you must complete the following:

• Install microservices

• Install Active Workspace Gateway

Install the Active Workspace client configuration using the Teamcenter 2412 software kit.

Install the Active Workspace client

1. Launch TEM from the Teamcenter 2412 software kit.

2. Proceed to the Install/Upgrade Options panel and then click Install.

3. Proceed to the Configuration panel. Enter an ID and a Description for the configuration.

4. In the Features panel, under Base Install→Active Workspace→Client, select Active Workspace
Client.

Select any additional client features you want to include in your Active Workspace environment.
(See Active Workspace Client features.)

Note:

• Some features add additional panels to the installation process that are not described in
this procedure. For information about any TEM panel, click the help button .

• To search for a feature by name, type the name or a partial name in the search box, and
then click the search button .

• Some features depend on other features. Prerequisite features are usually listed earlier
than the features that depend on them.

5. In the Active Workspace Client Settings panel, enter the required values:

Install the Active Workspace client
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Value Description

Publish to Gateway Select this check box to enable automatic publishing of
Active Workspace content to the Gateway.

Note:

The Active Workspace Gateway must be installed and
running before content can be published.

Gateway URL Type the URL to Active Workspace Gateway:

http://host:port

Replace host with the host on which you installed the
Gateway. Replace port with the port you specified when
you installed the Gateway.

For information about other values in the Active Workspace Client Settings panel, click the help
button .

6. In the Confirmation panel, click Start to begin the installation.

7. When the installation is complete, close TEM.

Installing indexing components

The Indexing Engine and the Indexer provide global search capabilities for Active Workspace. Install
these components using TEM:

• Indexing Engine

Installs the Solr enterprise search platform. The search engine stores indexed Teamcenter data for
global search in Active Workspace.

Selected product data is indexed in Solr, an open source search platform from Apache. The master
product data is not stored in Solr. It is always loaded from Teamcenter.

• Indexer

Installs a four-tier SOA client that exports Teamcenter data for merging into Solr. The indexer manages
overall indexing processes. TcFTSIndexer manages the initial indexing for object data. You can then
schedule synchronization to run periodically for subsequent updates to object data or structure data
indexes.
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TcFTSIndexer indexes external and Teamcenter objects into Solr. It connects to the server manager to
query and extract Teamcenter data to be indexed into Solr.

There are two modes for installing the Indexer: Standalone for object data and Dispatcher-based for
Active content structures.

For information about indexing components and planning your indexing deployment, see the Indexing
Data and Configuring Search in the Active Workspace documentation.

During installation of indexing components, you may need to enter or verify the following information:

Indexing Engine Configuration

Parameter Where value is
defined

Your value

Teamcenter machine name
and installation path

Teamcenter installation

TC_DATA Teamcenter installation

Java location Indexing Engine
installation

Solr directory and credentials Indexing Engine
installation

Solr URL (http://host:8983/
solr)

Indexing Engine
installation

Indexing Engine credentials Indexing Engine
installation

Install Indexing Engine (Solr)

You can install the Indexing Engine (Solr) in a new or existing environment.

Prerequisites

This procedure assumes you have an existing Teamcenter environment with Active Workspace.

Procedure

1. Launch TEM in maintenance mode.

2. In the Maintenance panel, choose Configuration Manager.

Install Indexing Engine (Solr)
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3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

4. In the Old Configuration panel, select the configuration you want to modify.

5. In the Feature Maintenance panel, select Add/Remove Features.

Options in the Feature Maintenance panel vary depending on the features in your configuration.

6. Proceed to the Features panel and select the Active Workspace Indexing Engine feature (under
Base Install→Active Workspace→Indexing Server).

If you select additional features in this step, TEM may display additional panels not described in this
procedure.

7. Proceed to the Indexing Engine User panel. Type the user name and password for the Solr
administrator. These credentials must match the credentials you entered when you installed the
Active Workspace server extensions.

The indexing user must have read access to object data, datasets, and their associated files to index
their text content.

8. In the Indexing Engine Configuration panel, enter required values for the indexing engine:

Value Description
SOLR
schema files
location

Specifies the location of the Solr schema files.

Enter the path that contains the Solr schema files. This allows the Solr and
Teamcenter schemas to be automatically merged during installation of the Indexing
Engine. If you leave this box blank, the schemas are not automatically merged; you
must manually merge them after installing the Indexing Engine.

The Solr schema files are created on the corporate server when you install
the Active Workspace Server Extensions. Two schema files are located in
TC_DATA\ftsi\solr_schema_files:

• TC_ACE_SOLR_SCHEMA.xml
• TC_SOLR_SCHEMA.xml

If you did not install the Server Extensions on the corporate server, you can
complete the installation of the Indexing Engine, but the schemas are not
automatically merged. You must manually merge the Solr and Teamcenter schemas
after installing the Indexing Engine and the Server Extensions.

JRE Location Specifies the location of the Java Runtime Environment (JRE) on the Indexing
Engine host.

Install
indexing

Specifies you want to install the Indexing Engine as a service. If you leave this check
box cleared, you must start the Indexing Engine manually.
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Value Description
engine as a
service

9. Proceed through any remaining panels in TEM, entering the required parameters for the
components you selected.

For information about each panel, click the help button .

10. When TEM displays the Confirmation panel, click Start to begin installation.

When installation is complete, close TEM.

11. Configure indexing and search after completing the Indexing Engine installation.

Install the Indexer (TcFTSIndexer)

You can install the Indexer (TcFTSIndexer) in a new or existing environment.

Prerequisites

This procedure assumes you have an existing Teamcenter environment with Active Workspace.

Procedure

1. Launch TEM in maintenance mode.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

4. In the Old Configuration panel, select the configuration you want to modify.

5. In the Feature Maintenance panel, select Add/Remove Features.

Options in the Feature Maintenance panel vary depending on the features in your configuration.

6. Proceed to the Features panel and select the Active Workspace Indexer feature (under Base
Install→Active Workspace→Indexing Server).

If you select additional features in this step, TEM may display additional panels not described in this
procedure.

Install the Indexer (TcFTSIndexer)
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7. Proceed to the Teamcenter Administrative User panel. Type the password for the Teamcenter
administrative user account.

8. Proceed to the Indexing Engine User panel. Type the user name and password for the Solr
administrator. These credentials must match the credentials you entered when you installed the
Active Workspace server extensions.

The indexing user must have read access to object data, datasets, and their associated files to index
their text content.

9. In the Active Workspace Indexer Settings panel, type the required values to configure the
Indexer:

Value Description
Teamcenter
Web Tier URL

Specifies the URL for the deployed Teamcenter web application. The URL should
be of this form:

http://host:port/web-app-name

Replace host with the machine on which the Teamcenter web application
is deployed. Replace port with the port used by the web application server.
Replace web-app-name with the name of the Teamcenter web application. (The
default name is tc.)

Maximum
Teamcenter
Connections

Specifies the maximum number of connection between the Teamcenter server
and the indexer to be open at a given time. This value should be less than the
number of warmed up Teamcenter servers available in the server manager. The
default value is 3. The minimum value allowed is 1.

Teamcenter
Retry Count

Specifies the number of tries to connect to the Teamcenter server. The default
value is 5. The minimum value allowed is 1.

Indexer Service
Settings

Specifies the names and intervals for indexer services that can be installed.

Select the Install Indexer as a Service  check box if you want to install the
objdata synchronization flow and the suggestion builder synchronization flow
of the indexer as services.

The Indexing Service Name and Builder Service Name fields populate with
suggested names for the services and can be edited.

The Service Interval fields populate with suggested intervals for the
synchronization flows and can be edited.

Select the Start Service  check box to automatically start the service.

10. Proceed through any remaining panels in TEM, entering the required parameters for the
components you selected.

For information about each panel, click help .
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11. When TEM displays the Confirmation, click Start to begin installation.

When installation is complete, close TEM.

12. Configure indexing and search after completing the Indexer installation.

Install shape search

You can install the shape search feature on a new or existing environment to search for objects of a
similar shape or size.

Prerequisites

• This procedure assumes you have an existing Teamcenter environment with Active Workspace.

• Install, configure, and complete indexing for Geolus. See the Geolus documentation.

• Verify system software requirements:

1. Log on to Support Center and open the Support White Papers Certifications page:

a. Open Products→Teamcenter→Downloads.

b. Under Select a Version, choose Support White Papers→Support White Papers
Certifications, and then click the Support White Papers Certifications tile.

2. Download the following support documents:

Software Certifications Matrix (Tc2412PlatformMatrix-date.xlsx)

Contains information about system software certified for Teamcenter, such as operating
systems and Java runtime environments (JREs).

Teamcenter Interoperability Matrix (Teamcenter Interoperability Matrix date.xlsx).

Lists versions of Siemens Digital Industries Software products that are compatible with
Teamcenter 2412. It also lists supported Teamcenter upgrade paths.

Teamcenter 2412 supports upgrades from Teamcenter 13.x or later. If your current
Teamcenter environment is using an earlier version than 13.x, you must upgrade to version
13.x or later before you upgrade to Teamcenter 2412.

Procedure

1. Add the Shape Search application to your Teamcenter environment:

In Teamcenter Environment Manager (TEM), in the Features panel, select Shape Search and any
prerequisite features.

Install shape search
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2. Proceed through the remaining panels to complete the installation.

Enter the Geolus server URL in the following format: protocol://gServer:gPort/gContext

• protocol can be http or https.

• gServer is the machine name or IP address of the machine running the Geolus server. It must be
accessible to all Teamcenter clients that need to connect to it.

• gPort is the port number that the server uses to handle HTTP or HTTPS requests.

• gContext is the context root of the Geolus server.

3. Configure shape search in NX so JT files are read in Teamcenter and shape search results are
displayed in Active Workspace. For more information, see NX documentation.

a. In NX, choose File > Utilities > Customer Defaults > Gateway > JT Files > Export, and select
Save JT Data.

b. In NX, choose File > Preferences > Teamcenter Integration > Active Workspace, and select
Display Shape Search Results in Active Workspace.

Install Dispatcher

The Teamcenter Dispatcher is an asynchronous executor and load balancer of scheduled jobs. If you
use Dispatcher, install the Dispatcher server and client as described in Dispatcher ─ Deployment and
Administration. Then, install the following Dispatcher translators, which Active Workspace uses:

• Active Content Structure Translator

Install this translator if you use Dispatcher-based indexing for structure data. This feature must be
installed in the same environment as the Dispatcher server.

• ReqMgmtWordToHtmlTrans (optional)

This translator converts requirements content that has been edited and saved in Microsoft Word from
Teamcenter (stored as a full-text dataset), so that it can be viewed in the rich text editor in Active
Workspace.

• AsyncService (optional)

This translator provides asynchronous reporting and printing.

To set up email notifications this translator uses, set the following preferences:

• MAIL_OSMAIL_ACTIVATED = true
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• MAIL_INTERNAL_MAIL_ACTIVATED = true
• MAIL_SERVER_CHARSET = ISO-8859-1
• MAIL_SERVER_NAME = mail-server-name
• MAIL_SERVER_PORT = 25
• MAIL_SUBSCRIPTION_NOTIFY_SUB_GROUP_TOO = FALSE
• WEB_DEFAULT_SITE_SERVER = host:port
• WEB_DEFAULT_SITE_DEPLOYED_APP_NAME = Teamcenter-web-tier-application

Add a business logic server

A business logic server processes requests from Teamcenter clients, applying your business model
and rules when accessing the Teamcenter database and files in Teamcenter volumes. It contains the
Teamcenter server process (TcServer), which performs the core functions of Teamcenter.

The corporate server is the primary business logic server in your environment. Every Teamcenter
environment contains one corporate server. But, a distributed environment can contain multiple
additional business logic servers. (A single box environment supports only one business logic server,
the corporate server.) Business logic server interaction with the Teamcenter database is managed by a
server manager (the Server Manager component).

When you install a component that requires a Teamcenter server process on a machine other than the
corporate server machine, Deployment Center automatically adds a Business Logic Server component
on that machine. You can also optionally add a business logic server on a specific machine to further
distribute server processes.

Add a business logic server
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Figure 3-1. Example: Corporate server and business logic server in a distributed environment

A business logic server contains the same libraries as the corporate server and can share an existing
Teamcenter application directory (TC_ROOT) or a Teamcenter data directory (TC_DATA) with another
business logic server. Or, it can use its own local application and data directories.

To add a business logic server, go to the Components tab, click Add a component to your
environment , select Business Logic Server in the Available Components list, and then click Update
Selected Components.

Configure the business logic server:

1. Go to the Components tab. In the Selected Components list, select Business Logic Server.

2. Set the Machine Name and OS for the business logic server.

3. If you want to use a local Teamcenter application directory and data directory on the business
logic server machine, type the Teamcenter installation path or accept the default Teamcenter
Installation Path shown. Then, proceed to step 6.

4. If you want to use a shared Teamcenter application directory, select the Shared TC_ROOT? 
check box. Then, supply the path to the shared TC_ROOT location by choosing one of the following
options:
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• Use Shared Teamcenter Root Path

Type the path to the TC_ROOT location on the target machine.

• Use Environment Variable TC_ROOT_SHARED during deployment

Set the TC_ROOT_SHARED system environment variable on the target machine to path to the
TC_ROOT location.

5. If you want to use a shared Teamcenter data directory, select the Shared TC_DATA?  check box.
Then, supply the path to the shared TC_DATA location by choosing one of the following options:

• Use Shared Teamcenter Data Path

Type the path to the TC_DATA location on the target machine.

• Use Environment Variable TC_DATA_SHARED during deployment

Set the TC_DATA_SHARED system environment variable on the target machine to path to the
TC_DATA location.

6. Click Save Component Settings.

You can add a business logic server to a distributed environment only. It is not supported in single box
environments.

Visualization Server

Visualization Server overview

The Visualization Server provides dynamic 3D and 2D visualization functionality to the Active Workspace
client. If you do not use the 3D viewer or the 2D part of the universal viewer in Active Workspace, do not
install the Visualization Server.

The Visualization Server comprises three components:

Visualization Server Manager

The Visualization Server Manager (VSM) starts and stops rendering processes as needed and streams
visualization data to the Active Workspace client.

The Visualization Server Manager is required for any use of the 3D viewer or the 2D viewer part of
the universal viewer in Active Workspace.

Siemens Digital Industries Software recommends that you install the Visualization Server Manager
on a machine that does not have a Teamcenter corporate server.

Visualization Server overview
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Visualization Server Pool Assigner

The Visualization Server Pool Assigner (VPA) manages Visualization Server Managers and routes
users to an available VSM to open 3D documents.

Each Visualization Pool Assigner hosts two MXBeans that contain information about its current
state: Assigner and Assigner monitoring. The MXBeans are located in the Administer Assigner
manager folder.

Siemens Digital Industries Software recommends that you install the Visualization Server Manager
on a machine that does not have a Teamcenter corporate server.

Visualization Data Server (optional)

The Visualization Data Server (VDS) improves Visualization performance by caching visualization
data close to the Visualization Server Manager.

The Visualization Data Server is required for using MMV feature in Active Workspace. Additionally,
you need to index structure dataindex structure data for the product configurations that you want to
view using MMV.

For appropriately indexed product configurations, the VDS performs the following to promote faster
rendering and streaming to the Active Workspace client:

• Caches product structure

• Prepopulates JT files in the FCC

• Computes Massive Model Visualization (MMV) spatial hierarchies

• Provides bounding box validation

You can use bounding box validation to suppress display of parts that fall outside a defined
assembly box. This can help avoid assemblies opening zoomed out to accommodate errant parts
located far outside the actual assembly. Bounding box validation can also limit a view to include
only a preferred range of the assembly.

Bounding box validation is described in Visualization ─ Deployment and Administration in the
Active Workspace help library.

A single Visualization Data Server can support one or more Visualization Server Managers.

A Visualization Server Manager is required on the same host as the Visualization Data Server. A
Visualization Data Server is required for implementation of MMV, but is otherwise optional.
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Choosing client-side or server-side rendering

At a glance: client-side rendering versus server-side rendering

Client-side rendering (CSR) uses WebGL to leverage client-side graphics capabilities using the Active
Workspace browser. Server-side rendering (SSR) does not require WebGL and is suited to larger
structures. The following comparison may help you decide which option to use.

Conditions CSR SSR
Data size limit The data size limit is affected by browser

memory, transfer time tolerance, and WebGL
performance as the data size increases.

Using render acceleration can increase this
limit significantly.

This option provides the highest
data size limit, because the server
has substantial CPU, RAM, and GPU
resources.

Load speed All data is streamed to the client.

Browser caching for client-side rendering is
supported.

Best option for loading speed.

Data is localized to the render server.

User
experience
interaction

Best experience within the limits of WebGL
performance.

All drawing and interactions are local.

Rendering is unaffected by network traffic, so is
more responsive and less latency sensitive.

Good experience, especially with low
latencies.

Better-to-best experience when
working with significantly increased
data sizes.

Server cost per
user

Lower cost. No server-side graphics card is
required.

Offloading rendering to clients means the
system can support more users per server.
However, the triangles of the model must be
loaded onto the client machine before it can
render.

This option has a higher cost, but
it can be more cost effective than
putting a high-end graphics device
on every user's desk.

Device support Devices that support WebGL and an HTML5
web browser.

Devices that support an HTML5 web
browser. This option is necessary for
devices that do not support WebGL.

Reserve slots on SSR servers for SSR users unless all CSR capacity is consumed

To optimize resource utilization, the Visualization Server Pool Assigner directs SSR users to SSR-capable
servers, while diverting CSR users to servers that can support CSR users only. However, since SSR servers
can also support CSR users, when all CSR servers are busy and the SSR servers still have capacity, you can
use SSR servers to support CSR users. This provides flexibility within the enterprise while reserving SSR
servers for users who need that resource.

To adjust or disable this behavior, you can contact Siemens Digital Industries Software support.

Choosing client-side or server-side rendering
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Rendering 3D data

In Active Workspace, the 3D viewer is displayed within the universal viewer area of the Overview tab for
objects that have viewable attachments. The 3D viewer is also displayed in the 3D tab, where you can
explore 3D data (JT) associated with parts and assemblies. The render location setting applies to both
viewer locations.

Visualization Server is required for visualizing 3D data in Active Workspace with CSR. However, the
Visualization Server Manager can be installed on a server without a graphics card.

For better user experience and certain functionality to work, ensure the following:

• The client machine for CSR must have a valid graphics card.

• You must enable WebGL on the browser.

• For SSR, even the server must have a valid graphics card.

Set default rendering method

To set the default rendering method for the 3D viewer and the universal viewer, set the value of the
AWV0ViewerRenderOption Teamcenter preference to either of the following:

• For client-side rendering (default option): Set the value to CSR.

• For server-side rendering: Set the value to SSR.

End users can change the rendering method on the Viewer Options panel in Active Workspace.

Additional settings for CSR

Ensure that you are not using integrated graphics, and perform the following steps to switch to your
graphics card:

1. Open the NVIDIA Control Panel.

2. Click 3D Settings→Manage 3D Settings.

3. Click the Program Settings tab.

4. From the list shown, select the program for which you want to choose a graphics card.

5. Select the preferred graphics processor from the list.

Alternatively, ensure that the GPU is used when running Google Chrome:
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1. Open Windows settings (Windows key+I).

2. Search for graphics settings or GPU.

Should I use MMV?

Massive Model Visualization (MMV) is a visualization technology that uses Visibility Guided Rendering
(VGR) to increase performance and scalability when viewing extremely large 3D models, such as cars,
airplanes, and ships. Models of this size typically consist of a massive amount of geometry arranged in
a relatively compact space with a huge amount of internal geometry hidden behind the outer shell of
the product. It can take hours to display such models in their entirety, because every piece of geometry
in the model needs to be retrieved and processed, far exceeding the typical capability most hardware.
MMV technology resolves this problem by leveraging VGR techniques to load only those parts that are
required to render a given scene; parts that are not visible because they are occluded by other parts
in the foreground are not loaded. As a result, large 3D models become visible in a fraction of the time
previously required.

Note:

If a structure has more than 30,000 BOM lines, MMV is recommended. If a structure has more
than 120,000 BOM lines, MMV rendering is required for scalability and performance.

Visualization of MMV data in the Active Workspace requires an MMV license. If the necessary license is
not present, the full model loads as standard JT data.

A Visualization Data Server is required for implementing MMV but is otherwise optional.

To use the Visualization Data Server to compute Massive Model Visualization (MMV) spatial hierarchies
of structures, you must do the following actions:

1. Apply the MMV index structure flag to the product configurations that you want to view using
MMV.

2. Use the bomindex_admin utility to include the configurations in the list of structures to index.

The Visualization Data Server has a structure and JT pre-caching feature that can help improve
visualization performance for structures not indexed for MMV. To use this feature:

1. Apply the VDS indexing flag for product configurations that will be viewed frequently but are not
indexed for MMV.

2. Use the bomindex_admin utility to include the configurations in the list of structures to index.

Should I use MMV?
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Visualization Server Manager

Visualization Server Manager prerequisites

Operating systems

The Visualization Server Manager (VSM) supports both large model visualization (LMV) and massive
model visualization (MMV) on supported Microsoft Windows and Linux server platforms.

On a Linux machine without a GPU or without a supported level of OpenGL, client-side rendering is
supported, but server-side rendering is not supported and fails to load.

For supported OS versions, see the Hardware and Software Certifications knowledge base article on
Support Center.

Server hardware and graphics cards

The following hardware is supported for VSM:

• For server-side rendering:

Server class hardware certified by NVIDIA to support NVIDIA RTX 6000, RTX 8000, T4, A10, A40, GRID
K1, K2, Tesla M60, or P40 graphics cards. Note that any server capable of supporting server-side
rendering also supports client-side rendering.

• For client-side rendering:

GPU hardware requirements for desktop Visualization applications (Lifecycle Visualization) are
sufficient for client-side rendering.

If no server-side rendering is needed, any web server class hardware is sufficient to support client-side
rendering (CSR).

The Visualization Server is required for visualizing 3D data in Active Workspace with client-side
rendering. However, to use client-side rendering, you must install the Visualization Server Pool
Assigner and VSM on a server without a graphics card.

Sizing of hardware should be appropriate to support intended data sizes and usage patterns. See VSM
hardware sizing for more info about hardware sizing.

Windows Server versions supported with the VSM support a maximum of 8 GPUs, with certain
exceptions. For example, on a Windows Server 2012 R2 machine with two NVIDIA GRID K1 cards, the
legacy VGA device makes the fourth GPU on one card unavailable for use.

Active Workspace supports virtualized server-side rendering for certain hardware and software
combinations.
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NVIDIA usage requires NVIDIA virtual application licenses — one per concurrent user.

For information about server hardware compatible with supported NVIDIA GRID graphics cards, see
www.nvidia.com.

Virtualization

If you use only client-side rendering, the VSM can be virtualized.

If you use server-side rendering, the VSM must be installed on physical hardware, unless you follow a
supported virtualization combination.

Active Workspace visualization supports virtualization for certain combinations of:

• Host OS and version

• Virtualization layer

• Guest OS and version

• NVIDIA GPU

For information about supported combinations, see the Graphics Card Certification Matrix in
the Hardware and Software Certifications knowledge base article on Support Center: https://
support.sw.siemens.com

For information about NVIDIA virtual GPU compatibility, see NVIDIA virtual GPU (vGPU) software
documentation at docs.nvidia.com.

VSM hardware sizing

Sizing of VSM hardware should allow for typical and maximum expected usage by considering the
following factors:

• Expected numbers of concurrent Active Workspace visualization users

• Expected product data sizes

• CPU, RAM, VRAM and GPU resources consumed by expected product data

In general, a high end server with:

• A maximum number of CPU cores with processing speeds of 3.0 GHz or faster

• A minimum of 64 GB of RAM

Visualization Server Manager prerequisites
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• A minimum of 256 GB of disc space

In addition, a VSM that will support server-side rendering requires an NVIDIA GRID graphics card.
For information about server hardware compatible with supported NVIDIA GRID graphics cards, see
www.nvidia.com.

For additional guidance in sizing of VSM hardware, contact your field services professionals.

Environment information

Make sure you know the following values. These are needed during installation of the VSM.

Visualization Server Pool Assigner host and port

These are defined in Install the Visualization Server Pool Assigner.

Visualization Data Server host and port (if VDS is to be installed)

These are defined in Install the Visualization Data Server.

Host and port of FCC parents

These are defined during Teamcenter installation.

Install the Visualization Server Manager

You can install the Visualization Server Manager in a new Teamcenter configuration or in an existing
Teamcenter configuration.

If you are adding the Visualization Server Manager to an existing configuration, launch the installed TEM
in maintenance mode and skip to step 8 below.

Otherwise, if you are installing the Visualization Server Manager on a host with no existing Teamcenter
environment, proceed with the following steps:

1. Ensure you have access to the Teamcenter 2412 software kit.

2. Launch TEM from the Teamcenter 2412 software kit.

On Windows systems, launch TEM with administrator privileges by using right-click→Run as
administrator.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. In the Install / Upgrade Options panel, click Install.
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5. In the Media Locations panel, you can optionally specify the locations of any Teamcenter update
software kits you want to apply to your configuration. Otherwise, proceed to the next step.

6. In the Configuration panel, enter values for ID and Description.

7. In the Solutions panel, make no selections.

8. Proceed to the Features panel, and under Base Install→Active Workspace→Visualization Server,
select the Visualization Server Manager feature.

In the Installation Directory box, enter the location in which to install the Visualization Server
Manager.

9. In the File Client Cache (FCC) panel, set the FMS_HOME environment variable.

10. In the FCC Parents panel, define the list of FSC parents to which the Visualization Server Manager
connects.

You must provide the protocol, host, and port of the FSC parent. To add rows to the table, click
Add.

Note:

If you are using a Visualization Data Server, the Visualization Data Server and the
Visualization Server Manager should use the same FSC.

11. In the Configuration section of the Visualization Server Manager panel, provide values for the
Visualization Server Manager.

Local Host
Alias

Specifies the alias for the local Visualization Server Manager.

Server Host Specifies the host where the Visualization Server Manager is running. This must
be the local machine name and must be resolvable by the Visualization Pool
Assigner machine (the machine running the Active Workspace Gateway). Do not
use localhost or 127.0.0.1.

Server Port Specifies the port on which the Visualization Server is listening.

Max Servers
in Sub-Pool

Specifies the maximum number of Visualization Server processes allowed to run
in this pool for a single-host configuration or in this subpool for a multihost
configuration.

For example, on Windows machines, the default value is 30. On Linux machines,
the default value is 200.

Min Warm
Servers

Specifies the minimum number of Visualization Server processes in this pool that
are started but not assigned.
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Teamcenter Installation on Windows Using TEM, Teamcenter 2412  13-43
© 2025 Siemens



Note:

If necessary to maintain the minimum number of warm servers while not
exceeding the maximum number of server processes, the server manager
times out the servers in use.

12. If you use a Visualization Data Server, provide the values for this server in the Visualization Data
Server Configuration section of the Visualization Server Manager panel.

Add
Visualization
Data Server

Select this if you are using a Visualization Data Server.

Host Type the name of the host on which the Visualization Data Server is installed.

Port Type the port value used by the Visualization Data Server.

A Visualization Data Server improves performance by caching product structure and JT parts files.

13. In the Visualization Server Manager Settings panel, define the settings for how the Visualization
Server Manager communicates with the pool assigners.

14. In the Operating System User panel, type the user’s password.

Override
local node
settings

Select this option to override the host name and the port value. Enter the Host
and Vis Assigner Port values of the local machine. In the Gateway Connection
Port box, enter the port used by the Active Workspace Gateway.

Visualization
Server Pool
Assigners

Lists the pool assigners that this Visualization Server Manager uses.

• Assigner Host

Host name of the machine where the Visualization Server Pool Assigner runs.

• Assigner Port

Port value of the pool assigner.

15. In the Confirmation panel, click Start.

16. When the installation is complete, close TEM.
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Start Visualization Server Manager

Start the Visualization Server Manager on Windows

1. Make sure the FMS_HOME environment variable is set as a system environment variable and not
a user variable. Visualization Server Manager runs as a service only if FMS_HOME is a system
environment variable.

2. Run the following file:

TC_ROOT\vispoolmanager\run_visservermgr.cmd

Note:

If Visualization Server Pool Assigner (VPA) is not running, Visualization Server Manager
displays console messages until it finds the VPA. To avoid this, start Visualization Server
Pool Assigner before you start Visualization Server Manager.

When running run_visservermgr.cmd, you can use Windows remote desktop connection to sign on to
the machine on which Visualization Server Manager is installed if you have an NVIDIA card with a driver
version of 340.66 or later. Other remote access products, such as VNC, can also be used.

After running run_visservermgr.cmd, you can lock the machine, but you must remain logged on. If you
sign out, Visualization Server Manager is shut down.

Visualization Server Manager requires access to the graphics card. Therefore, it cannot run as a Windows
service in server-side rendering mode. However, you can start Visualization Server Manager as a
Windows service when you use client-side rendering exclusively.

Optional: Configure automatic logon and restart on Windows

You can configure Windows to automatically log on and restart Visualization Server Manager in the
event of a system reboot.

Caution:

Enabling automatic logon bypasses security. When Windows is configured to automatically log
on, anyone with physical access to the machine can restart it and gain entry to the system. Use
automatic logon only if the system is in a secure environment.

1. Open the Windows User Accounts dialog box:

a. Press the Windows key+R to display the Run dialog box.

b. In Open, type netplwiz, and then click OK.
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2. In the User Accounts dialog box, select a user account from the list.

3. Clear the Users must enter a user name and password to use this computer check box.

4. Click Apply.

The Automatically sign in dialog box appears.

5. In the Password and Confirm Password boxes, type the user's password.

6. Click OK.

The specified user is automatically logged on when Windows starts.

7. Create a script or batch file to launch the Visualization Server Manager. Include the following
command to lock the workstation:

rundll32.exe user32.dll LockWorkStation

8. Create a new task with Windows Task Scheduler to run the script or batch file at log on.

Optional: Start Visualization Server Manager as a Windows service

You can start Visualization Server Manager as a Windows service only when you are exclusively using
client-side rendering. Windows services cannot access the graphics card, so this is not a suitable
deployment for server-side rendering.

1. To install Visualization Server Manager as a Windows service, run the installservice.bat command:

installservice.bat "%JAVA_HOME%" "VSM-dir" pool-IDport

Replace VSM-dir with the path to the Visualization Server Manager’s jetty directory. Replace pool-
ID and port with the ID and port for the VisPoolManager service. The port must match the
VisPoolProxy.poolUrl port in the jettyservice.properties file.

For example:

installservice.bat "%JAVA_HOME%" "%TC_ROOT%\vispoolmanager\jetty" vispool-A 8090

2. Locate the newly installed service named Teamcenter VisServletpool-ID in the list of Windows
services.

3. Right-click the service name and choose Properties.

4. On the Log On tab, enter logon credentials for the domain user account under which the service
runs.
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Visualization Server Manager requires an FMS client cache (FCC) to cache files. Use a dedicated
account to run this service, not the Local System account.

Windows attempts to run the service automatically by default. If the service is not already running,
a problem may have occurred.

If you set the service to start manually in its Properties, then you can click Run from the toolbar to
start the service, or right-click the service in the Services window and choose Start.

To stop the service, either click Stop Service on the toolbar, or right-click the service and choose
Stop.

To uninstall the service, type uninstallservice.bat "Teamcenter VisServlet pool-ID.

Test Visualization from the Active Workspace client interface

Before you begin the following procedure, make sure the Visualization Server Manager installation and
the Active Workspace client installation tasks are complete.

You can test the Visualization Server by logging on with the Active Workspace interface and viewing
Visualization data, for example, a JT file.

1. Ensure that the following are running:

• Visualization Server Manager

• Visualization Pool Assigner

• Active Workspace Gateway

• Web application server hosting the Teamcenter web tier application

• Teamcenter server manager

• Teamcenter database

2. Open a supported web browser.

3. Open Active Workspace at the following URL:

http://host:port

host is the machine running the Active Workspace Gateway.

port is the port used by the Active Workspace Gateway.
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4. Sign in with a valid user name and password.

5. Search for and open an object that has an attached JT file.

6. Click the 3D tab to display the JT file.

Configure the locale for Visualization Server Manager

You can configure the Active Workspace client to display the user interface in any of the supported
Teamcenter locales. However, some visualization data, such as Product and Manufacturing Information
(PMI), requires Visualization Server Manager (VSM) configured for the same locale as the information.
For visualization data to display correctly in Active Workspace, you must have at least one VSM
configured to run in each locale that you support. With a VSM in place to support each localization
being used, visualization processes are then routed to the appropriate server based on locale.

VSMs can be configured to support the following languages:

Brazilian Portuguese

Chinese (Simplified)

Chinese (Traditional)

Czech

French

English

French

German

Italian

Japanese

Korean

Polish

Spanish

Russian

You can configure a VSM with any one of these languages. If you want to configure a cluster of VSMs to
support more than one language, you need at least one VSM per language.

To change the language of a VSM, set the operating system to the required language, location, and
locale:
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1. Adjust the required language, location, and locale using the Region and Language options found
in the Windows Control Panel.

2. Adjust the Date and time formats, the Current location, and the Current language for non-
Unicode programs values.

3. Reboot the system after changing your Windows settings.

When the VSM is started again, it inherits the new language configuration of the operating system.

If all VSMs are configured to use the same language, all clients use the available language regardless of
browser preferences.

Note that if you have a VSM system configured for two or more different languages, then Siemens
Digital Industries Software highly recommends that at least one VSM be configured for English, even
though this may require a minimum of three VSMs. When the server system is configured with multiple
languages, if at least one VSM is configured for English, then the English locale is a default.

The following table shows the VSM system response to a visualization data request from a client when
the client is not in one of the preconfigured languages.

VSM system configured for two or more languages Client is not in a preconfigured VSM language
VSM for English exists. The data request is routed to an English VSM.
No VSM for English. The data request is rejected.

Visualization Server Pool Assigner

Visualization Server Pool Assigner prerequisites

Software

The Visualization Server Pool Assigner requires the following software:

• A supported Microsoft Windows Server operating system or Linux operating system on the
Visualization Server Manager host.

For supported versions, see the Hardware and Software Certifications knowledge base article on
Support Center.

• The Visualization Extension Server Extensions feature on the corporate server and on any server that
has Teamcenter Foundation installed.
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Environment information

Make sure you know the following values. These are needed during installation of the Visualization
Server Manager.

Visualization Server Pool Assigner host and port

Visualization
Data Server
host and
port (if VDS
is to be
installed)

These are defined in Install the Visualization Data Server.

Host and
port of FCC
parents

These are defined during Teamcenter installation.

Install the Visualization Server Pool Assigner

You can install the Visualization Server Pool Assigner in a new Teamcenter configuration or in an existing
Teamcenter configuration.

If you are adding the Visualization Server Pool Assigner to an existing configuration, launch the installed
TEM in maintenance mode and skip to step 8 below.

Otherwise, if you are installing the Visualization Server Pool Assigner on a host with no existing
Teamcenter environment, proceed to step 1.

1. Ensure you have access to the Teamcenter 2412 software kit.

2. Launch TEM from the Teamcenter 2412 software kit.

On Windows systems, launch TEM with administrator privileges by using right-click→Run as
administrator.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. In the Install / Upgrade Options panel, click Install.

5. In the Media Locations panel, you can optionally specify the locations of any Teamcenter update
software kits you want to apply to your configuration. Otherwise, proceed to the next step.

6. In the Configuration panel, enter values for ID and Description.
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7. In the Solutions panel, make no selections.

8. Proceed to the Features panel, and under Base Install→Active Workspace→Visualization Server,
select the Visualization Server Pool Assigner feature.

In the Installation Directory box, enter the location in which to install the Visualization Server
Manager.

9. In the Visualization Server Pool Assigner Settings panel, enter settings to configure the
Visualization Server Pool Assigner:

Value Description
Host Specifies the host on which this Visualization Server Pool Assigner runs.

This is the host on which this Visualization Server Pool Assigner is
deployed. You may type the host name or the IP address of the host.

Vis Assigner Port Specifies the port used by the local Visualization Server Pool Assigner.
Gateway Connection
Port

Specifies the port through which the Active Workspace Gateway
connects to the Visualization Server Pool Assigner. The default value is
3000.

Add pool assigner Specifies whether additional Visualization Server Pool Assigners are used.
Select the Add pool assigner check box to add pool assigners.

Peer Assigners The Peer Assigners table lists other Visualization Server Pool Assigners
known to the local Visualization Server Pool Assigners.

Assigner Host Specifies the host on which a peer Visualization Server Pool Assigner is
deployed. This value can be the host name or IP address.

Assigner Port Specifies the port number used by the peer Visualization Server Pool
Assigner.

Server Side 4-tier URL Specifies an alternate four-tier URL for the viewer to connect to
Teamcenter. The Visualization Server uses this in case the primary four-
tier URL is blocked by a firewall, or if a more direct route is needed for
performance.

10. In the Confirmation panel, click Start.

11. When the installation is complete, close TEM.

Start Visualization Server Pool Assigner

To start VPA on a Windows machine, run the following file:

TC_ROOT\visassigner\run_visassigner.cmd

Start Visualization Server Pool Assigner
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After running run_visassigner.cmd, you can lock the machine, but you must remain logged on. If you
sign out, the VPA is shut down.

Alternatively, you can start VPA as a Windows service only when you are exclusively using client-side
rendering. Windows services cannot access the graphics card, so this is not a suitable deployment for
server-side rendering.

1. To install VPA as a Windows service, run the installservice.bat command:

installservice.bat "%JAVA_HOME%" "VPA-dir" assigner-IDport

Replace VPA-dir with the path to the VPA’s jetty directory. Replace assigner-ID and port with the ID
and port used by Active Workspace Gateway to connect to the Assigner.

For example:

installservice.bat "%JAVA_HOME%" "%TC_ROOT%\visassigner\jetty" VisAssigner-A 8089

2. Locate the newly installed service named Teamcenter VisServletassigner-ID in the list of Windows
services.

3. Right-click the service name and choose Properties.

4. On the Log On tab, enter the logon credentials for the domain user account under which the
service runs.

Windows attempts to run the service automatically by default. If the service is not already running,
a problem may have occurred.

If you set the service to start manually in its Properties, then you can click Run from the toolbar to
start the service, or right-click the service in the Services window and choose Start.

To stop the service, either click Stop Service on the toolbar, or right-click the service and choose
Stop.

To uninstall the service, type uninstallservice.bat "Teamcenter VisServlet assigner-ID".

Visualization Data Server (optional)

Visualization Data Server prerequisites

Software

The Visualization Data Server requires the following software:
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• A supported Microsoft Windows Server operating system or Linux operating system on the
Visualization Server Manager host.

For supported versions, see the Hardware and Software Certifications knowledge base article on
Support Center.

• The Visualization Extension Server Extensions feature on the corporate server and on any server that
has Teamcenter Foundation installed.

• A Visualization Server Manager installed on the Visualization Data Server host.

• An FMS client cache (FCC) component on the Visualization Data server host.

• Structure indexing configured on the Visualization Data server host.

The Visualization Data Server uses the structure indexing infrastructure of Active Workspace to keep
cached product structure up-to-date.

Hardware

• Graphics card: No requirements.

• Network: You must deploy the Visualization Data Server on a high speed LAN near the Visualization
Server Manager.

• Memory: The Visualization Data Server host should have a minimum of 16 GB of RAM, but may
require more.

Note:

How to determine memory needed:

The amount of RAM needed depends on the number of structures to be indexed and their size.

A rough rule of thumb is to count the number of lines in the unconfigured structure to be indexed
and allow at least 2000 bytes per line. For example, if there are 1 million lines in the unconfigured
product index, then 1 million * 2000 = 2 GB of RAM.

If you are not sure of the size of the structures, Siemens Digital Industries Software recommends
that you allow approximately 4 GB of RAM for each structure you are planning to cache in
the Visualization Data Server. For example, if 4 structures are to be indexed, 16 GB of RAM is
recommended.

Environment information

You need to know the following values to install the Visualization Data Server:

• FCC parents
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• Teamcenter web tier URL

• Host name and port for the Visualization Data Server

Recommendations

Siemens Digital Industries Software recommends that you install the Visualization Data Server on a
machine with the following:

• Multiple processors

The Visualization Data Server is a multithreaded server program and is thus resource intensive;
multiple processors are utilized if they are available. Standard server class machine hardware is
sufficient.

• FSC cache or FSC volume

If you deploy the Visualization Data Server remote (on a WAN) from the FSC volume, you should
deploy an FSC cache on a LAN near or on the Visualization Data Server host machine.

• Visualization Server Manager

For maximum performance, the Visualization Data server should be installed on the same machine as
the Visualization Server Manager and should use the same cache.

A single Visualization Data Server can support one or more Visualization Server Managers.

Install the Visualization Data Server

You can install the Visualization Data Server (VDS) in a new or an existing Teamcenter configuration.
Siemens Digital Industries Software recommends that you install the Visualization Data Server on a
machine that does not have a Teamcenter corporate server.

If you are adding the Visualization Data Server to an existing configuration, launch the installed TEM in
maintenance mode and skip to step 8 below.

Otherwise, if you are installing the Visualization Data Server on a host with no existing Teamcenter
environment, proceed to step 1 below.

1. Ensure you have access to the Teamcenter 2412 software kit.

2. Launch TEM from the Teamcenter 2412 software kit.

3. In the Welcome to Teamcenter panel, select Teamcenter.
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4. In the Install / Upgrade Options panel, click Install.

5. In the Media Locations panel, you can optionally specify the locations of any Teamcenter update
software kits you want to apply to your configuration. Otherwise, proceed to the next step.

6. In the Configuration panel, enter values for ID and Description.

7. In the Solutions panel, make no selections.

8. In the Features panel, select the Visualization Data Server feature:

Base Install→Active Workspace→Visualization Server→Visualization Data Server

In the Installation Directory box, enter the location in which to install the Visualization Data
Server.

9. In the File Client Cache (FCC) panel, set the FMS_HOME environment variable. The FCC must be
installed on the same machine as the Validation Data Server.

10. In the FCC Parents panel, define the list of FSC parents to which the Visualization Data Server
connects.

You must provide the protocol, host, and port of the FSC parent. To add rows to the table, click
Add.

Note:

To improve performance, the Visualization Data Server and the Visualization Server Manager
should use the same FSC.

11. In the Teamcenter Administrative User panel, enter the user's password.

12. In the Visualization Data Server Configuration panel, enter the required values:

• Server Port

This is the port number on which the Visualization Data Server listens.

• Teamcenter 4-tier URL

This is the URL of the Teamcenter web tier application. The format is:

http://host:port/tc-web-app

host is the machine running the web application server on which the Teamcenter web
application is deployed.
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port is the port value used by the web application server.

tc-web-app is the name of the Teamcenter web application. The default is tc.

13. In the Confirmation panel, click Start.

14. When the installation is complete, click Close.

MMV indexing data

If you use Massive Model Visualization (MMV), configure MMV indexing.

When structures using MMV rendering are indexed, the last valid indexed data is always retained. So,
you can always see MMV indexed data; however, the data in a structure may be more recent.

When MMV data is being indexed it may use a backup system. It is recommended that the administrator
retains interim files so when an error occurs, they can be analyzed to determine the issue. These two
Teamcenter preferences can be used to control the output of the generated files:

• MMV_keep_generated_files

Use this preference to preserve the generated files for further examination. You can specify when
generated files are kept by using these values:

1: Keep the generated files when an error occurs.

2: Always keep the generated files.

3: Never keep the generated files.

• MMV_staging_directory

Use this preference to control the working directory to be used for the tcxml2mmp conversion
process on the Teamcenter server. If this is not set, the default temporary directory is used as staging
directory.

Start Visualization Data Server

To start Visualization Data Server Manager, enter the following command:

TC_ROOT\VisDataServer\Program\VisDataServer.exe

After the Visualization Data Server is started, it automatically detects and caches product configurations
that have been indexed with the MMV flag. These cached product configurations are ready for fast
visualization with the MMV technology.
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For a product configuration is ready for MMV visualization, the following criteria must be met:

• The product configuration has been indexed.

• Visualization Data Server has detected, downloaded, and cached the structure.

• Visualization Data Server has prepopulated the FMS system.

If you attempt to visualize a product configuration that is not yet completely indexed and cached in
the Visualization Data Server, the viewer uses the regular non-MMV mode by default. Changes in the
product configuration need to be re-indexed and reread by the Visualization Data Server before they can
be displayed by the viewer.

Additional configuration for the Visualization Data Server is available in the etc/
VisDataServer.properties file. This includes detailed logging and fine tuning for other settings. If you
make changes to the properties file, you need to restart Visualization Data Server.

Optional: Start the Visualization Data Server as a Windows service

1. Make sure the FMS_HOME environment variable is set as a system environment variable, not a
user variable. The VDS runs as a service only if FMS_HOME is a system environment variable.

2. Inspect the VisDataServer.properties file and make sure all file paths specified in it are full paths, not
relative paths.

3. Open a Teamcenter command prompt and change to the root directory of the Visualization Data
Server.

4. Install the Visualization Data Server as a Windows service by running the VisDataServer.exe
command with the /registerService argument:

VisDataServer.exe /registerService /displayName=name/startup=option

Replace name with a display name for the service. Replace option with automatic or manual.

For example:

VisDataServer.exe /registerService /displayName=VisDataServer /startup=automatic

Optional additional arguments:
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Argument Description Example
description Specifies a description for the service. /description="VDS for Active

Workspace"

config Specifies a configuration file to load for
the application.

/config="VDSConfig.txt"

After the service is successfully installed, Windows displays the following message:

The application has been successfully registered as a service.

5. Configure the VDS service:

a. In the Windows Services dialog box, locate the VDS service by the name you specified in the
displayName attribute.

b. Right-click the service name and choose Properties.

c. In the Log on tab, enable the service logon with the following options:

• Log on as: Select This account, and then enter the domain and user name, for example,
myDomain\myName.

• Password: Enter and confirm the password for the user account.

Note:

The VDS requires an FMS client cache (FCC) to cache files. Use a dedicated account to
run this service, not the Local System account.

Windows attempts to run the service automatically by default. If the service is not already running when
you open the Windows Services dialog box, the installation may have failed.

If you set the service to start manually, right-click the service name and choose Start. To stop the
service, right-click the service name and choose Stop.

To uninstall the service, run the VisDataServer.exe utility with the /unregisterService argument.

Rebuild VDS repository from scratch

As the VDS repository is updated via deltas containing incremental changes from Teamcenter that
occur as design data evolves, the repository used to support MMV viewing may introduce errors.
To reduce errors, a good practice is to periodically regenerate the VDS repository from scratch. The
default threshold for this scratch rebuild is every 500 delta updates, but this value is configurable by
an administrator. A full regeneration of the VDS repository can be set to occur more or less often,
depending on the observed need.
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To change the number of deltas that are processed before a scratch rebuild of the VDS repository, set the
MMV_delta_collection_accumulation_limit Teamcenter preference to a value higher or lower than the
default value of 500. This will change how often the VDS rebuilds its repository from scratch.

Note:

To manage the number of delta files that are to be deleted, use the
MMP_PERCENTAGE_OF_DELTA_TO_PURGE preference. Its default value is 100, but based on your
need, you can set it to any value from 10 to 100. Refer to the following table to understand
preference value limits:

If preference value is set to then preference value processed is

<=10 10

10 < value < 100 value

>=100 100

All delta files are deleted when the MMP_PERCENTAGE_OF_DELTA_TO_PURGE preference value is set to
100.

Example:

Set the MMV_delta_collection_accumulation_limit preference value to 500.

In this case, since the value is set to 500, it becomes the maximum delta limit. After 500 deltas are
processed, a completely new mmp file is created.

To delete 100% of the old delta files in the MMV dataset, set the
MMP_PERCENTAGE_OF_DELTA_TO_PURGE preference value to 100. If you want to delete only
10% of the old delta files in the MMV dataset, set the MMP_PERCENTAGE_OF_DELTA_TO_PURGE
preference value to 10.

Visualization Data Server status log settings

Configuration for the Visualization Data Server is available in the etc/VisDataServer.properties file. This
includes detailed logging and fine tuning for other settings. If you make changes to the properties file,
you must restart the Visualization Data Server.

Log information includes the status of all products hosted by the Visualization Data Server.

#
# Status logger settings. The status logger can be of help showing 
the current indexing status
# and also the current and waiting task to be processed.
#
# The interval to generate the status log (see the "Interval" 
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documentation
 for more info).
StatusLogger.StatusInterval=120
# This will output the name of the top level (root) node. 
StatusLogger.ShowRootName = true
# Shows the timestamp of the indexed product.
StatusLogger.ShowTimestamp = true
# Shows the available revision rules of indexed product.
StatusLogger.ShowRevRule = true
# Shows the status of the Spatial JTs.
StatusLogger.ShowSpatialJt = true
# If ShowSpatialJt is true, also shows the file path of the Spatial JTs.
StatusLogger.ShowSpatialJtPath = true
# If ShowSpatialJt is true and a Spatial JT is missing, the string will 
be added 
in from of the path.
# This can be used if a specific string is needed to search for a 
missing 
file (like using the grep utility).
StatusLogger.MissingSpatialJtMessage = (missing)
# Shows all the versions of a product instead of just the latest one.
StatusLogger.ShowAllVersions= false
# Shows the active tasks being processed.
StatusLogger.ShowActiveTasks=true
# Shows any waiting tasks to be processed.
StatusLogger.ShowWaitingTasks=true

Install the Teamcenter web tier

Install the .NET web tier application

Configure Microsoft IIS for the .NET web tier

The Teamcenter .NET web tier is an alternative to the Teamcenter Java EE web tier. It supports four-tier
Teamcenter deployments and does not require a Java EE application server.

The Teamcenter .NET web tier requires a supported Microsoft Windows Server operating system and also
the following Microsoft components:

• Microsoft Internet Information Services (IIS)

• Microsoft .NET Framework

For required versions of these products, see the Hardware and Software Certifications knowledge base
article on Support Center.
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Before you install the .NET web tier, configure the required role services in Microsoft IIS on a Windows
Server host. You can perform this from a command line or by using the Windows Server Manager.

Install role services from a command line

Open a Windows command prompt as an administrator and enter the following command in a single
line:

dism.exe /enable-feature /all /online /featureName:IIS-CommonHttpFeatures 
/featureName:IIS-DefaultDocument /featureName:IIS-DirectoryBrowsing 
/featureName:IIS-HttpErrors /featureName:IIS-StaticContent 
/featureName:IIS-HttpRedirect /featureName:IIS-HealthAndDiagnostics 
/featureName:IIS-HttpLogging /featureName:IIS-LoggingLibraries 
/featureName:IIS-RequestMonitor /featureName:IIS-HttpTracing 
/featureName:IIS-Performance /featureName:IIS-HttpCompressionStatic 
/featureName:IIS-HttpCompressionDynamic /featureName:IIS-Security 
/featureName:IIS-RequestFiltering /featureName:IIS-BasicAuthentication 
/featureName:IIS-ClientCertificateMappingAuthentication 
/featureName:IIS-DigestAuthentication 
/featureName:IIS-IISCertificateMappingAuthentication 
/featureName:IIS-IPSecurity /featureName:IIS-URLAuthorization 
/featureName:IIS-WindowsAuthentication 
/featureName:IIS-ApplicationDevelopment 
/featureName:IIS-NetFxExtensibility45 /featureName:IIS-ASP 
/featureName:IIS-ASPNET45 /featureName:IIS-CGI 
/featureName:IIS-ISAPIExtensions /featureName:IIS-ISAPIFilter 
/featureName:IIS-ServerSideIncludes /featureName:IIS-WebServerManagementTools
/featureName:IIS-ManagementConsole

Install role services using Windows Server Manager

Open the Windows Server Manager. Verify the Web Server (IIS) role is installed on your host. If this role
is not installed, install it according to your operating system documentation.

In the Windows Server Manager, under the Web Server (IIS) role, install the following role services:

Common HTTP Features

Default Document
Directory Browsing
HTTP Errors
Static Content
HTTP Redirection

Caution:

Do not install the WebDav Publishing role service.

Health and Diagnostics

HTTP Logging

Configure Microsoft IIS for the .NET web tier
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Logging Tools
Request Monitor
Tracing

Performance

Static Content Compression
Dynamic Content Compression

Security

Request Filtering
Basic Authentication
Client Certificate Mapping Authentication
Digest Authentication
IIS Client Certificate Mapping Authentication
IP and Domain Restrictions
URL Authorization
Windows Authentication

Application Development

.NET Extensibility 4.x
ASP
ASP.NET 4. x
CGI
ISAPI Extensions
ISAPI Filters
Server Side Includes

Install only the available ASP.NET 4.x role services. Do not install ASP.NET 3.x role services.
Management Tools

IIS Management Console

Install the .NET web tier

Before you install the .NET web tier, make sure you log on using an account with administrative
privileges and that you have access to the Teamcenter software kit. Also, make sure your host has
the required software and is configured for the Teamcenter .NET web tier.

During installation of the .NET web tier, Teamcenter Environment Manager (TEM) verifies that you have
the required software and operating system versions.

1. Launch Teamcenter Environment Manager (TEM).

If you create a new Teamcenter configuration, launch TEM from the Teamcenter software kit.
If you want to add the .NET-based server manager to an existing configuration, launch TEM in
maintenance mode.
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For a description of any TEM panel, click the help button  in the panel.

2. Launch Teamcenter Environment Manager. In the Windows start menu, click
Programs→Teamcenter, and then right-click Environment Manager and select Run as
administrator.

This procedure assumes you are adding the .NET web tier to an existing Teamcenter configuration.
Alternatively, you can create a new configuration and select the Web Tier for .NET feature in the
Features panel.

3. In the Maintenance panel, select Configuration Manager.

4. In the Configuration Maintenance panel, select Perform maintenance on an existing
configuration.

5. In the Old Configuration panel, select the configuration to which you want to add the .NET web
tier.

6. In the Feature Maintenance panel, select Add/Remove Features.

7. In the Features panel, under Server Enhancements→Teamcenter Web Tier, select Web Tier
for .NET.

8. Proceed to the Multiplexing Proxy panel. Accept the default values or type new values for the
Teamcenter multiplexing proxy (MUX).

Value Description

Port Specifies the TCP/IP port on which the MUX listens for
web tier requests. This is the Jetty server connector
port.

TECS Admin Port Specifies the port used by the Teamcenter Enterprise
Communication System (TECS).

The MUX listens on a single port for incoming requests from the .NET web tier, forwarding those
requests to an appropriate Teamcenter server using operating system named-pipe communication
protocol, and then streaming the response back to web tier. The MUX runs as an application within
the Teamcenter Enterprise Communication System (TECS).  The TECS container is based on the
Teamcenter client communication system (TCCS) container used in the client tier.

9. In the Server Manager Performance Tuning panel, accept the default performance tuning values
or optionally enter your own preferred values.

10. In the TcServer Character Encoding Settings panel, make sure the values reflect the character set
you use for Teamcenter. If you are not sure, accept the default settings.

Install the .NET web tier
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To ensure correct character mapping, make sure the Teamcenter server and database use the same
encoding.

11. Proceed to the .NET Web Tier panel. Type values for the following required parameters:

Parameter Description

Web Tier Language Specifies the same locale that is specified for Teamcenter
server. This locale is used for localization of messages coming
from web tier. The default web tier language is English.

Server Manager Peers Specifies server manager peer hosts for the .NET web tier.
Enter one or more hosts using the Add button and entering
host and port numbers for each.

At least one server manager must be configured for a working
deployment. The port number each server manager peer must
match the port you specify during the corresponding server
manager installation.

The remaining parameters in the .NET Web Tier panel are optional. Enter values for these
parameters as needed.

TEM examines settings in your Microsoft Internet Information Services (IIS). If any required settings
or roles are missing, you must correct them in IIS before you continue.

12. In the Internet Information Services (IIS) Settings panel, accept the default settings, or specify IIS
settings for the .NET web tier:

Parameter Description

Use Existing Web Site Specifies whether to use an existing web site. If you select this
option, select the web site you want to use from the list. The
IIS virtual directory for .NET web tier deployment is created in
the selected web site and the application is hosted on that web
Site.

Alternatively, you can select Create New Web Site, and then
type a name, port, and root path for the new web site.

Use Existing Application Pool Specifies whether to use an existing application pool from the
list provided. The default value is Use Existing Application
Pool.

An application pool is a set of one or more applications
assigned to an IIS worker process. The Teamcenter .NET web
tier is an ASP.NET application, so the application pool that
hosts it can only host applications based on the same version
of ASP.NET. Keep this in mind if you have this application pool
host other applications.
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Parameter Description

If possible, use a dedicated (stand-alone) application pool for
Teamcenter web tier deployment. For example, create a new
application pool named Teamcenter App Pool_Tc2412.

Virtual Directory Name Specifies the IIS virtual directory name for Teamcenter .NET
web tier deployment. The default value is tc. Web URLs for
Teamcenter four-tier deployments are based on this value. For
example, if you specify the default value as tc, the URLs are of
the form: http://host:port/tc.

For more information about these values, click the help button .

13. In the Confirmation panel, click Start to begin installing the .NET web tier.

14. When installation completes, exit TEM.

After you install the server manager and the .NET web tier, complete the .NET web tier installation by
launching the Teamcenter Management Console.

Install the Java EE web tier application

The Teamcenter Java EE web tier application provides communication between Teamcenter clients and
the enterprise tier.

Before you install the Java EE web tier, make sure you install:

• A Teamcenter server and server manager.

• A supported Java EE application server and the Java Runtime Environment (JRE) on the web tier host.1

Install the Web Application Manager

1. Create a home directory for the Teamcenter web tier, for example, c:\tcweb. This directory is
referenced as WEB_ROOT.

2. In the Teamcenter software kit, browse to the Web_tier directory and double-click the
INSTALL_TCWEB.EXE program icon.

7-Zip displays a self-extractor dialog box.

3. In the Unzip To Folder box, type the path to WEB_ROOT, and then click Unzip.

1 For information about supported application servers and Java versions, see the Hardware and Software Certifications
knowledge base article on Support Center.
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After 7-Zip extracts the installation files, click Close to close the 7-Zip self-extractor dialog box.

4. To launch the Web Application Manager, browse to the WEB_ROOT directory and double-click the
insweb.bat program icon.

Build the Teamcenter web tier application

1. Launch the Web Application Manager (insweb.bat).

2. Copy ICD files from the Teamcenter software kit. This populates the list of solutions available to
install.

a. Click Copy ICDs. In the Copy ICD Files dialog box, click Browse.

b. Browse to the Web_tier directory in the root directory of the Teamcenter software kit and
select the icd directory, and then click Open.

c. In the Copy ICD Files dialog box, click OK to load ICD files.

d. Repeat steps a through c to copy ICDs from the Teamcenter 2412 software kit.

3. Click Add to begin creating a web application.

Web Application Manager displays the Add Web Application dialog box.

4. Create the Teamcenter Web Tier web application:

a. In the Name box, type a name for the application, for example, Teamcenter Web Tier.

b. In the Staging Location box, enter a path where you want to place the web application files.
Typically, this is a directory under the WEB_ROOT directory. Web Application Manager creates
the directory if it does not exist.

c. Optionally, in the Description box, type a description of the application.

d. Enter software locations:

A. Click Add, next to the Disk Locations for Install Images box.

B. In the Add Disk Location dialog box, enter the path to the Web_tier directory on the
Teamcenter software kit:

path\Web_tier

C. Repeat steps A through B to add the path to the Web_tier directory on the Teamcenter
2412 software kit.
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To modify or remove a location in the Disk Locations for Install Images list, click Modify or
Remove.

Do not change the default solution type (Web tier) shown in the Solution Type box.

5. Select the solutions to include in the Teamcenter web tier web application:

a. Click Solutions.

b. In the Select Solutions dialog box, select the required solutions:

Teamcenter - Web Tier Infrastructure

Teamcenter - Web Tier Core Applications

6. Click Advanced Web Application Options to select the following advanced options, if applicable:

• If you want the web tier application to submit the client-side session cookie over HTTPS, select
the Secure Cookie  check box.

• If you deploy the web tier application in a cluster configuration, select the Distributable 
check box. This makes the web tier WAR file distributable.

7. Click OK.

The Web Application Manager displays the Modify Required Context Parameters dialog box.

8. Enter or verify values for the following required context parameters. Default values are acceptable
for most parameters

Local Service Port (when using TCP
communication protocol)

Connection Timeout

Server_Manager_URIs

LogVolumeName

LogVolumeLocation

Enterprise Application Registration ID

Max_Capacity

Enterprise Application Lookup ID

Deployable File Name

IS_SSO_ENABLED

SSO_APPLICATION_ID

SSO_LOGIN_SERVICE_URL

SSO_SERVICE_URL

TcLocale

Install the Java EE web tier application

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  13-67
© 2025 Siemens



To set a context parameter, double-click the Value box for the given parameter and enter the new
value. To view a description of any context parameter, click the parameter name in the Modify
Required Context Parameters dialog box.

Note:

If your network uses IPv6 (128-bit) addresses, use the hostname in URIs and do not use the
literal addresses, so the domain name system (DNS) can determine which IP address should
be used.

9. Click OK to begin building the web application.

When the application is complete, click OK to close the Progress dialog box.

10. Click Exit to exit the Web Application Manager.

11. Locate the deployable file (tc.war) generated during installation. This file is in the deployment
directory under the staging location you specified.

12. Deploy the web application on a supported application server.2

Deploying on an IPv6 network

If your network includes client hosts running on an IPv6 network, the Java EE web tier must be deployed
in an application server that supports an IPv6 URL as an external endpoint and uses IPv4 addresses to
support all communication with the Teamcenter enterprise tier, such as communication with the Java EE
server manager.

A typical environment for the Java EE web tier is a dual-stack machine that supports both IPv4 and IPv6
addresses in which the application server accepts HTTP requests from either IPv4 or IPv6.

Teamcenter enterprise tier server components that communicate with other server components in the
same network are assumed to be on an IPv4 network and are not supported on IPv6. Teamcenter IPv6
support is limited to clients or integrations that use Teamcenter client communication system (TCCS)
and Teamcenter components that communicate with clients on IPv6-enabled networks.

Sharing an application server instance for multiple four-tier environments (Optional)

Teamcenter supports deploying more than one instance of the same Teamcenter web tier application
(WAR file) into one application server instance. Multiple WAR files can be configured to run as discrete
applications, each with a unique entry point. This allows you to connect each application to a different
enterprise tier without the need to manage multiple application server instances. The following example
shows a possible scenario with three web applications (WAR files) deployed in a single application server
instance.

2 Web Application Deployment provides Teamcenter web tier deployment procedures for several supported application
servers.

13. Installing distributable components

13-68  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



Client
tier Web tier Enterprise tier

Resource
tier

Clients Single application server instance Server managers Databases

Client A ←
→

http://host:port/tc01 ←
→

svrmgr11 ←
→

DB1

Client B ←
→

http://host:port/tc02 ←
→

svrmgr2 ←
→

DB2

←
→

http://host:port/tc03 ←
→

svrmgr3 ←
→

DB3

To deploy multiple web applications in a single web application server instance, perform the following
tasks:

1. Install multiple server managers with unique server manager cluster configuration settings.

2. Create web applications. Assign each application a unique name.

3. Set the following web tier context parameters to unique values for each web application.

Context parameter Description

DEPLOYABLE-FILE-NAME Name of the deployable file you are creating for the web
tier application.

Enterprise Application Registration
ID

Identifier for the web application. If you want to deploy
multiple Teamcenter web tier applications in a single
application server instance, each application must be
assigned a unique ID.

Enterprise Application Lookup ID Specifies the ID by which the Teamcenter presentation
tier accesses the application identified by the Enterprise
Application Registration ID parameter. If you deploy
your WAR file with other WAR files in the same application
server instance, these two IDs should be set to the same
value for a given application.

Server_Manager_URIs The server manager URI(s) for the appropriate server
manager.

4. Deploy web application WAR files in the web application server instance.

Multiple WAR file deployment is not supported on JBoss. If you use JBoss as your web application server,
you must deploy each WAR file in a separate application server instance.
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Install a volume server

By default, you can create volumes only on local disks, but if you want to write files
to volumes residing on remote disks (shared across the network), you can create a
stand-alone volume server.

1. Log on to the operating system with the user account you want to own the volume.

2. Start Teamcenter Environment Manager (TEM):

a. Browse to the root directory of the Teamcenter software kit.

b. Right-click the tem.bat program icon and choose Run as administrator.

Teamcenter Environment Manager starts and displays the Choose Install Language dialog
box.

c. Select a language for the installation program and click OK.

The language you select is used only for the installation program.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. Proceed to the Install/Upgrade Options panel. Click Install.

5. (Optional) In the Media Locations panel, enter paths to any Teamcenter patches or minor releases
you want to apply during installation.

6. Proceed to the Configuration panel. Enter a unique ID and description for the new Teamcenter
configuration.

7. Proceed to the Solutions panel. Select the Volume Server solution.

For descriptions of solutions, point to the solution in the list or click Help or see the complete list
of features.

8. Proceed to the Features panel. This panel shows the FMS Server Cache feature preselected by the
Volume Server solution.

9. In the Installation Directory box, enter the absolute path to the directory where you want to
install the volume server.

10. Proceed to the Operating System User panel. Type the password for the operating system account
to which you logged on to install the volume server.
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11. Proceed to the File System Cache Service (FSC) panel. Enter required values for the FMS server
cache (FSC) service. For information about required values, click the help button .

12. Proceed through the remaining panels, entering required values for the volume server.

13. Proceed to the Confirmation panel. Verify the information you entered. If you want to change
any values, click Back to return to the panels you want to change. Otherwise, click Next to begin
installing the volume server.

14. When installation is complete, close TEM.

This procedure installs a single volume server. To configure multiple volume servers for load balancing,
and other advanced FMS configuration, see Teamcenter Administration.

Install a volume server
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14. Installing optional applications
Install the Business Modeler IDE

Choose a Business Modeler IDE installation type

Several types of Business Modeler IDE installation are possible. All BMIDE installation types can be used
to create, import, and modify a template project, and can generate a template package which can be
deployed using TEM or Deployment Center.

An important difference among the installation types is whether and how the BMIDE connects to a
Teamcenter site. A Teamcenter site connection is necessary for some tasks:

Perform data exchanges, such as:

• Synchronize the data model in a BMIDE template project with the Teamcenter server database.
• Live update non-schema data, such as lists of values (LOVs), from the BMIDE to a production

server without shutting down the production server.
• Live deploy a template to a test Teamcenter server.
• Incorporate live update changes made to the production environment into a BMIDE standard

template project.

Create certain data model elements, such as:

• Business object display rule
• Dynamic list of values
• Business context rule
• Item revision definition configuration (IRDC)
• System stamp configuration
• Subtype of AppInterface, and many others

Use the following general procedure for choosing a Business Modeler IDE installation type.

1. Ensure that the machine meets prerequisites for a BMIDE.

Caution:

Do not install BMIDE on a production environment corporate server. Doing so could have
unintended consequences, especially during Teamcenter upgrade.

2. Choose the BMIDE installation type that you want to perform.
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Installation
type

Teamcenter
connection type Advantage Limitation

2-tier Two-tier environment
via TCCS.

Allows live deployments even
while a web tier is inactive or
down for maintenance.

Requires local network
access.

4-tier Four-tier
environment via
HTTP server.

Allows remote access and live
deployments.

Requires an active web
tier.

Standalone None No requirement for or possibility
of unintentional interaction with
any Teamcenter site.

Cannot perform
actions that require
connection to a
Teamcenter site.

You may alternatively choose to add BMIDE functionality into your existing Eclipse environment.
This consists of manually patching your Eclipse environment with BMIDE jar files. Doing so offers
the advantage of allowing you to work on BMIDE templates within your existing custom Eclipse
environment. However, adding BMIDE functionality into your existing Eclipse environment does not
offer BMIDE functionality to perform actions that require connection to a Teamcenter site.

Add the Business Modeler IDE to an existing Eclipse SDK environment

If you already have an existing Eclipse SDK environment with the version of Eclipse that is certified
for your Teamcenter platform, and Business Modeler IDE plugins have never been installed into
the environment, then you can install the Business Modeler IDE plugins into your existing Eclipse
environment.

Caution:

If your Eclipse environment contains Business Modeler IDE plugins installed from an earlier version
of Business Modeler IDE, then installing a later version of Business Modeler IDE plugins into the
same environment results in version incompatibilities and is not supported.

1. Ensure that your Eclipse SDK environment uses the Eclipse version that is certified for your
Teamcenter platform.

For information about system hardware and software requirements, see the Software Certifications
Matrix (Tc2412PlatformMatrix-date.xlsx) in the Support White Papers Certifications page on
Support Center.

To check your Eclipse version, start Eclipse and select Help>About Eclipse SDK.

2. In the Teamcenter software kit for your Teamcenter platform, go to the following directory:

additional_applications\bmide_plugins (Windows) or additional_applications/
bmide_plugins (Linux)
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In that directory, find the file bmide_plugins.zip.

This archive contains the Business Modeler IDE plug-ins within an internal eclipse\plugins
directory.

3. Extract the contents of the eclipse\plugins directory within bmide_plugins.zip to your
ECLIPSE_HOME\eclipse\plugins directory.

4. In the Teamcenter software kit for your Teamcenter platform, go to the following directory:

bmide\compressed_files

In that directory, find the file bmide.zip.

5. Extract the bmide.zip content to some temporary local directory. For example C:\bmide (Windows)
or /bmide (Linux).

6. From the plugins directory within this local directory, copy the following directories and their
contents to your ECLIPSE_HOME\eclipse\plugins directory.

• antlr
• commons_lang
• commons_xmlschema
• httpclient_version
• org.apache.poi.39

7. Create a list of software repository site URLs for the following plugins. Use the Eclipse site to
identify the proper URLs. The examples shown are for Eclipse SDK version 2018-12 (4.1.10.0).

You will use this list in step 9.

For
this
plugin Do this
CDT Browse to https://www.eclipse.org/cdt/downloads.php and find the URL for the CDT

software repository for your Eclipse version. The URL looks similar to this: https://
download.eclipse.org/tools/cdt/releases/9.6

Record the URL in your list of plugin software repository sites.

DTP Browse to https://www.eclipse.org/datatools/downloads.php and find the DTP row for
your Eclipse version. Click the update site link.

Add the Business Modeler IDE to an existing Eclipse SDK environment
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For
this
plugin Do this

The URL of the page that opens looks similar to this: https://download.eclipse.org/
datatools/updates/1.14.103-SNAPSHOT/repository/

Record the URL in your list of plugin software repository sites.

EMF Add http://download.eclipse.org/modeling/emf/updates/releases/ to your list of plugin
software repository sites.

For details about the requirement for Eclipse version and software repository URL for EMF,
browse to https://www.eclipse.org/modeling/emf/

GEF Add http://download.eclipse.org/tools/gef/updates/releases to your list of plugin
software repository sites.

For details about the requirement for Eclipse version and software repository URL for GEF,
browse to https://projects.eclipse.org/projects/tools.gef

WTP Browse to https://download.eclipse.org/webtools/repository/ and then find the
directory for your Eclipse version. Click the directory link.

The URL for the resulting page looks similar to this: https://download.eclipse.org/
webtools/repository/2018-12/

Record the URL in your list of plugin software repository sites.
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For
this
plugin Do this

8. Launch Eclipse.

9. From the top menu bar, choose Help>Install New Software. Use the Eclipse software installation
feature to add the CDT, DTP, GEF, EMF and WTP plugin software update sites and install all of the
plugins. Refer to the list of plugin software update URLs you created in step 7.

After all the plugins are installed and you have restarted Eclipse, a BMIDE item appears on the top menu
bar. Command buttons to open the BMIDE Advanced and Standard perspectives appear on the toolbar.

Allocate memory to the Business Modeler IDE

Allocate memory to the Business Modeler IDE so that it has enough to launch and run.

If you perform live updates, you must have a minimum of 2 GB of RAM on the system running the
Business Modeler IDE to allow for other processes.

You can allocate memory in the following ways:

• BusinessModelerIDE.ini file

Allocate memory to the Business Modeler IDE
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To increase the memory allocated to the Business Modeler IDE, open the install-
location\bmide\client\BusinessModelerIDE.ini file and change the -Xmx1024M value to a higher
number to allocate maximum Java heap size. For example, if you have 2 GB available to dedicate for
this purpose, set the value to -Xmx2048M. Do this only if your machine has the available memory.

The Xms value in this file sets the initial Java heap size, and the Xmx value sets the maximum Java
heap size.

• BMIDE_SCRIPT_ARGS environment variable

To allocate the memory required by scripts during installation, update, or load of templates with large
data models, create a BMIDE_SCRIPT_ARGS environment variable. Set the BMIDE_SCRIPT_ARGS
variable to -Xmx1024M to allocate 1 GB of RAM to the Business Modeler IDE scripts. If your system
has more memory that you can allocate to the Business Modeler IDE, you can set the value higher.

If you are running the Business Modeler IDE in an Eclipse environment, run the following command to
increase virtual memory to 2 GB:

eclipse.exe -vmargs -Xmx2048M

Caution:

Java standards require that no more than 25 percent of total RAM be allocated to virtual memory.
If the amount allocated to the Business Modeler IDE is higher than 25 percent of total RAM, then
memory disk swapping occurs, with possible performance degradation.

If you set the Xmx value to a higher value than the RAM your system has, you may get the
following error when you launch the Business Modeler IDE:

Could not create the Java virtual machine.

Set the Xmx value to a setting that your system supports, in both the BMIDE_SCRIPT_ARGS
environment variable and the BusinessModelerIDE.ini file.

Start the Business Modeler IDE

Start a Business Modeler IDE in one of several ways, depending on the installation type:

Installation type Platform Procedure to start Business Modeler IDE
BMIDE Standalone, 2-tier,
or 4-tier

Windows Click the Start button and choose All Programs>Teamcenter
[version]>Business Modeler IDE. This runs the bmide.bat file.

Linux Run the bmide.sh file in the install-location/bmide/client
directory.

Eclipse environment to
which BMIDE plug-ins have
been added

Windows Navigate to the directory where Eclipse is installed and execute
the Eclipse.exe command.

Eclipse.exe -vmargs -Xmx2024M
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Installation type Platform Procedure to start Business Modeler IDE
To ensure that you have enough memory to run Eclipse, run the
command with a virtual memory argument. In the example, the
argument increases virtual memory to 2 GB.

Linux Navigate to the directory where Eclipse is installed and execute
the Eclipse command.

Eclipse -vmargs -Xmx2024M

For BMIDE operations that require connection to the Teamcenter server, users of the BMIDE must be
members of the Teamcenter database administrators (dba) group. To add a user to the dba group, in the
Teamcenter rich client use the Organization perspective.

If a perspective fails to open, it could be that not enough memory is allocated to the Business Modeler
IDE.

Installing custom software

Installing a custom solution or third-party template

Use TEM to install custom templates you package using the Business Modeler IDE.

Install a template using TEM

After you package extensions, install the resulting template to a production environment using
Teamcenter Environment Manager. You can also use this procedure to install a third-party template.
You could also install a template using Deployment Center, or the tem command line utility with its
-install argument.

1. Ensure that you have a good back up of the Teamcenter environment.

2. Copy the template files from the packaging directory on your Business Modeler IDE client to a
directory that is accessible by the server.

By default, packaged template files are located in the Business Modeler IDE workspace directory in
the folder under the project.

On Linux, users must have permissions to the workspace directory.

3. Start Teamcenter Environment Manager (TEM).

4. In the Maintenance panel, choose Configuration Manager and click Next.

5. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration and click Next.

Installing a custom solution or third-party template
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6. In the Configuration pane, select the configuration from which the corporate server was installed.
Click Next.

7. In the Feature Maintenance panel, under the Teamcenter section, select Add/Remove Features.
Click Next.

If you already installed a template to the database and want to update the template, under the
Teamcenter Foundation section, select Update the database. This option should not be used to
install a new template but only to update an already installed template.

Use the Add/Update templates for working within the Business Modeler IDE client option
under Business Modeler Templates only if you want to add a dependent template to your
Business Modeler IDE.

8. In the Features panel, click the Browse button beneath the features list on the right side of the
panel.

9. Browse to the directory where you have copied the template files. In the Files of type box, ensure
that Feature Files is selected so that you see only the installable template (feature) file. Select your
template's feature file (feature_template-name.xml in the tem_contributions directory) and click
the Select button.

The template appears as a new feature under Extensions in the Features panel.

You can change the location of the feature in the Features panel and add a new group to place the
feature under.

14. Installing optional applications
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10. Select the new template in the Features panel. Click Next.

11. In the Teamcenter Administrative User panel, enter your user name and password to log on to
the server. Click Next.

12. The Database Template Summary panel displays the list of templates that are installed as part of
your template install. Click Next.

13. In the Confirmation panel, click Start. The new template is installed.

Note:

If the installation fails because of invalid data model, perform the following steps:

Install a template using TEM
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a. Fix the incorrect data model and repackage the template.

b. Locate the template-name_template.zip in your project's packaging directory and
unzip it to a temporary location. Copy the following files to the server in the TC_ROOT/
install/template-name folder:

template-name_template.xml
template-name_dependency.xml
template-name_tcbaseline.xml (if the file exists)

c. Launch Teamcenter Environment Manager in the maintenance mode and continue with
recovery.

14. To verify the installation of the new template, confirm that the TC_DATA directory on the
Teamcenter server contains the new template files.

Also log on to the server and confirm that you can create instances of your new data model.

Note:

To have libraries read on the user system, the TC_LIBRARY environment variable must
be set to the platform-specific shared library path. This environment variable is set to
LD_LIBRARY_PATH on Linux systems. The platform is detected when the Teamcenter session
is initiated.

Update a template using TEM

If you already installed a template as a new feature and want to update it because you have added more
data model definitions to it, perform the following steps in the Teamcenter Environment Manager (TEM).

Note:

You can also update a template using the tem command line utility, for example.

tem -update -full -templates=template-name-1,template-name-2 -path=location-of-template-files 
-pass=password

1. Ensure that you have a good back up of the Teamcenter environment.

2. Copy the packaged template files from the packaging directory on your Business Modeler IDE client
to a directory that is accessible by the server.

By default, packaged template files are located in the Business Modeler IDE workspace directory in
the folder under the project. .

3. Start Teamcenter Environment Manager (TEM).

14. Installing optional applications
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4. In the Maintenance panel, choose Configuration Manager and click Next.

5. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration and click Next.

6. The Configuration panel displays the installed configuration. Click Next.

7. In the Feature Maintenance panel, under the Teamcenter Foundation section, select Update
Database (Full Model - System Downtime Required). Click Next.

Note:

Use the Add/Update Templates for working with the Business Modeler IDE Client option
under Business Modeler only if you want to add or update a dependent template to your
Business Modeler IDE.

8. Click Next

9. In the Teamcenter Administrative User panel, enter your user name and password to log on to
the server. Click Next.

The Update Database panel displays currently installed templates.

10. Click the Browse button to navigate to the directory where the packaged template files are located.
Select the updated feature_template-name.xml file.

Note:

If you are fixing a COTS template (for example, the Foundation template) using a new
template file provided in a patch, you must copy the template's feature_template-name.xml
and the template-name_install.zip files to the same temporary directory containing the new
template-name_template.zip file.

The template displays a refreshed status icon .

Update a template using TEM
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11. Click Next.

12. In the Confirmation panel, click Next.

The new template is installed.

13. To verify the installation of the revised template, log on to the server and confirm that you can
create instances of your new data model.

14. Installing optional applications
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Part III: Deploy the Teamcenter
Environment

When you have satisfactorily configured and validated your Teamcenter test environment, you are ready
to deploy to your environment as a production environment.

When you make your Teamcenter environment with Active Workspace available to users, you may want
to explore options for large-scale deployment of clients to connect to your environment.

Also, see the Teamcenter Deployment Reference Architecture, available on Support Center, for further
guidance and examples for development, test, and production environments.
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15. Installing the Security Services Session
Agent
Install the Session Agent using the stand-alone installation wizard

The Security Services Session Agent replaces Java applets (session agent, session detector, and status
reporter), making Security Services applet-free. Install the Session Agent on client machines to provide a
single sign-on experience without Java applets.

1. Close all programs before you begin installing the Session Agent.

2. Copy Session Agent installation files to your Teamcenter client host.

a. In the Teamcenter software kit, browse to the following location:

kit-location\additional_applications\sso

b. Copy the following files to your Teamcenter client host:

install.exe
TEAMCENTER_SSO_COMMON.zip
TEAMCENTER_SSO_SESSIONAGENT.zip
TEAMCENTER_SSO_SESSIONAGENT_COMPAT.zip

3. On your Teamcenter client host, right-click the install.exe program icon and choose Run as
administrator to launch the Session Agent installation program.

4. Choose a language for the installation wizard, and then click OK.1

5. Proceed to the License Agreement dialog box, and select the check box to accept the terms of the
license agreement.

6. In the Choose Install Folder dialog box, enter a destination folder for the installation.

If you accept the default path, the Session Agent automatically installs in a hidden folder.

On Windows systems, if you select a path in the Program Files folder, the location is available to
any user logging onto the system.

7. Proceed to the Compatibility Settings panel.

1 The list of available languages depends on your operating system locale. If the language you need is not in the list,
change your operating system locale to the correct language and restart the installation wizard.
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If you have Teamcenter client applications released with Teamcenter 13.2 or earlier that you are
not yet updating, select the Install XML-RPC libraries  check box. This option ensures Security
Services compatibility with earlier Teamcenter versions.

8. In the Pre-Installation Summary dialog box, verify your selections, and then click Install to install
the Session Agent.

9. If the installation is successful, a dialog window indicates the location where the Session Agent files
were installed. Click Done to close the installation wizard.

On Windows systems, you can verify the installation of the Session Agent by locating Teamcenter
Security Services Session Agent in the list of installed programs on the machine.

Installing the Session Agent for an administrator

On Windows systems, if you want to install the Session Agent for all users on the machine, open an
administrator command prompt and enter the following command:

kit-location\wntx64\additional_applications\sso\install -DENABLE_SYS_ENV=true

Perform the rest of the steps above from step 4 on.

Launching the Session Agent installation program this way sets the TCSSO_SESSION_AGENT_PATH
environment variable as a system environment variable.

Configure the Session Agent

Sharing an instance of the Session Agent

A local administrator can install the Session Agent in a common location, and that instance can be
shared among multiple users.  If an administrator has already installed the Session Agent on your client,
then set the TCSSO_SESSION_AGENT_PATH user environment variable to the location of the Session
Agent installation.

Uninstalling the Session Agent

On Windows systems, you can uninstall the Session Agent from the Windows installed programs list. In
the list, it is named Teamcenter Security Services Session Agent.

15. Installing the Security Services Session Agent
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16. Install the Active Workspace Launcher
on a client machine
The Active Workspace Launcher application helps you open Microsoft Office and PDF files from
Active Workspace to their native applications on the client machine. The Active Workspace Launcher
application also opens the appropriate Office application when you open an attachment in Active
Workspace.

Note:

Kerberos authentication is not supported with Client for Office.

Prerequisites

1. Install Microsoft Office and Adobe Reader on the client machine.

For supported versions, see the Software Certifications Matrix on Support Center.

2. Depending on your needs, install Teamcenter Client for Microsoft Office and/or Teamcenter
Extensions for Microsoft Office as described in Microsoft Office Integration With Teamcenter in
the Teamcenter documentation.

3. If you want to host Active Workspace within Client for Office, set Active Workspace hosting
preferences as described in Microsoft Office Integration With Teamcenter.

Procedure

1. In the Teamcenter 2412 software kit, locate the
wntx64\additional_applications\tcclientapplauncher\tcclientapplauncher.zip file. Expand this
file to a local directory.

2. Right-click the setup.exe program icon and choose Run as administrator to launch the Active
Workspace Launcher installation wizard.

3. Proceed to the Ready to Install the Program dialog box, and then click Install to install the Active
Workspace Launcher.

4. When the installation is complete, click Finish to close the installation wizard.

5. To enable the editing of requirements in Active Workspace, you must perform additional setup
tasks.
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Install Active Workspace Launcher silently

Alternatively, you can install the Active Workspace Launcher silently, without user interaction:

1. To generate a silent installation file, type the following command in a command prompt:

setup.exe /r /f1"path\tclauncher.iss"

For example, to generate a silent file in the c:\temp folder, enter the following command:

setup.exe /r /f1"c:\temp\tclauncher.iss"

Do not include a space between the f1 argument and the path that follows it. The path must be
enclosed in double quotation marks (" ") as shown.

2. To install the Active Workspace launcher silently on another system, type the following command:

setup.exe /s /f1"c:\tclauncher.iss"

Troubleshoot the Active Workspace Launcher installation

If Microsoft Office applications fail to launch when opening an attachment, the .awoai file may be
associated with Microsoft Word instead of the Active Workspace Launcher. To resolve this, perform one
of the following tasks:

• Uninstall and reinstall the Teamcenter Active Workspace Launcher and try again.

• In the HKEY_CLASSES_ROOT\awoai_auto_file\shell\open\command registry entry, ensure
the .awoai file extension is correctly associated with the TcClientApplauncher.exe command. For
example, the key value should be similar to the following:

@="\"C:\\Program Files (x86)\\Siemens\\Teamcenter\\WSLauncheri\
\TcClientAppLauncher.exe\" \"%1\""

16. Install the Active Workspace Launcher on a client machine
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17. Verify Active Workspace installation
To verify the Active Workspace installation is complete and successful, open the Active Workspace URL in
a web browser:

http://host:port

Replace host and port with the host and port of the Active Workspace Gateway.

For example:

http://myhost:3000

In the Active Workspace logon screen, enter the user name and password for the Teamcenter
administrative account.

If installation is successful, the browser displays the Active Workspace client.

You can also verify the status of Active Workspace Gateway and services using the Active Workspace
gateway ping:

http://myhost:3000/ping
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17. Verify Active Workspace installation
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18. Configure heterogeneous operating
system environment
If you are adding Windows Teamcenter clients to a Linux Teamcenter environment, you must perform
the following tasks:

1. Install Teamcenter and configure the database (Teamcenter application root and data directories)
on a Windows system that can serve a common mount point for all Windows clients.

This allows the Windows and non-Windows Teamcenter clients to interoperate, particularly in
volume management.

2. Synchronize the following files in the separate Teamcenter data directories:

• POM schema files (TC_DATA\pom_schema_server_sid)

• POM transmit files (\pom_transmit\*.sch)

• Dataset definition files (TC_DATA\gs_info\*.des)

3. Make sure your Windows and Linux server configurations contain identical sets of Teamcenter
features. For example, if you install features or custom templates on a Linux server, you must install
the same features and templates on your Windows server.

4. Configure File Management System (FMS) on Linux and Windows volume servers.

Conversely, if you create a Teamcenter database by running the Teamcenter setup program from
a Windows workstation, you must install Teamcenter on Linux clients you want to connect to the
database.
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19. Creating a custom distribution
Overview of custom distributions

Teamcenter supports the following custom distributions to simplify installation of Teamcenter on
multiple hosts.

• Silent distribution

A silent distribution is an XML-based configuration file you can use to install Teamcenter silently
(without user interaction) on another host. Silent installation suppresses most installation prompts
and requires minimal user interaction. As an alternative to installing and configuring Teamcenter on
individual hosts in your network, silent installation provides an efficient way to deploy Teamcenter on
multiple hosts in your network.

The silent installation configuration file records the selections and values you enter during a
Teamcenter installation and enables TEM to perform these steps noninteractively on other hosts.
You can modify a silent configuration file to change certain Teamcenter settings before installation.

Silent distributions are supported for Teamcenter servers, two-tier rich clients, and four-tier rich
clients.

• Compact distribution

A compact distribution is an installable package with a selected subset of Teamcenter client features.
It is much smaller than a full Teamcenter software kit and is more easily distributed to multiple hosts
in an organization.

A compact distribution is an alternative to installing Teamcenter from a full Teamcenter software kit.
A compact deployable package can contain a selected subset of Teamcenter features rather than the
entire set of features in the release. This reduces network loads and simplifies large-scale Teamcenter
deployments by providing an installation package that is smaller and more easily distributed to an
organization. For example, a two-tier rich client installation can be packaged in a deployable media as
small as 580 MB, where a full Teamcenter distribution can require up to 5 GB. A four-tier rich client
compact distribution can be as small as 283 MB, and a Client for Office compact distribution can be
only 93 MB.

Compact distributions are supported for Teamcenter two-tier and four-tier rich clients.

Create a silent distribution

Create a silent installation configuration file

1. Log on to the Teamcenter corporate server host and browse to the root directory of the Teamcenter
software kit.
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2. Start Teamcenter Environment Manager (tem.bat) from the Teamcenter software kit. Right-click
the tem.bat program icon and choose Run as administrator.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. In the Install/Upgrade Options panel, select the Create custom distribution  check box, and
then click Install.

5. In the Custom Distribution Options panel, select Create silent configuration file, and then
specify the path to the silent installation file, for example, C:\silent.xml. The specified path must be
to an existing directory and the file name must end in .xml.

6. Proceed through the remaining panels to complete the Teamcenter installation.

Teamcenter Environment Manager creates the silent installation file you specified in step 5. This file
records your settings and selections during the installation. You can use this file to silently install
Teamcenter on another host with the same settings.

Teamcenter Environment Manager creates a silent installation file (.xml) and a decryption key file
(.dat) with the name you specified in step 5, for example, silent.xml and silent.dat. To reproduce
your installation on another host, copy both of these files to the target machine, then install the
rich client silently.

Caution:

If you install a rich client silently using a compact distribution and your silent configuration file
requires features not included in the compact distribution, the silent installation fails. To avoid this,
make sure your silent configuration requires only features in the compact distribution, or install
using a full Teamcenter software kit.

Launch a silent installation

To launch a silent installation, type the following command:

tem.bat -s file-name.xml

Replace file-name with the name of the silent installation configuration file.

After installation is complete, you can view a log of the installation in the installxxx.log file under the
install directory in the Teamcenter application installation directory.

Note:

Before you launch the silent installation, make sure the prerequisite software is installed on the
client machine. The silent installation script does not install the prerequisite software.

19. Creating a custom distribution

19-2  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



The rich client can be uninstalled only through the TEM interface. Silent uninstallation is not supported.

Modify the silent installation configuration file

The silent installation configuration file is XML-based. After creating the file and establishing the
file structure using Teamcenter Environment Manager, you can change the installation by manually
modifying the values of the XML elements described in the following table.

Caution:

Use an XML editor to ensure well-formed XML code. Do not change the XML structure of the file. If
XML file structure is incorrect, or the XML code is not well-formed, installation fails.

Element Description

features Lists all the Teamcenter modules and features to be installed. These are
selected on the Features panel of Teamcenter Environment Manager.

feature Specifies one feature of a Teamcenter module. The code attribute
identifies the feature. To define whether Teamcenter Environment
Manager installs the feature, set the selected attribute to either true
or false.

data Lists all Teamcenter Environment Manager Java classes and values
defining aspects of installation, such as the path to the installation
directory for Teamcenter application files. For additional information, see
the comments in the configuration file. The comments describe the class
and valid values.

Modify the silent installation configuration file
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Sample silent installation configuration file

<?xml version="1.0" encoding="UTF-8"?>
<root>
<tem engine="2008.0.0" />
 <settings>
   <installDir value="C:\\Program Files\\Siemens\\Teamcenter2412" />
   <sourceDir value="D:\\kits\\tc2412\\win64" />
   <application value="tceng" />
   <silentMaintenance value="false" />
   <installingUser value="osuser" />
   <installLanguage value="ENGLISH" />
   <aboutFullVersion value="2412" />
   <version value="12000.1.0.20181207" />
 </settings>
 <sourceLocations>
   <coreLocations>
      <directory value="D:/kits/tc2412/win64" />
   </coreLocations>
   <browsedLocations />
 </sourceLocations>
 <config name="My Configuration 1" id="config1">
   <mode type="install" clone="false">
    <checkpoints>
      <checkpoint value="featureProperties">
         <point value="vcruntimes:vc2005,latest" />
         <point value="minMSSQL2005Version:10.50" />
         <point value="coreTemplate:foundation_template.xml" />
         <point value="feature_id:datamodel,rtserver" />
         <point value="vcruntimes:latest" />
         <point value="template_file:foundation_template.xml" />
         <point value="minDB2Version:9.7.4" />
         <point value="minOracleVersion:11.2.0.1" />
         <point value="template_name:foundation" />
         <point value="typeAnalysis:true" />
      </checkpoint>
    </checkpoints>
   </mode>
   <comments />
   <data>
    <adminUser guid="2E53CFC3AC75665E50FF0F207D1D013B">
      <password value="holrvg6fpj40nGt7ZlCM2Q" encrypt="true" />
      <user value="tcdba" />
    </adminUser>
    <director guid="661AA2A766CA975D998EBE61455F3EA3">
      <saveStateOnFail value="true" />
      <status value="0" />
      <script>
        <temBase />
        <copyFeature name="Microsoft Visual C++ Runtimes" 
feature="A0CF69C3A0BC61770EB81BD22667EA52" />
        <copyFeature name="Business Modeler IDE" 
feature="A9CECD82127A11DB9804B622A1EF5492" />
        <copyFeature name="VC 2008 Redistributables" 
feature="DPBL8RC6MUS0LCPS10NIPGR85RI7HPHQ" />
        <copyFeature name="Teamcenter File Services" 
feature="BC76F9D1AB7C93A848D0FE3602F59097" />
        <copyFeature name="Flex License Server" 
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feature="D1D683A8B2CE1EB821B97CD2EE5D7627" />
        <copyFeature name="VC 2005 Redistributables" 
feature="UDR4NG0DEZ1TN9XHKG7Z8AFDPVVTZXL2" />
        <copyFeature name="VC 2013 Redistributables" 
feature="NJCMQH3ZMYTPPPGA8BS4Q1C7OV6IXVXU" />
        <copyFeature name="VC 2010 Redistributables" 
feature="R08U30BA5KZYSNDFKMGXKKHWEYOOVD7V" />
        <copyFeature name="VC 2012 Redistributables" 
feature="Z9ICW073V9QXU4H5F8BK6CXG6KFYWBQZ" />
        <copyFeature name="Business Modeler Templates" 
feature="A909338A1CB411DB8AF6B622A1EF5492" />
        <copyFeature name="Digital Dashboard" 
feature="A9CECD82127A11DB9804B622A1EF5599" />
        <copyFeature name="FMS Server Cache" 
feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" />
        <copyFeature name="Teamcenter Foundation" 
feature="8C061DD51E13E0CB9DC4687B1A3348BE" />
        <copyFeature name="NX Part Family Classification Integration" 
feature="B176F6B6E9E91D9804EFB0D2
        010FD613" />
        <copyFeature name="Server Manager" feature="BF0E78AFE4280DCB08594EA2F3671BE8" />
.
.
.
        <unpack name="Microsoft Visual C++ Runtimes" 
feature="A0CF69C3A0BC61770EB81BD22667EA52" />
        <unpack name="FMS Server Cache" feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" />
        <unpack name="Teamcenter Foundation" 
feature="8C061DD51E13E0CB9DC4687B1A3348BE" />
        <unpack name="NX Part Family Classification Integration" 
feature="B176F6B6E9E91D9804EFB0D2010FD
        613" />
        <preInstall name="Microsoft Visual C++ Runtimes" 
feature="A0CF69C3A0BC61770EB81BD22667EA52" />
        <preInstall name="FMS Server Cache" feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" />
        <preInstall name="Teamcenter Foundation" 
feature="8C061DD51E13E0CB9DC4687B1A3348BE" />
        <preInstall name="NX Part Family Classification Integration" 
feature="B176F6B6E9E91D9804EFB0D20
        10FD613" />
        <install name="Microsoft Visual C++ Runtimes" 
feature="A0CF69C3A0BC61770EB81BD22667EA52" />
        <install name="FMS Server Cache" feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" />
        <install name="Teamcenter Foundation" 
feature="8C061DD51E13E0CB9DC4687B1A3348BE" />

        <install name="NX Part Family Classification Integration" 
feature="B176F6B6E9E91D9804EFB0D2010F
        D613" />
        <postInstall name="Microsoft Visual C++ Runtimes" 
feature="A0CF69C3A0BC61770EB81BD22667EA52" />
        <postInstall name="FMS Server Cache" 
feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" />
        <postInstall name="Teamcenter Foundation" 
feature="8C061DD51E13E0CB9DC4687B1A3348BE" />
        <postInstall name="NX Part Family Classification Integration" 
feature="B176F6B6E9E91D9804EFB0D2
        010FD613" />

Modify the silent installation configuration file
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        <featureInstalled name="Microsoft Visual C++ Runtimes" 
feature="A0CF69C3A0BC61770EB81BD22667EA5
        2" />
        <featureInstalled name="FMS Server Cache" 
feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" />
        <featureInstalled name="Teamcenter Foundation" 
feature="8C061DD51E13E0CB9DC4687B1A3348BE" />
        <featureInstalled name="NX Part Family Classification Integration" 
feature="B176F6B6E9E91D9804E
        FB0D2010FD613" />
      </script>
    </director>
    <FSCService guid="F2FCBCEC03DFF7F9D1E3A11EC9B64BD2">
      <fscReadCacheDir value="$HOME\\FSCCache" />
      <fscWriteCacheDir value="$HOME\\FSCCache" />
      <addToBootstrap value="true" />
      <fscReadCacheSize value="10" />
      <serverID value="FSC_tchost_osuser" />
      <log value="" />
      <fscWriteCacheSize value="10" />
    </FSCService>
    <FSCMasterSettings guid="EBC3422F77C6BF18FE0E3A821EFE1134">
      <masterModel value="Simple Model" />
    </FSCMasterSettings>
    <FscSiteImport guid="630BECF927EC742A748A97486D5868DA">
      <remoteSites value="" />
    </FscSiteImport>
    <tcdata guid="4500621E2BE24BF0DD6ABF31EBA01088">
      <serverHostLocation value="tchost" />
      <path value="C:\\Program Files\\Siemens\\tcdata" />
      <create value="true" />
      <shareName value="" />
      <dsmKeyPath value="" />
    </tcdata>
    <FSCServiceFCCDefaults guid="7311DC5E94724BED0DD7419FCDE055CF">
      <writeCacheSize value="1000" />
      <readCacheSize value="1000" />
      <cacheDirUnix value="/tmp/$USER/FCCCache" />
      <partialReadCacheSize value="3000" />
      <cacheDirWin value="$HOME\\FCCCache" />
    </FSCServiceFCCDefaults>
    <FccSite guid="35EE6A66B85467D5EDE5B3D91871EACE">
      <siteListString value="" />
    </FccSite>
    <FSCServiceConnections guid="E4BDA0B521CB10A49F0CE123C9F326F1">
      <connections value="http,4544,;" />
    </FSCServiceConnections>
    <OSUser guid="CA769D31FD7E122E5E509A0BBBD7E809">
      <password value="+rfq6mTJVSuqaYJixkwntg" encrypt="true" />
      <user value="DOMAIN\\osuser" />
    </OSUser>
    <flexClient guid="7221ECFBC9555CDF997FC3F575022761">
      <nX5String value="28000@flexhost" />
      <port value="27000" />
      <nX4String value="27000@flexhost" />
      <nX5Port value="28000" />
      <host value="flexhost" />
      <nX5Host value="flexhost" />
      <nX5CheckBox value="true" />
      <envServerString value="28000@flexhost" />
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    </flexClient>
    <signatureCertificate guid="RRK3WTCSY4020QSZO90QFJWMISFAC2AX">
      <replaceCerts value="false" />
      <certificates value="" />
    </signatureCertificate>
    <foundationSettings guid="LHBY67ZYMYHSKED26FHDNDHFJTZD84I7">
      <templatesToBeInstalled value="" />
      <genClientCache value="generate all" />
      <genServCache value="" />
      <productionEnvironment value="true" />
      <requestMetaCacheRebuild value="true" />
      <enableGenServCache value="true" />
      <quickClone value="false" />
    </foundationSettings>
    <transientVolume guid="983980098FF188A8C4BF08E8168A32A8">
      <windowsVolume value="C:\\Temp\\transientVolume_tcdbuser" />
      <unixVolume value="/tmp/transientVolume_tcdbuser" />
    </transientVolume>

    <TcOracleSystem guid="1EF0859AC04962CBFA41C4C8C84499A1">
      <password value="WsRDrEfD0/4vnLO0/mj2wA" encrypt="true" />
      <user value="system" />
      <tablespaces 
value="tcdbuser_IDATA:90;tcdbuser_ILOG:5;tcdbuser_INDX:5;tcdbuser_TEMP:5;tcdbuser_MM
      V:5" />
      <tablespacePath value="/db/oradata/tc/tcdbuser" />
    </TcOracleSystem>
    <security guid="ZUG63OE2YRNFD1VY13KCEZM52XFJP45D">
      <adminDirectory value="$TC_ROOT\\security" />
    </security>
    <volume guid="1F16971107DE44C0C7827F800EE4AEF8">
      <port value="4544" />
      <fscModel value="Simple Model" />
      <location value="C:\\Program Files\\Siemens\\volume" />
      <name value="volume" />
      <hostName value="tchost" />
      <fscId value="FSC_tchost_osuser" />
    </volume>
    <TcOracleEngine guid="F4F7C0852B27D6E56B8C64BE77FFA14C">
      <port value="1521" />
      <createUser value="true" />
      <host value="dbhost" />
      <flush value="false" />
      <populate value="true" />
      <service value="tc" />
      <uTF8Enabled value="true" />
      <password value="AdxT7Jmz2/WbYF6O/eqX9g" encrypt="true" />
      <user value="tcdbuser" />
      <create value="true" />
    </TcOracleEngine>
   </data>
   <features>
      <add feature="A0CF69C3A0BC61770EB81BD22667EA52" name="Microsoft Visual C++ 
Runtimes" />
      <add feature="90C2A1C96F6A61FAB397AF88ABE4AAC1" name="FMS Server Cache" />
      <add feature="8C061DD51E13E0CB9DC4687B1A3348BE" name="Teamcenter Foundation" />
      <add feature="B176F6B6E9E91D9804EFB0D2010FD613" name="NX Part Family 
Classification Integration" 

Modify the silent installation configuration file
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      />
   </features>
 </config>
 <updateManager />
</root>

Create a compact distribution

Create a compact distribution, a Teamcenter installation package that contains selected features, using
Teamcenter Environment Manager (TEM).

Compact distribution is recommended only for Teamcenter client configurations, not for servers.

1. Log on to the Teamcenter corporate server host and browse to the root directory of the Teamcenter
software kit.

2. Start TEM (tem.bat) from the Teamcenter software kit. Right-click the tem.bat program icon and
choose Run as administrator.

3. Proceed to the Install/Upgrade Options panel, select the Create custom distribution check box,
and then click Install.

4. In the Custom Distribution Options panel, select Create compact deployable media. Enter the
path in which to create the compact distribution and a file name for the package, for example,
C:\tc.zip.

The specified path must be to an existing directory and the file name must end in .zip.

5. Proceed through the remaining panels to complete the Teamcenter installation.

TEM creates the compact distribution file you specified in step 4. You can use this file to install
Teamcenter clients on other hosts.

Caution:

If you create a silent installation using a compact distribution and your silent configuration file
requires features not included in the compact distribution, the silent installation fails. To avoid this,
make sure your silent configuration requires only features in the compact distribution, or install
using a full Teamcenter software kit.

Embedding Active Workspace in a high-security environment

In case the rich client host does not have an internet connection, an administrator can replace
the distributed WV2R with a "Fixed" distribution to provide necessary support for Active Workspace
functionality.

19. Creating a custom distribution
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Functionality of Active Workspace when embedded in the rich client depends on the Microsoft Edge
WebView2 Runtime (WV2R). The type of WV2R distributed with Teamcenter is Evergreen, which
automatically provides regular platform updates and security patches through an internet connection.

Use the following procedure to configure the Fixed version of WebView2.

1. Download the Fixed version of the WebView2 Runtime package from the Microsoft site https://
developer.microsoft.com/microsoft-edge/webview2#download-section.

2. Decompress the WebView2 Runtime package using the command-line command expand {path
to the package} -F:* {path to the destination folder} or by using a decompression tool such as
WinRAR.

Avoid decompressing through File Explorer. It may not generate the correct folder structure.

3. Include all the decompressed Fixed Version binaries in your app package for deployment on the
target machine.

4. During your app's installation on the client machine, set the org.eclipse.swt.browser.EdgeDir
system property to the location of the WebView2 destination folder.

Embedded Active Workspace user data location

The default location for the WV2R user data cache is %LOCALAPPDATA%
\richclient\ActiveWorkspaceBrowser. If for some reason a different location for the user data cache
is desired, set the com.siemens.splm.browser.interop.AWDataDir system property to the desired
location.

Embedded Active Workspace user data location
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Part IV: Maintain the Teamcenter
Environment

Back up your environment after initial installation, and periodically for added security. Add applications
and components to Teamcenter environments. Perform database maintenance.
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20. Back up new installations
Siemens Digital Industries Software strongly recommends backing up new Teamcenter and Oracle
installations before using them by performing the following actions:

Terminate Teamcenter sessions

1. Instruct all users to check in all Teamcenter business objects, and then close and log off of
Teamcenter sessions, including tcserver processes.

2. Open a Teamcenter command prompt.

3. Use the clearlocks utility to remove locks on the database:

%TC_BIN%\clearlocks -assert_all_dead -u=Tc-Oracle-user -p=Tc-Oracle-user-
password -g=dba

4. Stop all Teamcenter services, including FMS.

Back up existing Teamcenter data

Back up the following directories:

• The Teamcenter application root directory on each installed workstation

• The Teamcenter data directory for each configured database

• The Teamcenter volume directories for each configured database

These are the only directories affected by Teamcenter installation. If you created other directories that
contain data used by your existing Teamcenter installation, such as a separate POM transmit schema
directory, Siemens Digital Industries Software recommends that you back up these directories as a
precautionary measure.

Back up Teamcenter databases

Back up your Oracle server and databases:

1. Export existing Oracle databases.

2. Terminate Teamcenter-Oracle sessions.

3. Back up the Oracle installation.
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21. Choose a display language
The default language displayed is the one specified by your operating system locale settings. You can
choose to override the default display language if required.

At each logon, you can choose between multiple languages, depending on your company's policy and
installation. Choose a language in the logon dialog when you log on to Teamcenter.

Alternatively, you can specify the language in your browser preferences. For example, in Microsoft Edge,
choose Settings→Languages to add languages or modify language preferences.

Your ability to set the language for the client depends on the character set encoding of the Teamcenter
server host and also the character set encoding of the Teamcenter database.

To prevent mixed-language display after you change the client display language, clear your web browser
cache. This prevents the interface from displaying in mixed languages.

You can also configure language display during Teamcenter installation.
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22. Manage environments
Add or remove software in the repository

Add software to the Deployment Center repository or remove software you no longer need to free space
on the software repository machine.

Add software kits into the repository

1. Download the software kits for the software versions that you want to deploy in your Teamcenter
environment.

2. Unzip the software kits and copy the unzipped directories to the software subdirectory in one of
your registered Deployment Center repository locations.

3. Log on to Deployment Center, and click SOFTWARE REPOSITORIES.

The Software Repositories page opens the Active Media tab of the repository and displays the
Software Media table.

4. Check the list of software to verify that the software you added is included in the list. If the list
does not update immediately, wait a few minutes for Deployment Center to finish scanning the
repository.

If the software you added still does not appear in the list, verify that you placed the complete,
unzipped software kit contents in the software directory.

If necessary, troubleshoot the Deployment Center repository service.

Remove obsolete software kits from the repository

When a software kit is no longer being used in a registered Teamcenter environment, you can remove it
from the Active Media list.

1. Open the Active Media tab to display all the registered software kits. Click the software kit you
want to remove.

2. Click Remove  on the command bar and confirm the deletion.

If the software is used by an environment, an error message explains that it can't be removed and
which environments are using it.

If the software is not used and is free to be removed, the selected software is moved to the
Obsolete Media tab. Deployment Center deletes the software and the software directory from the
file system.
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To complete the software kit removal from Deployment Center, click the Obsolete Media tab,
select the software to remove, and then click Remove  on the command bar.

The repository scanner removes the software kit registration and removes the software from
Deployment Center database. The selected software no longer appears in the Obsolete Media tab.

Create a configuration in TEM

When you installed Teamcenter executables using Teamcenter Environment Manager (TEM) from the
software kit, you created the first configuration.

You can modify features in an existing configuration, or create an additional Teamcenter
configuration in your existing TEM instance:

1. Launch Teamcenter Environment Manager (TEM). In the Windows start menu, choose
Programs→Teamcenter, and then right-click Environment Manager and choose Run as
administrator.

Alternatively, you can run the tem.bat file in the install directory in the application root
directory for the Teamcenter installation. Right-click the tem.bat program icon and choose Run
as administrator.

Note:

If you create a desktop shortcut to TEM, make sure the working directory (or Start in
location) for the shortcut is TC_ROOT\install. If the working directory for the shortcut is
incorrect, TEM displays errors during installation or updating of a configuration.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Create new configuration.

4. In the Configuration panel, type a description and unique ID for the new configuration.

5. In the Solutions panel, optionally select one or more solutions.

For a description of a solution, point to the solution name in TEM or see the solutions reference.

6. In the Features panel, select features to include in the configuration.

For a description of a feature, point to the feature name in TEM or see the features reference.

7. Proceed through the remaining panels in TEM, entering the required information for the features
you selected.

For information about each panel, click the help button .
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8. When TEM displays the Confirmation panel, click Start to begin installation.

Adding applications and components

Add applications

Applications contain administration data, software modules, and parameters that add specialized
functionality to the Teamcenter environment.

Adding applications using TEM

1. Launch Teamcenter Environment Manager. In the Windows start menu, click
Programs→Teamcenter 2412, and then right-click Environment Manager and choose Run as
administrator.

Alternatively, you can run the tem.bat file in the install directory in the application root
directory for the Teamcenter installation. Right-click the tem.bat program icon and select Run
as administrator.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

4. In the Old Configuration panel, select the configuration you want to modify.

5. In the Feature Maintenance panel, select Add/Remove Features.

Options in the Feature Maintenance panel vary depending on the features in your configuration.

6. In the Features panel, select applications to add to the configuration.

If an application has dependent components, you must first select those components to enable the
application. Hover over the application name in the feature list to display the required components
below the feature list. Find and select the required components to enable the desired application,
and then select the application.

To find an application or component by name, enter a search string in the Search box in the
Features panel, and then click the search button.

For information about an application, see the list of Teamcenter features.

7. Proceed through the remaining panels in TEM, entering the required parameters for the
applications you selected.

For information about each panel, click the help button .

Add applications
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8. When TEM displays the Confirmation panel, click Start to begin installation.

Can I remove an application after it is installed?

In TEM, you can attempt to remove an installed application from your configuration by deselecting
its feature in the Features panel, and then proceeding through the remaining panels to update the
configuration.

If you remove a feature that added data model objects to the Teamcenter database, the data model is
not removed when you remove the feature. Relations and objects created using the removed feature
persist in the database.

If no instances of the feature's data model objects were created in the database, you can attempt to
remove the template.

Caution:

If you installed an application using Deployment Center, do not attempt to uninstall it using TEM.
Deployment Center does not populate the uninstall information required by TEM. Uninstalling an
application using TEM may not remove it in Deployment Center, or may cause inconsistencies in
the environment in Deployment Center.

Add components

Components are the architectural pieces of Teamcenter, such as servers, services, and databases.

Adding components using TEM

In TEM, adding components involves the same steps as adding applications.

1. Launch Teamcenter Environment Manager. In the Windows start menu, click
Programs→Teamcenter 2412, and then right-click Environment Manager and choose Run as
administrator.

Alternatively, you can run the tem.bat file in the install directory in the application root
directory for the Teamcenter installation. Right-click the tem.bat program icon and select Run
as administrator.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

4. In the Old Configuration panel, select the configuration you want to modify.

5. In the Feature Maintenance panel, select Add/Remove Features.
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Options in the Feature Maintenance panel vary depending on the features in your configuration.

6. In the Features panel, select components to add to the configuration.

If a component has dependent components, you must first select those components to enable the
desired component. Hover over the component name to display the required components, find and
select the required components, then select the component.

To find a component by name, enter a search string in the Search box in the Features panel, and
then click the search button.

For information about a component, see the list of Teamcenter features.

7. Proceed through the remaining panels in TEM, entering the required parameters for the
components you selected.

For information about each panel, click the help button .

8. When TEM displays the Confirmation panel, click Start to begin installation.

Caution:

If you installed a component using Deployment Center, do not attempt to uninstall it using TEM.
Deployment Center does not populate the uninstall information required by TEM. Uninstalling a
component using TEM may not remove it in Deployment Center, or may cause inconsistencies in
the environment in Deployment Center.

Adding Active Workspace to a Teamcenter environment

If you have an existing Teamcenter environment without Active Workspace components, you can add
Active Workspace by installing the following Active Workspace and Microservice Framework components
in your environment:

Adding Active Workspace to a Teamcenter environment
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Active
Workspace
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Microservice
Framework and
Teamcenter
microservices

Active
Workspace
Gateway

Active
Workspace
Client

Indexing and
search
components

Visualization
Server

After you install components, deploy the Teamcenter environment to complete the installation of
Active Workspace in your environment.
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Install Active Workspace base

The Active Workspace base applications are a group of features selected by the Active Workspace
Server Extensions solution in TEM.

1. Launch Teamcenter Environment Manager. In the Windows start menu, click
Programs→Teamcenter 2412, and then right-click Environment Manager and choose Run as
administrator.

Alternatively, you can run the tem.bat file in the install directory in the application root
directory for the Teamcenter installation. Right-click the tem.bat program icon and select Run
as administrator.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

Adding Active Workspace to a Teamcenter environment
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4. In the Old Configuration panel, select the configuration to which you want to add Active
Workspace.

5. In the Feature Maintenance panel, select Add/Remove Features.

Options in the Feature Maintenance panel vary depending on the features in your configuration.

6. In the Solutions panel, select Active Workspace Server Extensions.

7. Proceed to the Features panel. Note that the features that comprise the Active Workspace
Server Extensions solution are preselected.

For information about an application, see the list of Teamcenter features.

8. Proceed through the remaining panels in TEM, entering the required parameters for the Active
Workspace Server Extensions features.

For information about each panel, click the help button .

9. When TEM displays the Confirmation panel, click Start to begin installation.

Install Active Workspace client

The Active Workspace base applications are a group of features selected by the Active Workspace Client
solution in TEM.

1. Launch Teamcenter Environment Manager. In the Windows start menu, click
Programs→Teamcenter 2412, and then right-click Environment Manager and choose Run as
administrator.

Alternatively, you can run the tem.bat file in the install directory in the application root
directory for the Teamcenter installation. Right-click the tem.bat program icon and select Run
as administrator.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

4. In the Old Configuration panel, select the configuration to which you want to add Active
Workspace.

5. In the Feature Maintenance panel, select Add/Remove Features.

Options in the Feature Maintenance panel vary depending on the features in your configuration.
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6. In the Solutions panel, select Active Workspace Client.

7. Proceed to the Features panel. Note that the features that comprise the Active Workspace
Client solution are preselected.

For information about an application, see the list of Teamcenter features.

8. Proceed through the remaining panels in TEM, entering the required parameters for the Active
Workspace Client features.

For information about each panel, click the help button .

9. When TEM displays the Confirmation panel, click Start to begin installation.

Migrate TEM to a different JRE

The Java Runtime Environment (JRE) used by Teamcenter and Teamcenter Environment Manager (TEM)
is set by TEM during Teamcenter installation. If you upgrade or install a new JRE, you must migrate
Teamcenter to the new JRE using TEM.

Caution:

Do not remove your previous JRE until after you complete migrating Teamcenter to the new JRE.
If you removed your old JRE before performing this procedure, problems or error messages may
occur, and TEM fails to start.

To change the JRE used by Teamcenter and TEM, perform the following steps.

1. If you changed the password for the Teamcenter administrative user after you installed the FMS
server cache (FSC) service, update the logon credentials for the FSC service to specify the current
password.

2. Start Teamcenter Environment Manager (TEM). From the Start menu, choose All
Programs→Teamcenter→Environment Manager, then right-click and choose Run as
administrator.

Alternatively, you can run the tem.bat file in the install directory in the application root directory
for the Teamcenter installation.

3. In the Maintenance panel, select Migrate Teamcenter to another JRE and then click Next.

4. The Migrate Teamcenter to another JRE panel lists Teamcenter services that depend on the JRE
and must be shut down before the migration can begin.

After you make sure these services are shut down, select All features from the above list have
been shut down, and then click Next.

Migrate TEM to a different JRE
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5. In the JRE Location panel, enter the path to the JRE you want Teamcenter to use.

Depending on the features in your configuration, TEM may prompt you for the operating system
user password.

Caution:

Make sure you specify a 64-bit JRE.

6. In the Confirmation panel, click Start to migrate Teamcenter to the specified JRE.

If you encounter problems migrating Teamcenter to the new JRE, see the available troubleshooting
solutions.
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23. Manage databases
Migrate a non-CDB database to a CDB database

Teamcenter supports Oracle's multitenant database architecture if you use Oracle 12c or later. A
multitenant architecture is deployed as a Container Database (CDB) with one or more Pluggable
Databases (PDB).

A Container Database (CDB) is similar to a conventional (non-CDB) Oracle database, with familiar
concepts like control files, data files, undo, temp files, redo logs, and so on. It also houses the data
dictionary for objects owned by the root container and those that are visible to databases in the
container.

A Pluggable Database (PDB) contains information specific to the database itself, relying on the container
database for its control files, redo logs and so on. The PDB contains data files and temp files for its own
objects, plus its own data dictionary that contains information about objects specific to the PDB. From
Oracle 12.2 onward a PDB can and should have a local undo tablespace.

You can migrate a non-CDB database to a CDB database using Oracle tools. The following example
illustrates the database architectures before and after migration.
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Teamcenter supports CDB and non-CDB databases. Be aware that Oracle has deprecated support for
non-CDB databases and may discontinue support after Oracle 19c.

If you migrate a non-CDB Teamcenter database to a CDB database, you must perform the migration after
you upgrade to Teamcenter 2412.

Add an existing Teamcenter database using TEM

You can add a Teamcenter database to an installation by creating a configuration that references an
existing Teamcenter data directory and its configured database. A data directory is associated with one
(and only one) database instance.

1. Launch Teamcenter Environment Manager. In the Windows start menu, choose
Programs→Teamcenter, and then right-click Environment Manager and choose Run as
administrator.
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Note:

You can also run the tem.bat file in the install directory in the application root directory
for the Teamcenter installation. Right-click the tem.bat program icon and choose Run as
administrator.

2. In the Configuration Maintenance panel, select Add new configuration.

3. In the Configuration panel, enter a description of and unique ID for the configuration you are
creating.

4. Proceed to the Features panel. Select the Teamcenter Foundation feature only and specify an
installation directory for the new configuration the Installation Directory box. The installation
directory must not already exist on your system. (TEM creates the directory.)

5. In the Foundation panel, select Use populated database and existing data directory and enter
the full path to the existing data directory in the Data Directory Location box.

6. In the Data Directory box, enter a location for the Teamcenter data directory. The directory must
exist.

The Teamcenter data directory is called the TC_DATA directory. This value is stored in the TC_DATA
environment variable on your system. TEM creates shared data subdirectories and files in this
location.

Do not set TC_DATA in the system environment. TEM sets this variable as required in various
scripts. Setting this variable in the operating system can cause conflicts if you install more than one
configuration.

7. In the Teamcenter Administrative User panel, enter the password for the Teamcenter
administrator.

Caution:

The password must not be empty nor contain any whitespace characters such as space, tab,
newline, carriage return, form feed, or vertical tab.

In addition, the password must not contain any of the following characters:

! # @ $ % = & ' " ^ : ; . _ < > ( ) { }

8. In the Confirmation panel, review your selections and click Start to add the database.

Add an existing Teamcenter database using TEM
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Add a new database using TEM

You can simultaneously configure a Teamcenter database and add it to an installation by creating a
new configuration. Because you are configuring a database, you must also install and configure File
Management System and create a data directory.

Prerequisites:

• A database server must be installed (Microsoft SQL Server or Oracle).

• A database instance must exist, either a specific instance configured for Teamcenter or a multipurpose
instance to be configured in this procedure.

1. Launch Teamcenter Environment Manager. In the Windows start menu, choose
Programs→Teamcenter, and then right-click Environment Manager and choose Run as
administrator.

Note:

Alternatively, you can run the tem.bat file in the install directory in the application root
directory for the Teamcenter installation. Right-click the tem.bat program icon and select
Run as administrator.

2. In the Configuration Maintenance panel, select Add new configuration.

3. In the Configuration panel, enter a description of and unique ID for the configuration you are
creating.

4. Proceed to the Features panel. Select the Teamcenter Foundation feature only and specify an
installation directory for the new configuration the Installation Directory box. The installation
directory must not already exist on your system. (TEM creates the directory.)

5. In the Foundation panel, select Create new data directory using existing populated database.

6. In the Foundation Database panel, enter access information for the existing database.

In the Data Directory box, enter a location for the Teamcenter data directory. The directory must
exist.

The Teamcenter data directory is called the TC_DATA directory. This value is stored in the TC_DATA
environment variable on your system. TEM creates shared data subdirectories and files in this
location.

Do not set TC_DATA in the system environment. TEM sets this variable as required in various
scripts. Setting this variable in the operating system can cause conflicts if you install more than one
configuration.
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7. In the Teamcenter Administrative User panel, enter the password for the Teamcenter
administrator.

Caution:

The password must not be empty nor contain any whitespace characters such as space, tab,
newline, carriage return, form feed, or vertical tab.

In addition, the password must not contain any of the following characters:

! # @ $ % = & ' " ^ : ; . _ < > ( ) { }

8. In the Confirmation panel, review your selections and click Start to add the database.

Change the Oracle password

If you use an Oracle database and want to change the password Teamcenter uses to connect to the
database, you can do this two ways using the install utility:

• Encrypt the password file using the -encryptpwf argument.

• Encrypt the database connection string using the -encrypt argument.

Encrypt the password file

To encrypt a password file, you set a temporary environment variable to the password you want to
encrypt, and then generate an encrypted password file using the -encryptpwf argument for the install
utility.

1. Open a Teamcenter command prompt.

2. Create a temporary environment variable and set it to the password you want to encrypt:

set variable-name=password

For example:

set temp_pw=mypassword

For security, choose a unique and obscure name for the environment variable, and delete the
variable promptly after completing this procedure.

3. Type the following command:

install -encryptpwf -e=variable-name -f=password-file

Change the Oracle password
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Replace variable-name with the name of the environment variable you created. Replace password-
file with the path and name of the password file to create. For example:

install -encryptpwf -e=temp_pw -f=pwd.txt

This command generates an encrypted password file that can be used for connecting to the
Teamcenter database. The password file can also be used with Teamcenter utilities that use the
password file (-pf) argument.

4. Delete the temporary environment variable you created in step 2.

Caution:

This step is important for security.

Encrypt the database connection string

To encrypt the database connection string, you must temporarily set the TC_DB_CONNECT environment
variable and then re-encrypt the connection string using the -encrypt argument for the install utility.

1. Open a Teamcenter command prompt.

2. Set the TC_DB_CONNECT environment variable:

set TC_DB_CONNECT=”db-user:password@database-ID”

Replace db-user with the database user name (the Oracle user). Replace password with the new
database password. Replace database-ID with the Oracle database name.

3. Type the following command:

install -encrypt

This command generates a new database connection string with the new Oracle password
encrypted. Copy the new database connection string.

4. Open the TC_DATA\tc_profilevars.bat file in a plain text editor.

5. Locate the following line in the file:

set TC_DB_CONNECT=connection-string

6. Replace the existing connection-string with the string generated by the install -encrypt command.

7. Save the changes to the tc_profilevars.bat file.

23. Manage databases
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Part V: Appendices
Supplemental procedures and references for installing Teamcenter and Active Workspace.
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24. Troubleshooting
Troubleshooting Teamcenter server installation

Installation log files

Teamcenter Environment Manager generates files in the install directory under the Teamcenter
application root directory.

• installdate-time_configuration-ID.log

Teamcenter Environment Manager generates a log file for each installation and configuration you
create. The log file contains a record of activities performed by Teamcenter Environment Manager.
Keep these files to maintain a complete history for troubleshooting purposes.

• configuration.xml

This file contains a record of the Teamcenter installation. Teamcenter Environment Manager uses
the configuration file to enable you to maintain the installation, including adding and removing
components, patching installations, and upgrading installations.

Caution:

Do not remove the configuration.xml file. Removing the configuration.xml file results in the
inability to modify the installation using Teamcenter Environment Manager.

• uninstall.xml

This file contains a record of the Teamcenter uninstallation.

In addition, auxiliary programs called by Teamcenter Environment Manager generate files in the logs
directory under the Teamcenter application root directory. Most files have the format:

program-name.syslog
program-name.log

Of these files, the system log (.syslog) files usually contain the most relevant error data.
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Problems/error messages

See the following information for help resolving errors encountered during Teamcenter installation.

Problem/error message Possible cause Solution

TEM does not start, reports JRE not
found.

JRE path is not set in the system
environment.

Set the JRE_HOME or JRE64_HOME
environment variable to specify the
path to the required Java Runtime
Environment (JRE).

For more information, see System
requirements.

JRE path is set incorrectly in the system
environment.

Make sure the path specified in
the JRE_HOME or JRE64_HOME
environment variable is correct.

For more information, see System
requirements.

The specified JRE has been removed
from the system.

If you installed a new Java Runtime
Environment (JRE) and removed the
previous JRE after you installed
Teamcenter, TEM cannot find the JRE,
even if JRE_HOME or JRE64_HOME is
set correctly.

To resolve this problem, perform the
following steps.

1. Open the following file in a plain
text editor:

TC_ROOT\install\tem_init.ba
t 

2. Locate the following line in the
file:

set 
TC_JRE_HOME=jre_loc
ation

3. Replace jre_location with the path
to the new JRE.

4. Save and close the file.

5. Perform the steps in Migrate TEM
to a different JRE.

24. Troubleshooting
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Problem/error message Possible cause Solution

To avoid this problem in the future, do
not remove your previous JRE until after
you complete migrating Teamcenter to
the new JRE.

Siemens License Server reports an error
similar to the following:

Cannot find license 
file.

Make sure the SPLM_LICENSE_SERVER
system environment variable contains
the correct port and host name of the
Siemens License Server, for example,
29000@myhost .

If a path in the CLASSPATH environment
variable contains whitespace characters,
those paths must be enclosed in double
quotes ("). For example:

"C:\Program 
Files\Microsoft\Web 
Platform
    
Installer";D:\TcSE\ap
ache-ant-1.9.4\bin

An error similar to the following
is displayed during a Teamcenter
installation, upgrade, or patch:

Error: Could not 
find or load main 
class files.

The CLASSPATH environment variable
contains an incorrectly formatted path.

If a path in the CLASSPATH environment
variable contains whitespace characters,
those paths must be enclosed in double
quotes ("). For example:

"C:\Program 
Files\Microsoft\Web 
Platform
    
Installer";D:\TcSE\ap
ache-ant-1.9.4\bin

TEM reports the installation path must
not contain spaces.

The installation drive specified in
the Installation Directory does
not support short file names
(8.3 convention). TEM requires this
capability.

Change the Installation Directory to a
path with no spaces, or to a path on a
drive that supports 8.3 file names.

To determine whether support for the
8.3 file name convention is enabled
for a given drive, type the following
command in a command prompt:

fsutil 8dot3name 
query drive-letter
    

Teamcenter Environment Manager
(TEM) cannot connect to the Microsoft
SQL Server database.

If your Microsoft SQL Server database
uses a named instance and the Server
Browser service is not running on the

Make sure the Server Browser service is
running on the database host.

Problems/error messages
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Problem/error message Possible cause Solution

database host, TEM cannot verify the
connection to the database.

Running Teamcenter in an IPv6 network
environment, the Teamcenter client
does not connect to the server at all
or hangs when trying to connect to the
server.

Some Teamcenter components
are sensitive to link-local IPv6
addresses. You must make sure your
hosts have global IPv6 addresses and
use those when connecting to the
Teamcenter server. Problems can occur
if you use local-link IPv6 addresses.

Find your IP address using the ping
or nslookup command.  Make sure
these commands find the a global IPv6
address, not a link-local IPv6 address.

If not, or if you are unsure, contact
your network administrator.  Make sure
your host name resolves to a global IPv6
address, not a link-local IPv6 address.

You can also view your host’s network
addresses using the ipconfig command
(on Windows systems) or the ipconfig
command (on Linux systems).

During logon using Kerberos
authentication, Teamcenter displays the
following error:

Mechanism level:
Clock skew too great

The system clock time on the
Teamcenter client is significantly
different from the system clock time
at the Kerberos Key Distribution Center
(KDC).

Synchronize the system clock times
between the Teamcenter client and the
KDC.

TEM displays errors like the following
during installation of features:

path\feature_acadgmo.
xml: Error on line 1 
of document
file: path/
feature_acadgmo.xml: 
Premature end of 
file.

If you launched TEM from a shortcut
with an incorrect working directory,
TEM encounters problems installing or
updating features.

If you create a desktop shortcut to TEM,
make sure the working directory (or
Start in location) for the shortcut is
TC_ROOT\install.

Database daemon services do not start.

These can include the following:

• Teamcenter Task Monitor Service
• Teamcenter Subscription Manager

Service
• Teamcenter Action Manager

Service
• Teamcenter Tesselation Manager

Service

If the database daemon services run on
the same host as the database server,
the database daemons may attempt to
start before the database server is fully
running. If this happens, the daemons
fail to start.

If the database daemons run on the
same host as the database server,
perform one of the following steps:

• Manually start the database daemon
services after the database server is
started.

• Modify the startup settings for the
database daemon services to create a
dependency on the database service.
This ensures the daemons do not

24. Troubleshooting
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Problem/error message Possible cause Solution

start before the database server is
fully running.

During an installation or upgrade, the
FMS server cache (FSC) reports a
startup failure with a message similar to
the following:

Installation 
interrupted
due to the
following reason:

Processing <upgrade> 
of feature FMS
Server Cache failed: 
FSC service failed to
start with an error 1

However, the FSC startup log shows
no errors and indicates the FSC is left
running.

Another service on the same host was
running on the same port that the FSC
is configured to use. This causes a fatal
error to the FSC and the FSC startup log
shows a bind exception on the port.

Some services, such as JBoss, allow the
FSC to bind to its port, resulting in
failure of the FSC to start, but no errors
in the FSC log.

Change the FSC settings to use a
different port.

<<null>>\\<<null>> on
host host-name does
not have administrator
privileges

This error most likely indicates
you attempted to start Teamcenter
Environment Manager using the
Windows runas command or the
Run as menu command. Teamcenter
Environment Manager cannot be
started as a user other than the user
logged on to the operating system.

Start Teamcenter Environment Manager
as a user logged onto the system with
Administrator group privileges and the
Log on as a service right.

Update Manager FTP errors

The following table describes errors that can occur while connecting to the update server or while
downloading updates.

Error Resolution

Cannot contact server Host or port may be incorrect. Check Host and Port values
and try again.

Cannot log on User name or password may be incorrect. Check User and
Password values and try again.

Update Manager FTP errors
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Error Resolution

Incorrect Path Path to the directory on the update server may be incorrect.
Check the path and try again.

Timeout Error The update manager received no response from the
update server. Try connecting later or contact your system
administrator for assistance.

Transfer Error Contact with the update server was interrupted. Try your
operation again or contact your system administrator for
assistance.

Resolving web tier connection problems

Diagnosing web tier connection problems

If the Teamcenter web tier and the corporate server do not reference the same web application name,
the web tier cannot connect to the Teamcenter server.

The web application name specified in the Teamcenter web tier must match the web application name
specified on the corporate server.

During installation of the Teamcenter corporate server, you specify this value in the Web Application
Name box in the Default Site Web Server panel of Teamcenter Environment Manager. The default web
application name is tc.

During installation of the Teamcenter web tier, the Web Application Manager assigns the web
application the default name of tc.

If you specify a web application name other than tc during corporate server installation, you must
change the corresponding value during web tier installation. If the web tier and the corporate server do
not reference the same web application name, the web tier cannot connect to the Teamcenter server.

To ensure the web tier and the corporate server reference the same web application name, perform one
of the following procedures:

Change the deployable file name on the corporate server

Change the deployable file name on the web tier

Change the deployable file name on the corporate server

Using Teamcenter on a two-tier rich client host, set the WEB_default_site_deployed_app_name
preference to reflect the deployable file name specified in Web Application Manager. (Alternatively, you
can set this preference using the preferences_manager utility from a command prompt.)

24. Troubleshooting
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Change the deployable file name on the web tier

1. In Web Application Manager, select your web application and click Modify.

2. In the Modify Web Application dialog box, click Modify Web Application Information.

3. Change the value in the Deployable File Name box to reflect the web application name you
entered during corporate server installation.

4. Click Generate Deployable File to rebuild your web application.

5. Deploy the rebuilt web application on your web application server.

Java exception errors during command-line updates

When making updates in TEM through the command-line interface, such as adding Teamcenter features
or data model update operations, certain Java exception errors may occur.

TEM performs error checking when processing command line parameters and exits quickly if it detects
an error such as an invalid parameter setting. In such cases, a Java exception error similar to the
following may occur:

Data model update
    Loading features from path
    Type: FULL
    Configuration: TEMFLOW1
    Verifying password
    Unable to locate:
        alpha1_template.zip Exception while removing reference: 
java.lang.InterruptedException
        java.lang.InterruptedException at java.lang.Object.wait(Native Method) at
        java.lang.ref.ReferenceQueue.remove(ReferenceQueue.java:118) at
        java.lang.ref.ReferenceQueue.remove(ReferenceQueue.java:134) at
        sun.java2d.Disposer.run(Disposer.java:125) at 
java.lang.Thread.run(Thread.java:619)
  

These types of Java exception errors are not a cause for concern because TEM begins shutting down
when a problem is detected, before any data model updates are performed. These errors occur while
threads are closing. In the above example, the java.lang.InterruptedException error occurs because
the main Java thread begins to exit while the Swing (GUI) thread is waiting to close.

Web Application Manager needs location of Java file when installing rich client

Under certain circumstances, the Web Application Manager does not find the Java jakarta-
regexp-1.3.jar file required to install the four-tier rich client.

To resolve this problem, make the jakarta-regexp-1.3.jar file available to the Web Application Manager.

Change the deployable file name on the web tier
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1. Locate the bmide\compressed_files directory in the Teamcenter software kit.

2. Expand the bmide.zip file to a temporary directory. (This file contains the jakarta-regexp-1.3.jar
file.)

3. Add the temporary directory to the list of Disk Locations for Install Images in the Web Application
Manager.

4. Build your web application WAR file using the Web Application Manager.

5. Deploy your WAR file.

Troubleshooting microservices

Problem/error
message Possible cause Solution
404 error for a
microservice request
with the Service
Dispatcher logging a
message that the HTTP
header is too large.

In a deployment with a
load balancer configured,
due to the addition of
large cookies by the load
balancer, some requests
exceed the limit for the
header size.

Create a CUSTOM_REQUEST_BUFFER_SIZE
environment variable and set its value higher
than the default microservice service dispatcher
request buffer size of 8192 (8 KB), and then
restart the service dispatcher.

Troubleshooting four-tier architecture deployment

Identify the problem you encountered in your four-tier rich client architecture and perform the solution
described.

Problem Solution
Out-of-memory error
during a call to
getAttrMappingsForDatasetType

If you use WebSphere and this occurs when launching NX
from the rich client, you must modify the JVM arguments in
WebSphere to increase memory allocation.

Error messages about the server
manager pool ID

These messages indicate that the pool ID is in use by another
server manager in the cluster. Either place the server managers in
different clusters or configure a distinct pool ID.

Configuration is correct, but run-
time errors occur

Determine from logs whether users are frequently losing a server
due to the server timing out and are then having a new server
assigned.

Server startup can consume a great amount of CPU. Consider
increasing timeout values and/or the pool size.

CFI_error displays when running AIE
export in batch mode

When you run AIE Export in batch mode, Teamcenter displays
a CFI error. This error occurs because jt.exe (Microsoft Task
Scheduler) file is missing from the %WINDOWS% directory.
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Problem Solution
To resolve this problem, download the Microsoft Task Scheduler
from the Microsoft Developer Network:

https://msdn.microsoft.com
Client-side Java session cookies are
overwritten by web tier applications
deployed in the same domain on a
WebLogic application server.

Multiple applications deployed in the same WebLogic domain can
cause client session cookies to overwrite each other. To avoid this,
deploy your Teamcenter web application in a domain by itself or
ensure each application has a separate cookie path.

To set your web application session cookie path:

1. Navigate to the WEB-ROOT/staging-directory/webapp_root/
WEB-INF directory for the application.

WEB_ROOT is the location where you installed the Web
Application Manager (insweb), and staging-directory is the
directory where the specific web application was generated.

2. Open the weblogic.xml file and add the following elements:

<session-param>
   <param-name>CookiePath</param-name>
   <param-value>/deployable-name</param-value>
</session-param>

Replace deployable-name with the deployable file name set
in the Web Application Manager, for example, tc.

3. Launch the Web Application Manager (insweb).

4. Select the web application name and click Modify.

5. In the Modify Web Application dialog box, click Generate
Deployable File.

6. In the Generate Deployable File dialog box, click OK.

The Web Application Manager displays the status of the
installation in the Progress dialog box. When the installation
is complete, click OK to close the Progress dialog box.

7. Click OK to close the Modify Web Application dialog box.
During peak activity, the web tier
encounters errors obtaining JCA
connections.

The Teamcenter web application is using all available connections
in the connection pool. To avoid this, increase the number of
available connections by increasing the Max_Capacity context
parameter value in the web application WAR file.

Troubleshooting four-tier architecture deployment
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Problem Solution
To set your web application maximum connection pool size:

1. Launch the Web Application Manager (insweb).

2. Select the web application name and click Modify.

3. In the Modify Web Application dialog box, click Modify
Context Parameters.

4. In the Modify Context Parameters dialog box, locate
Max_Capacity, double-click the Value column, and type a
larger number.

5. Click OK and click Generate Deployable File.

6. In the Generate Deployable File dialog box, click OK.

The Web Application Manager displays the status of the
installation in the Progress dialog box. When the installation
is complete, click OK to close the Progress dialog box.

7. Click OK to close the Modify Web Application dialog box.

8. Redeploy the WAR file in your application server.
Chinese characters are displayed as
square blocks in the Teamcenter
rich client.

If you use a nonnative language operating system version of
Windows, you must install and enable the Multilingual User
Interface (MUI) pack to ensure the language font is displayed
properly.

1. Download and install the MUI pack for Windows from
Microsoft.

2. Open the Regional and Language Options dialog box in
the Windows Control Panel.

3. In the Languages tab, set the required language for the
menus and dialogs.

4. In the Advanced tab and the Regional Options tab, set the
required language.

Teamcenter web application fails to
deploy on JBoss (WildFly) with the
following error message:

The Teamcenter web application takes longer than the default
60 seconds the JBoss (WildFly) deployment scanner allows for
deployments. Add the deployment-timeout attribute to the
deployment-scanner element and set the value to at least 600
seconds before attempting to deploy the web application.

24. Troubleshooting
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Problem Solution
Did not receive a response 
to the deployment operation 
within the allowed timeout 
period [60 seconds]. Check 
the server configuration 
file and the server logs to 
find more about the status 
of the deployment.

<subsystem xmlns="urn:jboss:domain:deployment-
scanner:1.1">
    <deployment-scanner path="deployments" 
       relative-to="jboss.server.base.dir" s
       scan-interval="5000" 
       deployment-timeout="600"/>
</subsystem>

Long running service request that
crosses firewalls or proxy servers
results in closed connections.

If a user is performing a time-consuming action such as running
a large BOM expansion, the server may not respond for 15
minutes or more. When this happens across a firewall, or other
proxies, the firewall might automatically close the perceived idle
connection. This results in a closed connection in the client
application and loss of data.

To avoid exceeding these idle connection time limits, enable TCP
keepalive functionality in the operating system (OS) of at least
one of the machines on the client or server side of the each of
the HTTP connections between the client applications and the
Teamcenter server.

For example:

• If a client machine connects to web tier machine, enable
TCP keepalive in the OS of the machine where the web tier
server runs. This supports both the HTTP connection between
client applications and the web tier, and the HTTP connection
between the web tier and the Teamcenter server (Server
Manager/MUX).

• If you use a reverse proxy server between a client machine and
the web tier machine, enable TCP keepalive in the OS of the
machine where the reverse proxy runs.

If your network configuration requires you to not enable TCP
keepalive on the TCP endpoint (such as a proxy server), you
must enable keepalive in the OS on each client machine.

On Windows machines, enable TCP keepalive by setting the
appropriate Windows registry keys. On Linux machines, set TCP
keepalive using kernel parameters. See your operating system
documentation for information on how to enable TCP keepalive.

Note:

TCP keepalive is enabled in Teamcenter client and web tier
software by default, and only requires TCP keepalive in the
OS of affected hosts to be enabled.

Troubleshooting four-tier architecture deployment
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Problem Solution
Alternatively, if you do not want to enable TCP keepalive,
you can increase the timeout setting in the firewall to allow
requests to complete.

Troubleshooting the .NET web tier

Resolving .NET server manager port conflicts

When starting the .NET Server Manager Service, Teamcenter may display a message that no Teamcenter
servers are available. This can be caused by a port conflict.

To diagnose and resolve this problem, perform the following steps.

1. Open the following file in the TC_ROOT\net_servermanager\logs directory:

TcServerManager_timestamp.log

2. Search the log file for errors similar to the following example:

2014-02-12 21:06:33 [6] ERROR Teamcenter.Enterprise.ServerManager.ServerPoolManager 
[(null)] - Remoting port configured for Pool ID: TcPoolA, is already in use. Stop 
and start server manager on a different port. Message is: Only one usage of each 
socket address (protocol/network address/port) is normally permitted

3. If you find an error that states a remoting port is already in use, another process is using the same
port as the .NET server manager.

To resolve this problem, either change the .NET server manager port to different value or stop the other
process that uses the .NET server manager port.

You can use the Windows netstat utility to view all TCP ports currently in use by the system. For
example, typing netstat -a -b or netstat -aon lists the TCP ports currently in use.

Troubleshooting Oracle

Finding Oracle errors

When Oracle detects an error, an error code is displayed in the system console window and written to
the Teamcenter trace and log files. To assist troubleshooting, Oracle embeds object names, numbers,
and character strings in error messages.

The oerr utility provides additional troubleshooting information. Often, the additional information offers
a solution to the problem.
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View additional information about an Oracle error message

1. Manually set the Oracle environment by entering the following command:

export ORACLE_HOME=/u01/app/oracle/product/oracle-version

Replace oracle-version with the installed Oracle version, for example, 920.

2. Enter the following command:

$ORACLE_HOME/bin/oerr facility error-number

Replace facility error-number with the Oracle error code, for example ORA 7300. ORA is the facility
and 7300 is the error number.

This command displays cause and action messages that you can use to troubleshoot the problem.

Troubleshooting Microsoft SQL Server

Microsoft SQL Server 2014 performance is poor

If you migrate a database application to Microsoft SQL Server 2014 from a previous version, the
database server may consume excessive CPU resources and cause poor performance.

To correct this problem, change the SQL Server 2014 Compatibility Level setting from SQL Server 2014
(120) to SQL Server 2012 (110).

For more information about this issue, see the following Microsoft support article:

https://msdn.microsoft.com

Teamcenter update fails with ODBC error

When upgrading a Microsoft SQL Server server, an error similar to the following can occur:

++++++++++++++++++++++++++++++++++  
ODBC error. SQLSTATE: 42000 Native error: 5074  
Message: [Microsoft][ODBC SQL Server Driver][SQL Server]The column '***' 
is 
dependent on column '***'.  
ODBC error. SQLSTATE: 42000 Native error: 4922  
Message: [Microsoft][ODBC SQL Server Driver][SQL Server]ALTER TABLE 
ALTER COLUMN 
<name> failed because one or more objects access this column.  
++++++++++++++++++++++++++++++++++++  

View additional information about an Oracle error message
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This error occurs when the upgrade process attempts to modify a column that has a dependent column
with an index. Microsoft SQL Server does not allow changes to columns with indexes. Also, local DBA
indexes may exist that don't match the standard OOTB template for indexes, so it was not anticipated.

This problem can happen because columns that have manually-created statistics attached cannot have
their properties modified without first dropping the statistics object. This to ensure the statistics object
accurately reflects the content of the column. Manual creation of statistics objects is important to
ensuring query performance if you set AUTO_CREATE_STATISTICS = OFF.

An auto-created statistics object does not prevent a modify action to a column because auto-created
statistics objects can be removed automatically. But, if the system encounters a manually-created
statistics object, it cannot be removed automatically, and may result in an access error.

To resolve this problem, perform the following steps:

1. Delete the index ***.

2. Delete the dependent column ***.

3. Continue the upgrade.

4. Run the index_verifier utility to re-create standard OOTB indexes:

index_verifier -u=tc-admin -p= -g=dba -o=DO_IT

Replace tc-admin with the Teamcenter administrative user.

Tuning WebSphere JVM memory consumption

If your Teamcenter application requires more memory than what is currently allocated in WebSphere,
out-of-memory errors can occur. For example, if you use the NX Integration and attempt to
launch NX from the rich client, Teamcenter may report an out-of-memory error during a call to
getAttrMappingsForDatasetType.

If errors like this occur, you must modify the JVM arguments in WebSphere to increase memory
allocation. For information about how to modify JVM arguments, see the IBM support article titled
Setting generic JVM arguments in WebSphere Application Server at the following site:

http://www-01.ibm.com

Before you tune JVM arguments, use memory profiling tools to analyze your memory issues and
determine which tuning options you need to use. The following table provides some suggestions, but
these may not be suitable in all cases.
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JVM options for tuning the WebSphere Application Server memory usage

JVM option Description

Typical
default
value

Suggested
value

-Xms Controls the initial size of the Java heap.

Properly tuning this parameter reduces the overhead
of garbage collection, improving server response time
and throughput. For some applications, the default
setting for this option may be too low, resulting in a
high number of minor garbage collections.

50 MB 512 MB

-Xmx Controls the maximum size of the Java heap.

In general, increasing the minimum/maximum heap
size can improve startup, reduce the number of
garbage collection occurrences, and increase the
throughput until the heap no longer resides in physical
memory. After the heap begins swapping to disk, Java
performance suffers drastically. Therefore, The heap
sizes should be set to values such that the maximum
amount of memory the VM uses does not exceed the
amount of available physical RAM.

256 MB 1024 MB

-XX:PermSize Sets the section of the heap reserved for the
permanent generation of the reflective data for the
JVM. This setting should be increased to optimize the
performance of applications that dynamically load and
unload many classes.

PermSize memory consumption is in addition to the
-Xmx value set by the user on the JVM options. Setting
this to a value of 128 MB eliminates the overhead of
increasing this part of the heap.

Client: 32
MB

Server: 64
MB

128 MB

-XX:MaxPermSiz
e

Allows for the JVM to be able to increase the PermSize
setting to the amount specified.

Initially, when a VM is loaded, the MaxPermSize
is the default value, but the VM does not actually
use that amount until it is needed. If you set both
PermSize and MaxPermSize to 256 MB, the overall
heap increases by 256 MB in addition to the -Xmx
setting.

If an application needs to load or reload a large
number of classes, the following error may result:

messageOutOfMemoryError: PermGen space

N/A 256 MB

Tuning WebSphere JVM memory consumption
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JVM option Description

Typical
default
value

Suggested
value

Typically, this means that the JVM started with an
insufficient maximum value for permanent generation.

Troubleshooting document rendering

If you are not successful rendering document revisions to translate dataset files, your administrator
should review your installation and configuration systematically and verify the following requirements
are met.

• Installation of Teamcenter lifecycle visualization Convert software is required by the previewservice
feature.

• You must select the Convert feature; the Print feature is optional.

• The destination installation directory name must not contain spaces.

• To accommodate high levels of input and output, modify the vvcp.ini file on Windows systems, or
the vvcp.platform.cfg file on Linux systems.

FileCheckWait=600
FileCheckWaitForZero=30

• When the installation is complete, verify the Convert option prepare.exe program exists under the
VVCP installation directory.

• You must enable the RenderMgtTranslator service and one or both of the following services:

• PreviewService

Configure translation services by enabling and configuring translators using TEM.

• PreviewService

Requires Teamcenter Visualization Convert. Source authoring applications such as Microsoft Office
applications are also required.

• RenderMgtTranslator

Required for either PreviewService, PdfGenerator, or any other service to be added.

• Use Business Modeler IDE to set up and deploy IRDC and dispatcher service configuration objects to
the Teamcenter database.
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Troubleshooting Teamcenter Integration for NX

Teamcenter Integration for NX may be unresponsive in a four-tier rich client if you specify an incorrect
value for Web Application Name during installation of the Teamcenter corporate server.

During corporate server installation, TEM prompts for the web application name in the Default
Site Web Server panel. The web application name you enter is used to populate the
WEB_default_site_deployed_app_name preference in the Teamcenter database. When you build the
Teamcenter Integration for NX web application in Web Application Manager, you specify the actual
name of the web application.

If the name of the deployed web application does not match the value specified in TEM, the web
application fails to connect to the Teamcenter server.

If you experience problems starting Teamcenter Integration for NX from the four-tier rich client, inspect
the ugs_router system log for messages that resemble the following example:

INTEROP: Executing: O:\win32\ugnx5.0.0.22\ugii\ugraf.exe -pim=yes -
http_url=http://AcmeCorp:8080/tc/aiws/aiwebservice -soa_url=http://AcmeCorp:8080/tc"-
http_cookie=IMAN=08100000000000madakash45b765e1cd0ea854705e5f8f; path=/;" -
http_vmid=b6e51c5aaaf5b200:-58275229:1104f3e3952:-8000 "-role=ALL" -
portalinfo=localhost:2377:PROCESS_COMMAND_LINE -
invoke=com.teamcenter.rac.commands.objectschanged.ObjectsChangedCommand+-uids=%s+-
src=madakash@4Tier_w__NX :madakash@4Tier_w__NX 4-tier
INTEROP: Waiting for UG/Manager V23.0 1 to start up...

This message results from the rich client expecting a web application named tc but being unable to find
it.

To resolve this problem, set the WEB_default_site_deployed_app_name preference to the correct
name of the deployed web application. You can update this preference using the preferences manager
from the command line or from within the rich client.

Recovering a corrupted database

Overview of recovery from a corrupted database

If you attempt to install Teamcenter using a database that is only partially installed, Teamcenter
Environment Manager (TEM) allows you to drop all existing data before beginning a new installation.

If the Teamcenter database is corrupted beyond repair, you can alternatively delete the database
and repeat the installation using an empty database. To do this, perform the appropriate procedure,
depending on your database vendor:

• Recovering from a corrupted Oracle database

• Recovering from a corrupted Microsoft SQL Server database

Troubleshooting Teamcenter Integration for NX
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Recovering from a corrupted Oracle database

1. Delete the database using Oracle Database Configuration Assistant (DBCA).

2. Create a new empty database using the appropriate DBCA template file.

3. Launch TEM and reinstall Teamcenter.

Recovering from a corrupted Microsoft SQL Server database

1. Remove the corrupted database using the Microsoft SQL Server Management Studio. Right-click the
appropriate database in the tree view and choose Delete.

This removes the database and the associated data files.

2. Launch TEM and reinstall Teamcenter.

TEM creates a new database during installation.

24. Troubleshooting
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25. Uninstalling Teamcenter
Uninstall the FOSS Repository

The FOSS Repository provides a central location for all third-party components used by Teamcenter. It
is installed automatically in the TC_ROOT\fossrepo directory during Teamcenter deployment. However,
when uninstalling Teamcenter (deleting the TC_ROOT folder), you must take care when deleting the
TC_ROOT\fossrepo folder.

• If there is only one Teamcenter environment on the given machine:

Delete the FOSS Repository and the FOSS_REPOSITORY_HOME environment variable.

1. Delete the %TC_ROOT%\fossrepo and %TC_ROOT% directories (on Windows systems) or the
$TC_ROOT/fossrepo and $TC_ROOT directories (on Linux systems).

2. Remove the FOSS_REPOSITORY_HOME system environment variable from the system.

Windows Systems: Delete the environment variable using standard Windows system tools.

Linux Systems:

a. Remove the definition of FOSS_REPOSITORY_HOME from the $HOME/.profile file for the
user who installed Teamcenter.

b. Remove the definition of FOSS_REPOSITORY_HOME from the $HOME/.bash_profile file, if
this file exists.

c. Remove the definition of FOSS_REPOSITORY_HOME from the $HOME/.kshrc file, if this file
exists.

• If there are multiple Teamcenter environments on the given machine:

Do not delete the FOSS Repository directory or the FOSS_REPOSITORY_HOME environment variable,
because the single repository is used by the other installed environments.

Restoring a deleted FOSS Repository

If the FOSS Repository is mistakenly deleted, you can restore it by performing the following steps:

1. In the Teamcenter software kit, locate the tc\foss_repository\TpcRepository.zip file and expand its
contents to the path specified by the FOSS_REPOSITORY_HOME variable.

2. Open the FOSS-repository-home\bin\tpc.bat file (on Windows systems) or FOSS-repository-
home/bin/tpc.sh file (on Linux systems) in a text editor.
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3. Replace @CHANGE_ME_JAVA_HOME@ with the location of the Java installation. Save the changes
to the file.

4. In an administrator command prompt, type the following command:

Windows Systems:

%FOSS_REPOSITORY_HOME%\bin\tpc.bat ImportProduct Tc-kit-
location\tc\foss_repository\TcPackage_wntx64.zip

Linux Systems:

$FOSS_REPOSITORY_HOME/bin/tpc.bat ImportProduct Tc-kit-location/tc/foss_repository/
TcPackage_wntx64.zip

Replace Tc-kit-location with the path to the Teamcenter software kit.

Uninstall Teamcenter configurations

You can remove Teamcenter configurations using Teamcenter Environment Manager (TEM). To
completely uninstall a Teamcenter deployment, you must remove all configurations in the deployment.

Caution:

If you installed an application or component using Deployment Center, do not attempt to uninstall
it using TEM. Deployment Center does not populate the uninstall information required by TEM.
Uninstalling an application or component using TEM may not remove it in Deployment Center, or
may cause inconsistencies in the environment in Deployment Center.

To remove a single Teamcenter configuration, use the Remove configuration option in the
Configuration Maintenance panel in TEM.

To remove an entire Teamcenter deployment, perform the following steps:

1. Log on to the operating system using the user account under which you installed Teamcenter.

2. Stop all Teamcenter services using the Services dialog box in the Windows Control Panel.

3. Start Teamcenter Environment Manager (TEM):

From the Start menu, choose Programs→Teamcenter→Environment Manager, then right-click
and choose Run as administrator.

You can also run the tem.bat file in the install directory in the application root directory for the
Teamcenter installation.

25. Uninstalling Teamcenter
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4. In the Configuration Maintenance panel, select Perform maintenance on an existing
configuration.

5. Select the configuration to uninstall from the displayed list.

TEM removes only the configuration you select.

6. Proceed to the Uninstall panel. Select

The Configuration Display panel shows all configurations in the Teamcenter installation. Review
the configuration details, and then click Next.

7. Proceed to the Uninstall panel. Select Yes to confirm that you want to remove the selected
configuration.

8. If the configuration includes Teamcenter Foundation, TEM displays the Uninstall Teamcenter
Foundation panel. Specify whether you want to remove the Teamcenter database, TC_DATA
directory, and volume. You must enter database server credentials to remove the database.

9. Proceed to the Confirmation panel and click Start to begin the uninstallation.

TEM removes the Teamcenter configuration.

If the uninstallation is not successful, TEM stops processing when it encounters the error and
displays a message indicating the location of the log file containing the error.

10. If you selected the option in TEM to remove the Teamcenter database, the database is moved to the
Oracle recycle bin. To permanently remove the database, launch SQL*Plus and enter the following
command:

PURGE RECYCLEBIN;

11. If you want to remove additional configurations, return to step 5.

TEM does not remove TCCS cache files (cache files generated by the FSC or FCC). After Teamcenter
uninstallation, you can manually delete these cache files.

If you shared the TC_DATA directory, TEM may not completely remove this directory because it may
be locked by sharing. To completely uninstall this directory, you must unshare it before you begin
uninstallation.

Uninstall TCCS

If you installed Teamcenter client communication system (TCCS) as part of an installation of the rich
client or Teamcenter Microsoft Office interfaces, uninstalling those clients automatically uninstalls TCCS
from your system.

Uninstall TCCS
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If you installed TCCS using the stand-alone installation wizard, perform the following steps to uninstall
TCCS.

1. Stop the FMS client cache (FCC) process:

a. Open a command prompt.

b. Change to the \tccs\bin directory in the TCCS installation directory.

The default TCCS installation directory is C:\Program Files\Siemens\Teamcenterversion\tccs.

c. Type the following command:

fccstat -stop

After stopping the FCC process, the fccstat command reports that the FCC is offline.

d. Close the command prompt.

2. Uninstall TCCS:

a. In the Windows Control Panel, open the Add or Remove Programs dialog box.

b. In the list of installed programs, select and remove Teamcenter client communication
system.

c. Restart the system to unset the FMS_HOME environment variable.

Uninstall database software

Uninstall your database software (Oracle or Microsoft SQL Server) according to the vendor
documentation.

25. Uninstalling Teamcenter
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26. Solutions and features reference
Teamcenter solutions

Solutions are preselected groups of features that provide starting points for recommended Teamcenter
configurations. You can add features or deselect features in the Features panel in Teamcenter
Environment Manager (TEM). For information about a solution, point to the solution name in the list.
TEM displays a description.

Solution Features

Active Workspace Server
Extensions

Teamcenter Foundation
Active Workspace
Active Architect Core
Active Collaboration
Active Content Structure
Audit
Authorization Active Workspace
Multisite Integration
Reporting
Shape Search

Subscription
Workflow
TC XML Import and Export
FMS Server Cache
Product Line Planning
Translation Service Database Module
Softlines, Hardlines and Footwear
Classification Interface
Vendor Management
NX Part Family Classification Integration
Color and Visual Appearance Management

Active Workspace Client Active Workspace Client
3D Visualization
Active Collaboration Client
Active Workspace Visualization 2D
Viewer
Content Management Client
DPV for Active Workspace Client
Document Management Client
Program Planning
Reactive Logging
Reporting
Schedule Manager
Subscription
Markup
Workflow
Active Content
Viewer Snapshot Tool
Change Management
PLMXML Export Import
Part Manufacturing Client
SLM Core Client

Teamcenter Simplified Client
Service Engineering Client
Service Manager Client
Service Planning Client
Resource Manager for Active Workspace
Client
Service Work Instructions Client
Program Change Client
Program Planning Event Change Client
Program Schedule Manager Client
Classification Client
Quality Manager
Training and Qualification Client
Control and Inspection Plan
APQP Program Management
Quality Audit
Digital Thread Navigation
Core Services for Manufacturing on BVR
Easy Plan Active Workspace Infrastructure

Corporate Server Teamcenter Foundation
FMS Server Cache
Translation Service Database Module
Classification Interface
NX Part Family Classification Integration

Volume Server FMS Server Cache

Rich Client 2-tier Teamcenter Rich Client 2-tier
Translation Service Database Module
Classification Interface
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Solution Features

Rich Client 4-tier Teamcenter Rich Client 4-tier
Translation Service Database Module
Classification Interface

Rich Client (2-tier and 4-
tier)

Teamcenter Rich Client (2-tier and 4-tier)
Translation Service Database Module
Classification Interface

Business Modeler IDE Business Modeler IDE Standalone

Dispatcher (Dispatcher
Server)

Dispatcher Server

Multisite Collaboration
Proxy Server

Teamcenter Foundation
Translation Service Database Module
Multisite Collaboration IDSM Service
Multisite Collaboration ODS Service
Classification Interface
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Teamcenter features

TEM provides a comprehensive list of features (applications and components) in the Features panel.
Features are grouped by related applications.

For information about a feature, such as its prerequisite features, point to the feature name in the list.
TEM displays a description of the feature.

To search for a feature by name, enter a keyword in the Search box, then click the search button. To see
the next search result, click the search button again.

Teamcenter features

Teamcenter Installation on Windows Using TEM, Teamcenter 2412  26-3
© 2025 Siemens



Some features are disabled because they require other features. To enable a feature, select its
prerequisite features. For information about prerequisite features, see the feature description.

Some features are mutually exclusive and cannot be installed in the same configuration, so selecting one
disables the other.

Features are organized into the following major feature groups:

• Base Install features

• Active Workspace Client features

• Indexing Server features

• Active Workspace Server Extensions features

• Visualization Server features

• Dispatcher features

• Server Enhancements features

• Microservices features

• Teamcenter Extensions features

• Miscellaneous features

Base Install features

The following features are in the Base Install feature group in Teamcenter Environment Manager (TEM).

To search for a feature by name, type the name or a partial name in the search box, and then click the
search icon.

Feature/Subfeature Description

Teamcenter
Foundation

Installs the complete Teamcenter application root directory (TC_ROOT), including the Teamcenter server
process (tcserver), and either creates a data directory for storing database-specific files or configures
this installation to connect to an existing data directory.

If you create a data directory, you also provide information about the database to use with this
installation. If you specify a new database, Teamcenter Environment Manager populates the database
and creates a volume.
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Feature/Subfeature Description

Installing Teamcenter Foundation is optional only when you install the following components: the
Multi-Site Collaboration proxy servers, File Management System, online help, or sample files. When
you install these components, Teamcenter Environment Manager creates an TC_ROOT directory, but
populates it with only the subdirectories necessary for these components to run.

Business Modeler
IDE Standalone

Installs only the Business Modeler IDE client without requiring a connection to a Teamcenter server.

Business Modeler
IDE 2-tier

Installs the two-tier Business Modeler IDE client. This client connects to the Teamcenter server using
TCCS.

Business Modeler
IDE 4-tier

Installs the four-tier Business Modeler IDE client. This client connects to a Teamcenter server in a
four-tier environment using HTTP.

Teamcenter Rich
Client (2-tier and 4-
tier)

Installs a Teamcenter rich client that supports multiple two-tier and four-tier connections using
Teamcenter client communication system (TCCS).

This rich client differs from the two-tier rich client that connects directly to the Teamcenter server using
TCCS, and from the four-tier rich client that connects directly to the Teamcenter web tier using HTTP
protocol.

This TCCS-based rich client architecture streams responses from the Teamcenter server (tcserver) to the
client through a multiplexing proxy, or MUX, that is part of Teamcenter Enterprise Communication
System (TECS), a Java component of the Teamcenter enterprise tier. The MUX supports four-tier
communication through its internal Jetty HTTP server, which services requests from the Teamcenter
web tier. The MUX communicates with the tcserver using Teamcenter Transfer Protocol (TCTP).

Teamcenter Rich
Client 2-tier

Installs a Teamcenter two-tier rich client that communicates with the Teamcenter corporate server using
TCCS. It supports most Teamcenter features and does not require a web tier.

Teamcenter Rich
Client 4-tier

Installs a four-tier rich client that connects directly to the Teamcenter web tier using HTTP protocol.

This rich client is an alternative to the newer four-tier rich client provided by the Teamcenter Rich
Client (2-tier and 4-tier) feature, which communicates with the Teamcenter web tier using Teamcenter
client communication system (TCCS).

TcRS Multisite
Enablement

Select this feature to enable multisite collaboration between Teamcenter Rapid Start and Teamcenter
sites for OOTB objects.

Note:

Multisite collaboration for OOTB objects between Teamcenter Rapid Start 12.x, and any version
of Teamcenter or Teamcenter Rapid Start prior to 12.x, is not possible.

Teamcenter Rich
Client (Lite Edition)

Installs a rich client and configures it for use with the NX Manager feature. This feature requires NX
Manager for Rich Client.

Active Workspace Client features

Active Workspace client features are available in Base Install>Active Workspace>Client feature group
in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search icon.

Feature Description

Active Workspace Gateway Installs the Active Workspace Gateway, a web application framework that resides between
the Active Workspace client application and your browser. The Gateway communicates with

Teamcenter features
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Feature Description

the Teamcenter server, the File Repository, and the volume server, and routes incoming
requests for static and dynamic content to the appropriate services handling those requests.

Active Workspace Client Selecting this feature builds the Active Workspace client.

3D Visualization Adds 3D visualization to the Active Workspace client.

Access Manager Client Adds support for managing Access Rule definitions in Active Workspace.

Active Collaboration Client Adds workflow capabilities of Active Collaboration to the client interface.

If you are installing this feature in the Client, you must install the Active Collaboration Server
Extensions feature in the corporate server.

Active Workspace Assistant
Client

Installs client components of the Assistant, a guided navigation tool for Active Workspace. It
predicts the next likely actions a user will perform based on the user's history, group, and role,
and presents suggested actions in the Assistant panel.

This feature requires the Active Workspace Assistant server extension feature on the
Teamcenter server.

Active Workspace
Visualization 2D Viewer

Adds the 2D Viewer to the Universal Viewer in Active Workspace. Requires the Visualization
Server.

Assignment Matrix Active
Workspace Client

Assignment Matrix is a mechanism to pre-define Assignee(s) for combinations of Assignment
Type and Target property values.

Audit Client Adds Audit Manager features to the Active Workspace client.

For more information, see Audit Manager in the Teamcenter help collection.

Content Management Client Adds Content Management support to Active Workspace.

DPV for Active Workspace
Client

Adds Dimensional Planning and Validation functionality to the client interface.

Document Management
Client

Installs Document Management support for the Active Workspace client.

Electronic Design
Automation

Adds Electronic Design Automation (EDA) support in the Active Workspace client.

Google Online Viewer Client Installs the Google Online Viewer, which enables Google Online features within Active
Workspace, such as viewing and editing Microsoft Office documents without the need for
Microsoft Office applications.

IP Management Active
Workspace

Provides a product lifecycle management solution for semiconductor manufacturers to
manage IP data using Teamcenter.

Initiative Lifecycle
Management - CPG
Reference Implementation
Active Workspace Client

Installs Initiative Lifecycle Management (ILM) support for the Active Workspace client,
with objects and processes specific to the Consumer Packaged Goods industry. For more
information, see Initiative Lifecycle Management ─ CPG Reference Implementation.

Initiative Planning Active
Workspace

This feature provides capability to create, discover and realize an Idea leading to the creation
of project. It also provides capability to create and manage campaigns. For more information,
see Initiative Planning.

Logical Object Allows users to access logical object data in the client interface.

Marine Integration Installs client-side support for Marine Integration in Active Workspace. This functionality
supports lifecycle management of electrical equipment and cables that connecting them,
provided by various electrical design tools. The feature enables creation of BOM structures for
electrical equipments and cables.

Multisite Integration Enables certain Multi-Site Collaboration capabilities in Active Workspace. Users can publish
objects for access by remote sites, check in and check out objects, and receive and update
objects from remote sites. Administrators can use the Multi-Site Dashboard to monitor the
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Feature Description

Multi-Site federation, viewing related issues through charts, graphs, and detailed object
reports.

NX Logical for Active
Workspace Client

This feature configures the Teamcenter installation to support logical model for the NX
diagramming application in Active Workspace. This feature allows users to view and navigate
diagramming sheets and logical model content in the Active Workspace client.

Office Online Viewer Client Installs the Office Online Viewer Client that enables you to edit Microsoft Office documents
within Active Workspace.

This feature requires Microsoft Office Online to be installed in your environment.

Order Management Installs Order Management support for the Active Workspace client. Order Management
manages the lifecycle of an order from inquiry to sales order. A customer inquires about
products, a sales person responds with the offer containing configurable products. Once the
offer is accepted by the customer, a sales order is created that refers to the configurable
products.

Product Configurator Adds Product Configurator features to the Active Workspace client. Product Configurator
enables you to formally introduce and manage variability across your product suite.

For more information, see Product Configurator in the Teamcenter help collection.

Program Planning Enables the Program Management capability in Active Workspace. This feature provides the
ability to manage business investments, from planning to execution, in terms of time, reuse,
volume, cost targets, and weight targets.

If you are installing this feature, you should also install the Program Planning feature under
Server Extensions.

Reactive Logging Installs valuable troubleshooting tools that enable you to record a problem in a log file to
share with the Teamcenter administrator.

By default, reactive logging provides the user with the log file location and machine
information. To configure this behavior, set the following preferences:
TC_reactive_log
ging_notificatio
n_list

Notifies administrator regarding log ZIP file.

TC_reactive_log
ging_file_downl
oad

Displays message to the user with a link to the downloaded file in Active
Workspace.

Reporting Adds the ability to view report templates, generate reports based on selected criteria, style
sheets, or both, and view them in HTML, Excel, or raw XML formats in the client.

If you are installing this feature in the Client, you must install the Reporting Server
Extensions feature in the corporate server.

Additionally, to allow for asynchronous report generation, install the AsyncService translator
in the Dispatcher Server.

Schedule Manager Enables Schedule Manager capabilities in Active Workspace.

If you are installing this feature, you must also install the Schedule Manager feature under
Server Extensions on the corporate server.

Stock Material Adds stock material management features for the Active Workspace client.

Many parts are made from stock materials such as bar stock, tubing stock and sheet stock.
This features enables you to manage stock materials in Teamcenter, performing actions like
creating libraries of stock materials and assigning stock materials to parts.

For more information, see Aerospace and Defense Solution in the Teamcenter help collection.

Subscription Allows users to manage subscriptions and notifications in the client.

Teamcenter features
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Feature Description

If you are installing this feature in the Client, you must install the Subscription feature under
Server Extensions in the corporate server.

Teamcenter Share
Collaboration client for
Active Workspace

Installs support for the Teamcenter Share collaboration in the Active Workspace client.
Teamcenter Share is a cloud application that allows you to share and collaborate on
project files with your partners, team members, and manufacturers. In this browser-based
collaboration, you can develop new products and designs, then share your projects with
customers for approval or manufacturers for production. Teamcenter Share controls and
secures file access, and maintains history of file sharing and exchange. For more information
about Teamcenter Share collaboration, see Teamcenter Share collaboration in Active
Workspace.

Work Package Management Installs work package management, which helps designers to create and maintain a work
package as a revisable collection of CAD files and documentation.

To install this feature, you must install the Work Package Management feature for both
server and client features for Active Workspace.

Rules of Credit Active
Workspace

Adds Rules of Credit functionalities to Active Workspace client.

3D Clearance Adds 3D clearance analysis and the 3D Clearance toolbar to Lifecycle Visualization.

Contract Data Management Installs Contract Data Management, which helps contractors manage the creation, review,
and delivery of contracts. A contract is a structured procurement document that lists
milestones and schedule dates.

If you are installing this feature, you must also install the Contract Data Management
Server Extensions feature on the server and the Contract Data Management feature under
Enterprise Knowledge Foundation.

Initiative Lifecycle
Management (ILM) Active
Workspace Client

Installs support for Initiative Lifecycle Management (ILM) in the Active Workspace client. This
solution unifies business processes from ideation to production. This includes management
of campaigns, ideas, programs, and projects. ILM leverages program planning capabilities
and combines those with process groups that distribute work to participants. For more
information, see Initiative Lifecycle Management in the Active Workspace documentation.

Markup Enables markup capabilities in the client interface.

Product Configurator Hosting Enables Product Configurator in Active Workspace in hosted mode for non-Active Workspace
clients.

Workflow For users to access Inbox components and workflow functionality in the Client interface, this
feature must be installed.

If you are installing this feature, you must also install the Workflow feature under Server
Extensions on the corporate server.

Master Document Register
and Transmittals (MDR&T)

Adds Master Document Register and Transmittals functionalities to Active workspace Client.

Active Content Adds structure search functionality to the client interface.

If you are installing this feature in the Client, you must install the Active Content Structure
Server Extensions feature in the corporate server.

Digital Signatures Adds digital signatures functionality to the client interface.

Before selecting this feature, see the additional setup requirements for digital signatures in
Active Workspace Customization.

If you are installing this feature in the Client, you must install the Digital Signatures Server
Server Extensions feature in the corporate server.

Linked Data Framework Provides a framework to link a Teamcenter business objects with an artifact of a remote
linked data enabled system. It enables rendering the remote system's delegated UIs in Active
Workspace.
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Feature Description

If you are installing this feature, you should also install the Linked Data Framework feature
under Server Extensions.

Viewer Snapshot Tool Installs the viewer snapshot tool for 3D visualization in Active Workspace.

4th Generation Design Allows users to view, navigate, and configure collaborative designs and their content in the
Client.

If you are installing this feature in the Client, you must also install the 4th Generation Design
Server Extensions feature, the Active Content Structure Server Extension feature, and the
4th Generation Design (under Advanced PLM Services) feature on the corporate server.

In addition to the Active Workspace Client feature, requires the Active Content Client
feature.

Advanced Multi-Schema
Exchanger

Adds the capability to create mapping rules to transform data when it is transferred between
Teamcenter sites using different schemas. You can create mapping rules for the item types in
your source schema or for subsets of item types in the schema as defined by schema subsets
attached to Briefcase files. See the PLM XML/TC XML Export Import Administration guide for
more information about creating, validating, and attaching mapping rules.

Assembly BOM Installs all required dependencies and configurations for enabling Assembly EBOM with
Design BOM Alignment automation for EBOM Level I and II products.

Briefcase Browser Enables the Briefcase file preview and comparison features in the Active Workspace client.

Briefcase Export and Import Enables the ability to collaborate with online and offline sites by importing and exporting
Teamcenter data packaged in Briefcase files. Other sites can optionally update the Teamcenter
objects and return the data to the originating site.

Also enables the ability to extract data from one Teamcenter environment to copy to another
using bulk loading tools.

Change Management Adds the ability to work with Change Management objects in the client.

If you are installing this feature in the Client, you must install the Extensions→Enterprise
Knowledge Foundation→Change Management feature in the corporate server.

Easy Plan - Opcenter
Integration Client

Installs the Easy Plan - Opcenter Integration Client.

Finish Management Installs Finish Management support for Active Workspace. A finish represents a finishing
process on a part. It may be used to improve appearance, adhesion, corrosion resistance,
tarnish resistance, chemical resistance, wear resistance, and remove burrs and so on.

For more information, see Aerospace and Defense Solution in the Teamcenter help collection.

Hazard and Risk Analysis Enables support of Hazard and Risk Analysis of system of models and functions.

Integrated Manufacturing
BOM Client

Installs support for integrated BOM management.

MCAD Integration In addition to the Active Workspace Client feature, requires the Active Content Client
feature.

Material Management Enables Active Workspace users to:

• Associate a material revision with a vendor part or an item revision.

• Associate a substance with a material revision.

• View the material/substance dashboard.

If you install this feature, you should also install the Material Management feature (under
Server Extensions) on the corporate server.
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Medical Device Foundation Installs Active Workspace client support for product development processes for medical
device manufacturers. This feature assists in ensuring compliance with regulatory guidelines,
accelerating innovation in development, and reducing costs.

NX Integration for Active
Workspace

Enables users to access NX integration functionality from the client interface.

If you are installing this feature, you should also install the NX for Active Workspace feature
(under Server Extensions) on the corporate server.

PLMXML Export Import Enables the ability to share data with organizations not using Teamcenter or for use with
third-party applications. You can use PLM XML to share Teamcenter objects such as items,
datasets, BOMs, forms, and folders.

Part Manufacturing Client Adds part manufacturing support in the Active Workspace client.

Partitions for Structure Installs client support for partitions and partition schemes for structures.

Product Configurator
Extension for Easy Plan

Adds support for Product Configurator in Easy Plan. Product Configurator allows you to enable
definitions for variant formulas on operations.

Please see the Product Configurator (Administrator) documentation for installation details.

By default, Easy Plan uses classic variants.

Product Master Automation Installs product master automation for the Active Workspace client.

Requirements Management Allows users to author a requirement structure in the Content tab of the client.

In addition to the Active Workspace Client feature, requires the Active Content feature.

If you are installing this feature in the Client, you must install the Requirements
Management and Systems Engineering features under Server Extensions on the corporate
server.

Note:

This feature is required to enable the Export to Excel button in Active Workspace.

SLM Core Client Provides core Service Lifecycle Management functionality for Active Workspace.

Solution Variant Support for
Active Workspace

Adds Product Configurator capabilities for Active Content Structure, such as creating and
managing solution variant structures for configurable generic assemblies.

Supplier Foundation This is a base solution for all the supplier solutions that will be developed for Teamcenter X.

Supplier Program Planning This is a program planning solution for supplier solutions that will be developed for
Teamcenter X.

Teamcenter Simplified Client Provides a simplified experience of Teamcenter for small- and medium-sized business
customers. User Experience (UX) redundancies and outlying commands are removed. This
allows users to quickly work on designs, documents and parts within their organization
without additional configuration.

Vendor Management Allows Active Workspace users to:

• Associate vendors with vendor parts.

• Associate vendor parts with commercial part revisions.

If you are installing this feature, you should also install the Vendor Management feature
under (Server Extensions) on the corporate server.

Active Workspace Weight
And Balance Management

Enables interaction with Weight and Balance Management in the Active Workspace client.
This supports functionality such as specifying weight and balance attributes for parts or
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assemblies, and performing their rollup. For more information, see Structure Management ─
Deployment and Administration.

Aerospace and Defense
Foundation

Adds the Aerospace and Defense Foundation feature to the Active Workspace client.

This feature is not selectable unless the following features are also selected:

If you are installing this feature in the Client, you must install the Aerospace and Defense
Foundation Server Extension feature in the corporate server and the following Active
Workspace Client features:

• Workflow
• Active Collaboration
• Active Content
• Vendor Management

Capital Asset Lifecycle
Management

Adds management of plant data for the Active Workspace client.

Embedded Software
Management

Adds Embedded Software Solutions functionality, which allows you to represent embedded
software artifacts using Active Workspace.

Enterprise Service BOM
Client

Adds support to facilitate the creation of physical structure from collaborative product EBOM
object.

Functional Safety Enables Teamcenter to conduct functional safety analysis on system models using HARA and
FMEDA.

Next Generation Planning
Client

Adds Next Generation Planning (NGP) support to Active Workspace.

Non-Functional Change
Management

Allows users to make non-functional changes in their parts. Non-functional changes are
changes which do not affect the fit, form, or function of the part.

PDX Export Installs support for exporting data as a PDX package. This package can be viewed by PDX
viewer applications or used by other systems that support the PDX data format. You can also
create a PDX package using a workflow process by specifying the workflow handler provided
for PDX packages.

Service Engineering Client Provides service engineering support for Service Lifecycle Management in the Active
Workspace client.

Service Manager Client Provides client-side support for Service Manager, which allows users to view disposition and
utilization history of physical parts.

Service Planning Client Provides the Active Workspace searching and BOM (Bill of Materials) extensions necessary to
support the SLM Service Planning in an Active Workspace environment.

Substance Compliance Installs support for Substance Compliance in Active Workspace.

Supplier Connect Active Workspace Supplier Connect client.

Easy Plan – Classification
Client

Adds support for Classification data in Easy Plan.

Electronic Work Instructions
Client

Installs the Electronic Work Instructions Client workspace in your environment.

Medical Device Submissions
for Active Workspace

Provides support for performing end-to-end medical device label authoring, object-based
content management, Unique Device Identifier (UDI) data management and submissions for
medical industry customers.

Resource Manager for Active
Workspace Client

Adds Manufacturing Resource Library support for the Active Workspace client.

For information about using Manufacturing Resource Library, see the Teamcenter help library.

Retail Footwear and Apparel Installs client components of the Retail Footwear and Apparel solution, which manages
products in the retail industry.
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Semiconductor Foundation
Active Workspace

Provides support for semiconductor manufacturers to manage their semiconductor design
and manufacturing data using Teamcenter.

Service Work Instructions
Client

This feature provides the functionality to build and view the Service Lifecycle Management
(SLM) Service Work Instructions for Active Workspace. This content represents extensions
necessary to support Service Work Instructions in an Active Workspace environment.

Substance Compliance-IMDS
Integration

Installs support for the Teamcenter Substance Compliance-IMDS Integration in Active
Workspace.

Substance compliance checks whether the parts used in your company products conform to
environmental regulations. International Material Data System (IMDS) is a third-party system
for exchanging material and substance information with suppliers. Automotive companies
use IMDS to collaborate with suppliers for material and substance declaration information.
Teamcenter is integrated with IMDS to send material data sheet (MDS) requests to IMDS and
to download the MDSs, uploaded by suppliers, from IMDS to Teamcenter.

This feature is deprecated and will be removed in a future version of Teamcenter. It is not
available to install in a new Teamcenter configuration.

Supplier Collaboration Installs support for Supplier Collaboration in Active Workspace. Teamcenter Supplier
Collaboration is a framework that helps companies manage their supply chains.

This feature is deprecated and will be removed in a future version of Teamcenter. It is not
available to install in a new Teamcenter configuration.

EWI Offline Client Installs EWI offline kits and EWI offline rendering services necessary for rendering offline
electronic work instructions.

Easy Plan - Process Planning
for ETO Client

Installs client support for the Engineering to Order (ETO) workspace in your environment.

This feature allows end users to author work instructions at the process station level.

Machine Builder Installs support for the Machine Builder solution in Active Workspace. This solution provides
a single-source data management system focused on the engineering, manufacturing and
product life BOM. This solution is designed to enable industrial machinery customers to move
from CAD data management to engineering process management, integrating requirements
management, project management, and change management.

Process Planning for
BTO/BTS/CTO

Installs support for the Process Planning workspace for build-to-order (BTO) or build-to-stock
(BTS), or configure-to-order (CTO) in your environment.

Easy Plan - Electronics Client Installs client support for the Easy Plan Electronics Process Planner workspace in your
environment.

Electronics engineers use Production Process Planning for the systems integration of the
electronics process planning tasks of Easy Plan and those of Valor Process Preparation
Software. The systems integration is available as a dedicated, optional feature of Production
Process Planning.

MDR&T and IPP&E Interface Provides an interface between Master Document Register and Transmittal (MDR&T) and
Integrated Program Planning and Execution (IPP&E).

The Master Document Register (MDR) is an agreed list of deliverables in the form of
documents that are associated with a contract between an owner/operator (o/o) and an
engineering, procurement and construction (EPC). The process of exchanging information
and submitting these deliverable documents to external stakeholders namely, the customers,
vendors, or external parties is termed as the Transmittal process.

Integrated Program Planning and Execution (IPP&E) allows project planning that integrates
cost, schedule, risk and technical requirements in a fully planned, resourced, and budgeted
program. It allows configuration control not only of products but also of the project plan. It
also communicates the status of requirements to users.
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Supplier Change
Management

The base solution for all the supplier solutions that will be developed for Teamcenter X.

Component Manufacturer
Active Workspace

Provides a specialized user interface in the Active Workspace client for component supplier
customers that simplifies management of projects and programs.

Active Admin Features to support active admin capabilities.

Preference
Management

Adds preference management to the active admin workspace.

CÆ Simulation Management Features to support management of computer-aided engineering (CAE) data.

Simulation
Process
Management

In addition to the Active Workspace Client feature, requires the Active Content Client
feature.

If you are installing this feature, you must also install the Simulation Process Management
Server Extensions feature on the corporate server.

Extended
Simulation
Process
Management

Extends Simulation Process Management capabilities in Active Workspace.

Simulation
Process
Management
with Git
Integration

Configures the Teamcenter installation to support the MBSE Git Integration data model and
functionalities in Simulation workflows.

Simulation
Process
Management
with
Measurable
Attribute for
Active
Workspace

Configures the Teamcenter installation to support Measurable Attribute and Target
Management data models and functionality in Simulation workflows.

Simulation
Process
Management
with
Parameter
Management

Provides support for Parameter Management data model and functionalities in Simulation
workflows.

Integrated Program Planning
and Execution

Integrated Program Planning and Execution (IPP&E) client features. The IPP&E solution allows
project planning that integrates cost, schedule, risk and technical requirements in a fully
planned, resourced, and budgeted program. It allows configuration control, not only of
products, but also of the project plan. It also communicates the status of requirements to
users.

IPP&E
Contract Data
Management
Extension

Adds Contract Data Management support to IPP&E.

Organization
Breakdown
Structure

Adds Organization Breakdown Structure (OBS) support to IPP&E.

IPP&E
Foundation

Provides essential functionality for Integrated Program Planning and Execution in Active
Workspace.
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Work
Breakdown
Structure

Adds Work Breakdown Structure (WBS) support to IPP&E.

Program Planning Execution
Client

Program Planning Execution features for the Active Workspace client.

Change
Management
Schedule
Manager
Client

Allows interaction between Schedule Manager and Change Management in Active
Workspace. It allows Active Workspace users to relate schedules and change objects.

If you are installing this feature in the Client, you must install the Change Management
Schedule Manager Server Extension feature in the corporate server and the following Active
Workspace Client features:

• Schedule Manager

• Workflow

• Change Management

Program
Change Client

Allows interaction between Program Planning Event Change and Change Management
in Active Workspace. It allows Active Workspace users to relate programs, projects, and
subprojects to change objects.

If you are installing this feature in the Client, you must install the Program Change Server
Extension feature in the corporate server and select the following Active Workspace Client
features:

• Program Planning

• Workflow

• Change Management

Program
Planning
Event Change
Client

If you are installing this feature in the Client, you must install the Program Planning Event
Change Server Extension feature in the corporate server and select the following Active
Workspace Client features:

• Program Planning

• Workflow

• Change Management

• Program Change Client

Program
Schedule
Manager
Client

If you are installing this feature in the Client, you must install the Program Change Server
Extension feature in the corporate server and select the following Active Workspace Client
features:

• Program Planning

• Schedule Manager

• Workflow
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• Change Management

• Program Change Client

• Program Planning Event Change Client

Reuse and Standardization Features to support Reuse and Standardization in the Active Workspace client.

Classification
Client

Allows users to access Classification data in the client interface.

Teamcenter
Classification
Collector
(earlier called
Library
Management
)

Installs the client component required to view classification libraries. Classification libraries
contain subsets of a classification hierarchy pertinent to a particular role, project, or use case.

Teamcenter Quality Features to support Teamcenter Quality.

Quality
Manager

Adds Quality Manager to the Active Workspace client.

For more information, see Quality in the Active Workspace help.

Reminder and
Escalation
Management

The Reminder and Escalation Management provides mechanism to process notifications and
escalation capability based on criteria defined for Teamcenter Business objects which helps to
track progress of defined task. This is generic solution and can be used by any application to
remind the due tasks at right time and also set up escalations at desired level if it is getting
delayed.

Training and
Qualification
Client

Adds client support for training and qualification actions in Active Workspace.

Quality
Action
Management
Client

Adds support for quality actions in the Active Workspace client.

For more information, see Quality in the Active Workspace help.

Failure Mode
Effect and
Analysis
(FMEA) Client

Adds support for Failure Mode Effect Analysis (FMEA) standards to the Active Workspace
client.

For more information, see Quality in the Active Workspace help.

Quality Issue
Management
and Problem
Solving

Adds Issue Manager and Problem Solving support for the Active Workspace client.

Control and
Inspection
Plan Client

Installs support for control and inspection planning in the Active Workspace client.

Control and inspection planning allows you to manage critical characteristics of Failure Mode
Effect Analysis (FMEA) and create a control plan that generates bill of process (BOP) elements.

APQP
Program
Management

Adds support for Quality Project Management (APQP) methodology in the Active Workspace
client.

For more information, see Quality Project Management.

Quality Audit Adds support for quality auditing in the Active Workspace client.

For more information, see Quality in the Active Workspace help.
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Supplier
Quality
Management

Provides support for Supplier Quality Management in the Active Workspace client.
This application enables you to perform Supplier Quality management operations with
applications like Vendor Management, Advance Product Quality Planning, and Quality Issue
Management and Problem Solving. Supplier Quality Management is used to evaluate vendor
performance based on quality issues and problem solving processes initiated for supplied
materials or parts. It can also assess a vendor using a quality checklist.

Model-Based Systems
Engineering

Features to support Model-Based Systems Engineering in the Active Workspace client.

Digital
Thread
Navigation

Adds Digital Thread Navigation capabilities to Model-Based Systems Engineering.

Parameter
Management

Adds parameter management to Active Workspace.

System
Lifecycle
Manager

Installs client support for the System Lifecycle Manager solution, with provides system
modeling functionalities such as the following:

• Tool neutral object-based information model
• Model interface management
• Branching, versioning and merging
• Model reuse (ID card, Library)
• Architecture visualization and reviews
• Multi-domain toolset interoperability
• Integrated change management

Teamcenter
Test
Management
Active
Workspace

Adds test management support to Model-Based Systems Engineering (MBSE).

Physical
Verification
Management
Active
Workspace

Adds support for inspections and physical tests in the Active Workspace client.

Active Architect Features to support Active Architect for Active Workspace.

UI Builder Installs UI Builder components of active architect. UI Builder adds new declarative pages to
the global navigation toolbar in Active Workspace, including:

• Command builder

• Panel builder

Consumer Packaged Goods Features to support Consumer Packaged Goods in the Active Workspace client.

Formulation
& Material
Management

Enables Teamcenter to create Material Management objects like Component Specification,
Parameter and substance.

Brand
Management

Installs the Brand Management template for Consumer Packaged Goods.

Packaging
and Artwork

Installs packaging and artwork functionality for Consumer Packaged Goods.

Specification
Management

Installs Specification Manager functionality for Consumer Packaged Goods.
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Consumer
Product
Management
Active
Workspace

Installs consumer product management functionality for Consumer Packaged Goods.

MBSE Integrations Model Management applications for the Active Workspace interface.

MBSE
Services
Active
Workspace
Client

Installs services to support the MBSE Integration Gateway in Active Workspace.

Indexing Server features

Indexing server features are available in the Base Install>Active Workspace>Indexing Server feature
group in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search icon.

Feature/
Subfeature

Description

Search Engine Installs the Solr enterprise search platform. The search engine stores indexed Teamcenter data for global
search in Active Workspace.

Selected product data is indexed in Solr, an open source search platform from Apache. The master product
data is not stored in Solr. It is always loaded from Teamcenter.

Indexer Installs a four-tier SOA client that exports Teamcenter data for merging into Solr. The indexer manages
overall indexing processes. TcFTSIndexer manages the initial indexing for object data. You can then schedule
synchronization to run periodically for subsequent updates to object data or structure data indexes.

TcFTSIndexer indexes external and Teamcenter objects into Solr. It connects to the server manager to query
and extract Teamcenter data to be indexed into Solr.

Active Workspace Server Extensions features

Active Workspace Server Extensions features are available in the Base Install>Active
Workspace>Server Extensions feature group in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature Description

Active Workspace Adds binaries to TC_ROOT and data model changes to the database and TC_DATA. It adds the
Active Workspace (aw3_template.xml) template to the database.

Rules of Credit Adds functionalities related to Rules of credit. Rules of Credit is a mechanism to pre-define various
progress values for Deliverables in a quantitative way, which can help to capture and report the
progress of Deliverables at a given time.
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Active Architect Core Installs core capabilities of Active Architect.

Active Collaboration Allows users to communicate between themselves using Active Workspace.

Adds the Active Collaboration (ac0activecollaboration_template.xml) template to the
database.

If you are installing this feature, you should also install the Active Collaboration feature (under
Client) when building the Client web application.

Active Content Structure If you plan to index structure data, you must install this feature. It provides functionality and data
model extensions necessary for indexing structure data. It adds the Active Content Structure
(activeworkspacebom_template.xml) template to the database.

If you are installing this feature, you should also install the Active Content feature (under Client)
when building the Client web application.

Advanced PLM Services
Core

Adds Advanced PLM Services capabilities to 4th Generation Design in Active Workspace.

Active Workspace
Assistant

Installs server support for the Assistant, a guided navigation tool for Active Workspace. It predicts
the next likely actions a user will perform based on the user's history, group, and role, and
presents suggested actions in the Assistant panel. This feature requires the Command Prediction
Service microservice and a database for the microservice to store data for the Assistant. TEM
prompts you for the necessary database creation values during installation.

To enable client support for the Assistant, install the Active Workspace Assistant client feature.

Active Workspace
Document Management

Adds support for document management in Active Workspace.

Audit Adds Audit Manager capabilities to Active Workspace.

For more information, see Audit Manager in the Teamcenter help collection.

Authorization Active
Workspace

Adds Active Workspace authorization components.

Data Exchange
Transaction Monitor

Installs an Active Workspace tool that lets you view records of Teamcenter data shared
between sites. Transactions monitored include those made using Multi-Site tools (such as
data_share, data_sync, rich client remote export/import, and Active Workspace share/retrieve)
and data exchange tools such as Briefcase import/export. For more information, see Teamcenter
Administration.

Digital Signatures Adds digital signatures functionality to the server. It does not add a database template.

Before selecting this feature, see the additional setup requirements for digital signatures.

If you are installing this feature, you should also install the Digital Signatures feature (under
Client) when building the Client web application.

Google Online Viewer Installs server support for the Google Online Viewer, which enables Google Online features within
Active Workspace, such as viewing and editing Microsoft Office documents without the need for
Microsoft Office applications.

In-Context Change Adds in-context change support to Active Workspace.

Multisite Integration Adds multisite reporting that enables administrators to identify underlying data issues before
multisite import or export.

Office Online Viewer Installs viewer support for Microsoft Office Online documents.

Order Management Installs Order Management support for Active Workspace. Order Management manages the
lifecycle of an order from inquiry to sales order. A customer inquires about products, a sales
person responds with the offer containing configurable products. Once the offer is accepted by the
customer, a sales order is created that refers to the configurable products.
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Program Planning Enables the Program Management capability in Active Workspace. This feature provides the ability
to manage business investments, from planning to execution, in terms of time, reuse, volume,
cost targets, and weight targets.

This feature adds the Program Planning for Active Workspace
(pgp0awprgplanning_template.xml) template to the database.

This feature is not selectable unless the Program Planning Infrastructure feature (under
Extensions) is also selected.

If you are installing this feature, you should also install the Program Planning Client feature
(under Client ) when building the Client web application.

Reporting Provides the ability to view report templates, generate reports based on selected criteria, style
sheets, or both, and view them in HTML, Excel, or raw XML formats. It adds the Reporting for
Active Workspace (rb0reportingaw_template.xml) template to the database.

If you are installing this feature, you should also install the Reporting feature (under Client) when
building the Client web application.

Additionally, to allow for asynchronous report generation, install the AsyncService translator in
the Dispatcher Server.

Rules of Credit Active
Workspace

Active workspace template for Rule of Credit functionalities.

Schedule Manager Enables Schedule Manager capabilities in Active Workspace.

It adds the Schedule Manager for Active Workspace
(saw1projectmanagementaw_template.xml) template to the database.

If you are installing this feature, you must also install the Schedule Manager feature (under
Client) when building the Client web application.

Shape Search Provides the binaries and data model extensions for the shape search functionality. It adds the
Shape Search for Active Workspace (shapesearch_template.xml) template to the database. To
use shape search, Geolus must be installed and configured.

If you are installing this feature, you should also install the Shape Search feature (under Client)
when building the Client web application.

Note:

Apache Tomcat and a supported Java runtime environment are required to run Geolus
shape search. See Support Center for software versions certified with Teamcenter.

Stock Material Adds stock material management to Active Workspace.

Many parts are made from stock materials such as bar stock, tubing stock and sheet stock. This
features enables you to manage stock materials in Teamcenter, performing actions like creating
libraries of stock materials and assigning stock materials to parts.

For more information, see Aerospace and Defense Solution in the Teamcenter help collection.

Subscription Allows users to manage subscriptions and notifications. It adds the Subscription
(sub0subscription_template.xml) template to the database.

If you are installing this feature, you must also install the Subscription feature (under Client)
when building the Client web application.

Teamcenter Share
Collaboration Active
Workspace

Installs support for the Teamcenter Share collaboration in Active Workspace. Teamcenter Share is
a cloud application that allows you to share and collaborate on project files with your partners,
team members, and manufacturers. In this browser-based collaboration, you can develop new
products and designs, then share your projects with customers for approval or manufacturers for
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production. Teamcenter Share controls and secures file access, and maintains history of file sharing
and exchange. For more information about Teamcenter Share collaboration, see Teamcenter Share
collaboration in Active Workspace.

Work Package
Management

Adds work package management to Active Workspace.

A work package or package is a collection of CAD files and documentation that an outsourcing
partner uses for building, testing, or maintaining a component or subassembly of a larger product.

Teamcenter helps to create and maintain the package as a revisable collection or a container of
product information and to use in a variety of contexts.

For more information, see Aerospace and Defense Solution in the Teamcenter help collection.

Access Manager Adds the capability to manage access rule definitions in Active Workspace.

Active Workspace
Requirements and
Systems Engineering

Adds support for Requirements and Systems Engineering to Active Workspace.

Concurrent Modeling Adds concurrent modeling support in Active Workspace. Concurrent modeling allows you to
manage models from supported 1D modeling tools in Teamcenter, using the Teamcenter MBSE
Integration Gateway MBSE framework.

Contract Data
Management

Installs Contract Data Management, which helps contractors manage the creation, review, and
delivery of contracts. A contract is a structured procurement document that lists milestones and
schedule dates.

To enable this feature to work in Active Workspace, select the Contract Data Management
feature under Enterprise Knowledge Foundation.

Core Services for
Manufacturing on BVR

Installs the manufacturing core for the BOM view revisions (BVR) data model and adds the
mbc0mfgbvrcore_template.xml template.

DPV Active Workspace Installs the database configuration for DPV in Active Workspace. This feature requires
corresponding Teamcenter f features.

EDA Server Support for
Active Workspace

Adds support for Electronic Design Automation (EDA) to Active Workspace.

For information about installing EDA, see the EDA documentation on Support Center.

IP Management Active
Workspace

Provides a product lifecycle management solution for semiconductor manufacturers to manage IP
data using Teamcenter.

Initiative Planning
Active Workspace

This feature provides capability to create, discover and realize an Idea leading to the creation of
project. It also provides capability to create and manage campaigns. For more information, see
Initiative Planning in the Active Workspace documentation.

Material Management Enables Active Workspace users to:

• Associate a material revision with a vendor part or an item revision.

• Associate a substance with a material revision.

• View the Material/Substance Dashboard.

This feature adds the Material Management for Active Workspace
(mtw0materialmgmtaw_template.xml) template to the database.

This feature is not selectable unless the Material Management feature (under
Extensions>Enterprise Knowledge Foundation) and Active Content Structure (under Server
Extensions) are also selected.
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If you install this feature, you should also install the Material Management feature (under Client)
when building the Client web application.

Part Manufacturing
Active Workspace

Adds Part Manufacturing support to Active Workspace.

Supplier Foundation Supplier Foundation is the base template used by supplier solutions such as PLM for Component
Manufacturers, Automotive Supplier and so on. It cannot be installed by itself.

Teamcenter Integration
for IP Management
Active Workspace

This feature is a Catalyst for Semiconductor industry. It provides PLM solution for Semiconductor
customers to manage their IP data using Teamcenter.

Vendor Management Allows Active Workspace users to:

• Associate vendors with vendor parts.

• Associate vendor parts with commercial part revisions.

This feature adds the Vendor Management for Active Workspace
(vm1vendormanagementaw_template.xml) template to the database.

This feature is not selectable unless the Active Content Structure feature and the Vendor
Management feature (under Extensions>Supplier Relationship Management) are selected.

If you are installing this feature, you should also install the Vendor Management feature (under
Client) when building the Client web application.

Visualization Extension This feature is required to launch the Teamcenter lifecycle visualization standalone application
viewer from the Client interface.

This feature enables Active Workspace 3D viewer functionality. It adds the Active Workspace
Visualization (awv0activeworkspacevis_template.xml) template to the database.

You must install this feature if you install the Visualization Server Manager feature (under
Visualization Server) when building the Client web application.

The Visualization Extension feature is not selectable unless the Active Content Structure feature
is also selected.

Workflow Workflow does not add a template to the database.

If you are installing this feature, you must also install the Workflow feature when building the
Client web application.

For users to access Inbox components and workflow functionality in the Client interface,
Workflow must be installed on the corporate server and Workflow must be installed in the Client
web application.

Easy Plan Change
Management

Adds change management capabilities in Easy Plan. For more information, see the Easy Plan
documentation.

Easy Plan Graphics Adds support for graphics capabilities used in the Work Instructions Authoring workspace.

This feature is automatically selected when you select the Easy Plan Work Instructions Authoring
option in the Features panel.

Electronic Work
Instructions

Installs the server side of Electronic Work Instructions in your environment.

Finish Management Installs Finish Management support for Active Workspace. A finish represents a finishing process
on a part. It may be used to improve appearance, adhesion, corrosion resistance, tarnish
resistance, chemical resistance, wear resistance, and remove burrs and so on.

For more information, see Aerospace and Defense Solution in the Teamcenter help collection.
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Product Configurator Adds Product Configurator functionality for Active Workspace. Product Configurator enables you to
formally introduce and manage variability across your product suite.

For more information, see Product Configurator in the Teamcenter help collection.

Requirements
Management

Allows users to author a requirement structure in the Content tab of the Client. Adds the Active
Workspace Requirements Management (arm0activeworkspacereqmgmt_template.xml)
template to the database.

This feature is not available with Teamcenter Rapid Start.

The Requirements Management feature is not selectable unless the Active Content Structure
feature is also selected.

If you are installing this feature, you must also install:

• Server Extensions>Workflow

• Extensions>Systems Engineering and Requirements Management>Requirements
Management feature on the corporate server.

• Requirements Management feature when building the Client web application.

Retail Footwear and
Apparel

Installs the Retail Footwear and Apparel solution. Retail Footwear and Apparel helps manage
products in the retail industry, enabling collaboration with the vendors and manufacturers. See
the Retail Footwear and Apparel documentation for more information.

Substance Compliance Installs support for Substance Compliance, which checks if the parts used in your company
products conform to environmental regulations. Teamcenter helps verify if the products are
environmentally compliant by checking the material and substance information for in-house parts
and supplier parts used in the products.

Supplier Collaboration Installs the Supplier Collaboration solution.

Teamcenter Supplier Collaboration is a framework that helps companies manage their supply
chains.

This feature is deprecated and will be removed in a future version of Teamcenter. It is not available
to install in a new Teamcenter configuration.

Teamcenter
Manufacturing Access

Adds support for Teamcenter Manufacturing Access to Active Workspace.

Teamcenter Manufacturing Access provides solutions for various manufacturing planning tasks
and business processes. It is designed as a cross-industry tool; use it in any environments where
Process Simulate is used.

For more information about Teamcenter Manufacturing Access, see Easy Plan help.

4th Generation
Foundation

Installs 4th Generation Design (4GD) functionality for the Teamcenter server. 4GD allows users of
NX CAD or Lifecycle Visualization to cooperate in real time during the design cycle of a product.

This feature requires corresponding Teamcenter features.

Capital Asset Lifecycle
Management AW

Adds management of plant data to Active Workspace.

EWI Offline Export Utility Installs the offline export service necessary to export electronic work instructions for offline mode.

Embedded Software
Management for Active
Workspace

Installs embedded software management capabilities for Active Workspace.

Manufacturing 4G Core Installs the interface between Next Generation Planning (NGP) and Teamcenter, and adds the
mac0mfgapscore_template.xml template.
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Manufacturing BOM
Manager - Common

Adds Multi-BOM Manager support to Active Workspace. Multi-BOM Manager enables you to link
and assign content across representations for different lifecycle stages or uses for a product.

For information about using this feature, see Mutli-BOM Manager in the Teamcenter help library.

Medical Device
Foundation

Installs Active Workspace server extensions to support product development processes for medical
device manufacturers. This feature assists in ensuring compliance with regulatory guidelines,
accelerating innovation in development, and reducing costs.

Product Configurator
Extension for Easy Plan

Adds support for Product Configurator in Easy Plan. Product Configurator allows you to enable
definitions for variant formulas on operations.

Please see the Product Configurator (Administrator) documentation for installation details.

By default, Easy Plan uses classic variants.

Product Configurator
Support for Active
Content Structure

Installs capabilities related to solution variants in Active Workspace.

Requirements
Management - Quality
Module

Adds Teamcenter Quality functions to Requirements Management.

Substance Compliance-
IMDS Integration

Installs support for the Teamcenter Substance Compliance-IMDS Integration.

Substance compliance checks whether the parts used in your company products conform to
environmental regulations. International Material Data System (IMDS) is a third-party system for
exchanging material and substance information with suppliers. Automotive companies use IMDS
to collaborate with suppliers for material and substance declaration information. Teamcenter is
integrated with IMDS to send material data sheet (MDS) requests to IMDS and to download the
MDSs, uploaded by suppliers, from IMDS to Teamcenter.

This feature is deprecated and will be removed in a future version of Teamcenter. It is not available
to install in a new Teamcenter configuration.

4th Generation Design Allows users to view, navigate, and configure collaborative designs and their content in the Client.

It adds the 4th Generation Foundation (fgd0aw4gfoundation_template.xml) and 4th
Generation Design (fgd0aw4gdesign_template.xml) templates to the database.

The 4th Generation Design feature is not selectable unless the Active Content Structure
feature (under Server Extensions) and the 4th Generation Design feature (under
Extensions>Advanced PLM Services) are also selected.

If you are installing this feature, you must also install the 4th Generation Design feature when
building the Client web application.

4th Generation Process
Planning

Adds Advanced PLM Services capabilities to 4th Generation Design in Active Workspace.

Initiative Lifecycle
Management (ILM)
Active Workspace

Installs support for Initiative Lifecycle Management (ILM) in Active Workspace. This solution unifies
business processes from ideation to production. This includes management of campaigns, ideas,
programs, and projects. ILM leverages program planning capabilities and combines those with
process groups that distribute work to participants. For more information, see Initiative Lifecycle
Management in the Active Workspace documentation.

Machine Builder Installs support for the Machine Builder solution in Active Workspace. This solution provides a
single-source data management system focused on the engineering, manufacturing and product
life BOM. This solution is designed to enable industrial machinery customers to move from CAD
data management to engineering process management, integrating requirements management,
project management, and change management.

Manufacturing BOM
Manager

Adds Multi-BOM Manager support to Active Workspace. Multi-BOM Manager enables you to link
and assign content across representations for different lifecycle stages or uses for a product.
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For information about using this feature, see Mutli-BOM Manager in the Teamcenter
documentation.

Master Document
Register and
Transmittals

Adds functionalities related to MDR&T. Master Document Register and Transmittals enables
streamlined communication and tracking of documents across all stages in the industry.

Medical Device
Submissions for Active
Workspace

Provides support for performing end-to-end medical device label authoring, object-based content
management, Unique Device Identifier (UDI) data management and submissions for medical
industry customers.

Partitions for Structure The Partitions for Structure feature is required to get the partitions that are in turn required to
organize the contents of a product structure.

Process Planning for
BTO/BTS/CTO

Installs the Process Planning workspace for build-to-order (BTO) or build-to-stock (BTS), or
configure-to-order (CTO) in your environment.

Adds these templates to the database:

• Manufacturing core for BVR/Data Model (mbc0mfgbvrcore_template.xml)

• Process Planning Change Management/Data Model (epc0mfgbvrmaturity_template.xml)

• Process Planning Line Balancing/Data Model (elb0linebalancing_template.xml)

• Process Planning Time Analysis/Data Model (ept0timeanalysis_template.xml)

Process planning and
work instructions
authoring for ETO

Installs support for the Engineering to Order (ETO) workspace in your environment.

This feature allows end users to author work instructions at the process station level.

Easy Plan - Opcenter
Integration

Installs the Easy Plan - Opcenter Integration.

Easy Plan for
Teamcenter X

This feature adds support for Easy Plan in Teamcenter X, which is a cloud software-as-a-service
(SaaS) delivery option for Easy Plan.

Electronics Process
Planner

Installs the Easy Plan Electronics Process Planner workspace in your environment.

Electronics engineers use Production Process Planning for the systems integration of the
electronics process planning tasks of Easy Plan and those of Valor Process Preparation Software.
The systems integration is available as a dedicated, optional feature of Production Process
Planning.

Adds these templates to the database:

• Manufacturing core for BVR/Data Model (mbc0mfgbvrcore_template.xml)

• Production Process Planning Change Management/Data Model
(epc0mfgbvrmaturity_template.xml)

• Production Process Planning Line Balancing/Data Model (elb0linebalancing_template.xml)

• Production Process Planning Time Analysis/Data Model (ept0timeanalysis_template.xml)

Initiative Lifecycle
Management -
CPG Reference
Implementation Active
Workspace

Initiative Lifecycle Management (ILM) support for Active Workspace with objects and processes
specific to the Consumer Packaged Goods industry. For more information, seeInitiative Lifecycle
Management ─ CPG Reference Implementation.
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Initiative Lifecycle
Management Overlay
for Semiconductor
Solution

Adds support for program planning and idea management for semiconductor manufacturers.

Manufacturing Change
Management

Adds Change Management capabilities to Manufacturing Process Management.

Manufacturing Resource
Manager (MRL)

Enables Manufacturing Resource Library functionality in Active Workspace, allowing users to
create, search, and manage resources needed for Manufacturing processes.

For information about using Manufacturing Resource Library, see the Teamcenter help library.

Master Document
Register and
Transmittals (MDR&T)
Active Workspace

Active workspace template for MDR&T functionalities.

Semiconductor
Foundation Active
Workspace

Provides a product lifecycle management solution for semiconductor manufacturers to manage
semiconductor design and manufacturing data using Teamcenter.

MDR&T and IPP&E
Interface

An interface between MDR&T and IPP&E.

Change Management Adds support for Change Management in Active Workspace. This feature requires corresponding
Teamcenter Change Management features.

Next Generation
Planning Client

Adds Next Generation Planning (NGP) support to Active Workspace.

Next Generation Planning is the 4G based solution for manufacturing planning. It is suitable for
industries where the product being produced is very large, the number of products being built is
small and the production build starts before final design is complete and continuously changes. It
supports the main business processes like initial/conceptual and detailed manufacturing planning,
and change management.

Component
Manufacturer Active
Workspace

Provides features for component supplier in Teamcenter X that enable you to simplify the user
experience for specific user roles, and more easily manage projects and programs. This application
can help all stakeholders in the engineering process manage engineering data as well as project
data in a simple and synchronized manner.

Active Admin Features to support Active Admin capabilities.

Active Admin Core Installs essential support for the active admin workspace.

Active Workspace
User Management

Adds support for user management in Active Workspace.

Preference
Management

Adds server support for preference management in Active Admin. Preference management
features in the active admin workspace are added by the corresponding Active Workspace client
feature.

Viewer
Administration

Adds viewer administration to the Active Admin workspace in Active Workspace.

Active Architect Features to support Active Architect capabilities.

Client
Configuration

Adds client configuration to the Active Admin workspace in Active Workspace.

Logical Object Adds logical objectsupport to the Active Admin workspace in Active Workspace.

TC XML Import and
Export

Configures Active Workspace to exchange data between different systems. This feature allows the
user to run Advanced Multi-Schema Exchanger for schema mapping.

XRT Editor Adds XRT Editor to the Active Admin workspace in Active Workspace.

Aerospace and Defense Aerospace and Defense features. These allow Active Workspace users to:
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• Create and view parts list: technical documents, parts, drawings, and designs.

• Work with notes: create standard notes and custom notes and attach them to technical
documents, parts, drawings, and designs.

• Work with Aerospace and Defense-related changes: create, edit, and search change requests,
change notices, and deviation requests in alignment with the out-of-the-box Change
Management functionality.

Aerospace
and Defense
Foundation

Adds the Aerospace and Defense Foundation Active Workspace
(ads1awadsfoundation_template.xml) template to the database. This feature is not selectable
unless the following features are also selected:

• Teamcenter Change Management
• Teamcenter Change Management (for Active Workspace)
• Active Workspace Indexing Engine under Active Workspace>Indexing Server
• Active Workspace Indexer under Active Workspace>Indexing Server
• Active Workspace under Active Workspace>Server Extensions
• Active Content Structure under Active Workspace>Server Extensions
• Vendor Management under Active Workspace>Server Extensions
• Aerospace and Defense Foundation under Active Workspace> Server

Extensions>Aerospace and Defense
• Aerospace and Defense Foundation under Active Workspace>Client
• Active Workspace Client under Active Workspace>Client
• Aerospace and Defense Change Management under Active Workspace>Client

Aerospace and
Defense Change
Management

Installs the change management functionality for the Aerospace and Defense Foundation
feature. This feature requires corresponding Teamcenter features.

CAE Simulation
Management

Features to support management of computer-aided engineering (CAE) data.

Simulation Process
Management

Allows Active Workspace users to author Simulation structures in Active Workspace.

It adds the Simulation Process Management Server (cae1caeaws_template.xml ) template to
the database.

The Simulation Process Management feature is not selectable unless the Active Content
Structure feature and the Simulation Process Management feature (under Extensions ) are
also selected.

If you are installing this feature, you must also install the Simulation Process Management
Client feature when building the Client web application.

Extended
Simulation Process
Management

Add extended Simulation Process and Data Management capabilities to Active Workspace.

Simulation Process
Management with
Git Integration

Configures the Teamcenter installation to support the MBSE Git Integration data model and
functionalities in Simulation workflows.

Simulation Process
Management
with Measurable
Attribute for Active
Workspace

Configures the Teamcenter installation to support Measurable Attribute and Target Management
data models and functionality in Simulation workflows.

Simulation Process
Management

Supports parameter management data model and functionality in Simulation workflows.
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with Parameter
Management

Integrated Program
Planning and Execution

Integrated Program Planning and Execution (IPP&E) server extensions features. The IPP&E solution
allows project planning that integrates cost, schedule, risk and technical requirements in a fully
planned, resourced, and budgeted program. It allows configuration control, not only of products,
but also of the project plan. It also communicates the status of requirements to users.

Organization
Breakdown
Structure

Adds Organization Breakdown Structure (OBS) support to IPP&E.

Work Breakdown
Structure

Adds support for authoring Work Breakdown Structure (WBS) hierarchy in Active Workspace from
top to bottom. For information about defining work breakdowns, see Schedule Manager in the
Teamcenter help library.

IPP&E Foundation Provides essential functionality for Integrated Program Planning and Execution in Active
Workspace.

IPP&E Contract
Data Management
Extension

Adds Contract Data Management support to IPP&E.

MRO Service Lifecycle Management features for Active Workspace.

MRO Core Installs the PhysicalPart business object used to designate physical instances of parts for Service
Lifecycle Management.

Service Work
Instructions

Adds support for work instructions to Service Lifecycle Management in Active Workspace.

As-Built for Active
Workspace

Provides searching and BOM extensions necessary to support MRO As-Built capabilities.

This feature is not available with Teamcenter Rapid Start.

In addition to the Active Workspace feature, this feature requires:

• Extensions>Maintenance Repair and Overhaul>As-Built Management

Adds these templates to the database:

• MRO Core, Active Workspace BOM Interface (smr1mrocoreaw_template.xml)

• As-Built (sab1asbuiltaw_template.xml)Program Planning Execution

As-Maintained Installs the As-Maintained feature to support the As-Maintained physical structure management
for Service Manager.

Service
Engineering

Provides service engineering support for Service Lifecycle Management.

Service Planning in
Active Workspace

Provides the searching and BOM (Bill of Materials) extensions necessary to support the SLM
Service Planning in an Active Workspace environment.

Transaction
Processing

Installs transaction processing functionality for Service Request Manager.

Service Processing Installs service processing functionality for Service Request Manager.

Service Event Provides searching and BOM extensions necessary to support MRO Service Event Management
capabilities.

This feature is not available with Teamcenter Rapid Start.

In addition to the Active Workspace feature, this feature requires:
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• Base Install>Active Workspace>Server Extensions>MRO>As-Maintained

• Extensions>Maintenance Repair and Overhaul>As-Maintained Management

• Extensions>Maintenance Repair and Overhaul>Service Event Management

Adds these templates to the database:

• Transaction Processing, Active Workspace BOM Interface
(stp1transactionprocessingaw_template.xml)

• Service Processing, BOM Interface (spr1serviceprocessingaw_template.xml)

• Service Event (sem1serviceeventmgmtaw_template.xml)

Service
Forecasting

Installs service forecasting capability for Service Request Manager.

This feature requires corresponding Teamcenter features.

Service Planning
and Service
Processing
Alignment

Installs the Service Planning functionality for Service Processing in Active Workspace.

Program Planning
Execution

Program Planning Execution features for Active Workspace

Program Change Allows interaction between Program Planning Event Change and Change Management in Active
Workspace. It allows Active Workspace users to relate programs, projects, and subprojects to
change objects.

This feature adds the Program Change (pch0pchinterface_template.xml) template to the
database.

This feature is not selectable unless these features are also selected:

• Change Management under Extensions>Enterprise Knowledge Foundation

• Program Planning under Server Extensions

• Program Planning Infrastructure under Extensions

If you are installing this feature, you should also install the Program Change Client feature (under
Client→Program Planning Execution Client) when building the Client web application.

Program Planning
Event Change

Allows interaction between Program Planning Schedule Manager and Program Change Interface in
Active Workspace. It allows users to relate events to change objects.

This feature adds the Program Planning Event Change (pec0ppeventchange_template.xml)
template to the database.

This feature is not selectable unless these features are also selected:

• Extensions>Enterprise Knowledge Foundation>Change Management

• Extensions>Program Planning Infrastructure
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• Server Extensions>Program Planning

• Server Extensions>Program Change

Program Schedule
Manager

Allows interaction between Schedule Manager and Program Planning in Active Workspace. It
allows users to create plan level items to schedules and supports automatic generation of
schedules within a program.

This features adds the Program Schedule Manager (psi0ppsminterface_template.xml) template
to the database.

This feature is not selectable unless these features are also selected:

• Extensions>Enterprise Knowledge Foundation>Change Management

• Extensions>Program Planning Infrastructure

• Server Extensions>Program Planning

• Server Extensions>Schedule Manager

• Server Extensions>Program Change

• Server Extensions>Program Planning Event Change

Change
Management
Schedule Manager

Allows interaction between Schedule Manager and Change Management in Active Workspace. It
allows users to relate schedules and change objects.

This feature adds the Change Management Schedule Manager
(csi1cmsmawinterface_template.xml) template to the database.

This feature is not selectable unless these features are also selected:

• Extensions>Enterprise Knowledge Foundation>Change Management

• Server Extensions>Schedule Manager

Reuse and
Standardization

Features to support Reuse and Standardization in Active Workspace.

Classification
Server

Allows users to access Classification data in the client interface.

Classification AI Installs the Classification artificial intelligence (AI) engine, which provides assistance in navigating
to desired classes.Classification

After being trained on a database, the engine receives object metadata from the Teamcenter
server and returns the probabilities for potential classes. You can specify which classes are
displayed in the user interface based on these probabilities.

Presentation Layer
- Next Generation
Classification
Server

Installs the Next Generation Classification foundation feature. This option installs the presentation
layer for classification standard taxonomy and for library management.

Teamcenter
Classification
Collector
Server (earlier
called Library

Enables indexing for Library Management business objects. The Library Management Server
feature is not selectable unless the Library Management feature (under Extensions>Reuse and
Standardization) is also selected.
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Management
Server)

Teamcenter Integration
for FORAN

Adds support for FORAN integration with Teamcenter. This feature allows users to publish marine
product models from the FORAN desktop application.

FORAN Integration
for Active
Workspace

Configures the Teamcenter installation to allow users to view and navigate FORAN product model
in the Active Workspace client.

Teamcenter Integration
for NX

Features that support the integration of Teamcenter with NX.

NX Logical for
Active Workspace

This feature configures the Teamcenter installation to support logical model for the NX
diagramming application in Active Workspace. This feature allows users to view and navigate
diagramming sheets and logical model content in the Active Workspace client.

NX Staged
Models for Active
Workspace

This feature adds support to Active Workspace for stage model application for NX. This feature
allows users to publish manufacturing process steps of a design part to Teamcenter from the NX
desktop application.

NX for Active
Workspace

Enables users to access NX integration functionality from the client interface. It adds the NX for
Active Workspace (awn0nx_template.xml) template to the database.

This feature is not selectable unless the NX Foundation feature (under Extensions>Teamcenter
Integration for NX) is also selected.

If you are installing this feature, you should also install the NX Integration feature (under Client)
when building the Client web application.

NX MBSE for Active
Workspace

Adds the NX Integration for Model-Based Systems Engineering.

NX P & ID Active
Workspace

Exposes NX P & ID in Active Workspace so that users can view, navigate, and configure sheets and
their content.

This feature adds the NX P & ID Active Workspace (nxp1pidaws_template.xml) template to the
database.

This feature is not selectable unless these features are also selected:

• NX Foundation under Extensions>Teamcenter Integration for NX

• Active Content Structure under Server Extensions

• 4th Generation Design BOM Management under Extensions>BOM Management

• MDConnectivity under Extensions>Advanced PLM Services

• System Modeling under Extensions>Advanced PLM Services

• Diagramming under Extensions>Advanced PLM Services

• NX Piping and Instrument Diagram (P&ID) Design under Extensions>Teamcenter
Integration for NX

• Systems Engineering under Server Extensions

If you are installing this feature, you should also install the NX Integration feature (under Client)
when building the Client web application.
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Teamcenter Quality data
model

Features to support Teamcenter Quality.

Quality Action
Management data
model

Adds support for quality actions to Active Workspace. This feature is mandatory for all Teamcenter
Quality solutions.

For more information, see Teamcenter Quality in the Active Workspace help.

Escalation
Management
Translator

Adds support for escalation workflows for quality actions.

These allow responsible users or quality managers to receive alerts or e-mail notifications to
remind them of their quality actions prior to the due date, thereby avoiding unnecessary delays or
escalations. Additionally, escalation workflows can be initiated for quality actions that are not in
the required state by the due date.

To install the Escalation Management Translator, choose Base Install > Active Workspace >
Server Extension >Teamcenter Quality data model > Escalation Management Translator.

To select Escalation Management Translator, ensure that you select Quality Action
Management and Dispatcher features

Quality Manager
data model

Adds support for Quality Manager to Active Workspace.

For more information, see Teamcenter Quality in the Active Workspace help.

Failure Mode Effect
Analysis (FMEA)
data model

Adds support for Failure Mode Effect Analysis (FMEA) to Teamcenter Quality.

For more information, see Teamcenter Quality in the Active Workspace help.

APQP Program
Management data
model

Adds support for Quality Project Management (APQP) methodology to Teamcenter Quality.

For more information, see Teamcenter Quality in the Active Workspace help.

Control and
Inspection Plan

Adds support for Control Plan to Teamcenter Quality.

For more information, see Teamcenter Quality in the Active Workspace help.

Training and
Qualification

Adds training and qualification actions to the Teamcenter Quality module, which allows you to
create and manage qualifications, qualification profiles, qualification records, and related objects.

Quality Issue
Management and
Problem Solving
data model

Adds support for Issue Manager and Problem Solving to Active Workspace.

For more information, see Teamcenter Quality in the Active Workspace help.

Quality Audit Enables capturing the status of quality actions in audit logs. A Teamcenter administrator logged
into Active Workspace can view these event logs and navigate to specific quality actions.

Quality Issue
Management and
Problem Solving
search

Adds the ability to search for Problem Solving objects in Active Workspace.

Quality
Management for
Life Sciences
Industry

Provides support for quality management for the Life Sciences industry. This application enables
you to perform Quality Management related operations like nonconformance management and
Corrective and Preventive Actions (CAPA) Management.

Audit and
Assessment
Translator

Processes quality audit logsquality audit logs for analysis.

Supplier Quality
Management

Provides support for Supplier Quality Management. This application enables you to perform
Supplier Quality management operations with applications like Vendor Management, Advance
Product Quality Planning, and Quality Issue Management and Problem Solving. Supplier Quality
Management is used to evaluate vendor performance based on quality issues and problem solving
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processes initiated for supplied materials or parts. It can also assess a vendor using a quality
checklist.

Model-Based Systems
Engineering

Features to support Model-Based Systems Engineering in Active Workspace.

Physical
Verification
Management
Active Workspace
Extension

Adds support for verification management in Active Workspace.

LMS System
Synthesis
Modeling

Installs the System Synthesis artifacts such as model template and core architecture in Active
Workspace.

Measurable
Attributes and
Targets

Configures Active Workspace to interact with Measurable Attributes and Targets, providing
functionality such as retrieving the associated measurable attributes from a parent object or
parent line.

This feature adds the Measurable Attributes and Targets for Active Workspace
(att1attrtargetmgmtaw_template.xml) template to the database.

This feature is not available with Teamcenter Rapid Start.

In addition to the Active Workspace feature, this feature requires:

• Extensions→Model-Based Systems Engineering→Verification and Validation Planning and
Reporting

Selecting this feature automatically selects these features in the same feature group:

Measurable Attributes and Targets
Attribute and Parameter Base Definitions

• Base Install→Active Workspace→Server Extensions→Systems Engineering

• Base Install→Active Workspace→Server Extensions→Model-Based Systems
Engineering→Verification and Validation Planning and Reporting

Selecting this feature automatically selects the Measurable Attributes and Targets feature in
the same feature group.

If you are installing this feature, you must also install the Measurable Attributes and Targets
Client feature in the Client web application.

Systems
Engineering

Installs the Systems Engineeringapplication, which provides capabilities such as functional
modeling and budgets.

This feature requires the Teamcenter Foundation feature and also a rich client or a two-tier
Business Modeler IDE client.

Digital Thread
Navigation

Adds Digital Thread Navigation capabilities to Model-Based Systems Engineering and adds the
relationshipviewer_template.xml template to the database.

If you are installing this feature, you should also install the Active Workspace>Client>Model-
Based Systems Engineering>Digital Thread Navigation feature for the Active Workspace client.
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Parameter
Management
Active Workspace

Adds parameter management support to Active Workspace.

System Lifecycle
Management

Installs the System Lifecycle Manager solution, with provides system modeling functionalities such
as the following:

• Tool neutral object-based information model
• Model interface management
• Branching, versioning and merging
• Model reuse (ID card, Library)
• Architecture visualization and reviews
• Xcelerator multi-domain toolset interoperability
• Integrated change management

Teamcenter Test
Management
Active Workspace

Adds test management support to Model-Based Systems Engineering (MBSE).

Physical
Verification
Management
Active Workspace

Adds support for inspections and physical tests.

Active Workspace
Linked Data Framework
Services

Features to support Linked Data Framework Services in Active Workspace.

LDF Foundation Provides a framework to link Teamcenter business objects with an artifact of a remote linked
data enabled system. It enables rendering the remote system's delegated user interfaces in Active
Workspace.

This feature adds the Linked data Framework for Active Workspace (ldf0ldfaws_template.xml)
template to the database.

This feature is not selectable unless the Linked Data Framework Support Infrastructure feature
(under Extensions>Platform Extensibility>Linked Data Services) is also selected.

If you install this feature, you should also install the Linked Data Framework feature (under
Client) when building the Client web application.

Active Workspace
LDF Change
Management
Integration

Installs the Change Management integration module of Linked Data Services (LIS). The feature
requires corresponding Teamcenter features.

Active Workspace
LDF Embedded
Software
Management
Integration

Installs the Embedded Software Management integration module of Linked Data Services (LIS).

For more information, see Integrating Applications Using Linked Data Framework in the
Teamcenter help collection.

Active Workspace
LDF Requirements
Management
Integration

Installs the Requirements Management integration module of Linked Data Services (LIS).

This feature requires corresponding Teamcenter features.

LDF Polarion Types
Integration

Installs Polarion data types for Linked Data Services (LIS) integration in Active Workspace.

This feature requires corresponding Teamcenter features.

Consumer Packaged
Goods

Features to support CPG in Active Workspace.

For more information, see Getting Started with CPG in the Teamcenter help collection.
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Brand
Management

Installs the Brand Management template for CPG.

For more information, see Getting Started with CPG in the Teamcenter help collection.

Packaging and
Artwork

Installs packaging and artwork functionality for CPG.

For more information, see Getting Started with CPG in the Teamcenter help collection.

Specification
Management

Installs specification management functionality for CPG.

For more information, see Getting Started with CPG in the Teamcenter help collection.

Consumer Product
Management
Active Workspace

Installs consumer product management functionality for CPG.

For more information, see Getting Started with CPG in the Teamcenter help collection.

MBSE Integrations Features to support Model-based system engineering in Active Workspace.

UML SysML
Modeling Active
Workspace
Interface

Installs server support for managing Unified Modeling Language (UML) and Systems Modeling
Language (SysML) models in Active Workspace.

Systems Modeling
IntegrationActive
Workspace

Installs support for the System Modeling Integration in Active Workspace.

Visualization Server features

Visualization Server features are available in the Base Install>Active Workspace>Visualization Server
feature group in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature/Subfeature Description

Visualization Server
Pool Assigner

Installs the Visualization Server Pool Assigner (VPA), which manages Visualization Server
Managers and routes users to an available VSM to open 3D documents.

Visualization Data
Server

Installs the Visualization Data Server (VDS), which improves Visualization performance by caching
visualization data close to the Visualization Server Manager.

The Visualization Data Server is required for using MMV feature in Active Workspace.

Visualization Server
Manager

Installs the Visualization Server Manager (VSM), which starts and stops rendering processes as
needed and streams visualization data to the Active Workspace client.

The Visualization Server Manager is required for any use of the 3D viewer or the 2D viewer part of the
universal viewer in Active Workspace.

Dispatcher features

Dispatcher features are available in the Base Install>Active Workspace>Dispatcher feature group in
TEM. These features require you install the Dispatcher server and client.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.
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Feature/Subfeature Description

Client Dispatcher client features.

Retail Color Image
Dispatcher

Installs Dispatcher support for the Retail Footwear and Apparel solution.

Retail Techpack Dispatcher Installs Dispatcher support for the retail techpack for the Retail Footwear and Apparel
solution.

Translators Dispatcher server translators.

Active Content Structure
Translator

Installs the Active Content Structure translator for indexing structure data.

Install this translator if you use Dispatcher-based indexing for structure data. This feature
must be installed in the same environment as the Dispatcher server.

Retail Color Image
Translator

Installs the retail color image translator for the Retail Footwear and Apparel solution.

Retail Techpack Translator Installs the retail techpack translator for the Retail Footwear and Apparel solution.

Server Enhancements features

Server Enhancements features are available in the Server Enhancements feature group in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature/Subfeature Description

Server Manager Installs the process that manages the pool of Teamcenter server processes. This
option is applicable only when you are deploying the web tier. This feature requires
Teamcenter Foundation and FMS Server Cache features.

For a smaller site, you can install the server manager and Teamcenter servers on the
same host as the web tier application. For deployment options for larger sites, you can
install the server manager on a separate host.

Sample files Installs sample source code for customizing Teamcenter and generating reports.

This component is optional. You can install the sample files individually; you need not
install any other components.

Teamcenter Management Console Installs Teamcenter Management Console, an SSL-secured console for managing and
monitoring server-side components such as the Java EE server manager and Java
EE web tier. The console's tabbed interface resembles a web application server
console. Teamcenter administrators can use the console to access multiple Teamcenter
management features from a single page.

Teamcenter Security Services Configures Security Services for Teamcenter. These services eliminate prompts for logon
credentials when users switch Teamcenter products within a user session.

Prerequisite:

Installation and configuration of Security Services.

Required information:

• Application ID for this instance of Teamcenter in the Security Services application
registry.
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Feature/Subfeature Description

• Complete URL of the Security Services logon Service web application.

• Complete URL of the Security Services Identity Service web application.

Database Daemons Optional database support services.

Action Manager Service Monitors the database for the creation of action objects and dispatches events that
have a specific execution time and events the Subscription Manager daemon fails to
process.

Installing the Action Manager service is required to enable the rich client Subscription
Administration application.

Subscription Manager
Service

Monitors the database event queue for the creation of subscription event objects.

Installing the Subscription Manager service is required to enable the rich client
Subscription Administration application.

To subscribe, right-click an item and choose Subscribe. To modify your subscription
settings, right-click an item and choose Subscription Manager.

Teamcenter Revision
Configuration Accelerator
Service

Installs the Revision Configuration Accelerator Service service, which improves revision
configuration performance

Teamcenter Task Manager
Service

Checks user inboxes for tasks that have passed due dates, notifies the delegated
recipients, and marks those tasks as late.

Installing the Task Monitor service is required to enable notification of late tasks.

Tessellation Manager
Service

Tessellates UGMASTER and UGALTREP datasets to the JT (DirectModel) dataset and
attaches the JT dataset back to the item revision and UGMASTER and UGALTREP
dataset.

Installing the Tessellation service is required to create the tessellated representations in
Repeatable Digital Validation (RDV) that enable users of the Design Context application
to quickly visualize components in context. The tessellated representations are created
during the workflow release process, ensuring that JT files of the DirectModel datasets
are updated as the NX files are released.

Workflow Remote Inbox
Service

This service syncs the data between two sites to enable working with remote inboxes.

Teamcenter Shared
Metadata Cache Service

Installs the Shared Metadata Cache Service.

File Management File management features.

FMS Server Cache Installs the File Management System FSC server and file caches. You must install an FSC
server on each host that runs a server manager and on each host that is to provide
volume services.

You can optionally choose to install the FSC as a configuration server or a performance
cache server.

Hierarchical Storage
Management (HSM)

Adds support for third-party hierarchical storage management software.

Teamcenter Web Tier Features to support the Teamcenter .NET web tier.

ASP .NET State Service Installs the middle tier processes that communicate with Teamcenter server processes.

Web Tier for .NET Installs the middle tier processes that communicate with Teamcenter server processes.
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Microservices features

Microservices features are available in the Microservices feature group in TEM.

These features require installation of Microservice Framework.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature Description

Microservices
Framework

Installs the Microservices Framework.

Advanced Multi-
Schema Exchanger
Service

Installs the Advanced Multi-Schema service, which supports creation of mapping rules to transform
data when it is transferred between Teamcenter sites using different schemas. This service is used
by the Advanced Multi-Schema Exchanger, which allows you to create mapping rules for the item
types in your source schema or for subsets of item types in the schema as defined by schema
subsets attached to Briefcase files.

See the PLM XML/TC XML Export Import Administration guide for more information about creating,
validating, and attaching mapping rules.

Classification AI Serving Installs the classification AI microservice that connects the Active Workspace Gateway to the
classification AI engine, which provides artificial intelligence (AI) to recommend the class in which
to classify new objects.

Command Prediction
Service

Installs the Command Prediction Service, which manages data for the Active Workspace Assistant

and a database for the microservice to store data for the Active Workspace Assistant. TEM prompts
you for the necessary database creation values during installation.

DPV Service Creation and authoring of BOP (Bill of Process) and BOR (Bill of Resource) structures in the Active
Workspace client, perform operations like "Send Plant ID" and submit the inspection data to ETL
(Extract Translate and Load) application.

Declarative Artifact
Service

Installs the microservice that stores your changes to the declarative definitions of Active Workspace.

The Declarative Artifact Service allows you to easily create new declarative definitions by
automatically creating new files, and also make changes to existing declarative definitions without
changing their original source code.

File Repository Service Installs the File Repository microservice, which facilitates transfer of Active Workspace client
content from the File Repository to Active Workspace client hosts through the Active Workspace
Gateway.

NX X Data Import
Microservice

This microservice is required to support the import of NX part files into Teamcenter X through a
drag and drop interface in Active Workspace.

Requirements
Management Compare
Service

Installs the microservice that provides compare capability for Requirements Manager.

Requirements
Management Export
Service

Installs the microservice that provides export capability for Requirements Manager.

Requirements
Management Import
Service

Installs the microservice that provides import capability for Requirements Manager.

TCM Vis - Easy Plan
Service

Installs the Teamcenter Manufacturing Easy Plan application microservice for visualization, which
interacts with Teamcenter and pulls structure information for the selected line.
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Feature Description

TCM Vis - Visualization
Service

Installs the Teamcenter Manufacturing Visualization microservice which provides the core 3D
visualization functionality, retrieves 3D models directly from Teamcenter, and manages a cache
to improve access speed for frequently accessed models.

Teamcenter GraphQL
Service

Installs the Teamcenter GraphQL microservice, which processes client queries passed from the
Active Workspace Gateway to the File Repository.

Teamcenter Share
Microservice

Installs the Teamcenter Share microservice, which enables the Teamcenter Share collaboration in
Active Workspace. Teamcenter Share is a cloud application that allows you to share and collaborate
on project files with your partners, team members, and manufacturers. In this browser-based file
storage, you can develop new products and designs, then share your projects with customers for
approval or manufacturers for production. Teamcenter Share controls and secures file access, and
maintains history of file sharing and exchange. For more information about Teamcenter Share
collaboration, see Teamcenter Share collaboration in Active Workspace.

Teamcenter Sysmlv2
Microservice

Installs the microservice that supports management of UML or SysML models in Teamcenter.

iModel Viewer Service Provides viewing capability for iModel data.

Teamcenter Google
Online Microservice

Provides interaction between the Google Online Viewer and the Teamcenter server.

Teamcenter Office
Online Microservice

Provides the capability to use the Microsoft Office Online Server features that allows users to edit
and view documents within Active Workspace instead of using the desktop version of the Microsoft
Office applications.

OData Microservice Installs the microservice that supports the Teamcenter OData API Framework.

Teamcenter Extensions features

Teamcenter Extensions features extend Teamcenter server and client functionality. These features are
available in the Extensions feature group in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

4D Planning Installs the 4D Planning feature. 4D Planning is the capability to add a time component
to process planning to simulate and visualize construction over an extended period of
time.

APS Configured Search Framework Installs the search framework for Advanced PLM Services.

Advanced PLM Services Core
Template

Installs the core functionality for Advanced PLM Services.

Assignment Matrix Adds support for Assignment Matrix to Teamcenter

CAD Lite Provides out-of-the-box CAD integrations for CAD users.

CFIHOS Standard Adds support for the Capital Facilities Information HandOver Specification (CFIHOS)
standard. CFIHOS offers practical standardized specifications for information handover
that work for anyone involved in making, operating, maintaining or decommissioning
industrial facilities, and everyone in the information supply chain - operators,
contractors and equipment manufacturers and suppliers.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Campaign Management Integrates campaign management with brand development and program planning.

Similar to how a program orchestrates projects, a campaign orchestrates ideas and
information about audience and goals. It also includes a high-level description of
planned resources and budget and can identify one or multiple windows of opportunity
that act as a reference for the windows of opportunity targeted by the ideas. For
more information about campaign management, see Initiative Planning in the Active
Workspace documentation.

Composite Part Laminate
Definitions

Installs support for composite part laminate definitions. This enables visualization of
plies for composite part definition outside of authoring tools, with particular emphasis
on change visualization to intuitively manage part changes.

Configurable Validation Installs support for creating custom validation applications to manage the validation
results in a Teamcenter database. For more information about this functionality, see
Product Data Validation.

Content Migration Manager Installs the Content Migration Manager feature.

For more information about this feature, see the Content Migration Manager and NX
Migration User's Guide provided with the Content Migration Manager software media.

Embedded Software Management Installs Embedded Software Management support for the Teamcenter server.

Engineering Views Installs the Engineering view for the Teamcenter rich client.

Google Viewer Integration Installs the Google Viewer Integration, which enables Google Online features within
Teamcenter, such as viewing and editing Microsoft Office documents without the need
for Microsoft Office applications.

Hazard and Risk Assessment Installs support for hazard and risk analysis of system models and functions.

IP Management Provides product lifecycle management for semiconductor manufacturers to manage IP
data using Teamcenter.

Idea Management Installs idea management, which provides the capability to create, discover and realize
an Idea leading to the creation of project.

Ideas are researched during the capture phase and are used during the discovery phase
to define a product, set goals and objectives, identify trends, record customer profiles,
and make projections. An accepted idea results in the start of a new project. For more
information about idea management, see Initiative Planning in the Active Workspace
documentation.

Order Management Installs Order Management, which manages the lifecycle of an order from inquiry to
sales order. A customer inquires about products, a sales person responds with the offer
containing configurable products. Once the offer is accepted by the customer, a sales
order is created that refers to the configurable products.

Product Line Planning Installs Product Line Planning.

Product Line Planning facilitates development of a collection of products by outlining
product assortment goals. The purpose of such assortment planning is to identify an
assortment that maximizes sales or gross margin within constraints such as limited
budget, space, vendors, and others.

Program Planning Infrastructure Installs Program Planning support for the rich client.

For more information about this feature, see Active Workspace Installation in the Active
Workspace help.

Sample Document Management Installs the sample template for Document Management.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Substances of Concern in Products Identifies products that contain hazardous substances above 0.1% weight of the
product, which are required to be reported to the European Chemical Agency (ECHA)
Substances of Concern in Products (SCIP) database for products.

Symbolica Integration Installs the Teamcenter integration to Symbolica software. Symbolica is a Siemens
Digital Industries Software product that allows you to visually create and perform
complex mathematical equations. The Symbolica integration enables you to create,
save, and revise Symbolica files within Teamcenter. These files can also be referenced by
NX part files stored within Teamcenter.

Symbolica software can be downloaded from Support Center.

Teamcenter Share Collaboration Installs support for the Teamcenter Share collaboration in Teamcenter. Teamcenter
Share is a cloud application that allows you to share and collaborate on project files with
your partners, team members, and manufacturers. In this browser-based collaboration,
you can develop new products and designs, then share your projects with customers for
approval or manufacturers for production. Teamcenter Share controls and secures file
access, and maintains history of file sharing and exchange. For more information about
Teamcenter Share collaboration, see Active Workspace documentation.

Teamcenter Integration for
Intosite

Installs the Teamcenter integration with Siemens Intosite.

Test Manager Installs the application model used to manage assembly tests for virtual assessment
processes in Automotive Edition and Aerospace and Defense.

Translation Service Database
Module

Installs the database module for the Dispatcher Server.

Weld Management Installs the template that manages NX welding features in Teamcenter.

Enterprise Recipe Management Installs integrated recipe authoring capabilities that help pharmaceutical, CPG, or similar
industries to track the development process of a product.

Advanced PLM Services for
Applications

Installs basic functionality for Advanced PLM Services applications.

Assignment Matrix Active
Workspace

Adds support for Assignment Matrix in Active Workspace.

Build Conditions Installs build condition support for Product Configurator, a feature that enables you to
formally introduce and manage variability across your product suite.

Data Discovery Services Enables the indexer administration data model and services.

Easy Plan Active Workspace
Infrastructure

Adds support for Easy Plan solutions to Active Workspace. For more information, see the
Easy Plan documentation.

Initiative Planning This feature provides capability to create, discover and realize an Idea leading to the
creation of project. It also provides capability to create and manage campaigns. For
more information, see Initiative Planning in the Active Workspace documentation.

Machine Builder Installs support for the Machine Builder solution, which provides a single-source data
management system focused on the engineering, manufacturing and product life BOM.
This solution is designed to enable industrial machinery customers to move from
CAD data management to engineering process management, integrating requirements
management, project management, and change management.

Medical Device Foundation Installs server and rich client extensions to support product development processes
for medical device manufacturers. This feature assists in ensuring compliance with
regulatory guidelines, accelerating innovation in development, and reducing costs.

Object Data Services Adds support for the OData framework for Teamcenter.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Reminder and Escalation
Management

The Reminder and Escalation Management provides mechanism to process notifications
and escalation capability based on criteria defined for Teamcenter Business objects
which helps to track progress of defined task. This is generic solution and can be used
by any application to remind the due tasks at right time and also set up escalations at
desired level if it is getting delayed.

Softlines, Hardlines and Footwear Adds capabilities to support the Softlines, Hardlines, and Footwear industries. It is an
add-on solution to help users manage the various needs of the retail industry.

Teamcenter Integration for IP
Management

Provides a solution to integrate Teamcenter with external IP management applications.
The application helps import IP data and its metadata from external application into
Teamcenter. It also adds the capability to share a bill of IP from Teamcenter to an
external application.

Teamcenter SLM Integration for
Service Execution

Adds Service Execution actions for Teamcenter Service Lifecycle Management (SLM).

Teamcenter Simplified Provides a simplified experience of Teamcenter for small- and medium-sized business
customers. User Experience (UX) redundancies and outlying commands are removed.
This allows users to quickly work on designs, documents and parts within their
organization without additional configuration.

Advanced BOM Rollup Installs a base/foundation template to perform rollup of properties such as weight and
balance, cost, sustainability indicators and other business critical KPIs.

Advanced PLM Services for
Realization

Installs realization support for existing items, item revisions, BOM views or BOM view
revisions into collaborative designs.

Aspect Infrastructure Support Adds aspect infrastructure support for Automation Designer.

CAD Lite Active Workspace Provides out-of-the-box CAD integrations for CAD users.

Change Management 4th
Generation Interface

Installs Change Management support for 4th Generation Design.

Color Appearance Active
Workspace

Provides the ability to define standard color attributes in Active Workspace.

Content Management Active
Workspace

Adds Content Management support to Active Workspace.

Design BOM Alignment
Automation

Provides the capability to generate the design or BOM data from an existing BOM or
design data from Active Workspace. Given a source BOM, a user can generate a target
BOM. The source and target BOM could be an engineering BOM or design BOM. For
more information, see Design and BOM Alignment ─ Deployment and Administration.

Dimensional Planning and
Validation Multi Field Key

Installs multifield key functionality in Dimensional Planning and Validation.

Engineering Views Active
Workspace

Installs the Engineering view for the Teamcenter rich client.

Initiative Lifecycle Management
(ILM)

Installs support for Initiative Lifecycle Management (ILM), which unifies business
processes from ideation to production. This includes management of campaigns, ideas,
programs, and projects. ILM leverages program planning capabilities and combines
those with process groups that distribute work to participants. For more information,
see Initiative Lifecycle Management in the Active Workspace documentation.

Integrated Materials Management
for Additive Manufacturing

Installs Integrated Material Management (IMM) for Additive Manufacturing (AM), which
manages raw materials and final materials for Additive Manufacturing. This feature
enables NX users to search and assign materials to parts based on material parameters.
It also enables selecting the printer, post-operation, and available corresponding
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

raw materials. For more information about Additive Manufacturing and NX, see
Manufacturing Process Planner.

Product Configurator Installs Product Configurator, a feature that enables you to formally introduce and
manage variability across your product suite.

Product Specification
Management

Enables Teamcenter with additional occurrence attributes to support Product Design
specification management for EBOM.

Teamcenter Integration for
Supplyframe

Enables integration with Supplyframe for BOM management.

Volume Planning Installs volume planning for Teamcenter.

This feature adds the cfp0featureplanning template.

Advanced PLM Services for
Partitioning

Installs support for creating partitions in collaborative designs.

Change Management
Configurator Interface

Installs Change Management support for Product Configurator.

Change Management Realization
Interface

Adds realization capability to Change ManagerChange Manager.

Realization is the process of representing data from one product design (the source)
into another product design (the target).

Initiative Lifecycle Management -
CPG Reference Implementation

Installs Initiative Lifecycle Management (ILM) with objects and processes specific
to the Consumer Packaged Goods industry. For more information, see Initiative
Lifecycle Management ─ CPG Reference Implementation in the Active Workspace
documentation.

Initiative Lifecycle Management
Overlay for Semiconductor
Solution

Supports project planning and idea management for the semiconductor industry.

Medical Device Submissions Provides support for performing end-to-end medical device label authoring, object-
based content management, Unique Device Identifier (UDI) data management and
submissions for medical industry customers.

Product Configurator Feature
Planning

Adds feature planning support to Product Configurator, a feature that enables you to
formally introduce and manage variability across your product suite.

Product Configurator Support for
Structure Manager

Provides the ability to use the Product Configurator variants to configure product
structures in Structure Manager.

This feature requires Product Configurator.

Teamcenter SLM Integration
for Service Execution, Active
Workspace BOM Interface

Adds Service Execution actions for Teamcenter Service Lifecycle Management (SLM) to
Active Workspace.

Weight and Balance Management Enables interaction with Weight and Balance Management. This supports functionality
such as specifying weight and balance attributes for parts or assemblies, and
performing their rollup.

Active Workspace Weight and
Balance Management

Enables interaction with Weight and Balance Management in the Active Workspace
client. This supports functionality such as specifying weight and balance attributes for
parts or assemblies, and performing their rollup. For more information, see Structure
Management ─ Deployment and Administration.

Capital Asset Lifecycle
Management

Installs the core components of Capital Asset Lifecycle Management (CALM)
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

The CALM solution aggregates plant data authored in various design tools into
Teamcenter to build a digital twin of a capital facility or plant.

For more information about the CALM solution, see the Active Workspace
documentation.

Configurator Partition Interface Installs the Configurator Partition Interface, which provides the Partition Variability View
for Product Configurator.

Partitions for Structure Installs server support for partitions and partition schemes for structures.

Service Partition Adds service-specific partition capabilities.

Supplier Program Planning Program planning solution for supplier solutions that will be developed for Teamcenter
X.

Teamcenter Integration for Label
Management Systems

Provides integration of Teamcenter with Label Management Systems for Medical
Devices.

4th Generation Target
Management (Deprecated)

Installs target management support for 4th Generation Design.

Classification Presentation Layer
L10N

This feature configures the Teamcenter installation to support localization for
Classification Presentation Layer elements.

Functional Hazard Analysis Configures the Teamcenter installation to support Functional Hazard Analysis of
system models and functions. This application requires Systems Engineering and other
additional applications.

Functional Safety Analysis for
Semiconductor Devices

Marine Integration Installs support for Marine Integration in Active Workspace. This functionality supports
lifecycle management of electrical equipment and cables that connecting them,
provided by various electrical design tools. The feature enables creation of BOM
structures for electrical equipment and cables.

NX Validation Contract for Active
Workspace

Configures the Teamcenter installation to interact and share data between Active
Workspace Validation Contract and NX.

Semiconductor Foundation Provides a product lifecycle management solution for semiconductor manufacturers to
manage semiconductor design and manufacturing data using Teamcenter.

Supplier Program Security Allows application of standard Teamcenter Project Security to Program Planning objects.

Automation Designer This feature provides the data model and server functionality for Automation Designer.
For more information, see the Line Designer documentation available with NX.

Change Management 4th
Generation Product Master
Interface

Adds support for 4th Generation Product Master objects to be managed by Change
Management. With this feature, 4th Generation Product Master objects may be related
to change objects like Problem Items, Impacted Items, or Solution Items.

Partitioned Design Guidelines Configures Teamcenter to provide the association between option families from
configurator with partitions. This feature provides guidelines about the available and
unavailable option families for the partitions.

Assembly BOM Installs all required dependencies and configurations for enabling Assembly EBOM with
Design BOM Alignment automation for EBOM Level I and II products.

Non-Functional Change
Management

Allows users to make non-functional changes in their parts. Non-functional changes are
changes which do not affect the fit, form, or function of the part.

Supplier Change Management The base solution for all the supplier solutions that will be developed for Teamcenter X.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Enterprise Service BOM This feature provides the extension of formal BOM management capabilities of
Enterprise BOM in Service Lifecycle Management

Integrated Manufacturing BOM Installs the integrated BOM manufacturing capabilities.

Process Planning for Component
Manufacturing

Adds Manufacturing Process Planner support for component manufacturing.

Teamcenter Lite for Component
Manufacturer

Installs a lightweight version of the solution to support component manufacturing.

Teamcenter Office Online
Connection

Installs Microsoft Office Online client integration.

Integrated Program Planning and
Execution (IPP&E)

Features to support Integrated Program Planning and Execution (IPP&E).

IPP&E Aurora
Integration

Adds the Aurora Integration for Integrated Program Planning and Execution (IPP&E).
This integration enables you to generate three special schedules: the best-case
schedule, the worst-case schedule, and the most-likely schedule. You can compare the
original schedule with any of these schedules and then perform a what if analysis to
provide an assessment of the original schedule for a bid.

Organization
Breakdown Structure
Foundation

Adds support for creating Organizational Breakdown Structures. An Organizational
Breakdown Structure (OBS) is a hierarchical representation of a functional organization.
Individual functional organizations are called OBS Elements.

Advance PLM Services 4th Generation Design features.

4th Generation Design Installs 4th Generation Design (4GD) functionality for the Teamcenter server. 4GD
allows users of NX CAD or Lifecycle Visualization to cooperate in real time during the
design cycle of a product.

MDConnectivity Installs support for multidisciplinary (MD) objects. This enables management of files
from piping and instrumentation diagram/drawing (P&ID) applications in Teamcenter.

System Modeling Installs the system modeling template for multidisciplinary (MD) objects.

4GD Change Detection
Service

Installs the change detection service for 4th Generation Design functionality for Issue
Manager. This feature requires Teamcenter Foundation and 4th Generation Design.

Change Management
4th Generation Design
Interface

Installs 4th Generation Design functionality for Change Manager. This feature requires
Teamcenter Foundation and Change Management.

Diagramming Installs the diagramming template for multidisciplinary (MD) objects.

4th Generation Design
Issue Management

Installs 4th Generation Design functionality for Issue Manager. This feature requires
Teamcenter Foundation and 4th Generation Design.

Aerospace and Defense Aerospace and Defense features.

Aerospace and
Defense Foundation

Installs Aerospace and Defense functionality for the Teamcenter server. This feature
requires Teamcenter Foundation and Vendor Management.

Aerospace and
Defense Change
Management

Installs the change management functionality for the Aerospace and Defense
Foundation feature. This feature requires Teamcenter Foundation and Aerospace and
Defense Foundation.

Aerospace and
Defense Foundation
Training

Installs the Aerospace and Defense Foundation training program for the Aerospace and
Defense Foundation feature. This feature requires Teamcenter Foundation, Vendor
Management, and Aerospace and Defense Foundation.

Automotive Teamcenter Automotive Edition and additional supporting features.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Teamcenter
Automotive Edition

Installs the optional Teamcenter Automotive Edition application.

GM Overlay Installs the Teamcenter Automotive Edition GM Overlay application.

Installing GM Overlay requires that you also install Teamcenter Automotive Edition.

Configure AutoCAD
Integration for GM
Overlay

Configures AutoCAD Integration/AutoCAD Manager to operate in a Teamcenter
Automotive Edition GM Overlay environment. Choose this option only when you
add GM Overlay to a Teamcenter environment that includes AutoCAD Integration.
If you attempt to include this configuration before installing GM Overlay and the
standard AutoCAD Integration, the install fails. Both GM Overlay and the base AutoCAD
integration must be installed and functioning before you choose this option. Requires
Teamcenter Foundation and GM Overlay.

GM Customization for
DPV

Installs GM-specific LOVs and GRM rules for Dimensional Planning and Validation (DPV).

For more information, see Deploying Dimensional Planning and Validation in DPV help.

Wire Harness
Configuration in GM
Overlay

Configures wire harness configuration for a Teamcenter Automotive Edition GM
Overlay environment. Requires Teamcenter Foundation, Wire Harness Configuration,
Teamcenter Automotive Edition, and GM Overlay.

GM PAD/TWP
Customization

Installs additional GM data types for PAD/TWP Customization. This feature requires
Teamcenter Foundation, GM Overlay, Customization for eM-Server Integration, and
PAD/TWP Customization.

BOM Management Features that support Product Master Management.

Product Master
Automation

Provides the capability to generate the design or BOM data from an existing BOM or
design data from Active Workspace. Given a source BOM, a user can generate a target
BOM. The source and target BOM could be an engineering BOM or design BOM. For
more information, see Design and BOM Alignment ─ Deployment and Administration.

4th Generation
Product Master

Provides formal BOM management capabilities. It supports features like release
of a formal bill of materials by Engineering, alignment of CAD designs with
formal BOM to enable digital mockup (DMU), operations release of formal BOM to
manufacturing plants, Engineering and operations solve requests including order solves
and forecast  order solves.

Product Master
Manager (PMM)

Product Master Manager features.

Change
Managem
ent Color
BOM
Interface

Provides support for color BOM objects to be managed by Change Manager. With this
feature, color rule objects can be related to change item revision objects as problem,
impacted, and solution objects.

CAE Simulation Management Features to support Computer-Aided Engineering (CAE) Simulation Management in
Teamcenter.

Simulation Process
Management

Installs Simulation Process and Data Management, a packaged solution that provides
unique simulation process and data management capabilities for CAE engineers and
CAE analysts performing analysis work.

Extended Simulation
Process Management

Installs extended capabilities of Simulation Process and Data Management.

Product Configurator
for Simulation Process
Management

Adds Simulation Process and Data Management actions to Product Configurator.

Product Configurator enables you to formally introduce and manage variability across
your product suite.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Consumer Packaged Goods Features to support Consumer Packaged Goods.

Consumer Products
and Retail Foundation

Installs the Consumer Products and Retail Foundation template, which supports datasets
that are used to integrate Teamcenter with external graphics design tools.

Finished Product
Management

Installs the Finished Product Management functionality for Consumer Packaged Goods.

Specification Manager Installs the Specification Manager feature.

Brand Management Installs the Brand Management template for Consumer Packaged Goods.

CPG Materials Installs Consumer Packaged Goods objects such as raw materials, formulated materials,
and so on.

Packaging and
Artwork

Installs packaging and artwork functionality for Consumer Packaged Goods.

Consumer Product
Management

Installs consumer product management functionality for Consumer Packaged Goods.

Finished Product
Management to CPG
Materials Bridge

Provides a bridge between finished products and Consumer Packaged Goods materials.

Packaging and
Artwork to Finished
Product Management
Bridge

Provides a bridge between Packaging and Artwork and Finished Product Management
for Consumer Packaged Goods.

Formulation &
Material Management

Enables Teamcenter to create Material Management objects like Component
Specification, Parameter and substance.

Content and Document
Management

Content and document management features.

Acrobat/Reader Plugin Installs the Teamcenter plug-in for Adobe Acrobat and Adobe Acrobat Reader. This
solution is optional.

Content Management
Base

Installs the data model for Content Management.

Content Management
DITA

Enables management of documentation for the DITA standard in Content Management.

Content Management
S1000D

Enables management of documentation for the S1000D standard in Content
Management.

Content Management
S1000D 4.X/5.X

Enables management of documentation for the S1000D standard in Content
Management.

EDA Client

ECAD
Design
Integratio
ns

Manages the Electronic CAD designs within Teamcenter using EDA Gateway application.

Mentor PADS Installs the Mentor Graphics PADS integration with the EDA client. Separate installation
of Mentor Graphics PADS is required.

Mentor PADS
Professional

Installs the Mentor PADS Professional integration with the EDA client. Separate
installation of Mentor PADS Professional is required.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Mentor Xpedition
Designer and Layout

Installs the Mentor Xpedition Designer and Layout integration with the EDA client.
Separate installation of Mentor Xpedition Designer and Layout is required.

Mentor Xpedition EDM
Design

Installs the Mentor Xpedition EDM Design with the EDA client. Separate installation of
Mentor Xpedition EDM Design is required.

Teamcenter Gateway
for EDA Design

Installs Teamcenter Gateway for EDA Design.

EDA Translation Allows converting a PCB or schematic design into the Teamcenter Visualization ECAD
format. Though EDA translation is also packaged within EDA standalone client, this
feature enables deploying EDA translation to be integrated in other environments like
Teamcenter Dispatcher.

EDA Translation Win32 Allows converting a PCB or schematic design into the Teamcenter Visualization ECAD
format for Windows 32 bit. Though EDA translation is also packaged within EDA
standalone client, this feature enables deploying EDA translation to be integrated in
other environments like Teamcenter Dispatcher.

ECAD
Library
Integratio
ns

Manages the library data of ECAD tools such as EDM and Allegro in Teamcenter.

Mentor PADS Library Installs the Mentor PADS Library integration. Separate installation of Mentor PADS is
required.

Mentor PADS Library
Win32

Installs the Mentor PADS Library integration for Windows 32 bit. Separate installation of
Mentor PADS is required.

Mentor Xpedition EDM
Library

Installs the Mentor Xpedition EDM Library integration. Separate installation of Mentor
Xpedition EDM Library is required.

Teamcenter Gateway
for EDA Library Win32

Installs Teamcenter Gateway for EDA Library to integrate ECAD part metadata databases
to Teamcenter for Windows 32 bit.

Teamcenter Gateway
for EDA Library

Installs Teamcenter Gateway for EDA Library to integrate ECAD part metadata databases
to Teamcenter.

Engineering Process Management Engineering Process Management features.

Spatial Search Installs Spatial Search capabilities of the cacheless search engine.

This feature requires Dispatcher Server.

Cacheless search is installed with Teamcenter Foundation, but its capabilities must be
enabled through TEM.

Bounding box
generation from JT
(Requires Dispatch
Server)

Enables generation of bounding box data from JT files, providing secondary data for the
cacheless search engine.

This feature requires Dispatcher Server. Also, during Teamcenter installation, you must
install the Spatial Search translator (JtToBboxAndTso).

Cacheless search is installed with Teamcenter Foundation, but its capabilities must be
enabled through TEM.

Trueshape generation
from JT (Requires
Dispatch Server)

Enables generation of Trushape data from JT files, providing secondary data for the
cacheless search engine.

This feature requires Dispatcher Server. Also, during Teamcenter installation, you must
install the Spatial Search translator (JtToBboxAndTso).
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Cacheless search is installed with Teamcenter Foundation, but its capabilities must be
enabled through TEM.

Bounding Box
generation from NX

Enables generation of bounding box data when saving NX files, providing secondary
data for the cacheless search engine.

Cacheless search is installed with Teamcenter Foundation, but its capabilities must be
enabled through TEM.

Enterprise Knowledge Foundation Enterprise Knowledge Foundation features.

Remote Workflow Configures linking between Teamcenter sites for remote workflow operations.

This option is applicable only when you are deploying the four-tier architecture.

Prerequisites:

• Remote Workflow components must be separately installed and configured.

• The web tier application, including the optional Remote Workflow parameters, must
be installed and configured.

Required information:

• Host name and port number of the Java servlet running the Teamcenter Application
Registry.

• The host name and port number of the host running a web tier application.

• If you are linking to Teamcenter portfolio, program and project management, the
chooser servlet name.

Teamcenter Client for
Microsoft Office

Installs the Teamcenter Client for Microsoft Office.

Change Management Provides a flexible change management framework that integrates with other
Teamcenter products.

If you install this feature, you may need to set the HiddenPerspectives preference in
the rich client.

Contract Data
Management

Installs Contract Data Management, which allows you to manage, initiate review
processes, and monitor correspondence for procurement documents, such as design
information, drawings, status reports, purchase orders, and so on.

Dispatcher Client for
Rich Client

Installs Dispatcher Client for the rich client. This feature requires Teamcenter Rich
Client 2-tier or Teamcenter Rich Client 4-tier.

Finish Management Installs Finish Management for Teamcenter. A finish represents a finishing process on
a part. It may be used to improve appearance, adhesion, corrosion resistance, tarnish
resistance, chemical resistance, wear resistance, and remove burrs and so on.

Materials
Management

Installs the Materials Management solution, which stores approved material and
substance information imported from a third-party database (for example, Granta,
IMDS) into a material library in the Teamcenter database.

Stock Material Installs the Stock Material feature for Teamcenter.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Many parts are made from stock materials such as bar stock, tubing stock and sheet
stock. This features enables you to manage stock materials in Teamcenter, performing
actions like creating libraries of stock materials and assigning stock materials to parts.

Work Package
Management

Enables management of work packages in Teamcenter.

Work packages or packages are typically collections of CAD files and documentation
that outsourcing partners require to build, test or maintain components or
subassemblies of larger products. Packages serve as revisable collections of product
information that can be used in a variety of contexts.

Change and Schedule
Management Interface

Installs support for using Change Management with Schedule Management.

Issue Management Installs Issue Manager, which allows you to track problems, or issues, with products by
managing the review, approval, and implementation of issues.

Render Document for
Rich Client

Provides Render Management capabilities for the rich client. This feature requires
Dispatcher Client for Rich Client.

Dispatcher Server Installs the following Dispatcher Server components: scheduler, module and
administration client.

Penetration Request
Management

Installs the penetration request management feature.

This feature requires the Change Management and Issue Management features and
also Teamcenter Foundation or a rich client.

Dispatcher Client (4-
tier)

Installs an integration of the Dispatcher Server and Teamcenter for the four-tier rich
client that enables users to translate Teamcenter data files to various visualization
formats for viewing in Teamcenter. This feature requires Teamcenter Foundation.

Dispatcher Client (2-
tier)

Installs an integration of the Dispatcher Server and Teamcenter for the two-tier rich
client that enables users to translate Teamcenter data files to various visualization
formats for viewing in Teamcenter. This feature requires Teamcenter Foundation.

Lifecycle Visualization Features to support Lifecycle Visualization.

Teamcenter
Visualization
(Embedded) for Rich
Client

Installs the embedded viewer for the rich client. This feature requires Teamcenter Rich
Client 2-tier or Teamcenter Rich Client 4-tier.

Teamcenter
Visualization (Stand-
alone) for Rich Client

Installs standalone application viewer for the rich client. This feature requires
Teamcenter Rich Client 2-tier or Teamcenter Rich Client 4-tier.

Localization Features that support localization of Teamcenter.

Classification L10N Installs the classification localization template, which enables localization in the
Classification environment.

MBSE Integrations Features that integrate Model-Based Systems Engineering MBSE with software like
MATLAB, Simulink, and others.

Client Model Management applications for Teamcenter clients.

Simulink
Integratio
n

Installs support for Simulink models in Active Workspace.

System
Modeling

Installs the capability to support and manage UML and SysML modeling in Teamcenter.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Integratio
n

Teamcent
er
Behavior
Modeling
for Rich
Client

Adds support for behavior modeling in the Teamcenter rich client.

Teamcent
er
MATLAB
for Rich
Client

Installs the rich client integration with MATLAB Simulink.

MBSE
Services
Client

Installs client support for MBSE Integration Gateway services.

Software
Managem
ent Client

Installs the client components to support software management for MBSE.

Server Model Management components for Teamcenter servers.

Branch
Data
Organizati
on

Installs branch data organization capabilities for the MBSE Integration Gateway.

Common
Integratio
n
Framewor
k

Installs the common framework for the MBSE Integration Gateway.

Gateway
for
Modeling

Installs concurrent modeling capabilities for the MBSE Integration Gateway.

Branching
and
Versioning
Foundatio
n

Adds support for branching and versioning in Teamcenter.

Simulink
Integratio
n

Installs support for Simulink models in Active Workspace.

Teamcent
er Polarion
Direct
Integratio
n

Installs support for managing artifacts created by the Polarion application.

UML
SysML
Modeling

Installs server support for managing Unified Modeling Language (UML) and Systems
Modeling Language (SysML) models in Teamcenter.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Systems
Synthesis
Modeling

Installs the System Synthesis artifacts such as model template and core architecture.

MBSE
Services

Installs services to support the MBSE Integration Gateway.

Capital
Marine
Integratio
n

Installs the Capital Marine integration for MBSE.

Software
Managem
ent

Enables ALM and build systems like Jenkins to automate publishing of software project
build artifacts such as binaries, configurations, parametrization, reports, and so on, to
Teamcenter. It captures build details and related information to manage and maintain
traceability of hardware and software products in Teamcenter.

Integratio
n for
Cameo

Installs support for managing artifacts created by the Cameo application for UML and
SysML modeling. This includes support for managing the Cameo model directly in
Teamcenter.

Integratio
n for IBM
Rhapsody

Installs support for managing artifacts created by the Rhapsody application for UML and
SysML modeling. This includes support for managing the Rhapsody model directly in
Teamcenter.

Integratio
n for
System
Modeling
Workbenc
h

Installs support for System Modeling Workbench objects such as Capella Model and
SysML Model.

MADe
Integratio
n

Installs support for managing reliability, availability, maintainability, and safety analysis
data created in the MADe tool from PHM Technology.

Maintenance Repair and Overhaul Maintenance Repair and Overhaul features.

MRO Core Installs the PhysicalPart business object used to designate physical instances of parts
for Service Lifecycle Management.

As-Built Management Installs the As-Built template for Teamcenter service lifecycle management.

As-Maintained
Management

Installs the As-Maintained feature to support the As-Maintained physical structure
management for Service Manager.

Service Planning Installs the Service Planner application that supports service planning capabilities within
Teamcenter. Service Planner requires a separate license and is installed as an optional
overlay to standard Teamcenter.

As-Built and As-
Maintained Alignment

Enables interoperability of data created by the As-Built Management and As-Maintained
Management features of Service Manager.

Transaction Processing Installs transaction processing functionality for Service Request Manager.

Service Processing Installs the optional MRO Service Processing Solution to support Service Process
Management.

Service Event
Management

Installs Service Event Management to support service process management for
Teamcenter service lifecycle management.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Service Planning and
Service Processing
Alignment

Installs the Service Planning functionality for Service Processing.

Service Request
Processing (Requires
Change Management)

Installs the Service Planning and Service Processing Alignment module to support using
discrepancies in Service Planner.

Service Scheduler Installs Service Scheduler, which supports scheduling within Teamcenter. Service
Scheduler lets companies define, schedule, and implement services for their products.
Service Scheduler is a separately licensed application that is installed as an optional
overlay on top of standard Teamcenter and Service Manager.

Next Generation
Service Planning

Enables Next Generation Service Planning capabilities. With this feature, the Service
Planner is able to create Service Requirements and the subsequent capabilities.

MRO Automated
Scheduling 1.0

MRO Automated Scheduling features.

Service
Forecastin
g

Installs the Service Forecasting plug-in to Service Scheduler.

Service
Automate
d
Schedulin
g

Installs the Service Automated Scheduling plug-in to Service Scheduler.

Manufacturing Process
Management

Teamcenter manufacturing process management features.

Advance Planner Installs Advance Planner, which configures Teamcenter installation to scope and report
data during pre-planning activities to determine the plant in which a vehicle will be
built. This feature will assist in determining cost and plant space needed within Line
Designer.

Composites Process
Planning

Installs Composites Process Planning, which leverages the benefits of Manufacturing
Process Management BOM and BOP to plan and manufacture composite parts.

Customization for eM-
Server Integration

Installs additional data types for Tecnomatix server integration customization.

Logistic Process
Planning

Installs the logistic process planning feature for Manufacturing Process Planner.

MTM Data Card Installs the Methods Time Measurement (MTM) data card system for Manufacturing.

Manufacturing
Foundation

Installs core functionality of Manufacturing Process Management.

Work Instructions Installs the work instructions feature for Manufacturing Process Planner.

Customization for
Process Simulate
Integration

Installs additional data types for Process Simulate Integration Customization.

Database
Configuration for DPV

Installs the database configuration for Dimensional Planning and Validation (DPV). This
feature requires Teamcenter Foundation and Customization for eM-Server Integration.

For more information, see Deploying Dimensional Planning and Validation in DPV help.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

MES Integration Installs the Manufacturing Execution System Integration (MES Integration), which
collects the bill of process, bill of materials, and any relevant work instructions into
a work package that is released to the MES system.

Manufacturing
Characteristics
Information

Installs additional data types for Manufacturing Characteristics Information.

eBOP Reports
Customization

Installs additional data types for eBOP Reports Customization. This feature requires
Teamcenter Foundation and Customization for eM-Server Integration.

MES Issue
Management

Installs additional data types required for shop floor issue management when
integrating with a manufacturing execution system. This feature provides Issue
Manager support for the Manufacturing Execution System Integration (MES
Integration).

PAD/TWP
Customization

Installs additional data types for PAD/TWP Customization. This feature requires
Teamcenter Foundation and Customization for eM-Server Integration.

Manufacturing core
using APS

Installs Manufacturing support with Advanced PLM Services.

Manufacturing
support for 4th
Generation Design

Installs additional data types required to work with 4th Generation Design (4GD) objects
in Manufacturing Process Planner.

Mechatronics Process
Management

Features to support Mechatronics Process Management.

EDA for Business
Modeler IDE

Integrates Teamcenter EDA with the Business Modeler IDE.

For information about installing EDA, see the EDA help under Teamcenter→Electronic
Design Automation (EDA).

EMPS - Foundation Installs electronic design and manufacturing types to support ECAD translation and PCB
design collaboration using Teamcenter embedded viewer.

ESM Base Installs ESS base types and updates preferences. Without these, ESS operations do not
work from any interface (rich client, custom utilities, and other clients).

SCM ClearCase for
Foundation

Installs ClearCase types and sets Teamcenter preferences to enable the integration
between Teamcenter and the IBM ClearCase software configuration management (SCM)
tool.

For more information about ClearCase integration, see Embedded Software Solutions.

Calibration and
Configuration Data
Management

Installs the Calibration and Configuration Data Management (CCDM) feature for
Embedded Software Solutions, which allows you to manage the calibration and
configuration-related parameter data of embedded systems. CCDM allows you to define,
create, view, update, and delete parameter data, and to group related parameter
definitions together and associate parameter values to a project.

EDA Server Support Installs the dataset types and transfer modes required to support Teamcenter EDA, the
application that integrates ECAD applications with Teamcenter.

For information about installing EDA, see the EDA help under Teamcenter→Electronic
Design Automation (EDA).

ESM Processor Installs ESS processor types and updates preferences. Without these, ESS operations do
not work from any interface (rich client, custom utilities, and other clients).

ESM Software Installs ESS software types and updates preferences. Without these, ESS operations do
not work from any interface (rich client, custom utilities, and other clients).
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Electrical and Wire
Harness Configuration

Installs Teamcenter schema support for wire harnesses.

Embedded Software
Design Data
Management

Installs Embedded Software Design Data Management for Embedded Software
Solutions.

ECAD Part Library
Management

Installs ECAD part types to support ECAD part library management. This feature requires
Teamcenter Foundation, Vendor Management, and EDA Server Support.

Embedded Software
Design Data
Management with
SCM Clear Case
Integration

Enables management of Embedded Software Design data in the SCM Clear Case
integration.

Multi-Disciplinary
Associations

Installs multidisciplinary (MD) associations in Teamcenter.

Multidisciplinary (MD) objects help facilitate collaboration between various disciplines
during the product design phase.

Model-Based Systems Engineering Features that support Model-Based Systems Engineering. For more information about
these features, see Model-Based Systems Engineering in the Active Workspace help.

Systems Engineering
Base

Installs data model for the Systems Engineering application, which provides capabilities
such as functional modeling and budgets.

This feature requires the Teamcenter Foundation feature and also a rich client or a
two-tier Business Modeler IDE client.

Attribute and
Parameter Base
Definitions

Installs attribute and parameter definitions for Product Planning. For more information
about this feature, see the topics about domain engineering in Model-Based Systems
Engineering in the Active Workspace help.

Parameter
Management

Adds parameter management capabilities to Model-Based Systems Engineering.

Systems Engineering Installs the Systems Engineering application, which provides capabilities such as
functional modeling and budgets.

This feature requires the Teamcenter Foundation feature and also a rich client or a
two-tier Business Modeler IDE client.

Test and Verification
Management

Installs support for test management in Teamcenter.

Test management (or verification management) is part of verification and validation,
which are similar but distinct processes of Model-Based Systems Engineering (MBSE).
It is used to check that a product or system meets requirements and specifications
established to fulfill its intended purpose.

Enterprise
Architecture Modeling

Enables Enterprise Architecture Models modeled using Unified Architecture Framework
(UAF) to be saved in Teamcenter. It provides data model supporting Unified Architecture
Framework.

Physical Verification
Management

Installs support for verification request management.

For more information about this feature, see the topics about verifying system models
in Model-Based Systems Engineering in the Active Workspace help.

Characteristics
Management

Installs Characteristics Management which supports Teamcenter Characteristics Digital
Thread.

Part Manufacturing Part Manufacturing features.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Part Manufacturing
Shopfloor Integration

Installs the Part Manufacturing Shopfloor integration for Part Manufacturing.

NX Fixed
Plane Additive
Manufacturing
Integration

Installs the NX Fixed Plane Additive Manufacturing Integration, which enables importing
of Additive Manufacturing printer files into datasets under fixed plane Additive
Manufacturing activities.

NX Machining Line
Planner Integration

Installs the Machining Line Planner Integration for NX.

Platform Extensibility Platform extensibility features.

Enterprise Integration Installs the Teamcenter Integration Framework integration with Teamcenter Enterprise.

PMM Integration Installs the Teamcenter Integration Framework integration with Product Master
Manager.

Substance Compliance
Integration

Installs the Teamcenter Integration Framework with Teamcenter Substance Compliance.

Supplier Collaboration
Integration

Installs the Supplier Collaboration Integration to Teamcenter.

This feature is deprecated and will be removed in a future version of Teamcenter. It is
not available to install in a new Teamcenter configuration.

Integration Framework Teamcenter Integration Framework features.

Integratio
n
Framewor
k Core

Installs the Teamcenter Integration Framework.

Global Services Global Services features.

Global
Services
Preference
s

Installs preferences for Global Services.

Multisite
Collaborat
ion IDSM
Service

Installs the distributed services manager (IDSM) required to replicate data between
multiple Teamcenter sites, enabling the exchange of data objects with other Teamcenter
databases over a wide area network (WAN).

Multisite
Collaborat
ion ODS
Service

Installs the object directory service (ODS) required to replicate data between multiple
Teamcenter sites, enabling the exchange of data objects with other Teamcenter
databases over a wide area network (WAN).

Catia Non
BOM

Installs the CATIA Non BOM feature.

ERP
Connect

Installs the ERP Connect Toolkit interface that integrates Teamcenter with other
Enterprise Resource Planning (ERP)-supported applications, such as BAAN.

Linked Data
Framework Services

Linked Data Framework Services features.

Java EE
Based
Linked

Installs web services that allow other lifecycle tools to use Teamcenter services like
change management. This feature builds the OSLC WAR file and installs the Linked Data
Services (LIS) core service.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Data Web
Services

LDF
Foundatio
n

Installs the linked data framework for Linked Data Services. This feature enables
linking external applications to Active Workspace.

LDF
Change
Managem
ent
Integratio
n

Installs the Change Management integration module of Linked Data Services (LIS).

LDF
Requireme
nts
Managem
ent
Integratio
n

Installs the Requirements Management integration module of Linked Data Services
(LIS).

LDF Server
Support

Installs server support for the Linked Data Services (LIS) framework. This includes the
data model for LIS

LDF
Embedded
Software
Managem
ent
Integratio
n

Installs the Embedded Software Management integration module of Linked Data
Services (LIS).

Portfolio, Program and Project
Management

Portfolio, Program and Project Management features.

Workflow to
Scheduling Integration

Allows workflow to send updates to the related tasks in a schedule. This feature requires
a four-tier installation and Dispatcher to be installed/configured. This feature requires
Teamcenter Foundation.

You must create the proxy user account (projproxy) before you install the Workflow to
Scheduling Integration.

Product Support Data
Management

Product supportability analysis sample data features available in Teamcenter.

Logistics Control
Number Management
Active Workspace
Client

Enables the capability to author LCN in Active Workspace.

Part Provisioning and
Cataloguing Active
Workspace Client

Enables capturing the provisioning and cataloguing requirements in Active Workspace.

Support Equipment
and Tools
Management

Enables the capabilities to define the Support/Test Equipment and Tools requirements
based on the GEIA STD.

Support Equipment
and Tools

Enables the capabilities to define the Support/Test Equipment and Tools requirements
based on the GEIA STD in Active Workspace.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Management Active
Workspace Client

Part Provisioning and
Cataloguing Interface
with LCN Management
Active Workspace
Client

Enables the capability to author LCN and provisioning data in Active Workspace. This
increases efficiency of maintenance and reduces the cost of providing support by
preplanning all aspects of provisioning and cataloguing.

Logistics Control
Number Management

Enables the capability to author LCN.

Part Provisioning and
Cataloguing

Enables capturing the provisioning and cataloguing requirements.

Part Provisioning and
Cataloguing Interface
with LCN Management

Enables the capability to author LCN and provisioning data. This increases efficiency of
maintenance and reduces the cost of providing support by preplanning all aspects of
provisioning and cataloguing.

Maintenance Task
Analysis

Enables Maintenance Task Analysis.

Operations and
Maintenance
Requirements
Management

Contains all the business objects and rules defined for the LSA (Logistic Support
Analysis) of the product.

Operations and
Maintenance
Requirements
Management Active
Workspace Client

Contains all the business objects and rules defined for the LSA (Logistic Support
Analysis) of the product in Active Workspace.

Reliability Analysis and
Data Management

Enables the capability to author the reliability analysis of the data. This increases
efficiency of maintenance and reduces the cost of providing support by preplanning
all aspects of reliability.

Reliability Analysis
and Data Management
Active Workspace
Client

Enables the capability to author the reliability analysis of the data in Active Workspace.
This increases efficiency of maintenance and reduces the cost of providing support by
preplanning all aspects of reliability.

Transportability
Analysis and Data
Management

Captures the transportability engineering requirements for an end item and critical
sections and subcomponents in its shipping configuration.

Transportability
Analysis and Data
Management Active
Workspace Client

Captures the transportability engineering requirements for an end item and critical
sections and subcomponents in its shipping configuration in Active Workspace.

Unit Under Test
Management

Enables the capability to capture the Unit Under Test Requirements (GEIA U Entities).

Maintenance Task
Analysis Active
Workspace Client

Enables Maintenance Task Analysis in Active Workspace.

Maintenance Task
Analysis Interface with
LCN Management

Enables Maintenance Task Analysis with LCN Management.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

Reliability Analysis
Interface with LCN
Management

Enables the capability to author LCN and the reliability analysis of the data. This
increases efficiency of maintenance and reduces the cost of providing support by
preplanning all aspects of reliability.

Reliability Analysis
Interface with LCN
Management Active
Workspace Client

Enables the capability to author LCN and the reliability analysis of the data in Active
Workspace. This increases efficiency of maintenance and reduces the cost of providing
support by preplanning all aspects of reliability.

Transportability
Analysis Interface with
LCN Management

Enables the capability to author LCN and the transportability engineering requirements
for a product.

Transportability
Analysis Interface with
LCN Management
Active Workspace
Client

Enables the capability to author LCN and the transportability engineering requirements
for a product in Active Workspace.

Unit Under Test
Management Active
Workspace Client

Enables the capability to capture the Unit Under Test Requirements (GEIA U Entities) in
Active Workspace.

Maintenance Task
Analysis Interface with
LCN Management
Active Workspace
Client

This feature provides Maintenance Task Analysis with LCN Management in Active
Workspace.

Reporting and Analytics Features to support Teamcenter Reporting and Analytics.

Teamcenter for
Reporting and
Analytics

Installs the Teamcenter Reporting and Analytics (TcRA) integration. TcRA is a standalone
reporting application that introduces a new folder in Report Builder called TcRA
Reports, which contains reports created with TcRA.

Dashboard Installs the Teamcenter Reporting and Analytics dashboard interface.

Reuse and Standardization Reuse and Standardization features.

Classification Interface Installs the Classification interface for Reuse and Standardization.

Presentation Layer
- Next Generation
Classification
Foundation

Installs the Next Generation Classification foundation feature for Library Management.

Advanced
Classification

Installs advanced capabilities for the Classification interface.

Teamcenter
Classification Collector
(earlier called Library
Management)

Installs a data model and functionality for Library Management that supports creating
and configuring multiple libraries to meet the reuse needs of business processes and
targeted sets of users. Library Management leverages Classification and includes a
rules-based search capability for enforcing technical constraints in the context of a
design process (known as Specifications, which is a distinct and separate feature from
Specification Manager used to support the Consumer Packaged Goods industry).

The lbrmanager command line utility is also included with this feature.

Deploying the Library Management feature automatically deploys the following
prerequisite features:

• Advanced PLM Services for Applications
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

• Advanced PLM Services for Partitioning
• Advanced PLM Services for Realization
• Next Generation Classification foundation

Supplier Relationship
Management

Supplier Relationship Management features.

SRM Integration Installs the Supplier Relationship Management integration for data exchange.

Vendor Management Installs the optional Vendor Management solution.

Substance Compliance Installs support for Substance Compliance, which checks if the parts used in your
company products conform to environmental regulations. Teamcenter helps verify if
the products are environmentally compliant by checking the material and substance
information for in-house parts and supplier parts used in the products.

Supplier Collaboration Installs the Supplier Collaboration solution.

Teamcenter Supplier Collaboration is a framework that helps companies manage their
supply chains.

This feature is deprecated and will be removed in a future version of Teamcenter. It is
not available to install in a new Teamcenter configuration.

Substance Compliance
IMDS (International
Material Data System)

Installs support for the Teamcenter Substance Compliance-IMDS Integration.

Substance compliance checks whether the parts used in your company products
conform to environmental regulations. International Material Data System (IMDS) is a
third-party system for exchanging material and substance information with suppliers.
Automotive companies use IMDS to collaborate with suppliers for material and
substance declaration information. Teamcenter is integrated with IMDS to send material
data sheet (MDS) requests to IMDS and to download the MDSs, uploaded by suppliers,
from IMDS to Teamcenter.

This feature is deprecated and will be removed in a future version of Teamcenter. It is
not available to install in a new Teamcenter configuration.

Systems Engineering and
Requirements Management

Features that support Systems Engineering and Requirements Management.

Teamcenter
Extensions for
Microsoft Office

Installs Teamcenter Extensions for Microsoft Office.

Requirements
Management for Rich
Client

Installs the Requirements Management functionality for Systems Engineering and
Requirements Management.

Teamcenter Integration for FORAN Adds support for FORAN integration with Teamcenter. This feature allows users to
publish marine product models from the FORAN desktop application.

FORAN Foundation Base feature for FORAN integration.

Teamcenter Integration for I-deas Teamcenter Integration for I-deas features.

Teamcenter
Integration for I-deas -
Database Extensions

Installs data model for Teamcenter integration for I-deas.

Teamcenter Integration for NX Teamcenter Integration for NX features.
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Feature/Subfeature Description

Teamcenter Office Online Installs the Teamcenter integration to Microsoft Office Online, which allows users
to edit and view documents within Active Workspace instead of using Microsoft
Office desktop applications.

NX Part
Family Classification
Integration

Installs core functionality of Teamcenter Integration for NX. This feature requires a
local installation of NX.

Teamcenter Integration for NX is a data management tool used with NX. When you
use NX with this integration, Teamcenter runs at the same time as a separate process,
enabling NX and Teamcenter to communicate so you can create, store, and access your
NX data within a Teamcenter database.

For information about using Teamcenter Integration for NX, see Teamcenter Integration
for NX in the NX help.

NX Multi-User
Notifications

This feature configures the Teamcenter installation to enable multi-user design
notifications microservice for NX. This feature allows users to publish and receive design
activity notifications from the NX desktop application.

Electrical Cable Route
Management

Configures the Teamcenter installation to manage the physical cable route for an
electrical solution. This enables authoring of physical cables using the NX routed system
designer application.

NX Foundation Installs default data types and loads template NX data to support Teamcenter
Integration for NX, the Teamcenter integration with Siemens Digital Industries
Software NX.

NX Logical Installs logical data model for Teamcenter Integration for NX.

NX Rich Client
Integration

Installs Teamcenter Integration for NX for the rich client. This feature requires
Teamcenter Rich Client 2-tier or Teamcenter Rich Client 4-tier.

NX Change
Management

Installs Change Management support for Teamcenter Integration for NX.

For information about using Teamcenter Integration for NX, see Teamcenter Integration
for NX in the NX help.

NX Staged Models This feature configures the Teamcenter installation to support stage model application
for NX. This feature allows users to publish manufacturing process steps of a design part
to Teamcenter from the NX desktop application.

NX 4th Generation
Design

Installs 4th Generation Design (4GD) support for Teamcenter Integration for NX.

4GD allows users of NX CAD or Lifecycle Visualization to cooperate in real time during
the design cycle of a product.

NX Piping
and Instrumentation
Diagram (P&ID) Design

Installs support for managing NX piping and instrumentation diagram/drawing (P&ID)
files in Teamcenter. Teamcenter supports P&ID files as part of its support for multi-
disciplinary (MD) objects.

NX Piping and Instrumentation Diagram (P&ID) Design is not supported with
Teamcenter Rapid Start. This feature is only available in Teamcenter.

Teamcenter Quality platform Features to support Teamcenter Quality functionality.

Quality Base Adds Teamcenter Quality support to Teamcenter.

For more information, see Teamcenter Quality in the Active Workspace help.

Control and Inspection
Plan Data Model

Installs support for control and inspection planning.

This feature allows you to manage critical characteristics of Failure Mode Effect Analysis
(FMEA) and create a control plan that generates bill of process (BOP) elements.

Quality Issue
Management and
Problem Solving base

Installs Issue Manager capabilities for Teamcenter Quality.
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Battery features

Battery features available in Teamcenter. These features are available in the Battery feature group in
TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature/Subfeature Description

Experiment Management for Battery Enables customers to understand the battery product and process. This
shortens the time to characterize the product in experimental measurement.

Battery Foundation Active Workspace Client Installs a collaborative platform with a battery-specific data model and
workflows providing a single source of product, project, and process data.

Miscellaneous features

Miscellaneous features provide additional capabilities to Teamcenter. These features are available in the
Miscellaneous feature group in TEM.

To search for a feature by name, type the name or a partial name in the search box, and then click the
search button.

Feature/Subfeature Description

Color and Visual Appearance
Management

This feature provides appearance parameters such as color, gloss, and texture along
with a color specification. The combination of color, gloss, and texture with the color
specification is called a visual appearance. Once a visual appearance is defined, it can be
associated with objects such as parts in the BOM system.

This feature is automatically selected when you select Color BOM for Product Master
Management.

LOGISTICS for Rich Client Installs the logistics feature for the rich client.

Product Variants Installs product variant support for Mechatronics Process Management. This feature is
required by Calibration and Configuration Data Management

Color Explosion Rule
Management

This feature which provides a common infrastructure support for definition of Color Rule
and its behavior. Color Rules can be associated with one or more visual appearances
and variant conditions. They are revisable and participate in workflows. These rules can
interact with systems such as Product Master Manager to author color parts and usages
automatically when invoked. This feature may be further used associate a design object's
color and variant condition.

This feature is automatically selected when you select Color BOM for Product Master
Management.
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27. Web tier context parameters
The following tables describe web tier context parameters provided by Teamcenter web tier solutions.

Web tier required parameters

Parameter Description

General parameters

TcLocale Locale of the Teamcenter server for localization of web
tier messages. This locale must match the locale of the
Teamcenter server.

For example, if Teamcenter server is running in the
Russian locale, specify ru_RU for this parameter.

Max_Capacity Specifies the maximum number of concurrent
connections to Teamcenter servers the server pool
maintains.

The default value of 500 connections may be
too low to prevent performance slowdowns when
running Websphere as a middle tier server. To
avoid performance slowdowns and possible connection
errors, increase the number of available connects by
setting max_capacity to a value greater than 500.

This parameter applies to web application deployment
on WebLogic, JBoss, and Oracle Application Server. For
other application servers, the maximum pool size must
be set using the application server console.

Server_Manager_URIs Specifies a list of server manager URIs, separated by
semicolons. For example:

http://hostA:8086/PoolA;http://hostB:8086/PoolB

LogVolumeName Name of the log volume.

LogVolumeLocation Log volume location, the root directory under which log
files are created. The default location logs represent a
child folder beneath the default root directory of the
target application server instance. This location varies
depending on the application server vendor.
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Parameter Description

If the path you enter contains backslash characters (\)
as path delimiters, use double backslash characters (\\)
to represent single backslash characters.

DEPLOYABLE-FILE-NAME Name of the deployable file you are creating for the
web tier application. The name is configurable; Web
Application Manager adds the file extension.

Security Services parameters

Parameter Description

IS_SSO_ENABLED Specifies whether Security Services is enabled for this
instance of Teamcenter.

SSO_APPLICATION_ID Application ID assigned to this instance of Teamcenter
in the Security Services application registry. This
information is required only when you are configuring
the optional Security Services.

This ID is determined when Security Services is installed
and configured.

SSO_logon_SERVICE_URL Complete URL of the Security Services logon Service
web application. This information is required only when
you configure the optional Security Services.

This URL is determined when Security Services is
installed and configured.

SSO_SERVICE_URL Complete URL of the Security Services Identity Service
web application. This information is required only when
you configure the optional Security Services.

This URL is determined when Security Services is
installed and configured.
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Web tier optional parameters

Parameter Description

General parameters

webmaster E-mail address of the administrator to whom questions
and comments about this application are addressed.

staticResourceClientCache
ExpiryTime

Maximum time in seconds that a client can use a locally
cached static content (for example, images or JavaScript)
before requesting a fresh copy from the server.

Setting this value too low causes the client to
unnecessarily request content. Setting this value too
high risks stale content. Typical values range from
several hours to one day.

Setting the value to 0 is valid and causes the client to
always ask for static content.

The default value is 28800 seconds (8 hours).

compressResponse Specifies whether a response to the client can be
compressed if the requesting client supports it.

Compressing the response typically yields faster response
time to the client but requires additional processing in
the web container.

Set this parameter value based on trial and error for
your instance of the server, bandwidth, and client access
environment.

The default value is true.

cacheCompressedStatic
ResourceOnServer

Specifies whether responses for static resources are
cached on the server. This parameter is used only when
the compressResponse parameter is set to true.

If the value is set to true, compressed responses for
static resources are cached on the server, memory
permitting.

If the value is set to false, the compression occurs each
time the client requests a static resource.

The default value is true.

responseCompression
Threshold

Threshold in bytes beyond which the server should
compress responses sent back to the client.
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Parameter Description

Typically compressing smaller responses does not yield
much compression - so all responses equal to or smaller
than this value will be sent to the client uncompressed.

Setting the value to 0 is valid and causes the server to
compress every response sent to the client (assuming
other parameters permit compression).

The default value is 500 bytes. Change this value only if
absolutely required.

calculateResponseTime Specifies whether the group of response time filters are
on (by setting to true) or off (by setting to false).

These filters are used for instrumentation purposes (for
example, the average time spent in processing a request
from a rich client).

The response time filters should remain turned off unless
you are collecting statistics.

The default value is false.

27. Web tier context parameters

27-4  Teamcenter Installation on Windows Using TEM, Teamcenter 2412
© 2025 Siemens



28. Required RPM package managers
If you use the visualization server manager (VSM) on a Linux machine, make sure the following required
RPM package managers are available on the machine.

SUSE Linux:

fontconfig-2.11.1-7.1.x86_64
glibc-2.31-150300.46.1.x86_64
glibc-32bit-2.22-15.3.x86_64
libbz2-1-1.0.6-29.2.x86_64
libexpat1-2.1.0-21.3.1.x86_64
libexpat-devel-2.1.0-21.3.1.x86_64
libfreetype6-2.6.3-7.15.1.x86_64
libgcc_s1-8.2.1+r264010-1.3.3.x86_64
libGLU1-9.0.0-18.1.x86_64
libICE6-1.0.8-12.1.x86_64
libjpeg8-8.1.2-31.7.4.x86_64
libpng16-16-1.6.8-14.1.x86_64
libSM6-1.2.2-3.59.x86_64
libstdc++6-8.2.1+r264010-1.3.3.x86_64
libstdc++6-12.2.1+git416-150000.1.7.1.x86_64
libuuid1-2.29.2-7.14.x86_64
libX11-6-1.6.2-12.5.1.x86_64
libXau6-1.0.8-4.58.x86_64
libxcb1-1.10-4.3.1.x86_64
libXext6-1.3.2-4.3.1.x86_64
libXft2-2.3.1-9.32.x86_64
libXm4-2.3.4-4.15.x86_64
libXmu6-1.1.2-3.60.x86_64
libXp6-1.0.2-3.58.x86_64
libXrender1-0.9.8-7.1.x86_64
libXt6-1.1.4-3.59.x86_64
libz1-1.2.11-1.27.x86_64
Mesa-libGL1-18.0.2-6.28.x86_64

Note:

On SUSE Linux, the /usr/lib64/libGLdispatch.so.0 file is not owned by any package.

Also, the /usr/lib64/libGLX.so.0 file is not owned by any package.

RedHat Linux:

bzip2-libs-1.0.6-13.el7.x86_64
expat-2.1.0-10.el7_3.x86_64
expat-devel-2.1.0-10.el7_3.x86_64
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fontconfig-2.13.0-4.3.el7.x86_64
freetype-2.8-12.el7.x86_64
glibc-2.28-225.el8.x86_64
libgcc-4.8.5-36.el7.x86_64
libglvnd-1.0.1-0.8.git5baa1e5.el7.x86_64
libglvnd-glx-1.0.1-0.8.git5baa1e5.el7.x86_64
libICE-1.0.9-9.el7.x86_64
libjpeg-turbo-1.2.90-6.el7.x86_64
libpng-1.5.13-7.el7_2.x86_64
libSM-1.2.2-2.el7.x86_64
libstdc++-4.8.5-36.el7.x86_64
libstdc++-8.5.0-18.el8.x86_64
libuuid-2.23.2-59.el7.x86_64
libX11-1.6.5-2.el7.x86_64
libXau-1.0.8-2.1.el7.x86_64
libxcb-1.13-1.el7.x86_64
libXext-1.3.3-3.el7.x86_64
libXft-2.3.2-2.el7.x86_64
libXmu-1.1.2-2.el7.x86_64
libXp-1.0.2-2.1.el7.x86_64
libXrender-0.9.10-1.el7.x86_64
libXt-1.1.5-3.el7.x86_64
mesa-libGLU-9.0.0-4.el7.x86_64
motif-2.3.4-14.el7_5.x86_64
zlib-1.2.7-18.el7.x86_64
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